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Symbols Used in This Document

Warning
Instructions that, if ignored, could result in death, serious personal injury, or property damage caused by
incorrect operation of the equipment. These must be observed for safe operation.

Caution
Instructions that, if ignored, could result in personal injury or property damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

Important
Instructions including important information that must be observed to avoid damage and injury or
improper use of the product. Be sure to read these instructions.

Note
Instructions including notes for operation and additional explanations.

Basics

Instructions explaining basic operations of your product.

Note
• Icons may vary depending on your product.
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Touch-enabled Device Users (Windows)

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."
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Printing Online Manual

To print the Online Manual, use the print function of your Web browser.

For Windows:
To set to print background colors and images, follow the steps below.

Note
• If you are using Windows 8.1, print in the desktop version.
• Background colors and background images cannot be printed in Microsoft Edge. To print background

colors and background images, use Internet Explorer 11, Mozilla Firefox, or Google Chrome.

• In Internet Explorer 11•

1. Select  (Tools) > Print > Page setup....
2. Select the Print Background Colors and Images checkbox.

• In Mozilla Firefox•

1. Select  (Menu) > Print... > Page Setup....
2. Select the Print Background (colors & images) checkbox in Format & Options.

• In Google Chrome•

1. Select  (Customize and control Google Chrome) > Print....
2. Click More settings, and then select the Background graphics checkbox in Options.

For macOS:
To print background colors and images, follow the steps below to display the Print dialog options, then
select the Print backgrounds checkbox.

1. Click Print... from the File menu.
2. Click Show Details.
3. Select Safari from the pop-up menu.3.
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Trademarks and Licenses

Trademarks

Licenses
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Trademarks

• Microsoft is a registered trademark of Microsoft Corporation.
• Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Microsoft Edge and Microsoft Excel are either trademarks or registered trademarks of Microsoft

Corporation in the U.S. and/or other countries.
• Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or

other countries.
• Mac, Mac OS, macOS, OS X, AirPort, App Store, AirPrint, the AirPrint logo, Safari, Bonjour, iPad, iPad

Air, iPad mini, iPadOS, iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and
other countries.

• IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

• Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Drive, Google Apps
and Google Analytics are either registered trademarks or trademarks of Google Inc. Google Play and
Google Play Logo are trademarks of Google LLC.

• Adobe, Acrobat, Flash, Photoshop, Illustrator, Adobe RGB and Adobe RGB (1998) are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

• Adobe, Acrobat, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB
(1998) are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

• Google, Google Home, and Android are trademarks of Google LLC.
• LINE Clova is a registered trademark of LINE Corporation.
• App Store is a trademark of Apple Inc., registered in the U.S. and other countries.
• Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.
• Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its

subsidiaries and/or affiliates in the USA and/or other countries.
• QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and in other

countries.
• The Mopria® word mark and the Mopria® Logo are registered and/or unregistered trademarks of Mopria

Alliance, Inc. in the United States and other countries. Unauthorized use is strictly prohibited.
• HP-GL and HP-GL/2 are either registered trademarks or trademarks of HP Inc. in the United States

and/or other countries.
• All other company names and products mentioned in this guide may be registered trademarks or

trademarks of their respective companies.

Note
• The formal name of Windows Vista is Microsoft Windows Vista operating system.
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Licenses

Copyright (c) 2003-2015 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.1.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.
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"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work
and any modifications or additions to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or
Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this
definition, "submitted" means any form of electronic, verbal, or written communication sent to the
Licensor or its representatives, including but not limited to communication on electronic mailing lists,
source code control systems, and issue tracking systems that are managed by, or on behalf of,
the Licensor for the purpose of discussing and improving the Work, but excluding communication
that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except
as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute
patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that
the Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in4.
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and
2. You must cause any modified files to carry prominent notices stating that You changed the files;

and
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3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works4.
that You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in
at least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works;
or, within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications,
or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions
of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
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such warranty or additional liability.
END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California

All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----

Copyright (c) 2001-2003, Networks Associates Technology, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ``AS IS'' AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright c 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.

Use is subject to license terms below.

This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
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SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----

Copyright (c) 2003-2012, Sparta, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
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ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----

Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com

Author: Bernhard Penz <bernhard.penz@fabasoft.com>

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ``AS IS'' AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 8: Apple Inc. copyright notice (BSD) -----

Copyright (c) 2007 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
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OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

---- Part 9: ScienceLogic, LLC copyright notice (BSD) -----

Copyright (c) 2009, ScienceLogic, LLC

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of ScienceLogic, LLC nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

MIT License

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
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OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright 2000 Computing Research Labs, New Mexico State University

Copyright 2001-2015 Francesco Zappa Nardelli

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE COMPUTING
RESEARCH LAB OR NEW MEXICO STATE UNIVERSITY BE LIABLE FOR ANY CLAIM, DAMAGES
OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Written by Joel Sherrill <joel@OARcorp.com>.

COPYRIGHT (c) 1989-2000.

On-Line Applications Research Corporation (OAR).

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby
granted, provided that this entire notice is included in all copies of any software which is or includes a
copy or modification of this software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.
IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND
CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE.

(1) Red Hat Incorporated

Copyright (c) 1994-2009 Red Hat, Inc. All rights reserved.

This copyrighted material is made available to anyone wishing to use, modify, copy, or redistribute it
subject to the terms and conditions of the BSD License. This program is distributed in the hope that it
will be useful, but WITHOUT ANY WARRANTY expressed or implied, including the implied warranties of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at
http://www.opensource.org/licenses. Any Red Hat trademarks that are incorporated in the source code or
documentation are not subject to the BSD License and may only be used or replicated with the express
permission of Red Hat, Inc.

(2) University of California, Berkeley

Copyright (c) 1981-2000 The Regents of the University of California.
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All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The FreeType Project LICENSE

----------------------------

2006-Jan-27

Copyright 1996-2002, 2006 by

David Turner, Robert Wilhelm, and Werner Lemberg

Introduction

============

The FreeType Project is distributed in several archive packages; some of them may contain, in addition to
the FreeType font engine, various tools and contributions which rely on, or relate to, the FreeType Project.

This license applies to all files found in such packages, and which do not fall under their own explicit
license. The license affects thus the FreeType font engine, the test programs, documentation and
makefiles, at the very least.

This license was inspired by the BSD, Artistic, and IJG (Independent JPEG Group) licenses, which
all encourage inclusion and use of free software in commercial and freeware products alike. As a
consequence, its main points are that:

o We don't promise that this software works. However, we will be interested in any kind of bug reports.
(`as is' distribution)

o You can use this software for whatever you want, in parts or full form, without having to pay us.
(`royalty-free' usage)

o You may not pretend that you wrote this software. If you use it, or only parts of it, in a program, you
must acknowledge somewhere in your documentation that you have used the FreeType code. (`credits')
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We specifically permit and encourage the inclusion of this software, with or without modifications, in
commercial products.

We disclaim all warranties covering The FreeType Project and assume no liability related to The FreeType
Project.

Finally, many people asked us for a preferred form for a credit/disclaimer to use in compliance with this
license. We thus encourage you to use the following text:

"""

Portions of this software are copyright © <year> The FreeType

Project (www.freetype.org). All rights reserved.

"""

Please replace <year> with the value from the FreeType version you actually use.

Legal Terms

===========

0. Definitions

--------------

Throughout this license, the terms `package', `FreeType Project', and `FreeType archive' refer to the set
of files originally distributed by the authors (David Turner, Robert Wilhelm, and Werner Lemberg) as the
`FreeType Project', be they named as alpha, beta or final release.

`You' refers to the licensee, or person using the project, where `using' is a generic term including
compiling the project's source code as well as linking it to form a `program' or `executable'.

This program is referred to as `a program using the FreeType engine'.

This license applies to all files distributed in the original FreeType Project, including all source code,
binaries and documentation, unless otherwise stated in the file in its original, unmodified form as
distributed in the original archive.

If you are unsure whether or not a particular file is covered by this license, you must contact us to verify
this.

The FreeType Project is copyright (C) 1996-2000 by David Turner, Robert Wilhelm, and Werner Lemberg.
All rights reserved except as specified below.

1. No Warranty

--------------

THE FREETYPE PROJECT IS PROVIDED `AS IS' WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL ANY OF THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY DAMAGES CAUSED BY THE USE OR THE INABILITY
TO USE, OF THE FREETYPE PROJECT.

2. Redistribution

-----------------

This license grants a worldwide, royalty-free, perpetual and irrevocable right and license to use, execute,
perform, compile, display, copy, create derivative works of, distribute and sublicense the FreeType Project
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(in both source and object code forms) and derivative works thereof for any purpose; and to authorize
others to exercise some or all of the rights granted herein, subject to the following conditions:

o Redistribution of source code must retain this license file (`FTL.TXT') unaltered; any additions, deletions
or changes to the original files must be clearly indicated in accompanying documentation. The copyright
notices of the unaltered, original files must be preserved in all copies of source files.

o Redistribution in binary form must provide a disclaimer that states that the software is based in part of
the work of the FreeType Team, in the distribution documentation. We also encourage you to put an URL
to the FreeType web page in your documentation, though this isn't mandatory.

These conditions apply to any software derived from or based on the FreeType Project, not just the
unmodified files. If you use our work, you must acknowledge us. However, no fee need be paid to us.

3. Advertising

--------------

Neither the FreeType authors and contributors nor you shall use the name of the other for commercial,
advertising, or promotional purposes without specific prior written permission.

We suggest, but do not require, that you use one or more of the following phrases to refer to this software
in your documentation or advertising materials: `FreeType Project', `FreeType Engine', `FreeType library',
or `FreeType Distribution'.

As you have not signed this license, you are not required to accept it. However, as the FreeType Project
is copyrighted material, only this license, or another one contracted with the authors, grants you the right
to use, distribute, and modify it.

Therefore, by using, distributing, or modifying the FreeType Project, you indicate that you understand and
accept all the terms of this license.

4. Contacts

-----------

There are two mailing lists related to FreeType:

o freetype@nongnu.org

Discusses general use and applications of FreeType, as well as future and wanted additions to the library
and distribution.

If you are looking for support, start in this list if you haven't found anything to help you in the
documentation.

o freetype-devel@nongnu.org

Discusses bugs, as well as engine internals, design issues, specific licenses, porting, etc.

Our home page can be found at

http://www.freetype.org

--- end of FTL.TXT ---

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit expressly
disclaim all implied, express or statutory warranties including, without limitation, the implied warranties
of merchantability, noninfringement of third party rights and fitness for a particular purpose. Neither the
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developers nor the distributors will be liable for damages, whether direct, indirect, special, incidental, or
consequential, as a result of the reproduction, modification, distribution or other use of the TWAIN Toolkit.

JSON for Modern C++

Copyright (c) 2013-2017 Niels Lohmann

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2011 - 2015 ARM LIMITED

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of ARM nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL COPYRIGHT HOLDERS AND CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2014, Kenneth MacKay

All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2006, CRYPTOGAMS by <appro@openssl.org> All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain copyright notices, this list of conditions and the following
disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the CRYPTOGAMS nor the names of its copyright holder and contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

ALTERNATIVELY, provided that this notice is retained in full, this product may be distributed under the
terms of the GNU General Public License (GPL), in which case the provisions of the GPL apply INSTEAD
OF those given above.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ISC License

Copyright (c) 2013-2017

Frank Denis <j at pureftpd dot org>
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Permission to use, copy, modify, and/or distribute this software for any purpose with or without fee is
hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS" AND THE AUTHOR DISCLAIMS ALL WARRANTIES WITH
REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY SPECIAL, DIRECT,
INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

Copyright (c) 2008 The NetBSD Foundation, Inc.

All rights reserved.

This code is derived from software contributed to The NetBSD Foundation
by Lennart Augustsson (lennart@augustsson.net) at
Carlstedt Research & Technology.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2000 Intel Corporation

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.
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* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.
* Neither name of Intel Corporation nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTEL OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Lua

Copyright © 1994–2014 Lua.org, PUC-Rio.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation
the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and
to
permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of
the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH
THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LuaSocket

LuaSocket 2.0.2 license
Copyright © 2004-2007 Diego Nehab
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Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the "Software"),
to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

LuneScript

Copyright (c) 2018 ifritJP

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Copyright (c) 2002-2019, Jouni Malinen <j@w1.fi> and contributors
All Rights Reserved.

This software may be distributed, used, and modified under the terms of
BSD license:

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:
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1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. Neither the name(s) of the above-listed copyright holder(s) nor the
names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (C) 2019, Broadcom Corporation. All Rights Reserved.

Permission to use, copy, modify, and/or distribute this software for any
purpose with or without fee is hereby granted, provided that the above
copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS" AND THE AUTHOR DISCLAIMS ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY
SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION
OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following applies only to products supporting Wi-Fi.

(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.
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* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS," AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The following applies only to products supporting PIXUS Cloud Link, PIXMA Cloud Link, or MAXIFY Cloud
Link.

THE BASIC LIBRARY FUNCTIONS

---------------------------

Written by:       Philip Hazel
Email local part: ph10
Email domain:     cam.ac.uk
University of Cambridge Computing Service, Cambridge, England.
Copyright (c) 1997-2012 University of Cambridge
All rights reserved.

PCRE JUST-IN-TIME COMPILATION SUPPORT

-------------------------------------

Written by:       Zoltan Herczeg
Email local part: hzmester
Emain domain:     freemail.hu
Copyright(c) 2010-2012 Zoltan Herczeg
All rights reserved.

STACK-LESS JUST-IN-TIME COMPILER

--------------------------------

Written by:       Zoltan Herczeg
Email local part: hzmester
Emain domain:     freemail.hu
Copyright(c) 2009-2012 Zoltan Herczeg
All rights reserved.

THE C++ WRAPPER FUNCTIONS

-------------------------
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Contributed by:   Google Inc.
Copyright (c) 2007-2012, Google Inc.
All rights reserved.

THE "BSD" LICENCE

-----------------Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of the University of Cambridge nor the name of Google
Inc. nor the names of their contributors may be used to endorse or
promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This software is based in part on the work of the Independent JPEG Group.
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Stopping Printing
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Front

A: Access Cover
Open when performing printer maintenance or when removing jammed paper.

Inside

B: Cut Sheet Feed Cover
Open when loading sheets in the top feed.

Top View

C: Roll Paper Feed Cover
Open when loading rolls. Operate with the cut sheet feed cover open.

Top View (with roll loaded)

D: Access Cover
Open when performing printer maintenance or when removing jammed paper.

Inside

E: Ink Tank Cover
Open to refill ink tanks.

Inside of Ink Tank Cover, Inside of Maintenance Cover

F: Maintenance Cover
Open when replacing the maintenance cartridge.

Inside of Ink Tank Cover, Inside of Maintenance Cover

G: Output Guide
Supports output paper.

H: Operation Panel
Use to change the settings of the printer or to operate it.

Operation Panel
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Inside of Ink Tank Cover, Inside of Maintenance Cover

A: Ink Tank Inner Cover
Open to refill ink tanks.

B: Tank Caps
Open to refill ink tanks.

C: Ink Tanks
Containers for ink inside the printer. Refill when the ink runs low.

Refilling Ink Tanks

D: Maintenance Cartridge
Maintenance Cartridge

Maintenance Cartridge

Model number: MC-32

Absorbs ink used for cleaning.

Replacing the Maintenance Cartridge
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Important
• When purchasing, check the Model number.•
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Back / Side

A: USB Port
Plug in the USB cable to connect the printer with a computer.

B: Wired LAN Connector
Plug in the LAN cable to connect the printer to a LAN.

C: Carrying Grips
When carrying the printer, have 2 people hold it by these handles under both sides. Furthermore, hold
the left and right of these parts when moving the printer with a stand.

D: Power Cord Connector
Plug in the supplied power cord.
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Top View

A: Top Feed
Load paper here. When loading sheets, open the top feed and then pull it upwards. Two or more sheets
of the same size and type of paper can be loaded at the same time, and fed automatically one sheet at
a time.

Loading Sheets in the Printer

B: Paper Guides
Align with both sides of the paper stack.
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Top View (with roll loaded)

A: Roll Holder
When the roll is loaded into the printer, it is attached and secured on either side of the roll paper.

Loading Rolls in the Printer

B: Slide Guide
Slide the roll holder over this guide to load the roll into the printer.

C: Roll Holder Slot
The roll holder shafts mounted on either side of the roll are set in these slots.

D: Roll Holder Support
Move this left or right when changing the width of the roll to be set.

Moving the Roll Holder Support

E: Feed Cover Rollers
When feeding roll paper, these rollers help carry the paper to the paper retainer.
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Inside

A: Paper Retainer
This retainer holds paper as it is fed.

B: Platen
The print head moves across the platen to print.

C: Ink Valve Lever
Use when the printer is sent for repair.

Repairing Your Printer

D: Carriage Rail
The Carriage slides along this rail.

E: Carriage
Moves the print head.

Carriage
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Carriage

A: Print Head Locking Cover
Secures the print head.

B: Print Head
Print Head

C: Print Head Lock Lever
Lock print head locking cover.

Print Head

Model number: PF-08

The print head is equipped with ink nozzles.

Replacing the Print Head

Important
• When purchasing, check the Model number.•
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Operation Panel

A: ON button
Turns the printer on or off.

Turning the Printer On and Off

B: ON lamp
Remains lit after flashing when the printer is turned on.

C: Touch Screen
Displays messages, menu items, and operating status. Touch the screen lightly with your finger to
select a menu item or button.

Home Screen Menu Composition

D: Stop button
Cancels printing.

E: Alarm lamp
Lights up or flashes in case of errors.

F: HOME button
Used to display the HOME screen.

Home Screen Menu Composition

G: Back button
Returns to the previous screen.
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Desktop Basket

The following basket is available for this printer.

• Desktop Basket BU-06•

Parts of Desktop Basket

A: Basket Adapters
Insert these into the printer body to attach the Desktop Basket.

B: Basket Arm
Move the arm to open or close the basket.

C: Basket Cloth
Catches the ejected printed documents.
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D: Support Stay
Attached in front of the output guide to support the basket cloth.

Note
• For instructions on how to use the Desktop Basket, see "Using the Desktop Basket".•
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Printer Stand

The following stand is available for this printer.

• Printer Stand SD-24•

Parts of Printer Stand

A: Stand
A stand that holds the printer. It is equipped with casters to facilitate movement.

B: Basket Cloth
Catches the ejected printed documents.
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C: Locking Caster
The casters can be locked securely. When moving the printer, be sure to unlock the 4 casters. If you
move it while the locking casters are locked, the floor may become scratched.

Note
• For instructions on how to use the basket that comes with the printer stand, see "Using the Basket on•

the Printer Stand".
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Using the Printer

Turning the Printer On and Off

Loading Rolls in the Printer

Loading Sheets in the Printer

Using the Desktop Basket

Using the Basket on the Printer Stand

Stopping Printing
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Turning the Printer On and Off

Turning on the printer

Press the ON button to turn on the printer.

The ON lamp flashes and then remains lit.

Checking that Power Is On

Note
• It may take a while for the printer to start printing immediately after you turn on the printer.•

• You can set the printer to automatically turn on when a print operation is performed from a computer•
connected by USB cable or wireless network. This feature is set to off by default.

ECO

Turning off the printer

Press the ON button to turn off the printer.

When the ON lamp stops flashing, the printer is turned off.

Important
• When you unplug the power cord after turning off the printer, be sure to confirm that the ON lamp is•

off.
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Note
• You can set the printer to automatically turn off when no operations are performed or no print jobs•

are sent to the printer for a certain interval. This feature is set to on by default.

ECO

Checking that Power Is On
The ON lamp is lit when the printer is turned on.

Even if the touch screen is off, if the ON lamp is lit, the printer is on.

Note
• The touch screen display will turn off if the printer is not operated for about 5 minutes. To restore the•

display, touch the touch screen. The display is also activated again when an original is printed from a
computer.
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Using the Desktop Basket

You can store printed documents in the basket.

When storing printed documents in the basket, use the basket in position (1).

When you are not using the basket, store it in position (2).

Important
• When storing printed documents on the basket, always use it in position (1). If you do not, printed•

documents may not be dropped into the basket, and the printed surface may become soiled.

• Lift the left and right sides of the basket arm (A) evenly so that the front of the basket is horizontal.•

• The number of sheets that can be collected in the basket is one. If printing multiple pages, print after•
removing each sheet.

• The basket can hold printed documents from paper up to 36.0 inches (914.4 mm) long.•

• Printed documents that are short in length relative to the roll paper width may not fall straight down and•
miss the basket. For short printed documents, it is recommended to use Eject cut.

Eject cut (when the paper surface is being scratched / to wait for ink to dry)
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• If the cloth part of the basket becomes dirty, wipe off the dirt without washing. Washing it may affect the•
performance of the basket.
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Using the Basket on the Printer Stand

You can store printed documents in the basket.

When storing printed documents in the basket, use the basket in position (1).

When you are not using the basket, store it in position (2).

Important
• When storing printed documents on the basket, always use it in position (1). If you do not, printed•

documents may not be dropped into the basket, and the printed surface may become soiled.

• To store printed documents in the basket, first pull down the side rod (B) evenly so that the front rod (A)•
is not askew, and then use the basket.

• The number of sheets that can be collected in the basket is one. If printing multiple pages, print after•
removing each sheet.

• The basket can hold printed documents from paper up to 48 inches (1219.2 mm) long.•
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• When moving the stand, make sure that the basket does not graze the floor and that all four of the•
casters are unlocked before moving the stand. Not doing so may damage the basket, scratch the floor,
or cause injuries.

• If the cloth part of the basket becomes dirty, wipe off the dirt without washing. Washing it may affect the•
performance of the basket.
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Stopping Printing

To cancel printing or reception of print jobs, press the Stop button on the operation panel.

When you press the Stop button during printing, the printer operation varies depending on the current
status.

• You press the Stop button before printing starts•

The print job is canceled.

• You press the Stop button during printing•

Printing stops immediately.

Important
• If you press the ON button while printing is in progress, the print data sent from the computer queues in•

the printer and you may not be able to continue to print. Press the Stop button to cancel printing.
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Printing

Printing from Your Computer (Windows)

Printing with Easy Setup Basics

Changing the Type of Paper

Printing Photos and Business Documents

Printing By Setting Print Purpose

Edit in PosterArtist and Print

Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Printing Hanging and Horizontal Banners (Large-Format Printing)

See more...

Printing from Computer (macOS)

Printing with Easy Setup Basics

Changing the Type of Paper

Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Print Area

Printing Hanging and Horizontal Banners (Large-Format Printing)

See more...

Printing from Computer (Chrome OS)

Printing from Smartphone/Tablet

Print Easily from a Smartphone or Tablet with Canon PRINT Inkjet/SELPHY

Printing from iOS Device (AirPrint)

Printing with Mopria Print Service
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Printing with Canon Print Service

Using PIXMA/MAXIFY Cloud Link
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Printing from Your Computer (Windows)

Printing with Easy Setup Basic

Setting the Number of Copies and Printing Order

Printing Photos and Business Documents

Printing CAD Drawings

Changing the Print Quality and Correcting Image Data

Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Printing Hanging and Horizontal Banners (Large-Format Printing)

Printing by Dividing/Joining Documents

Printing by Saving Roll Paper

Switching the Paper Source to Match the Purpose

Displaying the Print Results before Printing

Other Convenient Settings
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Printing with Easy Setup

This section describes the simple setting procedure so that you can carry out appropriate printing on this
printer.

Printing with Easy Setup

1. Check that printer is turned on1.

2. Load paper on the printer2.

Set roll paper or cut sheet to a printer.

3. Open the printer driver setup window3.

4. Select the media type4.

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

Important
• See "Paper Information List" for Canon authentic paper or Canon output check paper.

Note
• Click Get Information... to display the Paper Information on Printer dialog box. The Paper

Information on Printer dialog box allows you to get the paper information from the printer and
to set the paper source and the media type on the printer driver.

• For instructions on changing the media type from the printer's operation panel, see "Changing
the Type of Paper."
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5. Select print target5.

From the pull-down menu, select Easy Settings, and then select the setting that matches your
purpose from the Print Target list.

6. Select the print quality6.

For Print Quality, select High, Standard or Draft according to your purpose.

Important
• The print quality settings that can be selected may differ depending on a printing profile.

7. Select the paper size7.

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
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8. Select the paper source8.

For Paper Source, select the setting that matches your purpose.

9. Select roll paper width9.

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper
loaded in the printer.

68



10. Complete the setup10.

Click OK.
When you print, the document is printed with settings that match your purpose.

Note
• If the paper settings in the printer driver differ from the paper information registered on the printer, an

error message may appear on the printer's operation panel. You can execute Print, but you may not
obtain the correct printing result.

• Under initial settings, Print Priority in Advanced Settings is set to Line Drawing/Text, so your print
data will be printed with the appropriate density for line drawings.
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Checking Printer Settings and Applying Settings to Printer Driver

1. Open printer driver setup window1.

2. Click Get Information... on Main tab2.

The Paper Information on Printer dialog box appears.

3. Select the paper source3.

From Paper Source, check the setting or select a new paper source.
The current printer settings appear in Media Type and Roll Paper Width.

4. Apply settings4.

To apply the printer settings to the printer driver, click OK.

Note
• If the media type and the output paper size are not set on the printer, OK will be grayed out and

cannot be clicked.
• If communication with the printer is disabled, the Get Information... does not appear or printer

media information from the printer cannot be obtained.
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Setting the Number of Copies and Printing Order

The procedure for specifying the number of copies and printing order is as follows:

1. Open the printer driver setup window1.

2. Specify the number of copies to be printed2.

For Copies on the Layout tab, specify the number of copies to be printed.

3. Specify the print order3.

Check the Print from Last Page check box when you want to print from the last page in order, and
uncheck the check box when you want to print from the first page.
Check the Collate check box when you are printing two or more copies, and want to print them in
groups, and uncheck the check box when you want to print them as a group on the same page.

4. Complete the setup4.

Click OK.
When you execute print, the specified number of copies will be printed with the specified printing order.

Important
• When the application software that you used to create the document has the same function, specify

the settings on the printer driver. However, if the print results are not acceptable, specify the function
settings on the application software. When you specify the number of copies and the printing order with
both the application software and this printer driver, the number of copies may be multiplied numbers of
the two settings or the specified printing order may not be enabled.
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Printing Photos and Business Documents

Printing By Setting Print Purpose

Edit in PosterArtist and Print

72



Printing By Setting Print Purpose

The print settings that are generally used frequently are pre-registered as print purposes. By using a print
purpose to print, you can print with settings that match the document.

The procedure for printing by using a print purpose is as follows:

1. Open the printer driver setup window1.

2. Select the media type2.

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select print setting mode3.

From the pull-down menu, select Easy Settings.
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4. Select print purpose4.

For Print Target, select the setting that matches the document.

Default Settings
Select this when printing general documents such as business documents.

Photo (Color)
Select this when printing color illustrations or photos.

Poster
Select this when printing posters.

CAD (Color Line Drawing)
Select when printing data such as drawings.

CAD (Monochrome Line Drawing)
Select when printing data such as drawings in monochrome.

Perspective, GIS
Select when printing data such as perspectives and GIS.

Note
• To check the settings of the items that are set by Print Target, click View Settings.

5. Select the paper size5.

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source6.

For Paper Source, select the setting that matches your purpose.

7. Set the other items7.

Set the other items as necessary.

8. Complete the setup8.

Click OK.
When you print, the document is printed with settings to match the specified print purpose.
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Edit in PosterArtist and Print

Word processing and spreadsheet software documents and web browser screens, etc. can be edited a print
from PosterArtist.

The following explains the procedure for editing original documents made in multiple application software in
PosterArtist and printing in a poster layout.

1. Open the printer driver setup window1.

2. Select edit in PosterArtist2.

Check Page Layout in the Layout tab and select Edit Using PosterArtist from the pull-down menu.

Note
• Edit Using PosterArtist may not be available for use depending on the usage environment.

3. Start up PosterArtist3.

Click OK.
When printing is executed, PosterArtist starts up and PageCapture window opens.

4. Select page to get in PosterArtist4.

5. Edit page in PosterArtist5.

Image editing and sorting is implemented in PosterArtist.
By repeating steps 1 through 4 without closing the PosterArtist window, documents made in multiple
application software can be arranged on one page.
After editing is complete, please print from PosterArtist menu.
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Note
• For instructions on how to edit and rearrange images, refer to the PosterArtist manual.
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Printing CAD Drawings

Printing By Setting Print Purpose
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Changing the Print Quality and Correcting Image Data

Adjusting Color Balance

Setting the Print Quality Level (Custom)

Printing a Color Document in Monochrome

Specifying Color Correction

Adjusting Brightness

Adjusting Contrast

Printing Using Detailed Setting Mode
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Adjusting Color Balance

You can adjust the color tints when printing.
Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes
the total color balance of the document. Use the application software when you want to change the color
balance significantly. Use the printer driver only when you want to adjust the color balance slightly.
The following sample shows the case when color balance is used to intensify cyan and to diminish yellow so
that the overall colors are more uniform.

No adjustment Adjust color balance

The procedure for adjusting color balance is as follows:

1. Open the printer driver setup window1.

2. Select the advanced settings2.

Select Advanced Settings from the pull-down menu on the Main tab.

3. Select color mode3.

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.
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4. Adjust color balance4.

The Color Adjustment tab has individual sliders for Cyan, Magenta, and Yellow. Each color becomes
stronger when the corresponding slider is moved to the right, and becomes weaker when the
corresponding slider is moved to the left. For example, when cyan becomes weaker, the color red
becomes stronger.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.

5. Complete the setup5.

Click OK on the Main tab.
When you execute print, the document is printed with the adjusted color balance.

Related Topics
Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Brightness
Adjusting Contrast
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Setting the Print Quality Level (Custom)

Custom on the Print Quality tab allows you to set detailed print quality levels.

The procedure for setting the print quality level is as follows:

1. Open the printer driver setup window1.

2. Select advanced settings2.

From the Main tab pull-down menu, select Advanced Settings.

3. Select the print quality3.

For Print Quality, select Custom.
The Custom dialog box opens.

Important
• If Auto (Use Printer Settings) is selected for Media Type, Custom cannot be selected.

4. Setting the print quality level4.

Drag the slider bar to select the print quality level and click OK.
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Important
• Certain print quality levels cannot be selected depending on the settings of Media Type.

5. Complete the setup5.

Click OK on the Main tab.
When you execute print, the image data is printed with the selected print quality level.

Related Topics
Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
Adjusting Contrast
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Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:

1. Open the printer driver setup window1.

2. Select advanced settings2.

From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode3.

For Color Mode, select Monochrome or Monochrome Bitmap.

Note
• The selectable Color Mode depends on the media type selected for Media Type on the Main tab.
• You can select Monochrome Bitmap for Color Mode only if Line Drawing/Text is selected in

Print Priority.

4. Complete the setup4.

Click OK.
When you execute print, the document is converted to grayscale data. It allows you to print the color
document in monochrome.
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Important
• When Monochrome or Monochrome Bitmap are selected, the printer driver processes image data as

sRGB data. In this case, actual colors printed may differ from those in the original image data.
When using the grayscale printing function to print Adobe RGB data, convert the data to sRGB data
using an application software.

Note
• When Monochrome or Monochrome Bitmap is selected, inks other than black ink may also be used.
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Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed.
Normally, when data is printed, the printer driver automatically adjusts the colors.

When you want to print by using the color space of the image data effectively, select ICM or, ICC Profile
Matching. When you want to use an application software to specify a printing ICC profile, select Off.

The procedure for specifying color correction is as follows:

1. Open the printer driver setup window1.

2. Select advanced settings2.

From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode3.

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction4.

Click Matching tab, select Color Correction setting that matches your purpose from the following, and
click OK.
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Driver Matching
Print with the optimal color using the printer driver's original color profile. Normally, you should
choose this mode.

ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and matching
method in detail, and select when printing. You can use the digital camera or scanner ICC profile, or
the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when printing
from an ICM function-compatible application.

Off
Print without performing color matching on the printer driver. Select this when performing color
matching using applications such as Adobe Photoshop, or printing a color chart using a profile
creation tool.

5. Complete the setup5.

Click OK on the Main tab.
When you execute print, the document data is printed with the specified color correction.

Important
• When ICM is disabled in the application software, ICM is unavailable for Color Correction and the

printer may not be able to print the image data properly.
• If Auto (Use Printer Settings) is selected for Media Type, the Matching sheet is not displayed, and

color correction occurs according to printer settings.
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Related Topics
Optimal Photo Printing of Image Data
Adjusting Colors with the Printer Driver
Printing with ICC Profiles

88



Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones differ
from those of actual image or those displayed on the monitor.
To get the print results as close as possible to the desired color tones, you must select a printing method
that is best suited to the application software used or to your purpose.

Color Management
Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color
management (color matching) is a method that manages device-dependent "colors" as a common color
space.

For Windows, a color management system called "ICM" is built into the operating system.
sRGB is one of the common color spaces that is frequently used.

ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and
carrying out color management, you can draw out the color space of the image data within the color
reproduction area that the printer can express.

Note
• Normally, image files are saved in JPEG format. Some digital cameras allow you to save images in a

format called RAW. RAW data refers to an image saving format that requires a computer to develop
the image. You can embed an input ICC profile tag into a RAW file by using special application
software.

Selecting a Printing Method Suited to the Image Data
The recommended printing method depends on the color space of the image data or the application
software to be used.

There are two typical printing methods.
Check the color space of the image data and the application software to be used, and then select the
printing method suited to your purpose.

Adjusting Colors with the Printer Driver
This section describes the procedure for printing data by using the color correction function of the
printer driver.
Select this function when you want to print impressions that are close to those displayed on the
monitor, for example, if you corrected the colors while checking the print image on the monitor.

Printing with ICC Profiles
Describes the procedure for printing by using the color space of the image data effectively.
You can print with a common color space by setting up the application software and the printer driver
so that the color management matches the input ICC profile of the image data.
The method for setting up the printer driver differs depending on the application software to be used.
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Adjusting Colors with the Printer Driver

To use printer driver matching when printing, turn on the printer driver's color correction function. Printer
driver matching accurately applies the characteristics of data displayed on the monitor and allows you to
obtain print results of impressions that are close to those displayed on the monitor.

Important
• When printing using printer driver matching, Canon recommends that you set the monitor and the

environment light as follows:
Monitor
Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2
Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering
properties)
Brightness when looking at printed materials: 500 lx ± 125 lx

Note
• When printing from an application software that can identify ICC profiles and allows you to specify them,

use a printing ICC profile in the application software, and select settings for color management.

The procedure for adjusting colors with the printer driver is as follows:

1. Open the printer driver setup window1.

2. Select advanced settings2.

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode3.

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction4.

Click Matching tab, and select Driver Matching for Color Correction.

5. Select the rendering intent5.

Select the coloring adjustment method in Rendering Intent.

Perceptual (Photo)
Reproduces colors of general photos naturally and features smooth gradation. In addition, selecting
this setting allows you to adjust colors easily using an application software.

Saturation (Poster/CAD)
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors suitable
for line drawing.

6. Set the other items6.

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

7. Complete the setup7.

Click OK on the Main tab.
When you print, the colors get adjusted by the printer driver when printing the data.
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Related Topics
Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
Adjusting Contrast
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Printing with ICC Profiles

When the image data has a specified input ICC profile, you can print by using the color space of the data
effectively.

The printer driver setting procedure varies depending on the application software used to print.

Specify an ICC Profile from the Application Software and Print the Data
When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional,
or any application software that allows you to specify input and printing ICC profiles, you print by
effectively using the color space of the input ICC profile specified in the image data.

To use this printing method, use your application software to select color management items and specify
an input ICC profile and a printing ICC profile in the image data.
Even if you print using a printing ICC profile that you created yourself, be sure to select color management
items from your application software.
For instructions, refer to the manual of the application software you are using.

1. Open the printer driver setup window1.

2. Select advanced settings2.

From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode3.

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction4.

Click Matching tab, and select Off for Color Correction.
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5. Set the other items5.

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

6. Complete the setup6.

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Specify an ICC Profile with the Printer Driver, and then Print
When you print from application software that cannot identity input ICC profiles or does not allow you to
specify one, the data color space is printed as sRGB.

1. Open the printer driver setup window1.

2. Select advanced settings2.

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode3.

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction4.

Click Matching tab, and select ICC Profile Matching for Color Correction.

5. Select input profile5.

Select the Input Profile you want to use.

95



Important
• When the application software specifies an input profile, the input profile setting of the printer

driver becomes invalid.

6. Select the printer profile6.

Select Printer Profile as follows:

• To set the printer profile automatically:•
Select Auto Settings.

• To set the printer profile manually:•
Select a printer profile that matches the media type to be used.

7. Select the rendering intent7.

Select the coloring adjustment method in Rendering Intent.

Saturation
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors suitable
for line drawing.

Perceptual
Reproduces colors of general photos naturally and features smooth gradation. In addition,
selecting this setting allows you to adjust colors easily using an application software.

Important
• When you select Perceptual to print images, Canon recommends that you set the monitor

and the environment light as follows:
Monitor
Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2
Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering
properties)
Brightness when looking at printed materials: 500 lx ± 125 lx

Relative Colorimetric
When image data is converted to the color space of the printer, this method converts the image
data so the color reproduction approximates the shared color regions. Select this method to print
image data with colors that are close to the original colors.

Absolute Colorimetric
When Relative Colorimetric is selected, white spots are reproduced as white spots of the paper
(background color). However, when Absolute Colorimetric is selected, how the white spots are
reproduced depends on the image data.

Important
• Depending on the media type, you may obtain the same print results even when you change

the Rendering Intent setting.
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8. Set the other items8.

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

9. Complete the setup9.

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Related Topics
Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
Adjusting Contrast
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Adjusting Brightness

You can brighten or darken the colors of the overall image data during printing.
The following sample shows the case when light colors are darkened when the image data is printed.

No adjustment Darken light colors

The procedure for adjusting brightness is as follows:

1. Open the printer driver setup window1.

2. Select advanced settings2.

From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode3.

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Adjust brightness4.

On the Color Adjustment tab, moving the Brightness slider to the right brightens (dilutes) the colors,
and moving the slider to the left darkens (intensifies) the colors.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.
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5. Complete the setup5.

Click OK on the Main tab.
When you execute print, the data is printed at the adjusted brightness.

Related Topics
Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance
Adjusting Contrast
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Adjusting Contrast

You can adjust the image contrast during printing.
To make the differences between the light and dark portions of images greater and more distinct, increase
the contrast. On the other hand, to make the differences between the light and dark portions of images
smaller and less distinct, reduce the contrast.

No adjustment Adjust the contrast

The procedure for adjusting contrast is as follows:

1. Open the printer driver setup window1.

2. Select advanced settings2.

From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode3.

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Adjust the contrast4.

On the Color Adjustment tab, moving the Contrast slider to the right increases the contrast, and
moving the slider to the left decreases the contrast.
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You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.

5. Complete the setup5.

Click OK on the Main tab.
When you execute print, the image is printed with the adjusted contrast.

Related Topics
Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
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Printing Using Detailed Setting Mode

You can print by using your own settings instead of the pre-registered Print Target settings.

The procedure for using the detailed setting mode and printing is as follows:

1. Open the printer driver setup window1.

2. Select the media type2.

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select advanced settings3.

From the Main tab pull-down menu, select Advanced Settings.
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4. Set print conditions4.

Set the following items as necessary.

Print Priority
Select elements to prioritize for print results.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

Color Mode
Selects color adjustment method.

Thicken Fine Lines
To make thin lines thicker and easier to see when printing, add a checkmark.

5. Select the paper size5.

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source6.

For Paper Source, select the setting that matches your purpose.

7. Set the other items7.

Set the other items as necessary.

8. Complete the setup8.

Click OK.
When you print, the document is printed with the print conditions you set.

Related Topics
Adjusting Color Balance
Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Brightness
Adjusting Contrast
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Scaled Printing

The procedure for printing a document with pages enlarged or reduced is as follows:

1. Open the printer driver setup window1.

2. Select the paper size of the document2.

Using Page Size on the Page Setup tab, select the page size that is set with your application software.

3. Select the paper source3.

For Paper Source, select the setting that matches your purpose.

4. Select roll paper width4.

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper loaded
in the printer.

5. Select scaled printing5.

Check the Enlarged/Reduced Printing check box.

6. Set one of scaling methods described below6.

From the items listed below, select the setting that matches your purpose and select the corresponding
check box.
The current settings are displayed in the settings preview on the left side of the window.

• Fit Paper Size•
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Scales the document to match the paper size.
• Fit Roll Paper Width•

Scales the document to match the roll paper width.
• Scaling•

Allows you to specify the scaling by entering a number directly or by selecting the paper size you
want from the Printer Paper Size list.
The document is reduced when a size smaller than the Page Size setting is selected from the
Printer Paper Size list, and enlarged when a size larger is selected.

7. Complete the setup7.

Click OK.
When you execute print, the document will be printed with the specified scale.

Important
• When the application software which you used to create the original has the scaled printing function,

configure the settings on your application software. You do not need to configure the same setting in
the printer driver.
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Note
• Selecting Enlarged/Reduced Printing changes the printable area of the document.
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Printing to Oversized Paper Sizes

When printing a created document so that it fills the entire paper width, select a paper size from the
Oversize list (sizes resulting from adding margins necessary for printer operation to the document sizes) so
that all areas of the document are printed at their actual size.

A printout that has the same area as the document can be obtained by trimming the outer margins after
printing.

The procedure for printing with oversize is as follows:

1. Open the printer driver setup window1.

2. Select the paper size2.

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

3. Click Size Options...3.

The Paper Size Options dialog box opens.

4. Select oversize4.

Select the Oversize check box, and click OK.
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The current settings are displayed in the settings preview on the left side of the Page Setup tab.

5. Select the paper source5.

For Paper Source, select the setting that matches your purpose.

6. Select roll paper width6.

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper
loaded in the printer.

7. Set the other items7.

Set the other items as necessary.

8. Complete the setup8.

Click OK.
When you print, the document is printed using oversize.

Important
• When printing to oversized paper sizes, use paper that has the following necessary margins added to

the document size.
Cut sheet: 6 mm or more added to width and 23 mm or more added to height of document size
Roll paper: 6 mm or more added to width and 6 mm or more added to height of document size

Note
• An oversized paper size cannot be used for the largest paper size that can be loaded in the printer.
• To set an oversized paper size for a non-standard paper size, register the paper size in the Paper

Size Options dialog box. An oversized paper size cannot be set for paper sizes that were set in the
Custom Size Settings dialog box.
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Setting Paper Dimensions (Custom Size)

You can specify the height and width of paper when its size cannot be selected from the Page Size. Such a
paper size is called "custom size."

There are two ways of setting a user-defined paper, setting the paper from Size Options... on the Page
Setup tab and setting the paper from Custom Size of Page Size.

If you will be using a user-defined paper repeatedly, setting it from Size Options... is convenient because it
becomes registered to Page Size and can be selected any time after that.

If you want to use a user-defined paper temporarily, setting it from Custom Size is suitable.

The procedure for specifying a custom size is as follows:

Setting from Paper Size Options

1. Open the printer driver setup window1.

2. Click Size Options... on the Page Setup tab2.

The Paper Size Options dialog box opens.

3. Set user-defined paper3.

Set Custom Paper Size Name, Units, and Size, and then click Add.
For Size, specify a size or select the paper size to be used from Paper Size List.
To narrow down the paper sizes displayed in Paper Size List, select the Display Series check box.
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4. Set user-defined paper4.

Click OK, then it returns to Page Setup tab.
The paper size registered by using Custom Paper Size Name is registered to Custom Paper Size of
Page Size and can be selected at any time.

Setting from Custom Size

1. Open the printer driver setup window1.

2. Select the paper size2.

For Page Size on the Page Setup tab, select Custom Size from the Custom Paper Size list.

The Custom Size Settings dialog box opens.
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3. Set the custom paper size3.

Enter the Width and Height values of the paper to be used, specify the Units, and then click OK.

4. Complete the setup4.

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified paper size.

Important
• If the application software that created the document has a function for specifying height and width

values, use the application software to set the values. If the application software does not have such a
function or if the document does not print correctly, perform the above procedure from the printer driver
to set the values.

• Printing may be disabled depending on the size of the specified user-defined media.
For information about printable sizes for user-defined media, see "Paper Sizes."

• Any paper size that was set by using Custom Size can no longer be used after the application software
is closed.

Note
• If the paper settings in the printer driver differ from the paper information registered on the printer, an

error message may appear on the printer's operation panel. You can still print but you may not be able
to obtain correct print results.

• The maximum configurable size with Custom Size is 3.2m.
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Printing Hanging and Horizontal Banners (Large-Format
Printing)

A drapery or banner can be made by enlarging or reducing original documents made on application
software.

The procedure for printing hanging and horizontal banners is as follows:

Print for width of roll

1. Create document by using application software1.

2. Open the printer driver setup window2.

3. Select the paper size3.

Select the same original paper size created in the application soft in the Page Size on the Page Setup
tab.
In the event an optional size is set in the application software, select Custom Size from Custom
Paper Size in Page Size and designate size in the dialog box that appears.

4. Select roll width4.

Select the equivalent to the paper width of the roll set in the printer under Roll Paper Width.

5. Set Enlarged/Reduced Printing5.

Check Enlarged/Reduced Printing and select Fit Roll Paper Width.
When the Information dialog box appears, select the equivalent to the paper width of the roll set in
the printer.
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6. Complete the setup6.

Click OK.
When printing is executed, a drapery or banner can be printed according to the roll.

Enlarge and print

1. Register user-defined paper1.

Register both the actual desired print size (user-defined paper 1) and original document size created
in application (user-defined document size 2) in the Size Options... under the Page Setup tab.

Note
• Please set user-defined paper 2 to the same aspect ratio as user-defined paper 1. If the aspect

ratio differs, the enlarged image may not turn out to be the expected size.
After creating user-defined paper 1, if user-defined paper 2 is created after checking Fix the
Ratio of the Width to Height, settings can be set to the same aspect ratio.
Also set user-defined paper 2 to a size that doesn't exceed the maximum size supported by the
application.
For example, when printing on paper 600mm wide and 3,000mm long, use the following
settings.
(when setting length to 1/6 the user-defined paper)

User-defined paper 1: Width 600mm, Height 3,000mm
User-defined paper 2: Width 100mm, Height 500mm

2. Create original document in application software2.

Use the registered user-defined paper 2 size to create original document using an application.

3. Open printer driver settings screen3.

4. Select Paper Size4.

Select registered user-defined paper 1 from Custom Paper Size in the Page Size on the Page Setup
tab.

5. Complete the setup5.

Click OK.
When you print, the hanging or horizontal banner is printed by using the user-defined size.

Note
• Maximum printable length is 4.0m. In the event the enlarged length exceeds 4.0m, the part of the image

exceeding the length will not be printed.
• If printing cannot be performed correctly, you may be able to improve printing by using the Special

Settings dialog box on the Layout tab to change FineZoom Settings to Yes.
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Printing by Dividing/Joining Documents

Inputting Documents Created Using Multiple Applications into Free Layout plus

Printing by Connecting Multiple Pages

Printing Multiple Pages All on One Page

Dividing and Printing Posters
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Printing by Connecting Multiple Pages

Print documents with several pages as one continuous document. When you do this, the spaces between
the pages will be removed.

The procedure for printing by connecting multiple pages is as follows:

1. Open the printer driver setup window1.

2. Select the paper source2.

For Paper Source on the Page Setup tab, select Roll Paper.

3. Set roll paper options3.

Click Roll Paper Options... to display the Roll Paper Options dialog box.
Select the Banner Printing check box, and then click OK.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

4. Complete the setup4.

Click OK on the Page Setup tab.
When you print, the document is printed with the print conditions you set.
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Printing Multiple Pages All on One Page

The page layout printing function allows you to print more than one page image on a single sheet of paper.

The procedure for printing multiple pages all on one page is as follows:

1. Open the printer driver setup window1.

2. Select the print paper size2.

From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.

3. Set number of pages to be printed per sheet3.

On the Layout tab, select the Page Layout check box, and from the pull-down menu, select 2 Pages/
Sheet, 4 Pages/Sheet, 6 Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet.
The current settings are displayed in the settings preview on the left side of the window.
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4. Set the number of pages to be printed on one sheet and the page order4.

If necessary, click Set..., specify the following settings in the Page Layout Printing dialog box, and click
OK.

Page Order
To change the page arrangement order, select a placement method from the list.

Page Border
To print a page border around each document page, select something other than None from the list.

5. Complete the setup5.

Click OK on the Layout tab.
When you execute print, the specified number of pages will be arranged on each sheet of paper in the
specified order.

Important
• When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on the

Page Setup tab, Page Layout is grayed out and cannot be set.
• If Spooling at Printer Driver in Special Settings dialog box is set to No (Use RAW Spooling),

Page Layout is grayed out and cannot be set.
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Dividing and Printing Posters

The tiling/poster printing function allows you to enlarge image data, divide it into several pages, and print
these pages on separate sheets of paper. You can also paste the pages together to create a large print like
a poster.

The procedure for dividing and printing posters is as follows:

Setting for Dividing and Printing Posters

1. Open the printer driver setup window1.

2. Select the print paper size2.

From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.

3. Set number of divisions3.

On the Layout tab, select the Page Layout check box, and from the pull-down menu, select Poster (1
x 2) or Poster (2 x 2).
The current settings are displayed in the settings preview on the left side of the window.
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4. Complete the setup4.

Click OK on the Layout tab.
When you execute print, the document will be divided into several pages during printing.

Important
• When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on

the Page Setup tab, Page Layout is grayed out and cannot be set.
• If Spooling at Printer Driver in Special Settings dialog box is set to No (Use RAW

Spooling), Page Layout is grayed out and cannot be set.

Printing Only Specific Pages
If ink becomes faint or runs out during printing, you can reprint only the specific pages by following the
procedure below:

1. Display Pages to Print dialog box1.

For Page Layout, click Set... to display the Pages to Print dialog box.

2. Set print range2.

Clear the check boxes of the pages you do not want to print.
In the setting view, the pages that you cleared are deleted and only the pages to be printed are
displayed.
Check the pages to be printed, and then click OK.
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Note
• In the setting view on the left side of the Pages to Print dialog box, you can also clear the

display by clicking the pages you do not want to print.
To redisplay a cleared page, click that page again.

• To switch the pages to display/hide, click Invert in the Pages to Print dialog box.

3. Complete the setup3.

Click OK on the Layout tab.
When you print, only the specified pages are printed.

Important
• If you partition and print as a poster, the source document will be printed in enlarged form, so the print

results may become rough.
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Printing by Saving Roll Paper

Saving Roll Paper by Rotating Document 90 Degrees
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Saving Roll Paper by Rotating Document 90 Degrees

When printing a portrait document on roll paper, you can save paper by rotating the document 90 degrees
and printing the document so that it is oriented horizontally relative to the paper.

The procedure for saving paper by rotating the document 90 degrees is as follows:

1. Open the printer driver setup window1.

2. Select the media type2.

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select the paper size3.

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

4. Select the paper source4.

In Paper Source, select Roll Paper.

5. Selecting Paper Saving5.

Select the Rotate Page 90 degrees check box.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select roll paper width6.

For Roll Paper Width, select the width of the roll paper loaded in the printer.

7. Complete the setup7.

Click OK.
When you print, you can rotate a portrait document 90 degrees to save paper.

Important
• When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on the Page

Setup tab, Rotate Page 90 degrees is grayed out and cannot be set.

124



• When selecting paper in portrait format as the Page Size from the Page Setup tab, if the length in the
vertical direction is longer than the width selected in Roll Paper Width, even if a checkmark is placed
next to Rotate Page 90 degrees, the page will not be rotated.
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Switching the Paper Source to Match the Purpose

This printer has two paper sources: Roll and Top Feed.
You can facilitate printing by selecting a paper source setting that matches your media type or purpose.

The procedure for setting paper source is as follows:

1. Open the printer driver setup window1.

2. Select the media type2.

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select the paper source3.

From the Paper Source list on the Page Setup tab, select the paper source that matches your purpose.

Roll Paper
Feeds paper using roll paper.

Top Feed
Feeds paper using the cut sheet.

4. Complete the setup4.

Click OK.
When you execute print, the printer uses the specified paper source to print the data.
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Note
• If the paper settings in the printer driver differ from the paper information registered on the printer,

an error message may appear on the printer's operation panel. You can still print but you may not
be able to obtain correct print results.
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Displaying the Print Results before Printing

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

1. Open the printer driver setup window1.

2. Set the preview2.

Check the Preview before printing check box on the Main tab.

3. Complete the setup3.

Click OK.
When you execute print, the Canon imagePROGRAF Preview opens and displays the print results.

Related Topic
Canon imagePROGRAF Preview
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Other Convenient Settings

Stamp Printing

Setting a Page Size and Orientation

Registering a Frequently Used Printing Profile
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Stamp Printing

The Stamp function allows you to print a stamp text over or behind document data.
"DRAFT," "CONFIDENTIAL," and other stamps that are used often in companies are pre-registered.

The procedure for printing with a stamp is as follows:

1. Open the printer driver setup window1.

2. Select stamp2.

On the Layout tab, select the Stamp check box, and then select the stamp to use from the list.
The current settings are displayed in the settings preview on the left side of the Layout tab.

3. Complete the setup3.

Click OK.
When you execute print, the data is printed with the specified stamp.

Important
• Depending on your usage environment, you may not be able to use the Stamp function. In this case,

set Spooling at Printer Driver in the Special Settings dialog box to Yes.
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Registering a Stamp

You can create and register a new stamp. You can also change and re-register some of the settings of an
existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:

Registering a New Stamp

1. Open the printer driver setup window1.

2. Select stamp2.

On the Layout tab, select the Stamp check box, and click Define Stamp....

The Define Stamp dialog box opens.
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3. Set stamp details3.

Click Add to add a new stamp (Untitled) to the list.
In Name, enter the name of the stamp to register, and in Text, enter the character string you want as
the stamp.
Change the Font, Style, Size, and Color settings as necessary.

4. Set the other items4.

Set the following items as necessary.

Outline
Selects a frame that encloses the stamp text string.

Print Style
Select the stamp print method.
Select Transparent to print the stamp on the back of the document, and select Overlap to print it
on the front.

Position
Specifies the stamp position on the page.
Enter numbers in X and Y to set the coordinates, or drag the horizontal and vertical slide bars to
the left/right or up/down to change the settings.

Angle
Set the stamp placement angle.
Enter a number in Set Angle to set the angle, or drag the slide bar to the left/right to change the
setting.
Set the angle by entering a number in range of -180 to 180.

Stamp first page only
To print the stamp on the first page only, select this check box.
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5. Complete the setup5.

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

Changing and Registering Some of Stamp Settings

1. Select stamp1.

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp for which the settings are to be changed2.

From Stamps, select the title of the stamp you want to change the settings for.

3. Configure each setting while viewing the preview3.

4. Complete the setup4.

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

Note
• The stamp registered as the default setting cannot be changed.

Deleting an Unnecessary Stamp

1. Select stamp1.

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp to be deleted2.

Select the title that you wish to delete from the Stamps and click Delete.
Click Yes when the confirmation message appears.

3. Complete the setup3.

Click OK to return to the Layout tab.

Note
• The stamp registered as the default setting cannot be deleted.
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Setting a Page Size and Orientation

The paper size and orientation are essentially determined by the application software. When the page size
and orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the
application software, you do not need to select them on the Page Setup tab.

When you are not able to specify them with the application software, the procedure for selecting a page size
and orientation is as follows:

1. Open the printer driver setup window1.

2. Select the paper size2.

Select a page size from the Page Size list on the Page Setup tab.

3. Set Orientation3.

Select Portrait or Landscape for Orientation. Check Rotate Page 90 degrees check box when you
want to perform printing with the original being rotated 90 degrees.

4. Complete the setup4.

Click OK.
When you execute print, the document will be printed with the selected page size and the orientation.

134



Registering a Frequently Used Printing Profile

You can register the frequently used printing settings to Favorites. Unnecessary printing profiles can be
deleted at any time.

The procedure for registering a printing profile is as follows:

Registering a Printing Profile

1. Open the printer driver setup window1.

2. Set the necessary items2.

On the Main tab, the Page Setup tab, and the Layout tab, specify the print settings you want to
register.

3. Display Add dialog box3.

On the Favorites tab, click Add....

The Add dialog box opens.

4. Register favorite setting4.
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In Name, enter the name of the favorite. Set the Icon and Comment fields as necessary, and then
click OK.
The name and the icon appear in the Favorites list.
To check the settings of the registered favorite, click Settings Details.

Note
• To save the settings of the favorite to a file, click Export... on the Favorites tab.

Printing Using Favorite Settings

1. Open the printer driver setup window1.

2. Apply favorite2.

From the Favorites list on the Favorites tab, select the favorite you want to use.
Click Apply Favorite to replace the registered print settings.

3. Complete the setup3.

Click OK.
When you print, the document is printed with the settings of the registered favorite.

Deleting Unnecessary Printing Profile

1. Select favorite to be deleted1.

Select the favorite you want to delete from the Favorites list on the Favorites tab.

2. Delete setting2.

Click Delete. When the confirmation message appears, click OK.
The selected favorite is deleted from the Favorites list.

Note
• Printing profiles that are registered in the initial settings cannot be deleted.
• The settings of the favorite being applied to the current print settings cannot be deleted. To delete

that favorite, select another favorite from the Favorites list, click Apply Favorite to apply the settings
of that other favorite, and then delete the target favorite.
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Printing from Smartphone/Tablet

For more on printing from a device, refer to the device's or application's instruction manual.

Print Easily from a Smartphone or Tablet with Canon PRINT Inkjet/SELPHY

Printing from iOS Device (AirPrint)

Printing with Mopria Print Service

Printing with Canon Print Service
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Printer Driver

Windows Printer Driver

macOS Printer Driver
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Windows Printer Driver

Overview of the Printer Driver

Printer Driver Description

Updating the Printer Driver
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Overview of the Printer Driver

Canon IJ Printer Driver

Changing the Print Options

Canon imagePROGRAF Preview

How to Open the Printer Driver Setup Window

Updating Media Information in Printer Driver

Deleting the Undesired Print Job

Canon IJ Status Monitor

Instructions for Use (Printer Driver)
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Canon IJ Printer Driver

The Canon IJ printer driver (called printer driver below) is a software that is installed on your computer for
printing data with this printer.

The printer driver converts the print data created by your application software into data that your printer can
understand, and sends the converted data to the printer.

Because different models support different print data formats, you need a printer driver for the specific
model you are using.

Installing the Printer Driver
To install the printer driver, install the driver from the Setup CD-ROM or our website.

Specifying the Printer Driver
To specify the printer driver, open the Print dialog box of the application software you are using, and
select "XXX" (where "XXX" is your model name).

Displaying the Manual from the Printer Driver
To display a description of a tab in the printer driver setup window, click the Help button found on the tab.

Related Topic
How to Open the Printer Driver Setup Window
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Changing the Print Options

You can change the detailed printer driver settings for print data that is sent from an application software.

Check this check box if part of the image data is cut off, the paper source during printing differs from the
driver settings, or printing fails.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window1.

2. Click Special Settings... on the Layout tab2.

The Special Settings dialog box opens.

3. Change the individual settings3.

If necessary, change the setting of each item, and then click OK.

The Layout tab is displayed again.
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Canon imagePROGRAF Preview

The Canon imagePROGRAF Preview is an application software that displays what the print result will look
like before a document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.

When you want to display a preview before printing, open the printer driver setup window, click the Main
tab, and check the Preview before printing check box.

When you do not want to display a preview before printing, uncheck the check box.

Related Topic
Displaying the Print Results before Printing
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How to Open the Printer Driver Setup Window

You can display the printer driver setup window from the application software in use or from the printer icon.

Open the Printer Driver Setup Window through the Application Software
Follow the procedure below to configure printing profile when printing.

1. Select the command that you perform printing on the application software1.

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)2.

The printer driver setup window appears.

Note
• Depending on application software you use, command names or menu names may vary and

there may be more steps. For details, refer to the user's manual of your application software.

Opening the Printer Driver Setup Window from the Printer Icon
Follow the procedure below to perform printer maintenance operations such as print head cleaning, or to
configure a printing profile that is common to all application software.

1. Display the Devices and Printers window1.

Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.

2. Right-click your model name icon, and then select Printing preferences from the2.
displayed menu

The printer driver setup window appears.

Important
• Opening the printer driver setup window through Printer properties displays such tabs

regarding the Windows functions as the Ports (or Advanced) tab. Those tabs do not appear
when opening through Printing preferences or application software. For tabs regarding
Windows functions, refer to the user's manual for the Windows.
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Updating Media Information in Printer Driver

This function gets the latest media information from the printer and updates the media information in the
printer driver.
When the media information is updated, the media displayed for Media Type on the Main tab is updated to
the latest information.

The procedure for updating media information is described below.

1. Display the Devices and Printers window1.

Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

2. Display setup window2.

Right-click the "Your model name" icon, and select Printer properties.
The printer's Properties window appears.

3. Update media information3.

Click Update Media Information the Device Settings tab.
When a confirmation message appears, click Start.
If the paper information on the driver cannot be updated, click Initial Check Items and check the
displayed information.
The printer driver media information will update.

Important
• It may take some time to update the media information.

4. Finish updating media information4.

When a confirmation message appears, click OK.
The media information will be updated.

Important
• Restart the printer driver after updating media information.
• Do not change media information on the printer while you are updating media information on

the driver.

Important
• Ensure that a user with administrative privileges carries out the media information update.

Users other than administrators can check if a media information update is required, but cannot carry
out the update itself.

• When you have added, deleted, or edited media using administrative tools (the Media Configuration
Tool) but have not updated the media information, issues may arise such as the inability to print.
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Deleting the Undesired Print Job

If the printer does not start printing, canceled or failed print job data may be remaining.
Delete the undesired print job by using the Canon IJ Status Monitor.

1. Open the printer driver setup window1.

2. Display the Canon IJ Status Monitor2.

Click Status Monitor... on the Main tab.
The Canon IJ Status Monitor appears.

3. Display the print jobs3.

Click Display Print Queue.
The print queue window opens.

4. Delete the print jobs4.

Select the print jobs you want to delete, and select Cancel from the Document menu.
When the confirmation message appears, click Yes.

The deletion of the print job is complete.

Important
• Users who have not been granted access permission for printer management cannot delete the print

job of another user.
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Canon IJ Status Monitor

The Canon IJ Status Monitor is an application software that shows the status of the printer and the progress
of printing. You will know the status of the printer with graphics, icons, and messages.

Launching the Canon IJ Status Monitor
The Canon IJ Status Monitor launches automatically when print data is sent to the printer. When
launched, the Canon IJ Status Monitor appears as a button on the task bar.

Click the button of the status monitor displayed on the task bar. The Canon IJ Status Monitor appears.

Note
• To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setup

window and click Status Monitor... on the Main tab.
• The information displayed on the Canon IJ Status Monitor may differ depending on the country or

region where you are using your printer.

When Errors Occur
If an error occurs (e.g., if the printer runs out of paper or if the ink is low), the Canon IJ Status Monitor
displays an error information dialog box.
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In such cases, take the appropriate action as described.
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Checking the Ink Status from Your Computer

You can check the remaining ink level and the ink tank types for your model.

1. Open the printer driver setup window1.

2. Launching the Canon IJ Status Monitor2.

On the Main tab, click Status Monitor....
The Canon IJ Status Monitor opens.

3. Display Estimated ink levels3.

Ink status is displayed as an illustration.

Note
• The information displayed on the Canon IJ Status Monitor may differ depending on the country or

region where you are using your printer.
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Instructions for Use (Printer Driver)

This printer driver is subject to the following restrictions. Keep the following points in mind when using the
printer driver.

Restrictions on the Printer Driver
• Before installing, log on to Windows as user with administrator rights.
• Always check the following before installing the software.

1. Quit the application software while it is running.
2. If you are printing a document, abort printing or wait for it to finish.
3. Close all the printer driver's dialog boxes.

• If you can set the number of copies with the application software, set them either with the printer
driver or the application software.

• If you can configure enlarging/reducing settings with the application software, set the normal size
(100%) in the printer driver, and then configure the magnification factor with the application software.

• Depending on the application software used, it may be possible to print collated copies; however,
please do not use this feature when configuring layout printing with the Page Layout option in the
Layout tab.
This may cause incorrect layout.

• When printing enlarged/reduced documents, printed results may come out different due to a
discrepancy between the image data resolution and the enlarging/reducing ratio.

• When printing reduced color images, 1-dot wide lines or points may disappear from the color images.
• Depending on the application software, lines drawn at almost horizontal angles may not print

correctly.
If that should happen, re-draw the line horizontally and print one more time.

• Immediately after installing (or updating) the printer driver, you might not be able to visualize new
features in some of the application software.
In all application software provided with printing features, choose Print from the File menu and, after
selecting the printer you are using, click the Properties.
After the Properties dialog box has opened, immediately close it by clicking OK.

• If you update the model name of your printer through the General tab in the printer's Properties, the
Favorites settings registered in the printer driver will be disabled.
In such cases, save the Favorites settings as a file before changing the name of the printer and reload
the saved file after you have updated the printer's name.

• Printing at high resolution requires a large amount of memory on your computer.
When your computer is low on memory or you are using a large number of application software, the
application software may not work correctly.
In such cases, re-start Windows and, before resuming printing, close all the applications you are not
using. Also, when the printer is not printing correctly, switch the Print Quality setting in the Main tab
to a lower resolution.

• When using a local connection, if you do not see a check mark next to the Enable bidirectional
support option in the Ports tab in the printer's Properties, it will not be possible to acquire printer and
device information correctly.

• If you are you are using your printer with a USB connection, refrain from using standby mode. You
can set standby mode through the Power Options on the Control Panel.

150



• In case of a large amount of print data, the printer may time-out during printing and you may no longer
be able to print.
In such cases, in the Advanced tab in the printer's Properties, choose Spool print documents so
program finishes printing faster and place a check mark next to Start printing after last page is
spooled.

• Fine lines and gradients may not print correctly.
In such cases, choose Print from the File menu of the application, and after opening from there the
property dialog box of the printer driver, follow the procedure below and then run printing.

1. In the Main tab, uncheck Preview before printing.
2. In the Layout tab, uncheck Page Layout.
3. If you are using a 32-bit driver, open the Layout tab and click Special Settings....

Turn off Fast Graphic Process.

• In case of a large amount of print data, the printer may time-out during printing and you may no longer
be able to print.
In such cases, you may be able to print by increasing the time set in Job timeout in the printer's
operation panel.

• Depending on the application used, if you print using features like enlarging/reducing, layout printing,
page borders and so on, some of the data in the resulting printed document, for example graphics,
may differ from the source document.

• If you print very large images from your computer when it's running low on memory, you may not be
able to print correctly; for example, it may take a very long time to print or parts of the image may end
up missing.
In such cases, try printing after following the procedure indicated below.

◦ If you are using a 32-bit driver, open the Layout tab and click Special Settings....
Turn off Fast Graphic Process.

◦ Increase your computer memory.
◦ Increase the virtual memory of your operating system.

• Do not change the Print Processor... settings in the Advanced tab in the printer Properties.
If you change them, you will not be able to use some of the features correctly, such as the Page
Layout feature in the Layout tab.

• In the cases described below, you will not be able to use the Edit Using PosterArtist feature of Page
Layout in the Layout tab, as well as the Canon imagePROGRAF Preview feature.

◦ When right-clicking on the printer icon and choosing from See what's printing: Printer -> Pause
Printing, or when right-clicking on the printer icon and choosing Pause Printing

◦ When right-clicking on the printer icon and choosing from See what's printing: Printer -> Use
Printer Offline, or when right-clicking on the printer icon and choosing Use Printer Offline

◦ When printing during hours other than those set in Available from and To in the Advanced tab in
the printer's Properties

◦ When printing with the Enable advanced printing features turned off in the Advanced tab in the
printer's Properties

◦ When printing with Print directly to the printer enabled in the Advanced tab in printer's
Properties

◦ When printing after the printing port in the Ports tab in the printer's Properties has changed to
FILE:

◦ When printing after choosing Output to file in the Print dialog box in the application software
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• If you perform a point-and-print installation, you will not be able to use the Edit Using PosterArtist
features of Page Layout in the Layout tab.

• If you print after setting Edit Using PosterArtist, refrain from printing from other drivers.
• If you combine specific Print Quality with large paper sizes, you may not be able to correctly print

stamps and borders.
• In the Canon imagePROGRAF Preview, characters and fine lines visualized in the View screen may

look differ from printed results. In such cases, try choosing the Layout tab, opening the Special
Settings dialog and turning on Preview Switching.

Points to Note About Applications with Restrictions
• If, in Microsoft Excel, you place a checkmark next to the Collate and then you print more than one

copy, or if you do Entire workbook after configuring different settings in each tab, you may not be
able to perform layout printing nor to get the intended printing results.

• If you try to print data on a very large-size paper through applications like Adobe Illustrator, you may
not be able to print.
In such cases, try printing after following the procedure indicated below.

◦ Open the Main tab and uncheck Preview before printing.
◦ If you are using a 32-bit driver, open the Layout tab and click Special Settings....

Turn off Fast Graphic Process.
◦ Increase the virtual memory of your operating system.
◦ If you are using Adobe Illustrator, turn off/on Bitmap printing in the Print dialog box.

• When printing from application software that does not allow EMF spooling, you will not be able to use
the Edit Using PosterArtist feature of Page Layout in the Layout tab.

• When printing from Adobe Photoshop, tone jumps may occur in the gradation of black and white
photographs.
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Printer Driver Description

Main Tab Description

Page Setup Tab Description

Layout Tab Description

Favorites Tab Description

Utility Tab Description

Device Settings Tab Description

Canon IJ Status Monitor Description
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Main Tab Description

The Main tab allows you to create a basic print setup in accordance with the media type. Unless special
printing is required, normal printing can be performed just by setting the items on this tab.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Get Information...
Opens the Paper Information on Printer dialog box.
You can check the settings on the printer and apply the checked settings to the printer driver.

Specify...
Open the Paper Detailed Settings dialog box, and specify detailed print settings that match the media
type loaded in the printer.

Pull-down menu
Switches the Easy Settings and Advanced Settings.
Easy Settings

This mode allows you to print by using pre-registered print settings.
Print Target

Print settings that are generally used frequently are pre-registered as print purposes. By using
a print purpose to print, you can print by using settings that match the document.
Default Settings

Select this when printing general documents such as business documents.
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Photo (Color)
Select this when printing a color illustration or a photograph.

Poster
Select this when printing posters.

CAD (Color Line Drawing)
Select when printing data such as drawings.

CAD (Monochrome Line Drawing)
Select when printing data such as drawings in monochrome.

Perspective, GIS
Select when printing data such as perspectives and GIS.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

Important
• Depending on the Media Type settings, the same print results may be produced even if

the Print Quality is changed.

High
Gives priority to print quality over printing speed.

Standard
Prints with average speed and quality. Resolution settings depend on media type.

Draft
Good for trial printing.

Custom
Opens the Custom dialog box.
Select this when you want to set the printing quality level individually.

View Settings
Opens the View Settings dialog box.

Advanced Settings
This mode allows you to print by specifying detailed settings that match your purpose.
Print Priority

Select elements to prioritize for print results.
Image

Prioritize image results when printing.

Line Drawing/Text
Prioritize detailed lines and text when printing.

Auto (Use Printer Settings)
Use printer settings when printing.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.
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Important
• Depending on the Media Type settings, the same print results may be produced even if

the Print Quality is changed.

High
Gives priority to print quality over printing speed.

Standard
Prints with average speed and quality. Resolution settings depend on media type.

Draft
Good for trial printing.

Custom
Opens the Custom dialog box.
Select this when you want to set the printing quality level individually.

Color Mode
Select the color to print.
Color

Prints with the number of colors in the document.

Monochrome
Select this setting to print a line drawing using black ink.

Monochrome Bitmap
Print all non-white parts in black.

Color Settings
Opens the Color Settings dialog box.
You can adjust individual color settings such as Cyan, Magenta, Yellow, Brightness,
and Contrast on the Color Adjustment tab, and select the Color Correction method on
the Matching tab.

Thicken Fine Lines
To make thin lines thicker and easier to see when printing, add a checkmark.

Preview before printing
You can start up the Canon imagePROGRAF Preview, and check what the printing results will be
before executing the print.
Check this check box to display a preview before printing.

Status Monitor...
Displays the status monitor.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on the current screen to their default values (factory
settings).

Paper Detailed Settings dialog box
Drying Time

Wait time can be set to allow ink to dry. Between Pages settings are only enabled for roll paper.
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Between Pages
The wait time until outputting paper can be set after printing one page. Time is taken before
cutting roll paper to allow the ink to dry, so the page may be dropped into the basket with dried
ink.
Printer Default

Settings in printer unit operation panel are applied.

None
Page will be output immediately after printing

30 sec. / 1 min. / 3 min.
Page will be output after set amount of time has passed after printing.

Between Scans
The wait time until printing the next scan can be set after printing one scan in the page. Set to
avoid smudging or unevenness in the page.
Printer Default

Settings in printer unit operation panel are applied.

None
Next scan will be print immediately after first scan is print.

0.5 sec./1 sec.
Next scan will be print after the set amount of time has passed after printing one scan.
* If smudges and/or unevenness occur, please increase time.

Roll Paper Safety Margin
The margin length on the edge of the paper can be selected.
Top/Bottom Margins

Set how images are printed relative to the margin amount on the roll paper.
Printer Default

Settings in printer unit operation panel are applied.

Prioritize Image Size
This setting adds margins to the outside of the print data. Larger margins make the printed
material vertically longer, and more of the roll paper will be used.

Prioritize Paper Size
This setting adds margins to the inside of the print data. Larger margins increase the
unprinted area at the top and bottom of the printed material.

Important
• When using Prioritize Paper Size, the top and bottom of the image may be cut off

depending on the margin amount you set. It is recommended that you consider the
margins beforehand when creating the print data.

Leading Edge/Far End Margin
Set the margin length on each end of the roll paper.
Printer Default

Settings in printer unit operation panel are applied.

Auto
Automatically set the margin amount.
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Leading Edge 5 mm / Far End 5 mm / Leading Edge 15 mm / Far End 15 mm / Leading
Edge 30 mm / Far End 30 mm

Select a larger margin when rubbing of the print heads occurs, such as when heavily curling
paper is being used.

Cut Speed
Select auto-cut speed. This can be adjusted when paper cannot be cut precisely with auto-cut.
Printer Default

Settings in printer unit operation panel are applied.

Fast
Select when cut is not smooth with Standard settings.

Standard
Select when there are no particular problems with auto-cut.

Slow
If this is selected for paper with adhesive, the cutter will not stick to the adhesive easily and it will
slow deterioration of the cutter's capabilities.

Unidirectional Printing
Controls color unevenness and unaligned ruled lines.
Please check when printing in one direction.

Mirror
Select whether to print reflected image or not. When you select this check box, text and images will
be printed as if reflected in a mirror.

Custom dialog box
Set the quality level, and select the desired print quality.

Quality
You can use the slider bar to adjust the print quality level.

Important
• Certain print quality levels cannot be selected depending on the settings of Media Type.

Note
• The High, Standard, or Draft print quality modes are linked with the slider bar. Therefore when

the slider bar is moved, the corresponding quality and value are displayed on the left. This is the
same as when the corresponding quality is selected for Print Quality on the Main tab.

View Settings dialog box
Print Target

Select the print purpose. The settings of the selected print purpose are displayed in Details.

Name
Displays the name of the selected print purpose.
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Details
Displays the settings of the print purpose that was selected for Print Target.

Color Settings dialog box

Color Adjustment Tab
This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta, Yellow,
Brightness, and Contrast options.

Preview
Shows the effect of color adjustment.
The color and brightness change when each item is adjusted.

View Color Pattern
Displays a pattern for checking color changes produced by color adjustment.
If you want to display the preview image with a color pattern, check this check box.

Cyan / Magenta / Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a color
weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
This adjustment changes the relative amount of ink of each color used, which alters the total
color balance of the document. Use your application if you want to change the total color balance
significantly. Use the printer driver only if you want to adjust the color balance slightly.

Important
• When Monochrome is selected for Color Mode, the color balance (Cyan, Magenta, and

Yellow) can't be set.

Brightness
Adjusts the brightness of your print. You cannot change the levels of pure white and black.
However, the brightness of the colors between white and black can be changed. Colors become
brighter as you drag the slider toward the right and darker as you drag the slider toward the left.
You can also directly enter brightness values that are linked to the slider bar. Enter a value in the
range from -50 to 50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Matching Tab
This is displayed when Color is selected for Color Mode.
Allows you to select the method for adjusting colors to match the type of document to be printed.
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Color Correction
Allows you to select Driver Matching, ICC Profile Matching, ICM, or Off to match the purpose of the
print operation.
Driver Matching

Print with the optimal color using the driver's original color profile. Normally, you should choose
this mode.

ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and
matching method in detail, and select when printing. You can use the digital camera or scanner
ICC profile, or the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when
printing from an ICM function-compatible application.

Off
Print without performing color matching on the printer driver. Select this when performing color
matching using applications such as Adobe Photoshop, or printing using a profile creation tool or
color chart.

Important
• When setting not to use ICM in the application software, ICC Profile Matching and ICM of

Color Correction do not function. There are also times when it does not print correctly.

Input Profile
Specifies the input profile to be used when you select ICC Profile Matching for Color Correction.

Printer Profile
Specifies the printer profile to be used when ICC Profile Matching is selected for Color Correction.
Normally Auto Settings is selected but you can also select a printer profile manually.

Rendering Intent
Specifies the matching method to be used when you select Driver Matching, ICC Profile Matching,
or ICM, for Color Correction.
Perceptual (Photo) / Perceptual

Reproduces colors of general photos naturally and features smooth gradation. In addition,
selecting this setting allows you to adjust colors easily using an application software.

Saturation (Poster/CAD) / Saturation
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors
suitable for line drawing.

Relative Colorimetric
When image data is converted to the color space of the printer, this method converts the image
data so the color reproduction approximates the shared color regions. Select this method to print
image data with colors that are close to the original colors.
The white spots are reproduced as white spots (background color) on the paper.

Absolute Colorimetric
This method uses the white spot definitions in the input and output ICC profiles to convert the
image data.
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Although the color and color balance of the white spots change, you may not be able to get the
desired output results because of the profile combination.

Important
• Depending on the media type, you may obtain the same print results even when you change the

Rendering Intent setting.
• If Driver Matching is selected for Color Correction, then Relative Colorimetric and Absolute

Colorimetric are not displayed.
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Page Setup Tab Description

The Page Setup tab allows you to specify the scaling for enlarging or reducing, set the paper feeding
method, and more.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Page Size
Selects a page size.
Ensure that you select the same page size as you selected within the application.
When you select Custom Size from Custom Paper Size, the Custom Size Settings dialog box
appears, and you can specify any vertical and horizontal dimensions for the paper.

Enlarged/Reduced Printing
You can enlarge or reduce a document and then print it.
When you select Enlarged/Reduced Printing, you can then set Fit Paper Size, Fit Roll Paper Width,
or Scaling.
Fit Paper Size

Enlarge/reduce the document to match the size of the paper to be printed, and then print the
document.

Fit Roll Paper Width
You can enlarge/reduce the document to match the roll paper width and then print the document.
When you select this radio button, the Information dialog box appears, and you can select Roll
Paper Width.

Scaling
Enlarge or reduce the document to a specified scale before printing.
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Printer Paper Size
When you select Fit Paper Size, or Scaling, you can specify the setting.
Select the size of the paper to be printed.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait

Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.

Rotate Page 90 degrees
Rotate the long edge of the document 90 degrees, match it to the width of the roll paper, and then print
the document.
When you print a portrait document onto roll paper, you can save paper by rotating the document 90
degrees and print the document horizontally relative to the paper.

Paper Source
Shows the source from which paper is supplied.
You may be able to switch the paper source with the printer driver.
Roll Paper

Feeds paper using roll paper.

Top Feed
Feeds paper using the cut sheet.

Important
• Depending on the media type and size, the Paper Source settings that can be selected may differ.

Roll Paper Width
Select the roll paper width.
Select the width that matches the width of the roll paper loaded in the printer.

Roll Paper Options...
Displays the Roll Paper Options dialog box.
You can specify banner printing, and other settings for printing on roll paper.

Size Options...
Displays the Paper Size Options dialog box.
The Paper Size Options dialog box allows you to create and register any user-defined paper.

Custom Size Settings dialog box (Paper Size)
This dialog box allows you to specify the size (width and height) of the custom paper.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.
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Units
Select the unit for entering a user-defined paper size.

Roll Paper Options dialog box
You can specify settings for printing on roll paper.

Banner Printing
Select this check box to print documents with several pages as one continuous document. When you
do this, the spaces between the pages will be removed.

Paper Size Options dialog box
You can create and register any user-defined paper. You can then select the defined paper size from
Custom Paper Size of Page Size.

Paper Size List
The names and sizes of the paper sizes that the printer driver can use are displayed.

Delete
From Paper Size List, you can delete a user-defined paper that a user created.

Note
• Paper deletion is not possible in the following case:

When a standard paper size of the printer driver is selected
When an oversized paper size is selected
When a paper size with a red circle is selected

Custom Paper Size Name
You can specify the name of a user-defined paper.

Units
You can specify the units for the height and width dimensions of the user-defined paper.

Page Size
You can specify the Width and Height settings of the paper.
Fix the Ratio of the Width to Height

When you select this check box, you can change the size while keeping the Width and Height
ratio.

Width
Specify the paper width.

Height
Specify the paper height.

Register with the OS
Register the set user-defined paper in the OS.
By registering in the OS, any user sharing the use of the printer or PC can use the set user -defined
paper.

Add
You can register a user-defined paper that was set and overwrite the existing user-defined paper.
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Display Series
You can narrow down the paper sizes to be displayed in Paper Size List.

Oversize
When you select this check box, add appropriate margins so that the document contents will not get
cut off, and then print the document.
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Layout Tab Description

The Layout tab allows you to specify how to arrange the document onto the paper. You can also set the
number of copies to be printed and the print sequence. If the application software that you used to create
the document features the same functions, specify the settings from the application software.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Page Layout
Selects the size of the document you want to print and the type of printing.
Poster (1 x 2)/Poster (2 x 2)

Printing is performed with poster settings.
The value in parentheses represents the ratio of the vertical x horizontal lengths. As the number
of divisions increases, the number of sheets used for printing increases. If you are pasting pages
together to create a poster, increasing the number of divisions allows you to create a larger poster.
Set...

Opens the Pages to Print dialog box.
Specify this setting when you want to print only specific pages.

2 Pages/Sheet / 4 Pages/Sheet / 6 Pages/Sheet / 8 Pages/Sheet / 9 Pages/Sheet / 16 Pages/Sheet
Multiple pages are assigned to one sheet of paper and printed. The number presents the number
of pages assigned to one sheet.
Set...

Opens the Page Layout Printing dialog box.
You can freely specify detailed settings for assigned printing.

Edit Using PosterArtist
Word processing and spreadsheet software documents and web browser screens, etc. can be
edited a print from PosterArtist.
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You must install PosterArtist to use this function. Go to the Canon website, download PosterArtist,
and then install it.

Stamp
The Stamp function prints a specific character string over the document pages. You can select the
characters to be printed from a list or use the Define Stamp dialog box to set any characters.
Define Stamp...

Opens the Define Stamp dialog box.
You can specify detailed stamp settings or register any stamp.

Rotate 180 degrees
Rotates document 180 degrees and prints it.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.

Important
• If the application used to create your document has a similar function, specify the number of copies

with the application without specifying it here.

Print from Last Page
Check this check box when you want to print from the last page in order. If you do this, you do not
need to sort the pages into their correct order after printing.
Uncheck this check box to print your document in normal order, starting from the first page.

Collate
Check the check box when you are printing two or more copies, and want to print them in groups.
Uncheck the check box when you want to print them as a group on the same page.

Page Options...
Opens the Page Options dialog box.
You specify settings for printing information such as date, user name, and page number.

Important
• Depending on your usage environment, you may not be able to use the Page Options function. In

this case, set Spooling at Printer Driver in the Special Settings dialog box to Yes.

Special Settings...
Opens the Special Settings dialog box.
If you are unable to obtained the desired print results, you can change the print processing method.

Pages to Print dialog box
When printing a poster that has been divided into several pages, you can specify which pages to print and
just print those pages.
Simply clear the check boxes of the pages you do not want to print.
In the setting view, the pages that were unchecked are hidden, and only the pages to be printed are
displayed.

Invert
Switches the pages to be displayed or hidden.
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Note
• The Pages to Print dialog box appears only when Poster (1 x 2) or Poster (2 x 2) is selected

for Page Layout.

Page Layout Printing dialog box
This dialog box allows you to select the number of document pages to be placed on one sheet of paper,
the page order, and whether a page border line is to be printed around each document page.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Page Layout Printing dialog box.
You can check what the print result will look like before you actually print the data.

Page Order
Specifies the document orientation to be printed on a sheet of paper.

Page Border
Prints a page border line around each document page.
Select something other than None from the list to print the page border line.

Note
• The Page Layout Printing dialog box appears only when 2 Pages/Sheet, 4 Pages/Sheet, 6

Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet is selected for Page Layout.

Define Stamp dialog box
The Define Stamp dialog box allows you to specify settings for printing a stamp over the document
pages. In addition to the pre-registered ones, you can register and use your original stamp.

Stamps
This is a list of the pre-registered stamps.

Add
Creates an original stamp.
Click this item to set Name, Text, Font, Style, Size, and Color.
Name

Enter the stamp name to be registered.

Text
Enter the characters to be used in the stamp.

Font
Selects the font for the stamp text string.

Style
Selects the font style for the stamp text string.

Size
Selects the font size for the stamp text string.

Color
Select the color of the stamp text string.
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Delete
Deletes an unnecessary stamp.
Specify the title of an unnecessary stamp from the Stamps, and click this button.

Outline
Selects a frame that encloses the stamp text string.

Print Style
Select the stamp printing method.
Select Transparent to print the stamp on the back of the document, and select Overlap to print the
stamp on the front.

Position
Specifies the stamp position on the page.
You can specify values in X and Y to set the coordinates, or you can drag the horizontal and vertical
slide bars to the left/right or up/down to change the coordinates.
Move to Center

Moves the stamp to the center of the paper.

Angle
Set the stamp positioning angle.
You can specify a value in Set Angle to set the angle, or you can drag the slide bar left/right to
change the angle.
When specifying an angle value, set a value in the range of -180 to 180.

Stamp first page only
Select this check box if you want to print a stamp only on the first page.

Page Options dialog box
Specify the print settings, such as date, user name, and page number.

Print Date
Select the position for printing the date.

Print Time Also
Prints the time along with the date.

Print User Name
Select the position for printing the user name.

Print Page Number
Select the position for printing the page number.

Note
• It will be displayed if you select Yes in Spooling at Printer Driver in the Special Settings dialog

box.

Format Settings
The Format Settings dialog box opens, and you can set the format.

Format Settings dialog box
Set the format to be used when printing the contents set in the Page Options dialog box.
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Font
Select the font type.

Style
Select the font style.

Size
Select the font size.

Color
Select the font color.

Special Settings dialog box
The Special Settings dialog box allows you to change the print processing method if you do not get the
print results you want.

Settings Summary
This is a list of items that you can set in the Special Settings dialog box.
When you click an item that you want to set, the setting contents are displayed outside the box.
Spooling at Printer Driver

Set whether print jobs are to be spooled in the print driver or whether PageComposer processing
is to be performed.
Setting No (Use RAW Spooling) or Yes may improve the print results or the printing speed.
Also, depending on the setting, you may not be able to use some of the driver functions.
FineZoom Settings

Use this function to print on long paper.
Yes

The print problem may be corrected.
Select this in usual cases.

No
Image distortions may be corrected (for example, small lines may be eliminated).

Preview Switching
If you check the Preview before printing check box on the Main tab and then print,
PageComposer starts.

Application Color Matching Priority
You can assign higher priority to color management by the application software.

Fast Graphic Process
If image colors or line thicknesses are printed incorrectly, you may be able to get the print results
you want by setting this function to off.
This is only displayed when using a 32-bit driver.

Disable the color profile setting of the application software
If the color profile information set in the application software is output to the printer driver, the
printing results may include an unexpected tint. You can resolve the problem in this case by
setting Disable the color profile setting of the application software to On.
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Important
• Even if this is set to On, it will only disable some of the color profile information, and it is still

possible to print using the color profile.
This should normally be set to Off when using.

Adjust Faint Lines
This function prevents thin lines from fading when printing by darkening light colored lines.

Specify Pattern Resolution
This function is for switching the rendering resolution for drawings using the hatch brush or
pattern brush.

Cleaner Lines/Text
Set to Off if the thickness and density of lines and text are not printed uniformly.
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Favorites Tab Description

The Favorites tab allows you to register frequently used print settings as favorites.

Favorites
A list of the registered favorite settings appears. The Default Settings are registered in the initial
settings.

Settings Details
The settings of the favorite that you selected from Favorites appear.

Comment
The comment registered to the favorite appears.

Apply Favorite
You can change the print settings to the settings of the favorite that you selected from the Favorites
list.

Delete
You can delete favorites that have become unnecessary.

Edit...
The Edit dialog box opens.
You can change the name and icon settings of the favorite that you selected from the Favorites list.

Add...
The Add dialog box opens.
You can register the current settings as a favorite.

Application Settings Priority
The setting in the application software will take priority over the favorites setting set on the printer driver.
The setting in the application software is only prioritized for Page Size, Orientation and Copies.
Place a checkmark to prioritize the settings for the application software.

Import...
You can read the settings of the favorite that was saved to a file (.cfg).
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Export...
You can save the settings of a favorite to a file (.cfg).

Edit dialog box
You can change the name and icon of the favorite that you selected from the Favorites list.

Name
Changes name to be displayed in Favorites list.

Icon
Changes icon to be displayed in Favorites list.

Comment
Changes information to be displayed in Comment.

Add dialog box
You can save the current print settings as the settings of a favorite.

Name
Set the name to be displayed in Favorites list.

Icon
Set the icon to be displayed in Favorites list.

Comment
Enter information to be displayed in Comment.

173



Utility Tab Description

The Utility tab allows you to perform printer maintenance or check the settings of the printer.

Print Nozzle Check Pattern
Prints a nozzle check pattern.
Perform this function if printing becomes faint or a specific color fails to print. Print a nozzle check
pattern, and check whether the print head is working properly.
If the print result for a specific color is fainted, or if there are any unprinted sections, use Print Head
Cleaning to clean the print head.
Paper Source

Displayed using the Media Type, Page Size and Roll Paper Width for each currently set paper
feed position.

Print Head Cleaning
Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.
Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink levels
are sufficiently high.

Paper Feed Amount Adjustment
This function adjusts the paper feed amount if the print result is faint or contains streaks.
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About
Opens the About dialog box.
You can check information such as the version and copyright of the printer driver.

Settings Summaries...
The Settings Summaries dialog box is displayed.
You can confirm the list of items set in the printer driver.
If you click the tab of each sheet, you can confirm the setting details of each item.

Related Topics
Cleaning the Print Heads
Printing a Nozzle Check Pattern
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Device Settings Tab Description

Many of the tabs in the Properties windows of the printer are controlled by Windows. However, the Device
Settings tab is for specifying printer configuration-related settings and is part of the printer driver.
The Device Settings tab allows you to specify settings related to the printer unit, as well as administrator
settings.

Update Media Information
Opens the Update Media Information dialog box.
Gets the latest media information from the printer and updates the media information in the printer
driver.

Preferences...
Configure administrator settings for the printer driver.

About
Opens the About dialog box.
You can check information such as the version and copyright of the printer driver.

Preferences dialog box
Use System Language

Set this to On to change the display language of the printer driver according to the OS language
settings.
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Canon IJ Status Monitor Description

The Canon IJ Status Monitor displays the status of the printer and the printing progress. The monitor uses
graphics, icons, and messages to let you know the printer status.

Canon IJ Status Monitor Features
The Canon IJ Status Monitor offers the following advantages:

You can check the status of the printer on the screen.
The status of the printer is shown on the screen in real time.
You can check the printing progress of each printing document (print job).

Error types and solutions are shown on the screen.
Shown when a printer error occurs.
You can immediately check how to respond.

You can check the ink status.
This function displays graphics showing the ink tank type and the estimated ink levels.
Icons and messages are displayed when ink is running low (ink level warning).

Canon IJ Status Monitor Overview
Canon IJ Status Monitor allows you to check the status of the printer and ink with graphics and messages.
You can check the information on the printing document and the printing progress during printing.
When a printer error occurs, it shows the cause and solution. Follow the instruction in the message.

Printer
Canon IJ Status Monitor shows an icon when a warning or error occurs to the printer.

 : A warning is being displayed.

 : An operation error has occurred.

 : You are being informed of remaining ink levels, etc.

 : There has been an error which requires a service.
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Document Name
Shows the name of the document to be printed.

Owner
Shows the owner's name of the document to be printed.

Printing Page
Shows the number of printing page and total printing pages.

Display Print Queue
Shows the print window used to manage the print job that is being printed or being in the print queue.

Cancel Printing
Cancels the current print job.

Estimated ink levels
Displays icons to report a remaining ink level warning and an ink depletion error.

Click  (the disclosure triangle) to display a pictorial representation of the estimated ink level in the
ink tank.
Ink Model Number

You can look up the correct ink tank for your printer.

Estimated Maintenance Cartridge Usage
Displays icons to report that the available space in the maintenance cartridge is low or the cartridge is
full.

Click  (the disclosure triangle) to display a pictorial representation of the estimated usage amount
in the maintenance cartridge.

Paper Feed
Displays the size and type of paper loaded in each feeder.

Click  (the disclosure triangle) to check the remaining amount of paper.
Purchase information is displayed in Purchase Paper....

Option Menu
If you select Enable Status Monitor, when a printer related message is generated the Canon IJ
Status Monitor starts.
When Enable Status Monitor is selected, following commands are available.
Always Display Current Job

Displays the Canon IJ Status Monitor during printing.

Always Display on Top
Displays the Canon IJ Status Monitor in front of other windows.

Display Warning Automatically
When a Low Ink Warning Occurs

Starts the Canon IJ Status Monitor window automatically and displays it in front of the other
windows when a low ink warning occurs.

When a Maintenance Cartridge Warning Occurs
When a maintenance cartridge remaining space warning occurs, the Canon IJ status
monitor starts automatically and appears in front of all other windows.
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Other Warnings
When any other warning occurs, the Canon IJ Status Monitor will open automatically and be
displayed in front of other windows.

Start when Windows is Started
Starts the Canon IJ Status Monitor automatically when you start Windows.

Remote UI menu
You are able to open the printer's Remote User Interface.
You are able to check the printer status and run maintenance functions on the printer when
connected to and using it through a network.

Note
• When the printer is being used via USB connection Remote UI will not display.

Printer Information
Allows you check detailed information, such as the printer status, the print progress, and
remaining ink levels.

Maintenance
Allows you to run printer maintenance and change printer settings.

Job Log
Displays the Job history window.

Download Security Certificate
Displays the For secure communication window.
This window allows you to download the root certificate, register it to the browser, and disable
warning displays.

Help Menu
When you select this menu item, the Help window for Canon IJ Status Monitor is displayed, and you
can check the version and copyright information.
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Updating the Printer Driver

Obtaining the Latest Printer Driver

Deleting the Unnecessary Printer Driver

Before Installing the Printer Driver

Installing the Printer Driver
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Obtaining the Latest Printer Driver

By updating the printer driver to the latest version of the printer driver, unresolved problems may be solved.

You can check the version of the printer driver by clicking the About button on the Utility tab.

You can access our website and download the latest printer driver for your model.

Important
• You can download the printer driver for free, but any Internet access charges incurred are your

responsibility.

Related Topics
Before Installing the Printer Driver
Installing the Printer Driver
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Deleting the Unnecessary Printer Driver

The printer driver which you no longer use can be deleted.
When deleting the printer driver, first exit all programs that are running.

The procedure to delete the unnecessary printer driver is as follows:

1. Start the uninstaller1.

Select the Control Panel -> Programs -> Uninstall a program (Programs and Features).
From the program list, select "XXX Driver" (where "XXX" is your model name) and then click Uninstall.

The confirmation window for uninstalling the model appears.

Important
• A confirmation/warning dialog box may appear when starting, installing or uninstalling software.

This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

2. Execute the uninstaller2.

Click Start. When the confirmation message appears, click Yes.
When all the files have been deleted, click Complete.

The deletion of the printer driver is complete.
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Before Installing the Printer Driver

This section describes the items that you should check before installing the printer driver. You should also
refer to this section if the printer driver cannot be installed.

Checking the Printer Status
• Turn on the printer.

Checking the Personal Computer Settings
• Terminate all running applications.
• Log on as a user who has the administrator account.

Related Topics
Obtaining the Latest Printer Driver
Installing the Printer Driver
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Installing the Printer Driver

You can access our web site through the Internet and download the latest printer driver for your model.

The procedure for installing the downloaded printer driver is as follows:

1. Turn on the printer1.

2. Start the installer2.

Double-click the icon of the downloaded file.
The installation program starts.

Important
• A confirmation/warning dialog box may appear when starting, installing or uninstalling software.

This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

3. Install the printer driver3.

Take the appropriate action as described on the screen.

4. Complete the installation4.

Click Exit.

Depending on the environment you are using, a message prompting you to restart the computer may be
displayed. To complete the installation properly, restart the computer.

Important
• You can download the printer driver for free, but any Internet access charges incurred are your

responsibility.

Related Topics
Obtaining the Latest Printer Driver
Deleting the Unnecessary Printer Driver
Before Installing the Printer Driver
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Application Software

PosterArtist on the Web

PosterArtist Guide (Windows)

Direct Print Plus Guide

Preview Guide (Windows)

Preview Guide (macOS)

Free Layout plus Guide (Windows)

Free Layout Guide (macOS)

Quick Utility Toolbox Guide

Wi-Fi Connection Assistant Guide

Media Configuration Tool Guide
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Handling Paper

Loading Rolls in the Printer

Moving the Roll Holder Support

Removing the Roll from the Printer

Loading Sheets in the Printer

Paper Settings

Changing the Type of Paper

Specifying the Ink Drying Time

Specifying the Cutting Method for Rolls

Making Margin Settings for Rolls

Cutting the Leading Edge of Roll Paper Automatically

Reducing Dust from Cutting Rolls

Remove Jammed Roll Paper

Remove a Jammed Sheet

Information about Paper

Paper Sizes

Paper Information List

Updating paper information

Using Paper Other Than Genuine Paper and feed confirmed Paper

Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing
Settings

Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a
Media Type

Managing Paper Information on Printer Using Media Configuration Tool
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Loading Rolls in the Printer

Follow these steps to load rolls in the printer.

Caution
• Set the roll on its side on a table or other flat surface so that it does not roll or fall. Rolls are heavy, and

dropping a roll may cause injury.

Important
• Before loading a roll, make sure that the inside of the printer and the output guide are clean. If these•

areas are dirty, we recommend cleaning them in advance.

Cleaning Inside the Printer

• When handling the roll, be careful not to soil the printing surface. This may affect the printing quality.•
We recommend wearing clean cloth gloves when handling rolls to protect the printing surface.

• Cut the edge of the roll paper if it is uneven, dirty, or has tape residue. Otherwise, it may cause feeding•
problems and affect the printing quality.

• Align the edges of the paper on both ends of the roll. This may cause feeding problems.•

Note
• For details on roll paper sizes and types that can be used, see "Paper Sizes" or "Paper Information•

List".
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1. Select paper settings display area on the Home Screen.1.

2. Select the roll paper area.2.

3. Select Load roll paper or Replace paper.3.

Important
• If paper that will not be used is fed, a message confirming paper replacement is displayed. Follow•

the instructions on the screen, and then go to the next step.

Removing the Roll from the Printer

• When the cover is ready to be opened, instructions will be displayed on the touch screen. Do not•
open the cover before these instructions are displayed.

4. When a message confirming the change of roll paper width is displayed, confirm the4.
contents and select OK.

5. Open the cut sheet feed cover.5.

6. Unlock with the lever and open the roll paper feed cover.6.
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7. Load rolls on the roll holder.7.

1. Make sure that the lock levers on the left and right roll holders are toward  and unlocked.1.

2. Align the roll paper winding direction as shown in the figure, insert the roll holder marked with [R]2.
from the right, and press it firmly until the side of the roll paper (A) sits flush against the roll holder
without any gap.

Insert the roll holder marked with [R] so that it is on the right side.

Caution
• Do not touch the metal part inside the roll holder when setting the roll holder. The sharp•

edges of the metal may cause injury.
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Important
• When loading a roll, be careful to avoid hitting the printer hard with the roll. This may damage•

the roll holder.

3. Turn the lock lever (B) of the inserted roll holder toward  to lock it.3.

4. Insert the roll holder marked with [L] from the left and press it firmly until the side of the paper roll4.
(C) sits flush against the roll holder with no gap.
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5. Turn the lock lever (D) of the inserted roll holder toward  to lock it.5.

8. If necessary, move the roll holder support to match the width of the roll paper to be loaded.8.

Moving the Roll Holder Support

9. Before setting the roll holder, make sure that the roll holder support is firmly fixed.9.
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Important
• Make sure that the knurled screws on the roll holder support are tightened until they do not turn.•

10. Hold the left and right roll holders (E) and place the roll paper on the slide guide (H) so that10.
the roll holder shafts (F) are in front of the roll holder slots (G).

Place the paper roll so that the roll holder marked with [R] is on the right side and the roll holder marked
with [L] is on the left side.

Important
• Do not allow roll paper or other materials to come in strong contact with the feed cover rollers•

located inside the roll paper feed cover. Doing so may result in problems with paper feeding.
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11. Set the shafts (F) of the left and right roll holders in the roll holder slots (G) by sliding them11.
on the slide guides (H).

Caution
• Do not force the roll holder into the printer with the right and left ends reversed. This may damage•

the printer and roll holder.

• Do not release the roll holder until the holder is loaded in the roll holder slot.•

• Be careful not to pinch your fingers between the roll holder shafts (F) and the roll holder slots (G)•
when loading rolls.

Important
• If the leading edge of the roll paper is cut crooked or folded, it may not be fed correctly. Cut the•

leading edge of the roll paper with scissors or the like and straighten it.

• Load the roll paper so that it is not loaded in the opposite direction.•

• If the roll paper has become unwound, remove the slack before loading the roll paper.•

• If the paper is wrinkled or warped, straighten it out before loading it.•

• Load the roll so that there is no gap between the sides of the roll and the roll holder.•
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12. Insert the leading edge of the roll into the feed slot (I) and feed it until you hear a sound.12.

Important
• If the leading edge of the paper is stuck to the roll and difficult to insert into the feed slot, pull out•

the roll slightly before inserting the edge into the feed slot.

• Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect•
the printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the
printing surface.

13. Close the roll paper feed cover completely.13.

14. Select OK.14.
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15. Select the type of paper to use.15.

After selecting the paper type, paper feeding starts.

Important
• Do not open the roll paper feed cover after the paper feeding has started. It may cause paper•

feeding to fail.

• Cut the edge of the roll using the Set cut length function if the edge is creased or soiled.•

Set cut length (feeds and cuts paper rolls by a specified length)

Note
• For details on media types that you can select, see "Paper Information List."•

• When selecting Enable in Keep roll paper type, there is no need to specify the type of the paper.•
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Moving the Roll Holder Support

To load roll paper of different widths, move the roll holder support as described below.

1. Loosen the knurled screws (A) securing the roll holder support by turning them1.
counterclockwise.

2. Move the roll holder support according to the width of the roll paper to be set.2.

Important
• There are holes for the knurling screws at the positions of each support roll paper size. Move the•

holder to the required position and make sure that the screws are aligned with the holes.

3. Turn the knurled screws (A) clockwise to secure the roll holder support to the printer.3.
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Important
• Tighten knurled screws finger-tight until they stop turning. Do not use a screwdriver or similar tool•

to tighten the screws too tightly.

Note
• After moving the roll holder support, continue loading the roll paper.•

Loading Rolls in the Printer
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Removing the Roll from the Printer

Remove rolls from the printer as follows.

1. Select paper settings display area on the Home Screen.1.

2. Select the roll paper area.2.

3. Select Remove paper.3.

4. Select Yes.4.

The roll is rewound.

Important
• When the cover is ready to be opened, instructions will be displayed on the touch screen. Do not•

open the cover before these instructions are displayed.

5. Open the cut sheet feed cover.5.
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6. Unlock with the lever and open the roll paper feed cover.6.

7. Using both hands, rotate the roll holder toward the back to rewind the roll.7.

8. Hold the left and right roll holders (A) and remove the roll paper from the printer.8.

9. Remove the roll from the roll holder.9.

1. Turn the lock lever (B) on the left roll holder toward  to unlock.1.
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2. Remove the unlocked roll holder from the roll paper.2.

Caution
• Do not touch the metal part inside the roll holder when removing the roll holder. The sharp•

edges of the metal may cause injury.
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3. Turn the lock lever (C) on the right roll holder toward  to unlock.3.

4. Remove the unlocked roll holder from the roll paper.4.

Important
• Store the roll in the original bag or box, away from high temperature, humidity, and direct•

sunlight. If paper is not stored properly, the printing surface may become scratched, which
may affect the printing quality when you use it again.

10. Close the roll paper feed cover completely.10.
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Note
• To load new roll paper in the printer at this point, see "Loading Rolls in the Printer."•
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Loading Sheets in the Printer

Follow these steps to load sheets in the printer.

Important
• Do not load any sheet smaller than A4 size. Doing so may cause a paper jam.•

Note
• For the page size and paper weight you can use for this printer, see Paper Sizes or Paper Information•

List.

1. Prepare sheets.1.

Align the edges of paper. If paper is curled, flatten it.

Important
• Align the edges of paper neatly before loading. Loading paper without aligning the edges may•

cause paper jams.

• If paper is curled, hold the curled corners and gently bend them in the opposite direction until the•
paper becomes completely flat.

2. Open the cut sheet feed cover.2.

3. Open the top feed and then pull it upwards.3.
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4. Slide the left and right paper guides (A) to open both paper guides.4.

5. Load the sheets in portrait orientation with the print side facing up.5.

After loading the paper, the paper setting confirmation screen for the top feed appears on the touch
screen.
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6. Slide the left and right paper guides to align with both sides of the sheets.6.

Important
• Do not slide the paper guides too hard against the paper. The paper may not be fed properly.•

• Always load sheets in portrait orientation. Loading paper in landscape orientation can cause paper•
jams.

• Do not load sheets of paper higher than the load limit mark (B).•
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7. If the page size and type displayed on the touch screen match size and type of the sheets7.
loaded in the top feed, select Yes.

If not, select Change to change the settings in accordance with the size and type of the loaded paper.

Important
• There are many types of paper available, each best suited to a particular printing use. Each media•

type has specific preset settings (how ink is used and sprayed, distance from nozzles, etc.), that
allow you to print to that type with optimal image quality. The wrong paper settings may cause
poor printout color quality or scratches on the printed surface.

• For details on media types that you can select, see "Paper Information List".•
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Paper Settings

Changing the Type of Paper

Specifying the Ink Drying Time

Specifying the Cutting Method for Rolls

Making Margin Settings for Rolls

Cutting the Leading Edge of Roll Paper Automatically

Reducing Dust from Cutting Rolls
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Changing the Type of Paper

Follow these steps to change the type of paper specified on the printer after you have loaded paper.

Note
• If you want to continue using the same type of roll paper, set Keep roll paper type to Enable. The•

previously selected paper type is automatically selected, saving you the trouble of selecting the paper
type when loading the roll paper.

Keep roll paper type

Important
• For best printing results, the printer fine-tunes the print head height and the feed amount for each type•

of paper. Be sure to select the type of paper to use correctly before printing.

• Because the printer fine-tunes the paper feed rate and print head height, the margins and the size of•
printed images may vary depending on the type of paper used. If margins and the size of images are
not as you expected, adjust the image quality.

Adjustments for Better Print Quality

Changing the Type of Paper

1. Select paper settings display area on the Home Screen.1.

2. Select the roll paper area or sheet area.2.

3. Select Paper settings.3.
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4. Select Type.4.

5. Select media type of roll paper loaded in printer.5.

Important
• Be sure to select the correct paper type. If this setting does not match the loaded paper, it may•

cause feed errors and affect printing quality.

Note
• For details on media types, see "Paper Information List."•

6. Select Register.6.
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Specifying the Ink Drying Time

When you are using paper that takes longer for ink to adhere, ink may be transferred onto the paper surface
during ejection, soiling it. In that case, you may be able to improve the condition by setting the time to wait
for the ink to dry after printing.

Important
• Printer settings are applied when the ink drying time is not set in the printer driver. If the ink drying time•

is set in the printer driver, that setting has priority.

Note
• If the cutter touches the print surface on which the ink is not dry, the paper surface may become•

scratched or soiled, or the paper surface may rub when the paper falls and the surface may become
soiled.

To wait for the ink to dry without dropping the printed documents into the basket immediately after
printing, set Cutting mode to Eject cut.

Specifying the Cutting Method for Rolls

Set on the Printer

1. Select  (Setup) on the HOME screen.1.

2. Select  Printer settings.2.

3. Select Paper-related settings.3.

4. Select Advanced paper settings.4.

5. Select the paper type for which you want to change the setting.5.

6. Select Pause between scans or Pause between pages.6.
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Pause between scans
Specify the waiting time between printing one scan and printing the next one. You can set the
drying waiting time and the target area where the waiting time occurs.

Pause between pages
Specify the waiting time between printing one page and ejecting the paper. If there is a next page,
it will be printed after the ink drying time has passed.

Set on your Computer
Refer to the followings for how to set from your computer.

Main Tab Description (Windows)

Advanced Paper Settings (macOS)
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Specifying the Cutting Method for Rolls

How rolls are cut after ejection varies depending on printer settings.

• Automatic cut•

The roll is automatically cut by the cutter blade.

◦ Printer Setting◦

Cutting mode > Automatic cut

• Eject cut (when the paper surface is being scratched / to wait for ink to dry)•

Select this to move the cutter by operation panel operation and cut paper. With Automatic cut, the
paper drops and may rub against the basket, resulting in damage to the print surface, but you can cut
using this method and supporting the paper so that it does not drop to avoid damage to the paper. Also,
you can prevent paper that has not dried from dropping by visually checking the ink has dried, and then
cutting the paper.

After printing is finished, select Cut paper to cut the roll.

◦ Printer Setting◦

Cutting mode > Eject cut

• Set cut length (feeds and cuts paper rolls by a specified length)•

The roll paper is fed by the amount specified from the operational panel. The roll paper is always cut
after being fed.

Use this function when you want to cut the leading edge of the paper after the roll paper is loaded.

Note
• For some paper types, the default Cutting mode may be set to something other Automatic cut. For•

this paper, we recommend keeping the preset cutting mode.

• If documents printed using Automatic cut or Eject cut are short, rolls are advanced a specific amount•
before cutting to prevent problems with cutting and paper ejection. This may create a wider bottom
margin, in some cases.

Eject cut (when the paper surface is being scratched / to wait for ink to
dry)

Important
• When cutting wide printed documents after Eject cut, have two people support the documents. If the•

paper drops, printed documents may be damaged.

• Do not lift the paper when holding printed documents before cutting. If the paper rises, it may affect•
the printing quality or cause rough cut edges.

• After printing is completed, Eject cut is possible after the set ink drying time has passed. If 5 minutes•
have passed without Eject cut, the printed document will be cut automatically to protect the printer
mechanism.
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Note
• With Eject cut, printing does not resume after a series of jobs have been printed continuously until•

the roll is cut.

1. Select Eject cut in Cutting mode.1.

1. Select  (Setup) on the HOME screen.1.

2. Select  Printer settings.2.

3. Select Paper-related settings.3.

4. Select Advanced paper settings.4.

5. Select the paper type for which you want to change the setting.5.

6. Select Cutting mode.6.

7. Select Eject cut.7.

2. Print the job.2.

When printing is finished, the printer will stop without cutting.

3. While holding the printed document from the bottom edge to prevent it from dropping,3.
select Cut paper to cut the roll paper.

Set cut length (feeds and cuts paper rolls by a specified length)

1. Select paper settings display area on the Home Screen.1.
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2. Select the roll paper area.2.

3. Select Set cut length.3.

4. Select the input field and enter the length by which you want to feed the roll paper.4.

5. Select Cut paper.5.

6. Select Yes.6.

The roll paper is cut after the specified length is fed.
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Making Margin Settings for Rolls

Make settings related to margins when printing on roll paper. Setting a large margin may improve the image
quality of the printed document.

Important
• In the printer driver, you can set the margins from Roll Paper Safety Margin in the Paper Detailed•

Settings dialog box on the Main sheet. If you set from the printer driver, the setting from the printer
driver takes priority.

Main Tab Description (Windows)

Set the Margin Area of the Roll Paper
When printing on roll paper, set the size of margins to add to the top and bottom of the print data.

• Prioritize image size•

This setting adds margins to the outside of the print data. Larger margins make the printout longer in
the vertical direction and use more paper.

• Prioritize paper size•

This setting adds margins to the inside of the print data. Larger margins may cause part of the print
data not to be printed.
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Important
• When using Prioritize paper size, Roll paper lead edge/end margin may result in part of the image•

being lost. Prepare your print data to match the printable area.

1. Select  (Setup) on the HOME screen.1.

2. Select  Printer settings.2.

3. Select Paper-related settings.3.

4. Select Advanced paper settings.4.

5. Select the paper type for which you want to change the setting.5.

6. Select Roll paper top/bottom margins.6.

7. Select Prioritize image size or Prioritize paper size.7.

Set the Margins for the Leading Edge and Far End of the Roll Paper
When printing on roll paper, set the length of the vertical margin in the printing direction. When Auto is
selected, the margin amount is set according to the paper type and other factors.

Important
• Reducing the amount of space may result in the paper becoming dirty.•

1. Select  (Setup) on the HOME screen.1.

2. Select  Printer settings.2.

3. Select Paper-related settings.3.
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4. Select Advanced paper settings.4.

5. Select the paper type for which you want to change the setting.5.

6. Select Roll paper lead edge/end margin.6.

7. Select the margin length you want to set or Auto.7.
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Cutting the Leading Edge of Roll Paper Automatically

If the leading edge of the paper is cut crooked or is not cut straight when roll paper is loaded, it will not print
correctly. If this happens, you can cut the leading edge of the paper straight when loading a paper roll by
using Trim edge first in the operation panel menu.

• Auto•

If the leading edge of the paper is cut crooked and is not cut straight when loading roll paper, cut the
leading edge straight and eject the fragment of paper to prevent printing on the platen and soiling the
printer.

• On(Preset Length)•

The amount to cut from the leading edge of the paper varies depending on the media type and is cut to
a prescribed length. For the leading edge precut length, see "Paper Information List".

• On(Input Length)•

The amount to cut from the leading edge of paper is specified in the operation panel. The amount to
cut from the leading edge can be specified in the range of lengths displayed in the operation panel. The
range of lengths differs according to the media type.

Note
• The amount to cut from the leading edge of paper cannot be set shorter than the length displayed in•

the operation panel.

• Off•

The edge is not cut and scraps are not removed.

1. Select  (Setup) on the HOME screen.1.

2. Select  Printer settings.2.

3. Select Paper-related settings.3.

4. Select Advanced paper settings.4.

5. Select the paper type for which you want to change the setting.5.

218



6. Select Trim edge first.6.

7. Select desired Trim edge first settings.7.

This setting takes effect the next time you load a roll.
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Reducing Dust from Cutting Rolls

If the paper tends to generate dust when cut, such as with Backlit Film, you can reduce flying dust by setting
Cut-dust reduction to ON from the operation panel menu, which will coat the leading and trailing edges
of the printed document with ink. As a result, you can reduce problems with the print head. You can set
Cut-dust reduction according to the media type.

A: The ink is coated.

B: Cut Position

Important
• Do not set Cut-dust reduction to ON for paper that wrinkles easily, such as Plain Paper or lightweight•

paper. If not cut properly, the paper may jam.

1. Select  (Setup) on the HOME screen.1.

2. Select  Printer settings.2.

3. Select Paper-related settings.3.

4. Select Advanced paper settings.4.

5. Select the paper type for which you want to change the setting.5.

6. Select Cut-dust reduction.6.
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7. Select ON.7.
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Information about Paper

Paper Sizes

Paper Information List

Updating paper information

Using Paper Other Than Genuine Paper and feed confirmed Paper

Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using
Existing Settings

Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding
a Media Type
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Paper Sizes

Rolls
Rolls that meet the following conditions are supported.

• Outer diameter: within 4.4 in. (110 mm)•

• Inner diameter of paper core: 2 inches•

• Printing side out•

Roll Paper Width 24 in Roll : 24.00 in. (609.6 mm)

A1 Roll : 23.39 in. (594.0 mm)

B2 Roll : 20.28 in. (515.0 mm)

18 in Roll : 18.00 in. (457.2 mm)

17 in Roll : 17.00 in. (431.8 mm)

A2 Roll : 16.54 in. (420.0 mm)

B3 Roll : 14.33 in. (364.0 mm)

A3 Roll : 11.69 in. (297.0 mm)

Minimum Paper Length 8.00 in. (203.2 mm)

Maximum Printable Length 13 feet (4 m)

Thickness 3 mil (0.08 mm) to 11 mil (0.28 mm)

Sheets
Sheets of the following sizes are supported.

Sheet Width 8.27 in. (210.0 mm) to 11.69 in. (297.0 mm)

Minimum Paper Length 8.00 in. (203.2 mm)

Maximum Printable Length 17.01 in. (432.0 mm)

Thickness 3 mil (0.08 mm) to 11 mil (0.28 mm)

Note
• For details on non-standard sizes, see "Setting Paper Dimensions (Custom Size)" (Windows) or•

"Setting Paper Dimensions (Custom Size)" (macOS).
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Updating paper information

You can update the printer's media information to the latest information by applying the latest version of the
Media Information File.

For details on the procedure for applying the Media Information File, refer to the following.

Media Configuration Tool Guide

Important
• If you are using the Media Configuration Tool, the new Media Information File is downloaded•

automatically when released on the Canon website. A computer connected to the Internet is required to
download the Media Information File.

• Even if you are not using the printer driver, you should install the Media Configuration Tool in order to•
register the media types for your region in the printer.
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Using Paper Other Than Genuine Paper and feed confirmed
Paper

When using this printer to print on paper other than genuine Canon paper and feed confirmed paper, use
paper that meets the following conditions.

• Paper where the size is described in "Paper Sizes"•

• Paper where bleeding and ink overflow does not occur when printing•

• Paper that does not warp severely when loading the paper or printing•

Note
• For Canon genuine paper/feed confirmed paper, see "Paper Information List."•

Important
• If you use paper other than Canon genuine paper and feed confirmed paper, Canon provides absolutely•

no guarantees regarding print quality or paper feed properties.

After loading the paper in the printer, select the media type in the operation panel and printer driver and then
perform the printing. For the media type, you can select easily from existing settings or you can create and
use settings for the paper you are using.

Printing Using Existing Settings
You can print easily by selecting from existing settings provided in the operation panel and printer driver.

Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings

Printing Using Additional Settings
You can use the function to add custom paper in the Media Configuration Tool to create settings suitable
for paper other than genuine paper/output confirmation paper you are using. You can add the created
settings to the printer operation panel and printer driver as a new paper type for printing.

Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type
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Printing on Paper Other Than Genuine Paper and feed
confirmed Paper Using Existing Settings

You can easily print on paper other than genuine Canon paper and feed confirmed paper without making
complicated settings by selecting the existing settings provided in the operation panel and printer driver
depending on the media type you are using. The existing settings consist of general-purpose paper settings
provided for different media types.

Important
• The Canon genuine paper settings provided in the operation panel and printer driver are optimized for•

Canon genuine paper. If these settings are selected for printing on paper other than Canon genuine
paper, the ink may bleed or the print head may rub against the paper. To easily print on paper other
than Canon genuine paper and feed confirmed paper, we recommend that you select one of the
following general-purpose paper settings.

Note
• For the available paper types, see "Paper Information List."•

• For instructions on selecting the media type with the operation panel, see "Changing the Type of•
Paper". For instructions on selecting the media type with the printer driver, see "Main Tab Description"
(Windows) or "Quality & Media" (macOS).

Choosing General-Purpose Paper Settings
These settings anticipate a wide variety of paper other than Canon genuine paper and feed confirmed
paper, and, therefore, these settings make it difficult for bleeding ink and print head rubbing to occur. For
details on the relationships between the conditions of paper other than Canon genuine paper and feed
confirmed paper and the media type to select, see "Paper Information List."

Note
• If you cannot obtain the desired results by selecting the general-purpose paper settings, use the•

custom paper adding function in Media Configuration Tool to create settings suitable for the paper
you are using. For details, see "Printing on Paper Other Than Genuine Paper and feed confirmed
Paper by Adding a Media Type."
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Printing on Paper Other Than Genuine Paper and feed
confirmed Paper by Adding a Media Type

Media Configuration Tool provides a function for adding custom paper for better print quality and improved
paper feed properties when printing on paper other than Canon genuine paper/feed confirmed paper than
when printing with general-purpose settings. You can use this function to configure settings such as the
amount of ink used and the height of the print head according to the characteristics of the paper being used,
and thereby realize higher print quality. Also, you can add the settings created with this function as a new
media type to the operation panel and printer driver.

For details on Media Configuration Tool, refer as follows.

Media Configuration Tool Guide

Important
• For details on how to select the added media type in the operation panel, see "Changing the Type of•

Paper."

• You can select the media type to be used in printing from Media Type in the Main sheet (Windows) or•
Quality & Media (macOS) in the printer driver. For details, see "Main Tab Description" (Windows) or
"Quality & Media" (macOS).

• We recommend that you use an ICC profile created using commercially available profile creation•
software to perform color management accurately on paper other than Canon genuine paper and feed
confirmed paper. You can register the ICC profile you created when creating a custom paper with
Media Configuration Tool. See "Adding Custom Paper" in Media Configuration Tool Guide.
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Changing Printer's Setting

Changing Settings from Operation Panel

Home Screen Menu Composition

Menu Structure

Setting Items on Operation Panel

Setting Administrator Password on Operation Panel

Checking the Total Number of Uses of Printer

Changing Printer's Setting Using Web Browser

Start up Remote UI

Changeable Setting Items Using Remote UI

Setting Passwords Using Remote UI

Registering Printer's Root Certificate to Web Browser for SSL Communication

Registering Printer's Root Certificate to Local Computer for SSL Communication

Generating Server Certificate

Setting Mail Server

Receiving Printer Status by E-mail
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Changing Settings from Operation Panel

Home Screen Menu Composition

Menu Structure

Setting Items on Operation Panel

Setting Administrator Password on Operation Panel

Checking the Total Number of Uses of Printer
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Home Screen Menu Composition

After the printer starts up, the HOME screen appears on the touch screen.

From the HOME screen, you can check the printer status and select the maintenance, paper operations,
settings, and other menus.

Basic Touch Screen Operations

A: Paper Setting Display Area
Displays information on loaded paper. Selecting this option displays the menu for making paper
settings.

B: Basic Menu
The frequently used Load paper / Replace paper and Set cut length are displayed here.

C: Network
Displays the current network status. Select to display the basic network information or to change the
network settings.

The icon differs depending on the network of use or the network status.

 Wi-Fi is enabled and the printer is connected to the wireless router.

Note
• Depending on the signal state, the icon will change.•

 (Signal strength: 81 % or more): You can use the printer over a Wi-Fi without any problems.

 (Signal strength: 51 % or more): The problem such as the printer cannot print may occur
according to the network status. We recommends placing the printer near the wireless router.

 (Signal strength: 50 % or less): The problem such as the printer cannot print may occur.
Place the printer near the wireless router.
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 Wi-Fi is enabled but the printer is not connected to the wireless router.

 Wired LAN is enabled.

 Wireless Direct is enabled.

 Wi-Fi and Wired LAN are disabled.

D: Wireless connect
Select to connect the printer to a smartphone/tablet over Wi-Fi through Easy wireless connect.

Select this button to display a confirmation screen for starting a connection. Touch and hold this button
to switch to the standby mode for Easy wireless connect.

Easy wireless connect

E: Setup
Displays the printer's setting menus or the maintenance menus.

F: Information
Displays quick guides about such procedures as loading paper and troubleshooting and such
information as estimated ink level and system information.

Note
• By default, menu settings apply to all print jobs. However, for settings that are also available in the•

printer driver, the values specified in the printer driver take priority.

Basic Touch Screen Operations
You can select various functions and settings by gently touching and swiping the touch screen with your
fingertip.

Important
• Take the following precautions when operating the touch screen. Otherwise, the touch screen may•

malfunction or become damaged.

Do not forcibly press the touch screen with your finger.
Do not press the touch screen with an object other than your finger (such as a ballpoint pen,
pencil, fingernail, or other object with a sharp tip).
Do not operate the touch screen with wet or dirty hands.
Do not place objects on top of the touch screen.

• Do not place a protective film over the touch screen. Removing it can damage the touch screen.

Tap

Gently touch with your fingertip and then release.

Use this when selecting an item on the screen.
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Touch

Gently touch with your fingertip.

To go (or return) to a menu or list, touch the directional mark.

Flick

Drag and release your finger up, down, left, or right.

Use this to quickly scroll through a menu or list.

Drag

Move your finger up, down, left, or right while gently keeping it in contact with the touch screen.

Use this to move a menu or list while viewing it.
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Menu Structure

The * on the right side of an item indicates the default value.

Values may vary depending on your model and firmware version.

• Paper information•

This menu is displayed by selecting paper information area.

Roll paper settings

Load roll paper / Replace paper

Set cut length

Remove paper

Paper settings

Type

Page size

Cut sheet settings

Paper settings

Type

Page size

• Load paper / Replace paper•

• Set cut length•

• LAN settings•

This menu is displayed by selecting Network icon.

Wi-Fi

See settings

Enable/disable Wi-Fi

Enable / Disable

Wi-Fi setup

Easy wireless connect

Manual connect

WPS (Push button method)

Other connection types

WPS (PIN code method)

Advanced

Wireless Direct

See settings
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Connect to smartphone

iPhone/iPad

Android device

Others

Enable/disable Wireless Direct

ON / OFF

Change network name (SSID)

OK

Auto update

Yes / No

Change password

Change manually

Auto update

Yes / No

Connection request confirmation

ON / OFF

Advanced

Wired LAN

See settings

Enable/disable Wired LAN

Enable / Disable

Advanced

Print details

• Wireless connect•

• Setup•

This menu is displayed by selecting Setup icon.

Printer settings

Print settings

Prevent paper abrasion

ON / OFF*

Adjust horizontal print position

+3.0 / +2.9 / … / +0.1 / 0.0* / -0.1 / … / -2.9 / -3.0

Cleaner Lines/Text

Enable* / Disable
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IPP print settings

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) / Mono-
chrome / Monochrome BMP

Print resolution

Standard* / Print priority

Print target

Photo / Line drawing*

Paper settings

Unidirectional printing

ON / OFF*

Default print settings

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) / Mono-
chrome / Monochrome BMP

Print target

Photo / Line drawing*

Paper-related settings

Keep roll paper type

Enable / Disable*

Manage remaining roll amount

Auto estimate* / Disable

Roll amount warning settings

11m/36ft. / 9m/30ft. / 7m/23ft. / 5m/16ft. / 3m/10ft.* / 1m/3ft.

Detect top feed paper change

Enable* / Disable

Advanced paper settings

LAN settings
* The lower items of this menu are the same as the lower items of LAN settings displayed by selecting
Network icon.

Other printer settings

Date/time settings

Date display format

YYYY/MM/DD / MM/DD/YYYY / DD/MM/YYYY

Daylight saving time setting
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ON / OFF*

Sound control

Keypad volume

Loud / Standard* / OFF

Alarm volume

Loud / Standard* / OFF

Energy saving settings

Auto power off

Never / 240 min.* / 120 min. / 60 min. / 30 min. / 15 min.

Auto power on

ON / OFF*

Time zone

Keyboard settings

Standard* / Full keyboard

Ink level monitor

Timing for ink level notification

Standard* / Earlier notification

Length unit settings

Meters / Feet/inches

Language selection

Firmware update

Install update

Check current version

Update notification settings

ON* / OFF

Auto update settings

ON / OFF

DNS server setup

Auto setup* / Manual setup

Proxy server setup

Use / Do not use*

Administrator password settings

Change administrator password

Remove administrator password

Reset settings

Web service setup only
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LAN settings only

Settings only

Reset paper settings for all paper

Reset all

Maintenance

Nozzle Check

Roll paper

Top feed

Cleaning

All colors

Color

BK

Deep Cleaning

All colors

Color

BK

Print Head Alignment - Auto

Print Head Alignment - Manual

Roll paper

Top feed

Print the Head Alignment Value

Roll paper

Top feed

Paper feed adjustment

Set priority

(Paper type selection)

Auto

Prioritize print quality

Prioritize length accuracy

Adjust print quality

Auto

Roll paper

Manual

Roll paper

Adjust feed length

Print alignment pattern
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Roll paper

Change adjustment values

-0.70% / -0.68% / … / 0.68% / 0.70%

Roller Cleaning

Bottom Plate Cleaning

Replace Ink in Print Head

All colors

Color

BK

Platen cleaning

Transport mode

Head Replacement

Web service setup

Web service usage registration / Web service usage cancellation

Web service connection setup

IJ Cloud Printing Center setup

Register with this service

Delete from this service

Check Web service setup

Issue registration code

DNS server setup

Auto setup* / Manual setup

Proxy server setup

Use / Do not use*

Web service inquiry

Print from Canon server

ECO

Auto power off

Never / 240 min.* / 120 min. / 60 min. / 30 min. / 15 min.

Auto power on

ON / OFF*

• Information•

This menu is displayed by selecting Information icon.

Quick guide
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Loading paper

Refilling ink tanks

Using from a smartphone

Using smartphone apps

Using Cloud applications

Learn more about your printer

Displaying the manual

Estimated ink levels

Current estimated ink levels

How to set

Ink model no.

Order ink now

Maintenance cart. info.

Maintenance cartridge usage

Replace

System information

Current version

Printer name

Serial number

MAC address (Wi-Fi)

MAC address (Wired LAN)

Root cert. thumbprint (SHA-1)

Root cert. thumbprint (SHA-256)

Troubleshooting

Print is smudged or patchy

Connecting with Wi-Fi

Paper is jammed

Other problems

Job management

Display job history

Print job history

Restrict job history access

Usage stats
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Total sheets used on the device
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Advanced (Paper settings)

This menu is displayed by selecting the Setup icon and then selecting Printer settings > Paper-related
settings > Advanced paper settings.

Advanced paper settings

Paper thickness (head height)

Auto / High / Standard

Skew detection accuracy

Standard / Loose / OFF

Cutting mode

Automatic cut / Eject cut

Cut speed

Fast / Standard / Slow

Trim edge first

Auto / On(Preset Length) / On(Input Length) / Off

Cut-dust reduction

ON / OFF

Roll paper tension (printing)

High / Standard / Low

Roll paper tension (feeding)

High / Standard / Low

Pause between scans

Ink drying wait time

OFF / 0.5 seconds / 1 second

Ink drying target area

Overall / Leading edge

Pause between pages

OFF / 30 seconds / 1 minute / 3 minutes

Roll paper lead edge/end margin

Auto / 5 mm / 15 mm / 30 mm

Roll paper top/bottom margins

Prioritize image size / Prioritize paper size

Detect paper width

Enable / Disable

Paper core outer diameter

Paper thickness
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Reset paper settings by paper
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Advanced (LAN settings)

This menu is displayed by selecting Network icon > Wi-Fi / Wireless Direct / Wired LAN > Advanced.

The * on the right side of an item indicates the default value.

Advanced

Set printer name

TCP/IP settings

IPv4

IP address

Auto setup* / Manual setup

DNS server

Auto setup* / Manual setup

Proxy server

Use / Do not use*

IPv6

Enable/disable IPv6

Enable* / Disable

WSD settings

Enable/disable WSD

Enable / Disable*

Optimize inbound WSD

Enable* / Disable

Timeout settings

20 minutes / 15 minutes* / 10 minutes / 5 minutes / 1 minute

Bonjour settings

Enable/disable Bonjour

Enable* / Disable

Service name

LPR protocol settings

Enable* / Disable

RAW protocol

Enable* / Disable

LLMNR

Enable* / Disable

IPP settings

Enable* / Disable
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Wi-Fi DRX settings

Enable* / Disable

Wired LAN DRX settings

Enable* / Disable

IPsec settings

Enable / Disable*

IEEE802.1X/EAP settings

Enable/disable

Enable / Disable*

Search for EAP router

Last authentication result
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Setting Items on Operation Panel

Note
• The administrator password is required to change some setting items if it is enabled for changing•

settings using the operation panel.

Setting Administrator Password on Operation Panel

(Network)

(Setup)
• Printer settings•

◦ Print settings◦

◦ Paper-related settings◦

◦ LAN settings◦

◦ Other printer settings◦

◦ Language selection◦

◦ Firmware update◦

◦ Administrator password settings◦

Setting Administrator Password on Operation Panel

◦ Reset settings◦

• Maintenance•

• Web service setup•

• ECO•
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(Information)
• System information•

• Job management•

• Usage stats•

Checking the Total Number of Uses of Printer
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Print settings

This item is displayed when you select Printer settings from  (Setup) on the HOME screen.

• Prevent paper abrasion•

Use this setting only if the print surface becomes smudged.

Important
• Be sure to set this back to OFF after printing since it may result in lower print quality.•

• Adjust horizontal print position•

Adjusts the print position when the left/right margins are not aligned.

You can adjust the left/right margins in increments of 0.004 in. (0.1 mm) between -0.12 in. (-3 mm) and
+0.12 in. (+3 mm) centered on the horizontal center of the paper.

Important
• When using A4/Letter sized paper, the amount of adjustment that can be made is limited. You•

cannot make adjustments greater than this limit.

• Cleaner Lines/Text•

When enabled, lines and text are printed more sharply.

• IPP print settings•

Sets the image quality and paper settings for IPP printing.

For example, when printing using AirPrint or Mopria Print Service, this setting value is applied.

• Default print settings•

Sets the default values for print settings.

If Media Type is set to Auto (Use Printer Settings) in the printer driver, this setting value is applied.
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Paper-related settings

This item is displayed when you select Printer settings from  (Setup) on the HOME screen.

• Keep roll paper type•

Select Enable to continue using the same type of roll paper.

• Manage remaining roll amount•

Selects the method to manage remaining roll amount and that to display warning when the roll is
running short.

◦ Auto estimate◦

Estimates and manages the remaining amount of roll paper.

To estimate the remaining roll amount, Paper thickness and Paper core outer diameter have to
be set correctly.

When using a paper that is not listed in the paper information list, set Thickness and Paper Tube
Size in Advanced paper settings or in Media Configuration Tool.

For paper thickness and paper tube outer diameter size, contact the paper manufacturer.

Important
• If you do not select the media type correctly, the remaining roll amount may not be estimated•

correctly.

• There is an error in the estimated remaining roll amount, and paper may run out during printing.•

◦ Disable◦

Select to disable managing remaining roll amount.

• Roll amount warning settings•

Specifies when to warn the remaining roll paper amount.

Note
• This setting is enabled when Auto estimate is selected for Manage remaining roll amount.•

• Detect top feed paper change•

Detects paper insertion into the top feed when Enable is selected. When the paper registration screen is
displayed after replacing paper, register the paper size and the media type.

• Advanced paper settings•

Performs advanced paper settings for each media types.
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LAN settings

This item is displayed when you select Printer settings from  (Setup) on the HOME screen.

Important
• The administrator password is required to change the settings if it is enabled to change the settings on•

the operation panel using the administrator password.

Wi-Fi
Wireless Direct
Wired LAN

Wi-Fi

• See settings•

The network settings information of the printer appears when it is connected by Wi-Fi. (Some setting
items are not displayed depending on the printer settings.)

Items Setting

Connection Enabled (connected)/Enabled (disconnected)/Disable

Network name (SSID) XXXXXXXXXXXXXXXX
XXXXXXXXXXXXXXXX (up to 32 characters)

Wi-Fi security Disable/WPA-PSK (TKIP)/WPA-PSK (AES)/WPA2-PSK (TKIP)/
WPA2-PSK (AES)/WPA3-SAE (AES)/WPA-EAP (AES)*/WPA2-EAP
(AES)*/WPA3-EAP (AES)*
*Supports IEEE802.1X (EAP-TLS / EAP-TTLS / PEAP)

Signal strength (%) XXX

IPv4 address XXX. XXX. XXX. XXX (12 characters)

IPv4 subnet mask XXX. XXX. XXX. XXX (12 characters)

IPv4 default gateway XXX. XXX. XXX. XXX (12 characters)

IPv6 link-local address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

MAC address (Wi-Fi) XX: XX: XX: XX: XX: XX (12 characters)

Printer name XXXXXXXXXXXXXXX (up to 15 characters)

Bonjour service name XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX (up to 48 characters)

("XX" represents alphanumeric characters.)

• Enable/disable Wi-Fi•

Enables/disables Wi-Fi.
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• Wi-Fi setup•

Selects the setup method for Wi-Fi connection.

◦ Easy wireless connect◦

Select if you specify the settings of the access point information to the printer directly from a
device (e.g. smartphone, or tablet) without operating the wireless router. Follow the on-screen
instructions of the connecting device for the setup procedure.

◦ Manual connect◦

Select when you perform settings for Wi-Fi manually using the operation panel of the printer.

◦ WPS (Push button method)◦

Select when you perform settings for Wi-Fi using a wireless router supporting a Wi-Fi Protected
Setup (WPS) push button method. Follow the on-screen instructions during setup.

◦ Other connection types◦

▪ WPS (PIN code method)▪

Select when you perform settings for Wi-Fi using a wireless router supporting a Wi-Fi
Protected Setup (WPS) PIN code method. Follow the on-screen instructions during setup.

• Advanced setup•

For details on each setting item:

Advanced setup

Wireless Direct

• Wireless Direct setting list•

The network settings information of the printer appears when it is connected by the wireless direct.
(Some setting items are not displayed depending on the printer settings.)

Note
• To show or hide the password, select Show password/Hide password in the Wireless Direct•

setting list screen.

Items Setting

Connection Enable/Disable

Network name (SSID) DIRECT-XXXXXXXXX
XXXXXXXXXXXXXXXX (up to 32 characters)

Password XXXXXXXXXX (10 characters)

Wi-Fi security WPA2-PSK(AES)

No. of printers connected now XX/XX

IPv4 address XXX. XXX. XXX. XXX (12 characters)

IPv4 subnet mask XXX. XXX. XXX. XXX (12 characters)

IPv4 default gateway XXX. XXX. XXX. XXX (12 characters)
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IPv6 link-local address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

MAC address (Wi-Fi) XX: XX: XX: XX: XX: XX (12 characters)

Printer name XXXXXXXXXXXXXXX (up to 15 characters)

Bonjour service name XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX (up to 48 characters)

("XX" represents alphanumeric characters.)

• Connect to smartphone•

Enables to connect the smartphone to the printer by reading the QR code displayed on the touch
screen with the smartphone, or also by manually obtaining the network name and password.

• Enable/disable Wireless Direct•

Enables/disables Wireless Direct.

• Change network name (SSID)•

Changes the identifier (SSID/the printer's name displayed on a Wi-Fi Direct compatible device) for
Wireless Direct.

• Change password•

Changes the password for Wireless Direct.

• Connection request confirmation•

Selecting ON displays the confirmation screen when a Wi-Fi Direct compatible device is connecting
the printer.

• Advanced setup•

For details on each setting item:

Advanced setup

Wired LAN

• Wired LAN setting list•

The network settings information of the printer appears when it is connected by wired LAN. (Some
setting items are not displayed depending on the printer settings.)

Items Setting

Connection Enabled (connected)/Enabled (disconnected)/Disable

IPv4 address XXX. XXX. XXX. XXX (12 characters)

IPv4 subnet mask XXX. XXX. XXX. XXX (12 characters)

IPv4 default gateway XXX. XXX. XXX. XXX (12 characters)

IPv6 link-local address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)
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MAC address (Wired LAN) XX:XX:XX:XX:XX:XX (12 characters)

Printer name XXXXXXXXXXXXXXX (up to 15 characters)

Bonjour service name XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX (up to 48 characters)

("XX" represents alphanumeric characters.)

• Enable/disable Wired LAN•

Enables/disables wired LAN.

• Advanced setup•

For details on each setting item:

Advanced setup

Advanced setup
• Set printer name•

Specifies the printer name. You can use up to 15 characters for the name.

Note
• You cannot use the same printer name as that already used for other LAN connected devices.•

• You cannot use a hyphen for the initial or last character of the printer name.•

• TCP/IP settings•

Performs IPv4 or IPv6 setting.

• WSD settings•

Setting items when you use WSD (one of the network protocols supported in Windows).

◦ Enable/disable WSD◦

Selects whether WSD is enabled or disabled.

Note
• When this setting is enabled, the printer icon is displayed on the Network Explorer in•

Windows.

◦ Optimize inbound WSD◦

Selecting Enable allows you to receive the WSD printing data faster.

◦ Timeout settings◦

Specifies the timeout length.

• Bonjour settings•

Setting items when you use Bonjour.

◦ Enable/disable Bonjour◦
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Selecting Enable allows you to use Bonjour to perform the network settings.

◦ Service name◦

Specifies the Bonjour service name. You can use up to 48 characters for the name.

Note
• You cannot use the same service name as that already used for other LAN connected•

devices.

• LPR protocol settings•

Enables/disables the LPR setting.

• RAW protocol•

Enables/disables RAW printing.

• LLMNR•

Enables/disables LLMNR (Link-Local Multicast Name Resolution). Selecting Enable allows the printer
to detect printer's IP address from the printer name without a DNS server.

• IPP settings•

Selecting Enable allows you to print via the network with the IPP protocol.

• Wi-Fi DRX settings•

Selecting Enable allows you to activate discontinuous reception when using Wi-Fi (discontinuous
reception).

Note
• Depending on the Wi-Fi router used, discontinuous reception may not be activated even though•

Enable is selected.

• Discontinuous reception is enabled only while the printer is on standby. (The touch screen is in•
the screen saver mode.)

• Wired LAN DRX settings•

Selecting Enable allows you to activate discontinuous reception when the printer is connected to a
device compatible with wired LAN.

• IPsec settings•

Selecting Enable allows you to specify the IPsec security.

• IEEE802.1X/EAP settings (Wi-Fi/Wired LAN only)•

Setting item when you use IEEE802.1X/EAP.

◦ Enable/disable◦

Enables/disables IEEE802.1X/EAP.

◦ Search for EAP router◦

Searches switch/access point of IEEE802.1X/EAP and display it.

◦ Last authentication result◦
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Displays the latest authentication result of IEEE802.1X/EAP setting.
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Other printer settings

This item is displayed when you select Printer settings from  (Setup) on the HOME screen.

Important
• The administrator password is required to change the settings if it is enabled to change the settings on•

the operation panel using the administrator password.

• Date/time settings•

Sets the current date and time.

• Date display format•

Sets the format of dates displayed on the touch screen and printed on photos.

• Daylight saving time setting•

Enables/disables the summer time setting. If you select ON, you can select additional sub-settings. This
setting may not be available depending on the country or region of purchase.

◦ Start date/time◦

Sets the date and time that summer time starts.

Month: Specify the month.

Week: Specify the week.

DOW: Specify the day of the week.

The screen to set the shift time to start summer time will be displayed after specifying the items
above and selecting OK.

After specifying the shift time and selecting OK, you can specify the end date/time.

◦ End date/time◦

Sets the date and time that summer time ends.

Month: Specify the month.

Week: Specify the week.

DOW: Specify the day of the week.

The screen to set the shift time to end summer time will be displayed after specifying the items
above and selecting OK.

Specify the shift time and select OK.

• Sound control•

Selects the volume.

◦ Keypad volume◦

Selects the beep volume when pressing the touch screen or the buttons on the operation panel.

◦ Alarm volume◦
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Selects the alarm volume.

• Energy saving settings•

Allows you to turn on/off the printer automatically to save electricity.

◦ Auto power off◦

Specifies the length of time to turn off the printer automatically when no operation is made or no
printing data is sent to the printer.

◦ Auto power on◦

Selecting ON enables the printer to turn on automatically when printing data is sent to the printer.

Note

• You can also select this setting by selecting  (Setup) on the HOME screen, and then•
selecting ECO.

ECO

• Time zone•

Specifies the time zone according to a country or region you live in.

Specifying the time zone to the printer allows you to display the correct time an e-mail was sent from the
main unit on your mail software.

• Keyboard settings•

Set the keyboard.

Select Full keyboard to select the keyboard layout from the following three types.

◦ QWERTY◦

◦ QWERTZ◦

◦ AZERTY◦

• Ink level monitor•

Sets the timing of the remaining ink level notification.

• Length unit settings•

Selects the length unit (meter or feet/inch).
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Language selection

This item is displayed when you select Printer settings from  (Setup) on the HOME screen.

Changes the language for the messages and menus on the touch screen.

Important
• The administrator password is required to change the settings if it is enabled to change the settings on•

the operation panel using the administrator password.
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Firmware update

This item is displayed when you select Printer settings from  (Setup) on the HOME screen.

You can update the firmware of the printer, check the firmware version, or perform settings of a notification
screen, a DNS server and a proxy server.

Important
• The administrator password is required to change settings if it is enabled for changing settings using the

operation panel.

Note
• If LAN is disabled, you cannot use Install update, DNS server setup, Proxy server setup.•

• Install update•

Updates the printer's firmware.

Firmware update

• Check current version•

You can check the current firmware version.

• Update notification settings•

Select Yes to display a notification on the touch screen when a firmware update is available.

• Auto update settings•

Select ON to keep the firmware updated to the latest version.

• DNS server setup•

Performs settings for a DNS server. Select Auto setup or Manual setup. If you select Manual setup,
follow the display on the touch screen to perform settings.

• Proxy server setup•

Performs settings for a proxy server. Follow the display on the touch screen to perform settings.
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Reset settings

This item is displayed when you select Printer settings from  (Setup) on the HOME screen.

You can set the settings back to the default.

Important
• The administrator password is required to change the settings if it is enabled to change the settings on•

the operation panel using the administrator password.

• Web service setup only•

Sets the Web service settings back to the default.

• LAN settings only•

Sets the LAN settings back to the default.

• Settings only•

Returns the settings such as the paper size, media type, or other setting items back to the default. The
LAN settings is not returned back to the default.

• Reset paper settings for all paper•

Selecting Yes initializes each setting specified in Advanced paper settings.

Entering the administrator password is required if it is enabled.

Important
• When you set the paper settings back to the factory default, added or updated paper information•

using Media Configuration Tool is erased.

• Reset all•

Sets all settings you made to the printer back to the default. The administrator password specified by
Remote UI or Wi-Fi Connection Assistant reverts to the default setting.

After resetting, perform setup again as necessary.

Note
• You cannot set the following setting items back to the default:•

The language displayed on the touch screen

The current position of the print head

The cumulative usage count of this product registered in Usage stats.

CSR (Certificate Signing Request) for encryption method (SSL/TLS) setting
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Maintenance

This item is displayed when you select  (Setup) on the HOME screen.

• Nozzle Check•

Prints out the nozzle check pattern.

Checking for Nozzle Clogging

• Cleaning•

Select this to clean the print head.

Cleaning the Print Head

• Deep Cleaning•

Use this mode if no ink is ejected at all or if Cleaning does not solve the problem.

Deep Print Head Cleaning

• Print Head Alignment - Auto•

Adjusts the print head position automatically.

Automatic Adjustment to Straighten Lines and Colors

• Print Head Alignment - Manual•

Adjusts the print head position manually.

Manual Adjustment to Straighten Lines and Colors

• Print the Head Alignment Value•

Prints the print head position adjustment value.

• Paper feed adjustment•

Adjusts the paper feed amount.

◦ Set priority◦

Sets how the paper feed rate is adjusted.

▪ Auto▪

Selects Prioritize print quality or Prioritize length accuracy automatically according to the
printer driver settings.

▪ Prioritize print quality▪

Adjust to make the horizontal streaks of the printed documents less noticeable. The settings in
Adjust print quality are applied.

▪ Prioritize length accuracy▪

Adjusts the length of the ruled lines on the printed documents to match. The values of Change
adjustment values under Adjust feed length are applied.
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◦ Adjust print quality◦

Select this mode when the printed documents have horizontal streaks of different colors.

Automatically Adjusting Different Colored Horizontal Streaks
Manually Adjusting Different Colored Horizontal Streaks

◦ Adjust feed length◦

Select this mode when you want to print ruled lines in CAD drawings to their exact lengths.

Adjusting Line Length

• Roller Cleaning•

Select this mode when cleaning the paper feed rollers.

Cleaning Paper Feed Rollers

• Bottom Plate Cleaning•

Select this mode when cleaning the inside of the printer.

Performing Bottom Plate Cleaning

• Replace Ink in Print Head•

Select this mode when Deep Cleaning does not improve the print quality.

Replacing the Ink in the Print Head

• Platen cleaning•

Select this mode when cleaning the inside of the printer.

Cleaning Inside the Printer

• Transport mode•

Select this to prepare for transporting the printer.

Preparing to Transfer the Printer

• Head Replacement•

Select this mode when replacing the print head.

Replacing the Print Head
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Web service setup

This item is displayed when you select  (Setup) on the HOME screen.

• Web service usage registration / Web service usage cancellation•

Registers/Deletes Web service usage to use the printer device information to/from PIXMA/MAXIFY
Cloud Link.

• Web service connection setup•

The following setting items are available.

◦ IJ Cloud Printing Center setup◦

Registers/Deletes the printer to/from Canon Inkjet Cloud Printing Center.

◦ Check Web service setup◦

Make sure whether the printer is registered to Canon Inkjet Cloud Printing Center.

• Issue registration code•

In order to link the web service and printer, obtain the registration code from the service origin.

• DNS server setup•

Performs settings for a DNS server. Select Auto setup or Manual setup. If you select Manual setup,
follow the display on the touch screen to perform settings.

• Proxy server setup•

Performs settings for a proxy server. Follow the display on the touch screen to perform settings.

263



ECO

This item is displayed when you select  (Setup) on the HOME screen.

This setting allows you to turn on/off the printer automatically to save electricity.

• Auto power off•

Specifies the length of time to turn off the printer automatically when no operation is made or no printing
data is sent to the printer.

• Auto power on•

Selecting ON enables the printer to turn on automatically when printing data is sent to the printer.
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System information

This item is displayed when you select  (Information) on the HOME screen.

• Current version•

Displays the current firmware version.

• Printer name•

Displays the printer name currently specified.

• Serial number•

Displays the printer serial number.

• MAC address (Wi-Fi)•

Displays the MAC address for Wi-Fi.

• MAC address (Wired LAN)•

Displays the MAC address for wired LAN.

• Root cert. thumbprint (SHA-1)•

Shows the root certification thumbprint (SHA-1) of the printer.

• Root cert. thumbprint (SHA-256)•

Shows the root certification thumbprint (SHA-256) of the printer.
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Job management

This item is displayed when you select  (Information) on the HOME screen.

• Display job history•

Displays the job history of Print from.

• Print job history•

Prints the job history of Print from.

• Restrict job history access•

This is the menu for the developer.
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Setting Administrator Password on Operation Panel

The administrator password can be set or canceled.

Important
• The administrator password is set at time of purchase. The default password is the printer serial•

number (9 characters) which can be found on the sticker on the printer.

1. Select  (Setup) on the HOME screen.1.

Home Screen Menu Composition

2. Select  Printer settings.2.

3. Select Administrator password settings.3.

f you have set an administrator password, enter the password.

4. Select Change administrator password.4.

5. Select the effective range of the administrator password.5.

Remote UI and other tools
To change the setting using the remote UI or a certain software, the administrator password needs
to be entered.

LCD, Remote UI, and other tools
To change the setting using the operation panel of this printer, remote UI or a certain software, the
administrator password needs to be entered.

6. Enter new administrator password.6.

Important
• When changing the password, the character is limited as follows.•

Set the password using 4 to 32 characters.

Only alphanumeric characters are available.

From a security point of view, it is recommended to set the password of 8 characters or more
in combination of alphanumeric characters.

7. Select Apply.7.

8. Enter the administrator password again.8.

9. Select Apply.9.
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The administrator password is available.

When You Want to Disable the Administrator Password:

After selecting  (Setup) on the HOME screen, select Printer settings > Administrator
password settings > Remove administrator password. Select either item and follow the on-screen
instructions to perform settings.
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Checking the Total Number of Uses of Printer

You can get information on printer usage, such as the number of sheets printed.

1. Select  (Information) on the HOME screen.1.

Home Screen Menu Composition

2. Select  Usage stats.2.

3. Select item to check.3.

Total sheets used on the device
Displays the total number of printing.

Note
• The record of the total number of uses is not reverted even if the printer is reverted back to the default

by Reset settings in Printer settings.

269



Changing Printer's Setting Using Web Browser

Start up Remote UI

Changeable Setting Items Using Remote UI

Setting Passwords Using Remote UI

Registering Printer's Root Certificate to Web Browser for SSL Communication

Registering Printer's Root Certificate to Local Computer for SSL Communication

Generating Server Certificate

Setting Mail Server

Receiving Printer Status by E-mail
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Start up Remote UI

You can check the printer status and change the printer settings using the web browser on your
smartphone, tablet, or computer.

To check the printer status and to change the printer settings, display "Remote UI" on the web browser.

Note
• Remote UI is a software that enables you to perform operations, which are usually performed on the•

printer's operation panel, using a Web browser over a network.

LAN connection with the printer is required to use Remote UI.

• You can use Remote UI on the following OS and the web browser.•

iOS device

Web browser: iOS standard Web browser (Mobile Safari)

iPadOS device

Web browser: iPadOS standard Web browser (Mobile Safari)

Android device

Web browser: Android standard Web browser (Browser or Chrome)

macOS device

OS: macOS Mojave 10.14.6 or later

Web browser: macOS standard Web browser (Safari)

Windows device

OS: Windows 7 SP1 or later

Web browser: Microsoft Edge, Mozilla Firefox, Google Chrome

• Enable JavaScript and cookies in the web browser.•

1. Check printer's IP address.1.

1. Select  (Network) on the HOME screen.1.

Home Screen Menu Composition

2. Select the enabled LAN.2.

Diagonal lines are displayed for disabled LAN icons.

3. Check IPv4 address.3.

2. Open web browser on your smartphone, tablet, or computer and enter IP address.2.

Enter as following in the URL field of the web browser.

http://XXX.XX.X.XXX
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Enter the IP address of the printer in "XXX.XX.X.XXX".

Note
• If you have set a DNS host name, you can also enter this.

When you access, "Remote UI" will be displayed on the web browser on your smartphone, tablet, or
computer.

Note
• If you display Remote UI for the first time on your smartphone, tablet, or computer, download the

root certificate, and then register it.
Registering Printer's Root Certificate to Web Browser for SSL Communication

• If the root certificate is not registered, a message to warn you that the secure connection is not
guaranteed may appear.

3. Select Log in.3.

The password authentication screen appears.

Note
• When the standard user mode is enabled, choose either administrator mode or standard user•

mode to log on.

After choosing a mode and selecting Log in, the password authentication screen of each mode
appears.

4. Enter password.4.

When the password authentication is complete, the menus that can be utilized are displayed on the web
browser.

Important
• The password is set at the time of purchase. The password is the printer serial number. The•

printer serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters.

For details on setting password, see Setting Passwords Using Remote UI.
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5. Confirm that the main screen of Remote UI is displayed.5.

For changeable setting items, see below.

Changeable Setting Items Using Remote UI

When you finish checking printer status and changing printer settings, select Log out.
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Changeable Setting Items Using Remote UI

Note
• The item which can be used is different in administrator mode or in standard user mode.

Printer status
This function displays printer information such as the remaining ink amount, the status, and detailed
error information.

You can also connect to the ink purchase site or support page, and use Web Services.

Utilities
This function allows you to set and perform maintenance such as cleaning.

Printer settings
You can change various settings, such as print settings.

Additionally, this function allows you to receive the printer status information.

Setting Mail Server
Receiving Printer Status by E-mail

Note
• Some of the menu is available only when you logged on in administrator mode.

AirPrint settings
This function allows you to specify the AirPrint settings when printing with AirPrint.

Web service connection setup
This function configures web services that use printer device information, such as PIXUS/MAXIFY
Cloud Link.

Job history
This function allows you to display the job history and print it.

Security
You can specify passwords and settings related to certificates for encrypted communication
(SSL/TLS settings).
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Records of use
You can get information on printer usage, such as the number of sheets printed.

System info and LAN settings
• Confirm system information
• LAN settings

Firmware update
You can update the firmware of the printer, check the firmware version, or perform settings of a DNS
server and a proxy server.

Firmware update

Language selection
This function allows you to change the language on the display.

Manual (Online)
This function displays the Online Manual.
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Security

• Administrator password setting•

Setting Passwords Using Remote UI

• Standard user mode settings•

Select Enable/Disable for the standard user mode.

• SSL/TLS settings•

Perform settings of a certificate for encrypted communication.

Available TLS settings enables you to specify the range of the version used for SSL/TLS
communication.

• IEEE802.1X/EAP settings•

◦ Authentication◦

Select the authentication method.

Note
• In the case of using IEEE802.1X certificate, Security > IEEE802.1X/EAP settings > CA•

certificate, and register the CA certificate.

• Supported authentication method•

EAP-TLS(Extensible Authentication Protocol-Transport Level Security)

EAP-TTLS(EAP-Tunneled TLS)

PEAP(Protected EAP)

◦ Key and certificate settings◦

Perform settings for key and client certificate.

◦ CA certificate◦

Perform settings for the CA certificate that verifies a server certificate.

◦ Enable/disable IEEE802.1X/EAP◦

Select to enable or disable IEEE802.1X/EAP.
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LAN settings

• Wi-Fi•

Enables/Disables Wi-Fi.

• Wireless Direct•

Enables/Disables Wireless Direct.

• Wired LAN•

Enables/Disables Wired LAN.

• Confirm LAN settings•

The LAN setting information is displayed.

• Advanced setup•

◦ Set printer name◦

Specifies the printer name. You can use 2 to 15 characters for the name.

Note
• You cannot use the same printer name as that already used for other LAN connected devices.
• You cannot use a hyphen for the initial or last character of the printer name.

◦ TCP/IP settings◦

Performs IPv4 or IPv6 setting.

◦ WSD settings◦

Perform settings to use WSD.

◦ Bonjour settings◦

Perform settings to use Bonjour.

◦ LPD print◦

Perform settings for printing with LPD.

◦ SNMP settings◦

Perform settings for using SNMP to manage and control the printer.

◦ IPP Settings◦

Perform settings for printing with IPP.

◦ CHMP settings◦

Perform settings for communication at the time when printer drivers or applications acquire the
information on status, paper, and job log, from the printer.

Enable HTTPS redirection redirects the communication using CHMP to encrypted communication.

Note
• To use CHMP for encrypted communication, you need to register the printer's root certificate to

your computer.
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Registering Printer's Root Certificate to Local Computer for SSL Communication

• CHMP is a Canon proprietary protocol.

◦ DRX settings◦

Selecting Enable perform the intermittent data reception when connecting to the network.

◦ IPsec settings◦

When Enable is selected, IPsec security can be configured.

◦ IP filtering◦

Allows or denies access for specific IP addresses.

Settings for both IPv4 and IPv6 addresses can be specified.

Important
• If you accidentally set the address of the administrator's device to be rejected, select•

 (Setup) on the HOME screen of the operation panel, then select Printer settings >
Reset settings > LAN settings only to reset the printer's network settings.

After resetting, perform setup again as necessary.

◦ MTU◦

Configures the MTU settings.
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Setting Passwords Using Remote UI

Each of passwords for administrator and standard user can be set.

When logging on with password for administrator, all settings can be changed.

When logging on with password for standard user, some of the settings can be changed.

Setting Administrator Password
Setting Standard User Password

Note
• Password can be set only when you are logged in administrator mode.
• The standard user password is disabled by default.

Setting Administrator Password
Change the administrator password by following the steps below.

Important
• The password is set at the time of purchase. The password is the printer serial number. The

printer serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters.

1. Start up Remote UI.1.

Start up Remote UI

2. Select Security.2.

3. Select Administrator password setting.3.

4. Select Change administrator password.4.

If an administrator password is not specified, the confirmation message appears. Confirm the
message and select Yes. When message appears again, confirm it and select OK.

5. Select range where administrator password is valid and select OK.5.

Remote UI and other tools
Entering the administrator password is required to change the setting items using the Remote UI
or some software.

Operation panel/Remote UI/other tools
Entering the administrator password is required to change the setting items using the operation
panel of the printer, the Remote UI, or some software.

6. Enter password and select OK.6.

Important
• The following character restrictions apply to the password:•
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Set the password by using 4 to 32 characters.
The allowed characters are single-byte alphanumeric characters, blank space, umlaut
characters, and the below characters.
- ! @ # $ % ^ & * _ ; : , . / ` = + ' " ( ) { } [ ] < > |

For security reasons, we recommend you use 8 and more alphanumeric characters.

7. When completion message appears, select OK.7.

Setting Standard User Password
For restricting the function for standard user, enable the standard user mode and set a standard user
password by following the steps below.

1. Start up Remote UI.1.

Start up Remote UI

2. Select Security.2.

The menus appear.

3. Select Standard user mode settings.3.

4. When confirmation message appears, select Yes.4.

5. Enter password and select OK.5.

Important
• The following character restrictions apply to the password:•

Set the password by using 4 to 32 characters.
The allowed characters are single-byte alphanumeric characters, blank space, umlaut
characters, and the below characters.
- ! @ # $ % ^ & * _ ; : , . / ` = + ' " ( ) { } [ ] < > |

For security reasons, we recommend you use 8 and more alphanumeric characters.

6. When completion message appears, select OK.6.
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Registering Printer's Root Certificate to Web Browser for SSL
Communication

If the printer's root certificate has not been registered to the web browser, a message to warn you that the
secure connection is not guaranteed may appear.

When you display Remote UI for the first time on your smartphone, tablet, or computer, download the root
certificate, and then register it to the web browser. The secure connection will be confirmed and a message
will not appear. However, the message may appear depending on a web browser even after you have
registered the root certificate.

How to register the root certificate varies depending on the web browser.

For Microsoft Edge
For Safari
For Chrome on Android
For Mobile Safari on iOS

Operating procedure may differ depending on the version of your web browser. For other web browser, refer
to each help.

Important
• Make sure that you have accessed to the printer IP address correctly by checking the URL field of the•

web browser before registering the root certificate.

• If the printer is connected via IPv6 using Windows, you need to generate a server certificate using•
Remote UI.

For details, see Generating Server Certificate.

For Microsoft Edge

1. Select For secure communication on Remote UI.1.

2. Select Download.2.

Downloading the root certificate is started.

3. If confirmation screen appears, select Open.3.

Certificate screen is displayed.

Note
• To save the certificate file and register it, select Save. To register, select Control Panel >•

Network and Internet > Internet Options, and register the root certificate from Certificates on
Content sheet.

4. Select Install Certificate.4.

Certificate Import Wizard screen is displayed.
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5. Select Next.5.

6. Select Place all certificates in the following store.6.

7. Select Browse.7.

Select Certificate Store screen is displayed.

8. Select Trusted Root Certification Authorities and OK.8.

9. Select Next on Certificate Import Wizard screen.9.

10. If Completing the Certificate Import Wizard appears, select Finish.10.

Security Warning screen is displayed.

11. Make sure that thumbprint on Security Warning screen matches printer's thumbprint.11.

To display the printer's root certificate thumbprint in Root cert. thumbprint (SHA-1) or Root cert.

thumbprint (SHA-256), select  (Information) on the HOME screen of the operation panel, and
then select System information.

12. If thumbprint on Security Warning screen matches printer's thumbprint, select Yes.12.

13. Select OK on Certificate Import Wizard screen.13.

The root certificate registration is completed.

For Safari

1. Select For secure communication on Remote UI.1.

2. Select Download.2.

Downloading the root certificate is started.

3. Open the downloaded file.3.

Keychain access starts up and Add Certificates screen is displayed.

4. Select Add.4.

Information on the certificate is displayed.

Note
• You can also add the certificate by selecting Show Certificate, checking certificate name to

add, and then selecting the same certificate on Keychain access.
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5. Make sure that fingerprint of certificate detail information matches printer's thumbprint.5.

To display the printer's root certificate thumbprint in Root cert. thumbprint (SHA-1) or Root cert.

thumbprint (SHA-256), select  (Information) on the HOME screen of the operation panel, and
then select System information.

6. If fingerprint of certificate detail information matches printer's thumbprint, display6.
information on certificate from the menu or by double-clicking the certificate, and select
Always Trust on Trust.

The root certificate registration is completed.

Note
• If a password is set on your device, entering a password may be required.

For Chrome on Android

1. Select For secure communication on Remote UI.1.

2. Select Download.2.

Downloading the root certificate is started and then Name the certificate screen is displayed.

3. As entering the root certificate name is required, enter an arbitrary certificate name and3.
select OK.

The root certificate registration is completed.

Note
• If PIN or password is not set as security type, the attention screen may appear. Select OK, and

then set the security type to PIN or password.

After Root Certificate Registration
We recommend that you make sure that the correct root certificate has been registered.

To make sure that the correct root certificate has been registered, make sure that thumbprint of
certificate information matches printer's thumbprint. Follow the steps below.

Note
• Some Android devices cannot be checked the thumbprint of a registered route certificate.

1. From Settings menu on your device, select Security, Trust credentials, and USER.1.

The list of downloaded certificates appears.

2. Select downloaded certificate.2.

The certificate information appears.
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3. Make sure that thumbprint of certificate information matches printer's thumbprint.3.

To display the printer's root certificate thumbprint in Root cert. thumbprint (SHA-1) or Root cert.

thumbprint (SHA-256), select  (Information) on the HOME screen of the operation panel,
and then select System information.

4. If thumbprint of certificate information screen matches printer's thumbprint, select OK.4.

The root certificate registration is completed.

If the message to warn you that the secure connection is not guaranteed appears when you select
Log in on Remote UI after registering the root certificate, restart the web browser. The message will
not appear on the web browser.

Note
• Depending on the Android device, a warning may appear even after registering the proper root

certificate.

For Mobile Safari on iOS

1. Select For secure communication on Remote UI.1.

2. Select Download.2.

Downloading the root certificate is started and then Install Profile screen is displayed.

3. Select Install.3.

Warning screen is displayed.

Note
• If a password is set on your device, entering a password may be required.

4. Select Install.4.

5. Select Install on displayed dialog.5.

The root certificate registration is completed.
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Registering Printer's Root Certificate to Local Computer for
SSL Communication

To use Device Management Console or Accounting Manager, etc. when you connect the printer to a
computer using SSL encrypted communication, you need to register (import) the printer's root certificate to
your computer.

Procedure to register the certificate varies depending on your operation environment.

Important
• If the printer is connected via IPv6 using Windows, you need to generate a server certificate using•

Remote UI.

For details, see Generating Server Certificate.

For Windows 11/Windows 10/Windows 8.1
For Windows 7
For macOS

Operation procedure may differ depending on your OS version.

For Windows 11/Windows 10/Windows 8.1
The procedure below describes how to import a root certificate in Windows 11/Windows 10/Windows 8.1.

1. Start up Remote UI.1.

Start up Remote UI

2. Select For secure communication.2.

Note
• You can download a certificate from Status Monitor.•

1. Open status monitor.1.

Open the Printing preferences, and select Status Monitor... on Main.

2. Download a certificate.2.

Select Download Security Certificate from the Remote UI menu.

3. Select Download.3.

The root certificate will be downloaded.

4. When download confirmation screen is displayed, select Open.4.

The Certificate screen appears.

5. Select Install Certificate.5.
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The Certificate Import Wizard screen appears.

6. Select Local Machine.6.

1. Select Local Machine on the startup screen of Certificate Import Wizard.1.

2. Select Next.2.

3. Select Yes on the displayed screen.3.

The Certificate Store screen appears.

7. Select Place all certificates in the following store.7.

8. Select Trusted Root Certificate Authorities.8.

1. Select Browse to open the Select Certificate Store screen.1.

2. Select Trusted Root Certificate Authorities from the list and select OK.2.

3. Select Next on the Certificate Store screen.3.

9. Select Finish.9.

When the Completing the Certificate Import Wizard screen appears, check the settings and select
Finish.

For Windows 7
The procedure below describes how to import a root certificate in Windows 7.
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Important
• Be sure to create a certificate snap-in before importing a root certificate.•

The root certificate will be registered to the local user if you import it without creating a certificate
snap-in.

Creating Certificate Snap-in

1. Start up Microsoft Management Console.1.

Enter MMC on Search programs and files in the Start menu and press the Enter key.

2. Select Yes on displayed screen.2.

3. Select Add/Remove Snap-in from File menu.3.

The Add or Remove Snap-ins screen appears.

4. Add Certificate snap-in.4.

1. Select Certificates from Available snap-ins list and select Add.1.

2. Select Computer account for This snap-in will always manage certificates for on the Certificates2.
snap-in screen and select Next.

3. Select Local computer on the Select computer screen and select Finish.3.

4. Select OK on the Add or Remove Snap-ins screen.4.

Downloading Certificate

1. Start up Remote UI.1.

Start up Remote UI
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2. Select For secure communication.2.

Note
• You can download a certificate from Status Monitor.•

1. Open status monitor.1.

Open the Printing preferences, and select Status Monitor... on Main.

2. Download a certificate.2.

Select Download Security Certificate from the Remote UI menu.

3. Select Download.3.

4. Select Save.4.

Importing Certificate

1. Open Certificate Import Wizard.1.

1. On the left window, open Trusted Root Certificate from Certificate on Console Root.1.

2. Right-click Certificates and select Import from All tasks.2.

2. Specify certificate file to import.2.

1. Select Next.1.

2. Specify the certificate file to import on File name and select Next.2.

3. Specify certificate store.3.

1. Select Place all certificates in the following store.1.

2. Select Trusted Root Certificate Authorities for Certificates Store.2.

4. Finish certificate import wizard.4.

1. Select Next and check the specified settings.1.

2. Select Finish to finish the wizard.2.

3. Select OK on the displayed screen.3.

Checking Imported Certificate
Make sure the imported certificate has been registered to your computer.
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1. Display certificate list.1.

On the left window of Microsoft Management Console, select Console Root > Certificates (Local
Computer) > Trusted Root Certificate Authorities in this order, and Select Certificates to display
the certificate list.

2. Check registered certificate.2.

Make sure the imported certificate name is displayed on the list.

Note
• Make sure you can see the registered certificate from Current user by creating the Current

user snap-in.

Note
• When you finish Microsoft Management Console, a message asking you whether to save the console

setting. If you continue to apply the same settings next, select Yes to save.

For macOS
The procedure below describes how to import a root certificate in macOS.

1. Start up Remote UI.1.

Start up Remote UI

2. Select For secure communication.2.

3. Select Download.3.

The root certificate will be downloaded.

4. Open downloaded certificate file.4.

When the download procedure is completed, a downloaded item pops up on the right of the screen.

Double-click the downloaded certificate on the list starts up Keychain Access and the Add
Certificates screen appears.

Note

• If the downloaded item does not pop up, select the Show Downloads  button on the
right.

• Selecting the magnifying glass icon on the right of download list displays the folder containing
the certificate.

5. Select Add.5.

Select the destination for the certificate on Keychain.

Selecting Add displays information on the certificate.
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Note
• You can add the certificate by selecting the same certificate on Keychain Access. Check the

name of certification to add after selecting View Certificates.

6. Check certificate.6.

Make sure the fingerprint of certificate shown on Details corresponds with the root certificate
thumbprint of the printer.

To display the printer's root certificate thumbprint in Root cert. thumbprint (SHA-1) or Root cert.

thumbprint (SHA-256), select  (Information) on the HOME screen of the operation panel, and
then select System information.

7. Select Always Trust.7.

If the fingerprint of certificate detail information matches printer's thumbprint, display information on
certificate from the menu or by double-clicking the certificate, and select Always Trust on Trust.

The root certificate has been registered.

Note
• Entering the password may be required if you specify it for your printer.
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Generating Server Certificate

When you use SSL connection via IPv6 network, you need to generate an IPv6 server certificate using the
printer.

Generate the server certificate from Remote UI.

Follow the procedure below.

1. Checking Printer's IP Address1.

2. Generating Server Certificate2.

3. Checking Generated Server Certificate3.

Important
• If you generate an IPv6 server certificate, a warning message may appear if you are using Remote UI.•

To reset the IPv6 server certificate, select Security > SSL/TLS settings > Delete key and certificate
in this order, and select OK on the displayed screen.

Checking Printer's IP Address

1. Select  Network on the HOME screen.1.

Home Screen Menu Composition

2. Select the enabled LAN.2.

Diagonal lines are displayed for disabled LAN icons.

3. Select See settings.3.

4. Check the value on IPv6 link-local address.4.

Write down the value on IPv6 link-local address for your reference when you generate a server
certificate.

Generating Server Certificate

1. Start up Remote UI.1.

Start up Remote UI

2. Select Security.2.

3. Select SSL/TLS settings.3.

4. Select Generate key and certificate.4.
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5. Select Generate self-signed cert.5.

6. Specify each setting item.6.

• Signature algorithm•

Select SHA256.

• Public key length (bits)•

Select 2048 bits.

• Specify the expiration date.•

Enter the date you generated the server certificate on Valid from.

Enter the date the server certificate expires on Valid to.

• Enter the common name.•

On Common name, enter the IPv6 link-local address you checked in abbreviated form.

Note
• When you enter the common name, add [ ] to each end of the abbreviation value of the

printer's IPv6 address.
• Do not use a comma or make a space for the common name.

7. Select Next.7.

You need not enter anything on Country, State or province, Locality, Organization, or
Organizational unit.

8. Select Generate.8.

The server certificate starts to be generated.

When the server certificate has been generated, Generated a self-signed certificate. appears.

9. Select Restart LAN.9.

LAN will be restarted.

When LAN has been restarted, Printer status on Remote UI appears.

Note
• If you cannot access to Remote UI after you restart LAN, reload your web browser.

Checking Generated Server Certificate

1. Select Security on Remote UI.1.

2. Select SSL/TLS settings.2.

3. Select Check key and certificate.3.
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Make sure the issuer of the root certificate is displayed on Issued by, and the value you entered is
displayed on Common name on Subject.
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Setting Mail Server

To use mail function, specify the mail server settings.

Note
• If you did not specify the time zone setting using the printer's operation panel, a message to inform you•

that the correct time may not be reflected on the sent e-mail appears. We recommend that you set the
time zone setting using the printer's operation panel.

Other printer settings

• These functions can be set only when you are logged in administrator mode.•

1. Launch the remote UI.1.

Start up Remote UI

2. Select Printer settings.2.

3. Select Set mail server / test connect.3.

4. Select Set mail server.4.

5. Specify mail server settings.5.

Specify the following items.

• Sender address•

Enter the e-mail address of the sender (this printer).

• Outgoing mail server (SMTP)•

Enter the address of your SMTP server.

• Port number (SMTP)•

Enter the port number of your SMTP server.

• Secure connection (SSL)•

Select if you use the secure connection (SSL).

• Don't verify certificates•

Select if you do not verify the certificate.

• Authentication•

Select one of the following authentication methods.

• SMTP authentication•

Select if you send e-mail with SMTP authentication.

Next, you can specify the following settings.

◦ Outgoing account◦

Enter the account name for sending to perform the authentication.
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◦ Outgoing password◦

Enter the password for sending to perform the authentication.

• POP before SMTP•

Select if you send e-mail with POP before SMTP authentication.

Next, you can specify the following settings.

◦ Incoming mail server (POP3)◦

Enter the address of your POP server.

◦ Port number (POP3)◦

Enter the port number of your POP server.

◦ Incoming account◦

Enter the account name for receiving to perform the authentication.

◦ Incoming password◦

Enter the password for receiving to perform the authentication.

◦ Use APOP authentication◦

Select if you send the password by the encryption transmission.

◦ Clear mailbox◦

Select if you delete the e-mails that remain in the POP3 server.

Important
• When this setting is enabled, e-mail in the Inbox on the server will have all been removed.•

If you specify the e-mail address of your everyday, be sure to disable this setting as
unread e-mail is not deleted. We recommend that you prepare this printer dedicated
e-mail account not to accidentally delete the unread e-mail.

• No authentication•

Select if the authentication is not necessary.

6. After specifying mail server settings, select OK.6.

The setting operation is completed.

Note
• To make sure that the mail server settings have been specified correctly, select Test connection•

to mail server.
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Receiving Printer Status by E-mail

You receive the printer status information such as the remaining ink level and the error from the printer.

* This function may not be available depending on the country or region of purchase.

Note
• Specify the mail server settings in advance.•

Setting Mail Server

• If you did not specify the date and time setting using the printer's operation panel, the date and time•
may not be reflected on the sent e-mail. We recommend that you set the date and time setting using the
printer's operation panel.

For the date and time setting, see Other printer settings.

• These functions can be set only when you are logged in administrator mode.

1. Start up Remote UI.1.

Start up Remote UI

2. Select Printer settings.2.

3. Select Status notification email.3.

4. Select Notification recipients.4.

5. Specify destination settings.5.

Up to 5 destinations can be registered by following the steps below.

1. Select number of destination.1.

2. Select Add.2.

3. Enter e-mail address, and then select printer status to send information.3.

4. Select OK.4.

The registration for destination is completed.

6. Select Printer settings > Status notification email > Retry settings.6.

7. Specify resending settings.7.

The number of resending can be specified by following the steps below.

1. Specify number of resending.1.

2. Specify interval of resending.2.
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3. Select OK.3.

The resending setting is completed.
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Network Setting

Printer Connection Methods

Wi-Fi Connection

Wireless Direct Connection

Wired Connection

USB Connection

Default Network Settings

Another Printer Found with Same Name

Printing Network Settings

Countermeasures against Unauthorized Access

Network Status and Troubleshooting

Checking Printer Connection Status Using Wi-Fi Connection Assistant

Sharing the Printer on a Network (Windows)

Setting Up a Shared Printer

Restrictions on Printer Sharing

Sharing the Printer on a Network (macOS)

Settings on Print Server

Settings on Client PC

Restrictions on Printer Sharing
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Printer Connection Methods

4 connection methods are available on the printer.

• Wi-Fi Connection•

• Wireless Direct Connection•

• Wired Connection•

• USB Connection•
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The printer cannot use a wired LAN connection simultaneously with a Wi-Fi or wireless direct connection.

When connecting another device while the devices are already connected to the printer, connect using a
method other than the above.

Restrictions

Important
• If you connect a device connected to the Internet via a wireless router to the printer that is in the

wireless direct, the connection between the device and wireless router will be disabled. In that case,
the connection of the device may switch to a mobile data connection automatically depending on your
device. Transmission fees for connecting to the Internet using a mobile data connection apply.
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Wi-Fi Connection

Follow the procedure below to setup a printer.

Note
• Refer to the following notes when connecting to Wi-Fi.

Notes on Wi-Fi Connection

1. Make sure printer is turned on before starting wireless connection setup.1.

If the power is on, the ON lamp will be lit.

Important
•  If printer is performing cleaning, print head alignment, or other processes, wait for the process

to finish, before starting setup.

2. Press the HOME button.2.

Note
• If an error screen appears, select OK, and then press the HOME button.

3. On the HOME screen, select the Network icon.3.
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Depending on the current LAN status, the icon displayed on the button may differ.

Home Screen Menu Composition

4. Select Wi-Fi.4.

5. Select Wi-Fi setup.5.

6. Select a connection method below.6.

Easy wireless connect

Set wireless router information to the printer directly from a device (such as a computer),
without operating the wireless router

Easy wireless connect may take some time. Internet connection may become temporarily
unavailable during setup.

Easy wireless connect is not available on Chrome OS or Windows 10 in S mode. Select Other
connection types.
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Manual connect

Connect to wireless router using a password

WPS

Connect to a WPS-compatible wireless router

WPS (PIN Code) Connection

A wireless connection can also be set up by using the WPS PIN code method
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WPS Connection

1. Select WPS (Push button method).1.

2. Select OK.2.

3. Press and hold the WPS button on the wireless router.3.

Note
• For more on pressing the WPS button, see the wireless router manual.

4. Select OK on the printer within 2 minutes.4.

5. When the screen on the below appears, select OK.5.
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6. Press the HOME button.6.

The network connection setup is now complete.

Once connection is complete,  appears on the screen.

If performing setup with software, return to the software and proceed with the installation.

Windows

Click  (or  ) on the  taskbar at the bottom of the screen, follow the
on-screen instructions to proceed with setup.

macOS

Click  on the  Dock at the bottom of the screen, and follow the on-
screen instructions to proceed with setup.
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WPS (PIN Code) Connection

1. Select Other connection types.1.

2. Select WPS (PIN code method).2.

3. Follow the on-screen instructions on a computer to set a PIN code on the wireless router.3.

4. When the screen on the below appears, select OK.4.
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5. Press the HOME button.5.

The network connection setup is now complete.

Once connection is complete,  appears on the screen.

If performing setup with software, return to the software and proceed with the installation.

Windows

Click  (or  ) on the  taskbar at the bottom of the screen, follow the
on-screen instructions to proceed with setup.

macOS

Click  on the  Dock at the bottom of the screen, and follow the on-
screen instructions to proceed with setup.
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Manual connect

1. Select Manual connect.1.

2. Select your wireless router.2.

If you select a Wi-Fi router name, proceed to step 8 and continue with the settings.

If you select [Directly enter the wireless router name], proceed to step 3 and continue with the settings.

If [Failed to connect to the wireless router.] appears, see "Failed to connect to the wireless router."
Appears

3. Select the input area.3.

4. Enter the wireless router name (SSID). Text entry is case-sensitive.4.
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If you don't know your wireless router name, see the wireless router manual or contact its
manufacturer.

5. Select OK.5.

6. Make sure the wireless router name (SSID) is correct.6.

7. Select OK.7.

8. The screen below will appear.8.

If "Connected to the wireless router." appears, the network does not require a password. Continue
from step 13.
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9. Select the input area.9.

10. Enter the password. Text entry is case-sensitive.10.

If you don't know the password for your wireless router, see the wireless router manual or contact its
manufacturer.

11. Select OK.11.

12. Select OK.12.
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13. When the screen on the below appears, select OK.13.

14. Press the HOME button.14.

The network connection setup is now complete.

Once connection is complete,  appears on the screen.

If performing setup with software, return to the software and proceed with the installation.

Windows

Click  (or  ) on the  taskbar at the bottom of the screen, follow the
on-screen instructions to proceed with setup.

macOS

Click  on the  Dock at the bottom of the screen, and follow the on-
screen instructions to proceed with setup.
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Easy wireless connect

1. Select Easy wireless connect.1.

2. Select Start.2.

3. When the printer preparation is complete, the screen below appears.3.

4. Return to the application software and proceed with the setup.4.

Windows

Click  (or  ) on the  taskbar at the bottom of the screen, follow the
on-screen instructions to proceed with setup.
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macOS

Click  on the  Dock at the bottom of the screen, and follow the on-
screen instructions to proceed with setup.
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Wireless Direct Connection

This section describes wireless direct, which allows you to print by connecting the devices to the printer
directly.

Important
• Check the usage restrictions and switch the printer to the wireless direct.•

Restrictions

• The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

• If a device has already been connected to the printer directly and you want to add a device to connect,
connect it to the printer directly. You can connect up to 5 devices to the printer at the same time.

Enable Wireless Direct

1. On the HOME screen, select the Network icon.1.

Depending on the current LAN status, the icon displayed on the button may differ.

Home Screen Menu Composition

2. Select Wireless Direct.2.

3. Select Enable/disable Wireless Direct and select Yes.3.

4. Confirm displayed message and select OK.4.

After Wireless Direct is enabled, the identifier (SSID) etc. when using the printer with wireless direct
connection are displayed.

By flicking the touch screen, you can check various settings of wireless direct.

Note
• The identifier (SSID) and password are specified automatically.•

• You can check the password set for the printer by the following method.•

1. On the HOME screen, select  (Network).1.

2. Select Wireless Direct.2.
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3. Select Change password.3.

4. Select Change manually.4.

5. Select Show password.5.

• By selecting Wireless Direct, you can change the following settings.•

Enable/disable Wireless Direct
Change network name (SSID)
Change password
Connection request confirmation

For updating the SSID / password or changing the name of the printer displayed on Wi-Fi Direct
compatible device, see Change Wireless Direct Connection Setting.

Connecting Smartphone/Tablet to Printer

1. Turn on Wi-Fi communication on Wi-Fi Direct compatible device.1.

For more on turning on Wi-Fi communication, see your device's instruction manual.

2. Select "DIRECT-XXXX-XX-XXXX" ("X" represents alphanumeric characters.) from list2.
displayed on device.

Note
• If "DIRECT-XXXX-XX-XXXX" does not appear on the list, wireless direct is not enabled.•

See Enable Wireless Direct to enable wireless direct.

• You can change the name of the printer displayed on Wi-Fi Direct compatible devices.•

See Change Wireless Direct Connection Setting as necessary.

3. Enter password on Wi-Fi Direct compatible device.3.

The device is connected to the printer.

Note
• You can check the password set for the printer by the following method.•

1. On the HOME screen, select  (Network).1.

2. Select Wireless Direct.2.

3. Select Change password.3.

4. Select Change manually.4.

5. Select Show password.5.

• If your Wi-Fi Direct compatible device is set to prioritize using Wi-Fi Direct and it is connecting•
to the printer, the printer displays a confirmation screen asking if you allow the device to
connect to the printer.
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Make sure the name on the touch screen is the same as that of your Wi-Fi Direct compatible
device and select Yes.

Change Wireless Direct Connection Setting

1. On the HOME screen, select  (Network).1.

Home Screen Menu Composition

2. Select Wireless Direct.2.

3. Change settings as necessary.3.

• To update the password for wireless direct•

Select Change password to display the confirmation screen.

To check the updated password, select Change manually > Show password.

• To change the printer's name displayed on the Wi-Fi Direct compatible device•

Select Change network name (SSID) to display the printer's name (the initial value is "DIRECT-
XXXX-XX-XXXX") displayed on a Wi-Fi Direct compatible device.

Follow the procedure below to change the name.

1. Select the device name entry field on the touch screen.1.

2. Enter device name (up to 32 characters).2.

3. Select OK and confirm the entered device name.3.

4. Select OK.4.

• To change the confirmation screen setting when a Wi-Fi Direct compatible device is connecting•
to the printer

Select Connection request confirmation to display the confirmation screen.

If you want the printer to display the screen to inform you a Wi-Fi Direct compatible device is
connecting to the printer, select Yes.

Important
• To prevent an unauthorized access, we recommend you should not change the setting from

the default.

When you finished performing the settings, the printer returns to the Wireless Direct settings screen.

Note
• If you change the wireless direct setting on the printer, also change the setting on the device.
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Wired Connection

Follow the procedure below to setup a printer.

Note
• Refer to the following for notes when connecting to a wired LAN.•

Notes on Wired Connection

1. Make sure printer is turned on before starting wired connection setup.1.

If the power is on, the ON lamp will be lit.

Important
•  If printer is performing cleaning, print head alignment, or other processes, wait for the process

to finish, before starting setup.

2. Press the HOME button.2.

3. You will need an Ethernet cable (sold separately).3.

4. Connect the printer and a network device (router, etc.) with an Ethernet cable.4.
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Do not connect to any other port.

5. On the HOME screen, select the Network icon.5.

Depending on the current LAN status, the icon displayed on the button may differ.

Home Screen Menu Composition

6. Select Wired LAN.6.

7. Select Enable/disable Wired LAN.7.
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8. Select Enable.8.

9. Press the HOME button.9.

The network connection setup is now complete.

Once connection is complete,  appears on the screen.

If performing setup with software, return to the software and proceed with the installation.

Windows

Click  (or  ) on the  taskbar at the bottom of the screen, follow the
on-screen instructions to proceed with setup.
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macOS

Click  on the  Dock at the bottom of the screen, and follow the on-
screen instructions to proceed with setup.
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USB Connection

Connect the printer to a computer using a USB cable.

What Is USB Cable?

In USB connection, the printer is connected one-on-one to the computer.

If your computer is connected to LAN, you can use the printer with other devices by enabling the sharing
setting on your computer.

Note
• You can connect the printer to a computer via USB even when the printer is already connected to

another one via wired LAN.
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Default Network Settings

LAN Connection Defaults

Item Default

Enable/Disable LAN Wired LAN enabled

Network name (SSID) BJNPSETUP

Wi-Fi security Disable

IP address (IPv4) DHCP

IP address (IPv6) Auto setup

Set printer name *1 XXXXXXXXXXXX

Enable/disable IPv6 Enable

Enable/disable WSD Disable

Timeout settings 15 minutes

Enable/disable Bonjour Enable

Service name Canon XX-NNNN *2

LPR protocol settings Enable

Wi-Fi DRX settings Enable

Wired LAN DRX settings Enable

("XX" represents alphanumeric characters.)

*1 Default value depends on printer. To check value, use operation panel.

LAN settings

*2 NNNN means your printer model name.

Wireless Direct Defaults

Item Default

Network name (SSID) DIRECT-abXX-YY-NNNN *1

Password ZZZZZZZZZZ *2

Wi-Fi security WPA2-PSK (AES)

Connection request confirmation Displayed
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*1 "ab" is specified at random and "XX" represents last two digits of printer's wireless MAC address. "YY"
is alphanumeric, and "NNNN" means your printer model.

*2 The password is specified automatically when the printer is turned on for the first time.
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Another Printer Found with Same Name

When the printer is found during setup, other printers with the same name may appear on the results
screen.

Select a printer with checking the printer settings against those on detection result screen.

Check the printer's MAC address or serial to select the correct printer from the results.

Note
• Serial number may not appear on result screen.

Check the printer's MAC address and the serial number by one of the following methods.

• Display on the touch screen.•

◦ MAC address◦

LAN settings

◦ Serial number◦

 (Information) >  System information.

• Print the network settings.•

Printing Network Settings

324



Printing Network Settings

Use the operation panel to print the printer's current network settings.

Items to Prepare

At least 10 sheets of unused A4 size plain paper

Important
• The network settings printout contains important information about your network. Handle it with care.

1. Load paper.1.

Loading Sheets in the Printer

2. Select  (Setup) icon on HOME screen.2.

3. Select Printer settings.3.

4. Select LAN settings.4.

5. Select Print details.5.

6. Select Yes on displayed screen.6.

7. Select ON or OFF on displayed screen.7.

The printer starts printing network settings information.

The printed network settings information is as follows: (Some setting values are not displayed depending on
the printer settings.)

Item Num-
ber

Item Description Setting

1 Product Information Product information –

1-1 Product Name Product name XXXXXXXX

1-2 ROM Version ROM version XXXXXXXX

1-3 Serial Number Serial number XXXXXXXX

2 Network Diagnostics Network diagnostics –

2-1 Diagnostic Result Diagnostic result XXXXXXXX

2-2 Result Codes Result codes XXXXXXXX

2-3 Result Code Details Result code details http://canon.com/ijnwt
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3 Wireless LAN Wireless LAN Enable/Disable

3-2 Infrastructure Infrastructure Enable/Disable

3-2-1 Signal Strength Signal strength 0 to 100 [%]

3-2-2 Link Quality Link quality 0 to 100 [%]

3-2-3 Frequency Frequency XX (GHz)

3-2-4 MAC Address MAC address XX:XX:XX:XX:XX:XX

3-2-5 Connection Connection status Active/Inactive

3-2-6 SSID SSID Wireless LAN network name (SSID)

3-2-7 Channel Channel XXX (1 to 13)

3-2-8 Encryption Encryption method None/WEP/TKIP/AES

3-2-9 WEP Key Length WEP key length (bits) Inactive/128/64

3-2-10 Authentication Authentication method None/auto/open/shared/WPA-PSK/WPA2-PSK

3-2-11 TCP/IPv4 TCP/IPv4 Enable/Disable

3-2-12 IP Address IP address XXX.XXX.XXX.XXX

3-2-13 Subnet Mask Subnet mask XXX.XXX.XXX.XXX

3-2-14 Default Gateway Default gateway XXX.XXX.XXX.XXX

3-2-15 TCP/IPv6 TCP/IPv6 Enable/Disable

3-2-16 Link Local Address Link local address XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

3-2-17 Link Local Prefix
Length

Link local prefix length XXX

3-2-18 Stateless Address1 Stateless address 1 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

3-2-19 Stateless Prefix
Length1

Stateless prefix length
1

XXX

3-2-20 Stateless Address2 Stateless address 2 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

3-2-21 Stateless Prefix
Length2

Stateless prefix length
2

XXX

3-2-22 Stateless Address3 Stateless address 3 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

326



3-2-23 Stateless Prefix
Length3

Stateless prefix length
3

XXX

3-2-24 Stateless Address4 Stateless address 4 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

3-2-25 Stateless Prefix
Length4

Stateless prefix length
4

XXX

3-2-26 Default Gateway1 Default gateway 1 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

3-2-27 Default Gateway2 Default gateway 2 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

3-2-28 Default Gateway3 Default gateway 3 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

3-2-29 Default Gateway4 Default gateway 4 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

3-2-33 IPsec IPsec setting Active/Inactive

3-2-34 Security Protocol Security method ESP/ESP & AH/AH/Blank (Not selected)

3-2-35 Wireless LAN DRX Discontinuous recep-
tion (wireless LAN)

Enable/Disable

3-3 Wireless Direct Operation mode for
Wireless Direct

Enable/Disable

3-3-1 MAC Address MAC address XX:XX:XX:XX:XX:XX

3-3-2 Connection Connection status Active/Inactive

3-3-3 SSID SSID Wireless Direct network name (SSID)

3-3-4 Password Password Wireless Direct password

3-3-5 Channel Channel 3

3-3-6 Encryption Encryption method AES

3-3-7 Authentication Authentication method WPA2-PSK

3-3-8 TCP/IPv4 TCP/IPv4 Enable/Disable

3-3-9 IP Address IP address XXX.XXX.XXX.XXX

3-3-10 Subnet Mask Subnet mask XXX.XXX.XXX.XXX

3-3-11 Default Gateway Default gateway XXX.XXX.XXX.XXX

3-3-12 TCP/IPv6 TCP/IPv6 Enable/Disable
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3-3-13 Link Local Address Link local address XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

3-3-14 Link Local Prefix
Length

Link local prefix length XXX

3-3-15 IPsec IPsec setting Active/Inactive

3-3-16 Security Protocol Security method ESP/ESP & AH/AH/Blank (Not selected)

3-3-17 Wireless LAN DRX Discontinuous recep-
tion (wireless direct)

Enable/Disable

4 Wired LAN Wired LAN Enable/Disable

4-1 MAC Address MAC address XX:XX:XX:XX:XX:XX

4-2 Connection Wired LAN status Active/Inactive

4-3 TCP/IPv4 TCP/IPv4 Enable/Disable

4-4 IP Address IP address XXX.XXX.XXX.XXX

4-5 Subnet Mask Subnet mask XXX.XXX.XXX.XXX

4-6 Default Gateway Default gateway XXX.XXX.XXX.XXX

4-7 TCP/IPv6 TCP/IPv6 Enable/Disable

4-8 Link Local Address Link local address XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

4-9 Link Local Prefix
Length

Link local prefix length XXX

4-10 Stateless Address1 Stateless address 1 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

4-11 Stateless Prefix
Length1

Stateless prefix length
1

XXX

4-12 Stateless Address2 Stateless address 2 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

4-13 Stateless Prefix
Length2

Stateless prefix length
2

XXX

4-14 Stateless Address3 Stateless address 3 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

4-15 Stateless Prefix
Length3

Stateless prefix length
3

XXX

4-16 Stateless Address4 Stateless address 4 XXXX:XXXX:XXXX:XXXX
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XXXX:XXXX:XXXX:XXXX

4-17 Stateless Prefix
Length4

Stateless prefix length
4

XXX

4-18 Default Gateway1 Default gateway 1 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

4-19 Default Gateway2 Default gateway 2 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

4-20 Default Gateway3 Default gateway 3 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

4-21 Default Gateway4 Default gateway 4 XXXX:XXXX:XXXX:XXXX

XXXX:XXXX:XXXX:XXXX

4-25 IPsec IPsec setting Active/Inactive

4-26 Security Protocol Security method ESP/ESP & AH/AH/Blank (Not selected)

4-27 Wired LAN DRX Discontinuous recep-
tion (wired LAN)

Enable/Disable

5 Other Settings Other settings –

5-1 Printer Name Printer name Printer name (Up to 15 alphanumeric characters)

5-2 Wireless Direct Dev-
Name

Device name for wire-
less direct

Device name for wireless direct (Up to 32 alphanumeric
characters)

5-4 WSD Printing WSD printing setting Enable/Disable

5-5 WSD Timeout Timeout 1/5/10/15/20 [min]

5-6 LPD Printing LPD printing setting Enable/Disable

5-7 RAW Printing RAW printing setting Enable/Disable

5-9 Bonjour Bonjour setting Enable/Disable

5-10 Bonjour Service Name Bonjour service name Bonjour service name (Up to 52 alphanumeric characters)

5-11 LLMNR LLMNR setting Enable/Disable

5-12 SNMP SNMP setting Enable/Disable

5-14 DNS Server Obtain DNS server ad-
dress automatically

Auto/Manual

5-15 Primary Server Primary server address XXX.XXX.XXX.XXX

5-16 Secondary Server Secondary server ad-
dress

XXX.XXX.XXX.XXX
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5-17 Proxy Server Proxy server setting Enable/Disable

5-18 Proxy Address Proxy address XXXXXXXXXXXXXXXXXXXX

5-19 Proxy Port Proxy port specification 1 to 65535

5-20 Cert. Fingerprt(SHA-1) Certificate finger-
print(SHA-1)

xxxxxxxx xxxxxxxx xxxxxxxx

xxxxxxxx xxxxxxxx

5-21 Cert. Fin-
gerprt(SHA-256)

Certificate finger-
print(SHA-256)

xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx

xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx

("XX" represents alphanumeric characters.)
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Network Status and Troubleshooting

Check the network status referring to LAN setting information on the touch screen.

Printing Network Settings

Network Status What to Do

Connected normally.

If you are unable to
print, see 1 on What
to Do.

1. If you are unable to print, check the items below:1.

• whether the computer is connected to Wi-Fi
• whether the firewall of your security software is enabled
• whether a privacy separator, SSID separator, or Network separation function is ena-•

bled on your wireless router

If one of the above is enabled, disable it before setup.

• whether the network name (SSID) of the printer matches that of the router to connect

2. To change the network connection method (wired/wireless), change it on the printer's
network setting screen.

Wi-Fi is disabled on
the printer.

Perform printer setup following the instructions of the manual.

Wired LAN connec-
tion is disabled.

• Make sure the printer is connected to the router with the LAN cable.•

If the LAN cable is loose, connect the cable properly.

If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN
side of the router.

• Make sure the network devices (e.g. hub or router) are turned on.•

IP address is not as-
signed.

• If you specify the printer's IP address automatically, enable DHCP on the router.•

• If you specify the printer's IP address manually, the address is disabled because it is out of•
the valid range. You specified (0.0.0.0) as the IP address, for example.

Specify the valid IP address.

The default gateway
is not specified.

Check the items below to communicate by hopping routers (e.g. using a cloud application).

• Make sure the device specified as the default gateway is turned on.•

• Specify the default gateway address correctly.•

To check the default gateway, print out the network settings information.

Note
• For some printers, you can check the default gateway on the operation panel.

Cannot connect to
the specified network.

Check the status of the printer, network devices (e.g. wireless router), or smartphone/tablet.

• If they are turned off, turn them on.
• Make sure wireless signal is strong.•

Monitor signal status and move the printer and wireless router as necessary.

• The security key specified for the wireless router may not match that you entered.•

The security key is case-sensitive.

Enter the correct security key.
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Make sure wireless
signal is strong.

• Make sure the printer is not placed too far away from the wireless router.•

• Monitor signal status and move the printer and wireless router as necessary.•

The number of con-
nected clients rea-
ches the upper limit.

• Wireless Direct does not allow more than 5 devices to be connected.•

If you add a device to connect, disconnect a device you do not use before adding the
device.

The signal to noise
ratio (S/N ratio) is
low.

• There is a lot of noise from other devices.•

Move the printer apart from other devices.

A link local address is
assigned.

• Perform printer setup again.
• The security key specified for the wireless router may not match that you entered.•

The security key is case-sensitive.

Enter the correct security key.

The specified net-
work name (SSID) is
left default value.

The network name (SSID) is not specified.

Enter the network name (SSID) specified for the destination.
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Sharing the Printer on a Network (Windows)

When computers are used in a network environment, documents can be printed from multiple computers
that share a single printer.

• Setting Up a Shared Printer•

This section describes how to set up the print server and the client.

Note
• The Windows versions of the computers connected to the network do not necessarily have to be the

same.

Related Topic
Restrictions on Printer Sharing
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Setting Up a Shared Printer

On the print server, set up sharing of the printer driver. Then from the client, set up the connection to the
print server.

1. Install the printer driver on the print server system1.

2. Display the Devices and Printers window2.

Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

3. Click the icon for the model name of printer to be shared3.

Press the Alt key, and from the displayed File menu, select Printer properties -> Sharing tab.

Important
• When starting up the software and performing install or uninstall, a confirmation or warning dialog

box may appear.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

4. Set sharing4.

On the Sharing tab, check (or select) Share this printer, set the shared name as necessary, and then
click OK.

5. If the print server and the client have different architectures (32 bit or 64 bit), install an5.
additional driver

1. Display the Devices and Printers, Printers, or Printers and Faxes window.1.

2. Select the printer icon, click Print server properties, and select the Drivers tab.2.

3. Click Add....3.

4. When the Add Printer Driver Wizard window is displayed, click Next.4.

5. If the print server has a 32-bit architecture, select x64. If the print server has a 64-bit5.
architecture, select x86. Then click Next.

6. Click Have Disk....6.

7. In the Install From Disk window, open the "Driver" folder of the downloaded printer driver,7.
specify the "inf" file, and click OK.
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Note
• If the printer server is 32-bit, specify it as "xxxxxxx3.INF". If it is 64-bit, specify it as "xxxxxxx6.INF".

8. Select the printer to be used, and click Next.8.

Note
• If an error message is displayed, select the other printer.

9. Click Finish9.

The setup on the print server system is complete. Next, set up the client systems.

6. On the client, open Explorer, and double-click the icon of the printer to be shared6.

7. Follow the window instructions, and install the printer driver7.

The setup on the client system is complete.
Even when you perform the setup on a different client, follow the same steps 6 and 7.
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Restrictions on Printer Sharing

These are restrictions that apply when you are using a printer in a network environment. Check the
restrictions for the environment you are using.

Restriction on setting up printer sharing
• If "ntprint.inf" is requested when you install the driver from Add Printer, specify the file as follows:

1. Start Explorer on the print server and on the client with the different architecture, paste the
following path in the address bar, and press Enter on the keyboard:
%windir%\system32\driverstore\

2. Right-click the FileRepository folder, and click Properties.
3. On the Sharing tab, click Share.
4. In the message window displayed on the print server, specify "ntprint.inf_xxxxxxxx" in the folder

that was shared in step 3, and click OK.
If there are multiples copies, select the file with the latest update date and time.

Restrictions on sharing and using a printer
• A print completion message may be displayed. To disable the message display, follow the procedure

below.
1. In the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers window of

the client system, select the printer, and click Print server properties on the command bar.
2. Uncheck Show informational notifications for network printers on the Advanced tab, and

then restart the computer.

• The bi-directional communication function is disabled and the correct printer status may not be
recognized.
If a client user opens the printer driver properties and then clicks OK with the Enable bidirectional
support check box cleared on the Ports tab, the bidirectional communication function of the print
server may also be disabled.
In this case, check Enable bidirectional support check box on both the print server system and the
client system.

• When you print from a client system, the following functions cannot be used.
◦ The Edit Using PosterArtist feature of Page Layout in the Layout tab

• When the functions on the Device Settings tab cannot be set properly from a client system, they may
be grayed out. In this case, change the settings from the print server.
When you change the settings of the print server, you should delete the icon of the shared printer
from the client system, and then specify the shared settings again in the client system.

• If the same driver installed on the print server is also installed on the client, the network printer icon
may be created automatically.

• If an error occurs when you print a document on a shared printer from a client, the error message
of the Canon IJ status monitor is displayed on both the client and the print server. If a document is
printed out normally, the Canon IJ status monitor is displayed only on the client.
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Adjustments for Better Print Quality

Checking for Nozzle Clogging

Cleaning the Print Head

Deep Print Head Cleaning

Automatic Adjustment to Straighten Lines and Colors

Manual Adjustment to Straighten Lines and Colors

Automatically Adjusting Different Colored Horizontal Streaks

Manually Adjusting Different Colored Horizontal Streaks

Adjusting Line Length
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Checking for Nozzle Clogging

If the print is blurred or has different color threading, print a nozzle check pattern to see if each nozzle of the
print head is not clogged.

Note
• If the remaining ink level is low, the nozzle check pattern will not be printed correctly. Refill the ink tanks•

whose ink is low.

Refilling Ink Tanks

Items to Prepare

When Using Rolls
Roll at least 11.69 in. (297.0 mm) wide

When Using Sheets
One unused sheet of A4 or larger size paper

1. Load paper.1.

Loading Rolls in the Printer
Loading Sheets in the Printer

2. Select  (Setup) on the HOME screen.2.

Home Screen Menu Composition

3. Select  Maintenance.3.

4. Select Nozzle Check.4.

5. Check message and select Yes.5.

6. Select Roll paper or Top feed6.

The nozzle check pattern will be printed and two pattern confirmation screens will appear on the touch
screen.

7. Check the print result.7.

Check if there are missing lines in the pattern C or horizontal streaks in the pattern D.
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A: No missing lines/No horizontal streaks
B: Lines are missing/Horizontal streaks are present

8. Select the pattern that is closer to the printed nozzle check pattern on the confirmation8.
screen.

 

For A (no missing lines or no horizontal streaks) in both the pattern C and pattern D:

The cleaning is not required. Select All A, confirm the message, then select OK.

The screen will return to the Maintenance screen.

For B (lines are missing or horizontal streaks are present) in the pattern C or pattern D, or in both
patterns:

The cleaning is required. Select Also B, then go to next step.

339



If the pattern D or any color in the pattern C is not printed:

 (Example: Magenta pattern is not printed)

The cleaning is required. Select Also B, then go to next step.

9. Select Yes on the cleaning confirmation screen.9.

The printer starts cleaning the print head. This takes about 2 minutes.

Important
• Do not perform any other operations until the printer completes the cleaning of the print head.•

10. Check message and select Yes.10.

11. Select Roll paper or Top feed.11.

A nozzle check pattern is printed and two pattern confirmation screens appear on the touch screen.

12. Repeat steps 7 through 11.12.

Important
• If there is no improvement after repeating the cleaning process twice, perform Deep Cleaning.•

Deep Print Head Cleaning
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Cleaning the Print Head

Clean the print head if lines are missing or if horizontal streaks are present in the printed nozzle check
pattern. Cleaning unclogs the nozzles and restores the print head condition. Cleaning the print head
consumes ink, so clean the print head only when necessary.

Important
• When performing the print head cleaning, check the free space in the maintenance cartridge. If there•

is not enough free space, replace with the new maintenance cartridge. In the case of shortage of free
space in the maintenance cartridge, a message is displayed and the cleaning cannot be performed.

Replacing the Maintenance Cartridge

Items to Prepare

When Using Rolls
Roll at least 11.69 in. (297.0 mm) wide

When Using Sheets
One unused sheet of A4 or larger size paper

1. Load paper.1.

Loading Rolls in the Printer
Loading Sheets in the Printer

2. Select  (Setup) on the HOME screen.2.

Home Screen Menu Composition

3. Select  Maintenance.3.

4. Select Cleaning.4.

5. Check message and select Yes.5.

6. Select All colors, Color or BK.6.

The printer starts cleaning the print head.

Do not perform any other operations until the printer completes the cleaning of the print head. This takes
about 2 minutes.

7. Check message and select Yes.7.

8. Select Roll paper or Top feed.8.

The nozzle check pattern will be printed.
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9. Check the print result.9.

Check if there are missing lines in the pattern C or horizontal streaks in the pattern D.

A: No missing lines/No horizontal streaks
B: Lines are missing/Horizontal streaks are present

10. Select the pattern that is closer to the printed nozzle check pattern on the confirmation10.
screen.

 

For A (no missing lines or no horizontal streaks) in both the pattern C and pattern D:

The cleaning is not required. Select All A, confirm the message, then select OK.

The screen will return to the Maintenance screen.

For B (lines are missing or horizontal streaks are present) in the pattern C or pattern D, or in both
patterns:

The cleaning is required. Select Also B, then go to next step.
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If the pattern D or any color in the pattern C is not printed:

 (Example: Magenta pattern is not printed)

The cleaning is required. Select Also B, then go to next step.

11. Select Yes on the cleaning confirmation screen.11.

The printer starts cleaning the print head.This takes about 2 minutes.

Important
• Do not perform any other operations until the printer completes the cleaning of the print head.•

12. Check message and select Yes.12.

13. Select Roll paper or Top feed.13.

A nozzle check pattern is printed and two pattern confirmation screens appear on the touch screen.

14. Repeat steps 9 through 13.14.

Important
• If there is no improvement after repeating the cleaning process twice, perform Deep Cleaning.•

Deep Print Head Cleaning
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Deep Print Head Cleaning

If print quality does not improve by the standard cleaning of the print head, clean the print head deeply.
Cleaning the print head deeply consumes more ink than the standard cleaning of the print head, so clean
the print head deeply only when necessary.

Important
• When performing the print head deep cleaning, check the free space in the maintenance cartridge. If•

there is not enough free space, replace with the new maintenance cartridge. In the case of shortage of
free space in the maintenance cartridge, a message is displayed and the cleaning cannot be performed.

Replacing the Maintenance Cartridge

Items to Prepare

When Using Rolls
Unused roll at least 11.69 in. (297.0 mm) wide

When Using Sheets
One unused sheet of A4 or larger size paper

1. Load paper.1.

Loading Rolls in the Printer
Loading Sheets in the Printer

2. Select  (Setup) on the HOME screen.2.

Home Screen Menu Composition

3. Select  Maintenance.3.

4. Select Deep Cleaning.4.

5. Check message and select Yes.5.

6. Select All colors, Color or BK.6.

The printer starts cleaning the print head deeply. This takes about 2 to 3 minutes.

Important
• Do not perform any other operations until the printer completes the deep cleaning of the print•

head.

7. Check message and select Yes.7.

8. Select Roll paper or Top feed.8.
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The nozzle check pattern will be printed.

9. When the completion message appears, select OK.9.

10. Check the print result.10.

Check if there are missing lines in the pattern C or horizontal streaks in the pattern D.

A: No missing lines/No horizontal streaks
B: Lines are missing/Horizontal streaks are present

Important
• If the problem is not resolved, turn off the power and clean the print head deeply again after 24 hours.•

Do not unplug the power cord when turning off the power.

• If there is no improvement after repeating Deep Cleaning twice, perform Replace Ink in Print Head.•

Replacing the Ink in the Print Head
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Automatic Adjustment to Straighten Lines and Colors

If vertical lines on the printed document are misaligned or a color shift occurs, adjust the print head position.

When Print Head Alignment - Auto is performed, the adjustment pattern will be printed and the print head
position is automatically adjusted based on the print result.

Important
• Since the adjustment result depends on the type of paper, adjust with the paper used for printing.•

• Paper with high transparency, and photo paper with a glossy finish cannot be used.•

Note
• If the remaining ink level is low, the print head alignment sheet will not be printed correctly. Refill the ink•

tanks whose ink is low.

Refilling Ink Tanks

Items to Prepare

When Using Rolls
Roll at least 11.69 in. (297.0 mm) wide

1. Load paper.1.

Loading Rolls in the Printer

Important
• Make sure to match the paper loaded in the printer with the paper type setting in the printer. If the•

loaded paper is different from the paper type setting in the printer is different, the print head will
not be adjusted correctly.

2. Select  (Setup) on the HOME screen.2.

Home Screen Menu Composition

3. Select  Maintenance.3.

4. Select Print Head Alignment - Auto.4.

5. Check message and select Yes.5.
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An adjustment pattern is printed and the print head position is automatically adjusted.

6. When the completion message appears, select OK.6.

Note
• If the print results are still not satisfactory after adjusting the print head position as described above,•

adjust the print head position manually.

Manual Adjustment to Straighten Lines and Colors

• If adjusting the print head with special paper does not produce the expected results, try again with•
different paper, or manually adjust the print head.

Manual Adjustment to Straighten Lines and Colors

• To print and check the current head position adjustment values, select Print the Head Alignment•
Value on the Maintenance screen.
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Manual Adjustment to Straighten Lines and Colors

If vertical lines on the printed document are misaligned or a color shift occurs, adjust the print head position.
When Print Head Alignment - Manual is performed, the adjustment pattern will be printed. Check the print
result and enter the setting value.

Important
• Since the adjustment result depends on the type of paper, adjust with the paper used for printing.•

Note
• Using automatic print head adjustment is recommended.•

Automatic Adjustment to Straighten Lines and Colors

Items to Prepare

When Using Rolls
Roll at least 11.69 in. (297.0 mm) wide

When Using Sheets
Two sheets of A4 / Letter / A3 size paper

1. Load paper.1.

Loading Rolls in the Printer
Loading Sheets in the Printer

2. Select  (Setup) on the HOME screen.2.

Home Screen Menu Composition

3. Select  Maintenance.3.

4. Select Print Head Alignment - Manual.4.

5. Check message and select Yes.5.

6. Select Roll paper or Top feed.6.

The print head alignment pattern will be printed.

348



7. When Did the patterns print correctly? appears, make sure pattern was printed correctly,7.
and if so, select Yes.

8. Check message and select Next.8.

9. Examine first patterns and select A. In column A, find pattern in which stripes are least9.
noticeable, and then select the number of that pattern.

Note
• If all patterns look different, choose the pattern in which vertical stripes are least noticeable.•

Subtle vertical stripes

Noticeable vertical stripes
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• If all patterns look different, choose the pattern in which horizontal stripes are least noticeable.•

Subtle horizontal stripes

Noticeable horizontal stripes

10. Repeat these steps until you have finished entering pattern numbers for columns B to L,10.
and then select OK.

11. Check message and select OK.11.

The second set of patterns is printed.

12. Examine second patterns and select M. In column M, find pattern in which stripes are least12.
noticeable, and then select the number of that pattern.

13. Repeat these steps until you have finished entering pattern numbers for columns N to S,13.
and then select OK.
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14. When confirmation message appears, select OK.14.
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Automatically Adjusting Different Colored Horizontal Streaks

If printed images are affected by banding in different colors across the sheet, execute Adjust print quality
for automatic adjustment of the paper feed amount.

The printer prints and reads a test pattern for automatic adjustment of the feed amount.

Important
• When using highly transparent media, use manual adjustment.•

Manually Adjusting Different Colored Horizontal Streaks

Note
• We recommend executing the adjustment if you have changed the paper type or paper size.
• Always check the Set priority values.•

Paper feed adjustment

• Use Adjust feed length to ensure that lines in CAD drawings are printed at exactly the right length.•

Adjusting Line Length

• This may take some time, depending on the type of paper.

Items to Prepare

When Using Rolls
Roll at least 11.69 in. (297.0 mm) wide

Follow the procedure below to adjust.

1. Load paper.1.

Loading Rolls in the Printer

2. Select  (Setup) on the HOME screen.2.

Home Screen Menu Composition

3. Select  Maintenance.3.

4. Select Paper feed adjustment.4.

5. Select Adjust print quality.5.

6. Check message and select OK.6.

7. Select Auto.7.

8. Select Roll paper to adjust.8.
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A test pattern is printed for adjustment and adjustment is finished.

Note
• Depending on the type of paper, horizontal streaks may not improve. If the horizontal streaks are not•

improved, adjust it manually.

Manually Adjusting Different Colored Horizontal Streaks
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Manually Adjusting Different Colored Horizontal Streaks

If printed images are affected by banding in different colors, execute Adjust print quality for adjustment of
the paper feed amount.

Use manual adjustment with highly transparent media.

Manual adjustment requires you to enter an adjustment value after a test pattern is printed.

Note
• We recommend executing the adjustment if you have changed the paper type or paper size.
• Always check the Set priority values.•

• Use Adjust feed length to ensure that lines in CAD drawings are printed at exactly the right length.•

Adjusting Line Length

Items to Prepare

When Using Rolls
Roll at least 11.69 in. (297.0 mm) wide

Follow the procedure below to adjust.

1. Load paper.1.

Loading Rolls in the Printer

Important
• Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be

completed correctly unless the loaded paper matches the settings.

2. Select  (Setup) on the HOME screen.2.

Home Screen Menu Composition

3. Select  Maintenance.3.

4. Select Paper feed adjustment.4.

5. Select Adjust print quality.5.

6. Check message and select OK.6.

7. Select Manual.7.

8. Select Roll paper to adjust.8.

Test pattern A is printed for manual adjustment.
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9. Examine test pattern A for adjustment. Determine pattern in which banding is least9.
noticeable.

Note
• If banding seems least noticeable in two patterns but you cannot decide which one is better,

choose an intermediate value. For example, choose 11 if you cannot decide whether pattern 10 or
12 is better.

10. Select number you decided.10.

Test pattern B is printed for manual adjustment.

11. Examine test pattern B for adjustment. Determine pattern in which banding is least11.
noticeable.

12. Select number you decided.12.

The adjustment value is now registered, and adjustment is complete.

355



Adjusting Line Length

To ensure that lines in CAD drawings are printed at exactly the right length, use Adjust feed length to
adjust the amount that paper is advanced.

There are two options in Adjust feed length : Print alignment pattern and Change adjustment values.

Note
• We recommend executing the adjustment if you have changed the paper type or paper size.
• Always check the Set priority values before adjustment.•

Items to Prepare

When Using Rolls
• Rroll at least 11.69 in. (297.0 mm) wide
• High-precision ruler

Follow the procedure below to adjust.

1. Load paper.1.

Loading Rolls in the Printer

Important
• Always make sure the loaded paper matches the type of paper specified.•

Adjustment cannot be completed correctly unless the loaded paper matches the settings.

2. Select  (Setup) on the HOME screen.2.

Home Screen Menu Composition

3. Select  Maintenance.3.

4. Select Paper feed adjustment.4.

5. Select Adjust feed length.5.

6. Select Print alignment pattern or Change adjustment values.6.

• If you select Print alignment pattern:•

The test pattern is printed for you to measure the scale and calculate the discrepancy.

The scale bar prints "Millimeter" in 50 mm increments and "Inch" in 1-inch increments.
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• If you select Change adjustment values:•

No test pattern is printed.

Instead, you will measure a document already printed to determine the discrepancy.

7. Select amount of discrepancy.7.

If the scale is shorter than the actual size, use a positive setting value. If it is longer, use a negative
value. The feed amount can be adjusted in 0.02% increments.
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Maintenance and Consumables

Replacing Consumables

Refilling Ink Tanks

Checking Ink Level

Replacing the Print Head

Checking the Remaining Maintenance Cartridge Capacity

Replacing the Maintenance Cartridge

Cleaning the Printer

Cleaning the Printer Exterior

Cleaning Inside the Printer

Cleaning Paper Feed Rollers

Performing Bottom Plate Cleaning

Performing Maintenance Functions from Your Computer (Windows)

Cleaning the Print Heads

Printing a Nozzle Check Pattern

Performing Maintenance Functions from Your Computer (macOS)

Opening Remote UI for Maintenance

Cleaning the Print Heads

Printing a Nozzle Check Pattern

Other Maintenance

Preparing to Transfer the Printer

Reinstalling the Printer

Firmware update
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Replacing Consumables

Refilling Ink Tanks

Checking Ink Level

Replacing the Print Head

Checking the Remaining Maintenance Cartridge Capacity

Replacing the Maintenance Cartridge
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Refilling Ink Tanks

When remaining ink cautions or errors occur, the message will appear on the touch screen to inform you
of the error. In this state, the printer cannot print. Check the remaining amount of ink and refill the ink if
necessary.

Note
• For information on how to check the remaining ink level, see "Checking Ink Level".•

Checking Ink Level

• For precautionary notes on handling ink bottles, see "Notes on ink bottles".•

Notes on ink bottles

Refilling Procedure
When you refill ink tanks, follow the steps below.

Important
• Please ensure the printer remains flat after initial setup and is NOT turned upside down or on its side,

as ink in the printer may leak.

1. Check that printer is turned on.1.

Checking that Power Is On

2. Open the ink tank cover (A).2.

3. Open the ink tank inner cover (B) of the ink tank to be refilled.3.
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4. Open the tank cap (C).4.

Important
• Carefully open the tank cap of the ink tank. Ink on the inside of the tank cap may spatter when

opening it.

5. Hold the ink bottle upright and gently twist the bottle cap (D) to remove.5.

Important
• Do not shake the ink bottle. Ink may spatter when opening the cap.

6. Refill the ink tank.6.

Aligning the ink bottle's tip with the ink tank's inlet (E), slowly stand the bottle upside down, and push
the bottle into the inlet.
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The ink tank is refilled. Support the bottle with your hand so that it does not fall.

Important
• Make sure that each color of ink tanks is filled with corresponding color of ink bottles.
• If ink does not pour into the ink tank, slowly remove and insert the ink bottle.
• Pouring stops automatically when the ink tank is full.

Note
• You can check the ink status from the touch screen.•

7. When ink refilling is complete,remove the ink bottle from the inlet.7.

Hold up the ink bottle slightly and remove the bottle from the inlet while slowly tilting it.

Important
• Do not leave ink bottles in ink tanks.
• Close the bottle cap of the ink bottle completely and store the ink bottle upright.
• Discard empty ink bottles in compliance with local laws and regulations regarding disposal of

consumables.

8. Close the tank cap of the ink tank.8.

Make sure the tank cap is completely inserted.
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9. Close the ink tank inner cover completely.9.

10. Close the ink tank cover.10.

Note
• If the error message appears on the touch screen after the ink tank cover is closed, take appropriate•

action.

363



Notes on ink bottles

Important
• Keep out of reach of children.
• Do not drink ink.
• If ink is accidentally licked or swallowed, rinse out your mouth or drink one or two glasses of water

and obtain medical advice immediately. If ink gets into your eyes, flush them with water right away,
and obtain medical advice immediately.

• If ink gets on your skin, wash the area with soap and water immediately. If irritation to your skin
persists, obtain medical advice immediately.

• When you store ink bottles, close bottle caps completely and place bottles in standing position. If the
ink bottles are laid down, ink may leak.

• When refilling ink tanks, take sufficient care to prevent ink from spattering onto surroundings.
• Ink may stain clothes or other belongings permanently. Washing may not remove ink stains.
• Do not use ink bottles and ink contained therein except to refill tanks of printers specified by Canon.
• Do not leave ink bottles in areas exposed to high temperature, such as near fire or a heater or in a

car. Bottles may warp and cause ink leakage or ink may become poor quality.
• Do not subject ink bottles to impacts. Ink bottles may be damaged or bottle caps may come off by

such impact, and ink may leak.
• Do not transfer ink to other containers. This may result in accidental ingestion, inappropriate use, or

poor ink quality.
• Do not mix ink with water or other ink. This may damage the printer.
• Once an ink bottle has been opened, do not leave it with bottle cap off. Ink will dry out, possibly

preventing proper operation of the printer when an ink tank is refilled using this bottle.
• To obtain the optimum print quality, it is recommended to refill the ink about once a year until the ink•

level display on the operation panel shows that the ink level is full.

Note
• Color ink may be consumed even when printing a black-and-white document or when black-and-•

white printing is specified. Every ink is also consumed in the standard cleaning and deep cleaning of
the print head, which may be necessary to maintain the performance of the printer.

When ink runs low, promptly refill it.

Ink Tips
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Checking Ink Level

You can check the remaining amount of ink on the touch screen.

1. Select  (Information) on the HOME screen.1.

Home Screen Menu Composition

2. Select  Estimated ink levels.2.

The Current estimated ink levels screen is displayed.

When the ink level is low,  is displayed above the ink level on the touch screen, and  is displayed
when ink runs out.

Note
• When a message appears instructing you to check the remaining ink level, or when performing•

banner printing or head cleaning that consumes a large amount of ink, check the remaining ink
level and refill ink as necessary.

Refilling Ink Tanks

• To ensure you receive premium print quality and to help protect your print head, a certain amount•
of ink remains in the ink tank when the printer indicates to refill the ink tank. The estimated page
yields of the ink bottle do not include this amount.

• Ink flows from the ink tanks to the inside of the printer. Ink may seem to run out fast due to this•
procedure when you start using the printer or after transporting it.
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• Select Ink model no. > Order ink now for information on where to purchase ink.•
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Replacing the Print Head

If the touch screen indicates to replace the print head or if instructed to do so by your Canon dealer, replace
the print head.

Compatible Print Head
For details on compatible print head, see Print Head.

Precautions When Handling Print Head
Take the following precautions when handling the print head.

Caution
• For safety, keep print head out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.
• Do not touch the print head immediately after printing. The print head becomes extremely hot, and

there is a risk of burns.

Important
• There may be ink around the nozzles of the print head you remove. Handle the print head carefully

during replacement. The ink may stain clothing.
• Do not open the print head pouch until immediately before installation. After removing the print head

from the pouch, install it right away. If the print head is left as is after the pouch is opened, the
nozzles may dry out, which may affect printing quality.

How to Replace Print Head

Caution
• When replacing the print head immediately after printing, wait a few minutes before replacing it. The

metal parts of the print head become hot during printing, and there is a risk of burns from touching
these parts.

Important
• Your hands may become dirty during print head replacement. Use the gloves provided in the box with

the new print head for replacement.

Note
• Refill the ink tanks when ink levels are low.

Refilling Ink Tanks

• Prepare a new maintenance cartridge when the remaining capacity of the maintenance cartridge is
low.

Replacing the Maintenance Cartridge
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1. Select  (Setup) on the HOME screen.1.

Home Screen Menu Composition

2. Select  Maintenance.2.

3. Select Head Replacement.3.

4. Check message and select Start.4.

Draining ink from the print head starts. Draining ink takes about 3 minutes.

Important
• When the cover is ready to be opened, instructions will be displayed on the touch screen. Do

not open the cover before these instructions are displayed.

5. Open the access cover on the left.5.

6. If the print head locking cover and print head lock lever are dirty, use a damp cloth that6.
you have wrung out completely to wipe them clean.

Important
• Do not touch the linear scale (A) and carriage rail (B). Touching these may cause malfunction.•
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• Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so
as not to scratch the surface.

7. Open print head lock lever firmly toward the front while holding its center (C) with your7.
fingertip.

8. Grab grip (D) and open print head locking cover.8.

369



9. Grab grips (E), remove print head, and then select OK.9.

Important
• Never touch the metal contacts of the carriage. Furthermore, do not allow any dirt or debris to

become adhered to the metal contacts of the carriage. These may damage the printer.

Note
• Dispose of the used print head in accordance with local regulations.

10. Remove print head that was in case from pouch.10.

11. Remove tape used to secure print head.11.
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12. Hold the left and right grips, and remove the print head from the case.12.

Important
• Always carry the print head by holding its right and left grips. Never touch nozzle (F) or metal

contacts (G). This may damage the print head and affect printing quality.
• Never touch the ink holes (H). This may affect printing quality.•

• The print head contains ink to protect the nozzle. If ink accidentally spills, wipe off the ink with a
dry cloth.

• If you need to put a print head somewhere temporarily before installation, do not set it down
with the nozzles and metal contacts facing down. If the nozzles or metal contacts are damaged,
it may affect the printing quality.

13. Turn ink holes (H) toward the front and insert print head into carriage.13.
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Insert the print head all the way into the carriage, while taking care to keep the ink supply unit from
touching the carriage.

When inserting the print head into the carriage, make sure that the print head lock lever is firmly
opened toward the front of the printer.

Important
• Do not force the print head. The carriage may be damaged.

14. Grasp tab (D) of print head locking cover and lower it to front to lock print head.14.

15. While holding center part (C) of print head lock lever, lower it toward back.15.

16. Close the access cover on the left.16.
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Ink now fills the print head. It takes about 7 minutes.

Important
• While ink is being filled, definitely do not remove the maintenance cartridge. Ink may leak out.
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Checking the Remaining Maintenance Cartridge Capacity

1. Select  (Information) on the HOME screen.1.

Home Screen Menu Composition

2. Select  Maintenance cart. info..2.

The Maintenance cartridge usage screen appears.

When  appears on the touch screen, the maintenance cartridge is nearly full. Prepare a new one.

Note
• To replace the maintenance cartridge, select Replace.•

Replacing the Maintenance Cartridge
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Replacing the Maintenance Cartridge

Compatible Maintenance Cartridges
For details on compatible maintenance cartridge, see Maintenance Cartridge.

Precautions When Handling Maintenance Cartridge
Take the following precautions when handling the maintenance cartridge.

Caution
• For safety, keep maintenance cartridge out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.

Important
• If the displayed message indicates that the maintenance cartridge is nearly full, promptly obtain a

new one. If the maintenance cartridge becomes full, an error message is displayed and the printer
stops working until it is replaced with a new one.

• Do not remove the maintenance cartridge except to replace it. Ink may leak out.
• Do not remove a maintenance cartridge during initialization immediately after turning on the printer,•

during print head cleaning, while ink is being drawn out, or during initialization immediately after
replacing the maintenance cartridge.

The maintenance cartridge may become damaged or ink may leak out.

• To prevent ink from leaking from a used maintenance cartridge, avoid dropping the cartridge or
storing it at an angle. Otherwise, ink may leak and cause stains.

• Handle the maintenance cartridge carefully during replacement. The ink may stain clothing.

How to Replace a Maintenance Cartridge
If a message indicates you should replace a maintenance cartridge, check the message details and go to
step 6.

1. Select  (Information) on the HOME screen.1.

Home Screen Menu Composition

2. Select  Maintenance cart. info..2.

3. Select Replace.3.

4. Select Yes.4.

5. Check message and select OK.5.
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Instructions for the maintenance cartridge replacement procedure appear on the touch screen.

6. Open box, and remove plastic bag and maintenance cartridge.6.

Important
• Do not touch the terminal (A) or opening (B) of the maintenance cartridge.•

7. Open the maintenance cover.7.

8. Pull out the maintenance cartridge.8.

Hold the upper portion of the maintenance cartridge with your hands so that its bottom does not touch
the floor or desk.
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Important
• A used maintenance cartridge is heavy. Always grasp the cartridge firmly and keep the

cartridge level during removal. If you drop a used maintenance cartridge or store it at an angle,
ink may leak and cause stains.

9. Put used maintenance cartridge in supplied plastic bag and store on flat surface.9.

Important
• Always put the used maintenance cartridge back in the box and store the box on a flat surface.
• Be careful not to drop or place the removed maintenance cartridge on a desk or something. Dirt•

on the bottom may adhere to it or the ink inside may be scattered.

• Do not turn the removed maintenance cartridge upside down to prevent leakage of ink.•

• Put the used one immediately into the plastic bag attached to the new maintenance cartridge•
and seal the bag by tying the opening tightly to prevent the ink from leaking.
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• Do not put your hands inside the printer, as ink may adhere to your hands.•

6. Wipe away any soiling on the maintenance cover.6.

Important
• When wiping the maintenance cover, support the left side of the cover.•

7. Keeping the new maintenance cartridge level, insert it all the way in.7.

The maintenance cartridge is initialized.
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Important
• Do not remove the maintenance cartridge during initialization immediately after replacing the

maintenance cartridge. The maintenance cartridge may become damaged.

8. Close the maintenance cover.8.
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Cleaning the Printer

Cleaning the Printer Exterior

Cleaning Inside the Printer

Cleaning Paper Feed Rollers

Performing Bottom Plate Cleaning
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Cleaning the Printer Exterior

Clean the printer regularly to maintain better printing quality and help prevent problems.

To ensure a comfortable working environment, clean the printer exterior about once a month.

1. Turn printer off.1.

Turning off the printer

2. Unplug power cord from outlet.2.

Caution
• Always turn off the printer and unplug the power cord before cleaning or maintenance.

Accidentally leaving the printer on poses a risk of injury if you touch moving parts inside the
printer.

3. Wring out soft cloth with water or watered-down neutral detergent, and use it to wipe off dirt.3.

Clean the printer exterior and the power cord plug.

Warning
• Never use flammable solvents such as alcohol, benzine, or thinner. If these substances come into

contact with electrical components inside the printer, there is a risk of fire or electrical shock.

Important
• If the output guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend•

cleaning the output guide even if it does not appear dirty, because it may actually be covered with
paper dust.

Cleaning Inside the Printer

• Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as
not to scratch the surface.

• When neutral detergent is used, be sure to wipe off the detergent with soft cloth with water.

4. After cleaning, dry with a soft dry cloth.4.

5. Plug power cord into outlet.5.
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Cleaning Inside the Printer

Clean inside the printer about once a month to maintain better printing quality and help prevent problems.

Also clean inside the printer in the following situations to ensure optimal operation.

• If the printed surface or the underside of paper is dirty after printing
• When a roll paper runs out
• After printing on small paper
• After printing on paper that generates a lot of cutting debris
• After changing the roll paper
• After printing on paper that generates a lot of paper dust

Important
• If the platen inside the printer becomes dirty, it may soil the underside of paper. We recommend

cleaning the platen after printing on small paper.
• If the output guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend

cleaning the output guide even if it does not appear dirty, because it may actually be covered with
paper dust.

• Cleaning may not be performed if there is paper in the cleaning area. Remove the paper.

1. Select  (Setup) on the Home Screen.1.

Home Screen Menu Composition

2. Select  Maintenance.2.

3. Select Platen cleaning.3.

4. Select Yes.4.

Important
• When the cover is ready to be opened, instructions will be displayed on the touch screen. Do not•

open the cover before these instructions are displayed.

5. Open the access cover on the right side of the printer.5.
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Important
• Do not touch the linear scale (A) or carriage rail (B). Touching these may cause malfunction.•

6. Clean the inside of the right side of the printer with a well wrung-out damp cloth.6.

Wipe off ink stains and paper dust (such as cutting scraps) on the platen (C), paper retainer (D), and
output guide (E).

Warning
• Never use flammable solvents such as alcohol, benzine, or thinner. If these substances come into

contact with electrical components inside the printer, there is a risk of fire or electrical shock.
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Important
• Do not use a dry cloth to wipe the inside of the printer. This may create a static charge, which may

attract dust and affect the printing quality.
• Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as

not to scratch the surface.
• If the protruding part of the platen is badly dirty, gently wipe off the ink stain on the protruding part

with a cotton swab.

7. After wiping off the inside of the right side of the printer, select OK.7.

8. Close the access cover on the right side of the printer.8.

Important
• When the cover is ready to be opened, instructions will be displayed on the touch screen. Do not•

open the cover before these instructions are displayed.

9. Open the access cover on the left side of the printer.9.

10. Clean the inside of the left side of the printer with a well wrung-out damp cloth.10.
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Follow the same procedure for cleaning the inside of the left side of the printer as for cleaning the right
side.

11. After wiping off the inside of the left side of the printer, select OK.11.

12. Close the access cover on the left side of the printer.12.

If the printed document is still dirty after performing these operations, the part that cannot be wiped off may
be dirty. The dirt may be removed by passing a blank sheet of paper, so perform the following operations.

◦ If the roll paper is dirty, perform Set cut length several times.◦

Set cut length (feeds and cuts paper rolls by a specified length)

◦ If the sheet is dirty, perform Bottom Plate Cleaning.◦

Performing Bottom Plate Cleaning
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Cleaning Paper Feed Rollers

If the paper feed roller is dirty or paper powder is attached to it, paper may not be fed properly.

In this case, clean the paper feed roller. Cleaning will wear out the paper feed roller, so perform this only
when necessary.

You need to prepare: three sheets of A4 or Letter-sized plain paper

1. Select  (Setup) on the Home Screen.1.

Home Screen Menu Composition

2. Select  Maintenance.2.

3. Select Roller Cleaning.3.

4. Select Yes.4.

5. Follow the instructions to remove any paper from the top feed.5.

6. Select OK.6.

The paper feed roller will rotate as it is cleaned without paper.

7. Make sure that the paper feed roller has stopped rotating, then follow the instructions to7.
load the prepared plain paper in the top feed.

Loading Sheets in the Printer

8. Select OK.8.

The printer starts cleaning. The cleaning will be complete when the paper is ejected.

9. When the completion message appears, select OK.9.

If the problem is still not resolved with the operation described above, follow the operation below.

1. Turn off the power and then unplug the power cord.1.
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2. While rotating the paper feed rollers (A) located inside the top feed more than two laps, wipe them with2.
a cloth tightly squeezed after moistening.

Important
• Do not touch the paper feed rollers with your fingers. Paper feeding performance may be•

degraded.

3. Turn on the power, then clean the paper feed rollers again.3.

If the problem is not resolved after cleaning the paper feed roller, contact your nearest Canon service center
to request a repair.
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Performing Bottom Plate Cleaning

Remove stains from the inside of the printer. If the inside of the printer becomes dirty, printed paper may get
dirty, so we recommend performing cleaning regularly.

You need to prepare: a sheet of A4 or letter size plain paper *

* Be sure to use a new piece of paper.

1. Select  (Setup) on the Home Screen.1.

Home Screen Menu Composition

2. Select  Maintenance.2.

3. Select Bottom Plate Cleaning.3.

4. Select Yes.4.

5. Follow the message to remove any paper from the top feed, then select OK.5.

6. Fold the prepared plain paper in half lengthwise, unfold the paper, then select OK.6.

7. Load the plain paper horizontally in the top feed with the open side up.7.

Loading Sheets in the Printer

8. Select OK.8.
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Bottom Plate Cleaning is performed, and paper is fed.

Check the folded parts of the ejected paper. If they are smudged with ink, perform Bottom Plate
Cleaning again.

9. When the completion message appears, select OK.9.

Note
• When performing Bottom Plate Cleaning again, be sure to use a new piece of paper.•

If printed pages are still dirty even after cleaning again, the inside of the printer may be dirty. Clean the
inside of the printer.

Cleaning Inside the Printer
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Performing Maintenance Functions from Your Computer
(Windows)

Cleaning the Print Heads

Printing a Nozzle Check Pattern
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Cleaning the Print Heads

The print head cleaning function allows you to clear up clogged print head nozzle. Perform print head
cleaning if printing is faint or a specific color fails to print, even though there is enough ink.

The procedure for print head cleaning is as follows:

 Print Head Cleaning

1. Open the printer driver setup window1.

2. Click Print Head Cleaning on the Utility tab2.

When the Print Head Cleaning dialog box opens, click OK.

3. Execute cleaning3.

Make sure that the printer is on and then click OK.

Print head cleaning starts.

Note
• After Cleaning is complete, perform Print Nozzle Check Pattern and check the cleaning results.

Related Topic
Printing a Nozzle Check Pattern

391



Printing a Nozzle Check Pattern

The nozzle check function allows you to check whether the print head is working properly by printing a
nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.

The procedure for printing a nozzle check pattern is as follows:

 Print Nozzle Check Pattern

1. Open the printer driver setup window1.

2. Load paper in the printer2.

3. Click Print Nozzle Check Pattern on the Utility tab3.

The Print Nozzle Check Pattern dialog box opens.

4. Select the paper source4.

Select the paper source from the displayed dialog box.

5. Print a nozzle check pattern5.

Make sure that the printer is on and click OK.
Printing of the nozzle check pattern begins.

Click OK when the confirmation message appears.

6. Check the print result6.

Check the print results.

(A) As long as the horizontal lines are in line, and not missing, the nozzle is working normally.
(B) Where the horizontal lines are not in line or are missing, the color nozzle is blocked.

Note
• From the nozzle check pattern printing results, if it becomes patchy or there are areas that

cannot be printed, use Print Head Cleaning to clean the print heads.
Once cleaning is complete, print the nozzle check pattern again and check the results.
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Related Topic
Cleaning the Print Heads
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Other Maintenance

Preparing to Transfer the Printer

Reinstalling the Printer

Firmware update
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Preparing to Transfer the Printer

To protect the internal parts in transit, always follow these steps before transferring the printer to a new
location.

For details on installing printer after transfer, see Reinstalling the Printer.

Important
• You cannot take ink out of ink tanks.•

• Prepare for transporting the printer with the print head attached. This allows the printer to automatically•
cap the print head, thus preventing it from drying.

• Do not remove the print head. Ink may leak.•

• If ink stains the inside of the printer, wipe them using a soft cloth dampened with water.•

Cleaning Inside the Printer

• Transport the printer in a plastic bag to prevent ink leakage. Prepare the plastic bag before transporting•
the printer.

Note
• If you can move the printer in a level state using casters or something similar, you do not need to

execute Transport mode.

Switch to Transport mode using the Operation Panel
To switch to Transport mode using the operation panel, follow the steps below. If you cannot switch to
Transport mode using the operation panel due to a malfunction, see "Repairing Your Printer".

1. Remove all paper.1.

Removing the Roll from the Printer

2. Select  (Setup) on the Home Screen.2.

Home Screen Menu Composition

3. Select  Maintenance.3.

4. Select Transport mode.4.

5. Confirm the message, then select Yes.5.

The mode is shifted to the Transport mode.

When it is completed, the power is turned off automatically.
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Packing Printer

1. Check that ON lamp is off and unplug power cord.1.

Checking that Power Is On

Important
• Do not unplug the printer while the ON lamp is lit or flashing. This may cause malfunction or•

damage to the printer, making the printer unable to print, or it may not be ready for transport,
leading to ink leakage during transportation.

2. Unplug the printer cable from the computer and from the printer, then unplug the power2.
cord from the printer.

3. Open the ink tank cover (A).3.

4. Open all the ink tank inner covers (B).4.

5. Make sure tank caps are closed securely.5.
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Important
• Check if the tank cap is completely inserted. If the ink tank inner cover is not completely closed,•

insert the tank cap properly.

6. Close all the ink tank inner covers.6.

7. Close the ink tank cover.7.

8. Open the cut sheet feed cover.8.
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9. Unlock with the lever and open the roll paper feed cover.9.

10. Loosen the knurled screws (C) securing the roll holder support by turning them10.
counterclockwise.

11. Remove the roll holder support.11.

398



12. Use adhesive tape to secure the top feed to keep it from opening.12.

13. Close the roll paper feed cover completely.13.

14. Close the cut sheet feed cover.14.
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15. Use adhesive tape to secure all covers on the printer to keep them from opening.15.

16. Remove the desktop basket or printer stand by following the installation instructions in16.
reverse.

Important
• When removing the desktop basket, hold down the buttons on the basket adapters and pull it•

out from the printer.

Note
• Refer to the Desktop Basket Setup Guide for the desktop basket installation procedure and the•

Printer Stand Setup Guide for the printer stand installation procedure.

Caution
• Moving the printer requires two people. Be careful to avoid back strain and other injuries.•

• When moving the printer, firmly grasp the carrying grips. The printer may be unsteady if you•
hold it at other positions, which poses a risk of injury from dropping the printer.
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17. Pack printer in plastic bag.17.

Seal the mouth of the plastic bag with the tape or tie it tightly so that ink does not leak.

18. Pack printer in box.18.

Attach the protective material to the printer to pack it securely in the box.
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Important
• Pack the printer in a sturdy box so that it is placed with its bottom facing down, using sufficient•

protective material to ensure safe transport.

• Do not tilt the printer. Ink may leak.•

• When a shipping agent is handling transport of the printer, have its box marked "THIS SIDE•
UP" to keep the printer with its bottom facing down. Mark also with "FRAGILE" or "HANDLE
WITH CARE".

• Please handle with care and ensure the box remains flat and NOT turned upside down or on its•
side, as the printer may be damaged and ink in the printer may leak.

• Pack the removed roll holder and roll holder support separately from the printer.•

19. Disassemble and pack the removed desktop basket or printer stand by following the19.
installation instructions in reverse.

Important
• Pack the removed desktop basket or printer stand separately from the printer.•
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Reinstalling the Printer

The basic workflow for reinstalling the printer is as follows.

Assemble the stand (Option)

1. If you want to use the printer stand, assemble the printer stand.1.

Note
• For instructions on assembling and installing the printer stand, see the Printer Stand Setup•

Guide.

Install the printer

1. Remove the packed printer from the box and bag.1.

Caution
• Moving the printer requires two people. Be careful to avoid back strain and other injuries.•

• When moving the printer, firmly grasp the carrying grips. The printer may be unsteady if you•
hold it at other positions, which poses a risk of injury from dropping the printer.
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2. When using the printer stand, attach the printer to the assembled stand.2.

3. When using a desktop basket, attach the desktop basket to the printer.3.

Important
• The printer stand and desktop basket cannot be installed at the same time.•

Note
• For instructions on installing the desktop basket, see the Desktop Basket Setup Guide.•

2. Install the roll holder support.2.
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3. Plug the power cord into the power cord connector on the back of the printer.3.

4. Plug the power plug into an outlet.4.

5. Press ON button to turn on printer.5.

Turning on the printer

6. Load paper in the printer.6.

Loading Sheets in the Printer
Loading Rolls in the Printer

7. Install the software.7.

Note that the driver installation procedure varies depending on the type of connection.

Installing the Printer Driver (Windows)
Installing the Printer Driver (macOS)
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Important
• When the printer is connected to a network (via TCP/IP), the printer's IP address may be•

changed if you reinstall the printer.

In this case, be sure to reconfigure the printer's IP address.
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Firmware update

Important
• When you use this function, make sure the printer is connected to the Internet.
• The administrator password is required to change settings if it is enabled for changing settings using the

operation panel.

Using Operation Panel

1. Select  (Setup) on the HOME screen.1.

Home Screen Menu Composition

2. Select Printer settings.2.

3. Select Firmware update.3.

If an administrator password is set, enter the password.

4. Select Install update.4.

5. Select Yes.5.

6. Check message and select Start update.6.

Using Remote UI

1. Start up Remote UI.1.

Start up Remote UI

2. Select Firmware update.2.

3. Select Install update.3.

4. Check message and select Update.4.

Note
• If the firmware update is not complete, check the following and take an appropriate action.•

Check the network settings such as a wireless router.
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If Cannot connect to the server. is displayed on the touch screen, select OK and try again after a
while.
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Printing is faint
Banding in different colors occurs
Colors in printed images are uneven
Image edges are blurred or white banding occurs

Paper rubs against the Print Head
The edges of the paper are dirty
The surface of the paper is dirty
The back side of the paper is dirty

Printed colors are inaccurate
Documents are printed in monochrome

Frequently Asked Questions

Problems with the Printing Quality

Unevenness, Banding, Faint

dirt

colors are inaccurate
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Line thickness is not uniform
Lines or colors are misaligned

The length of the printed image in the paper ejection direction is not accurate
Images are printed crooked
Margins are wide

Line

Others

General FAQ
Printer Does Not Print
Cannot Print or Connect
The printer does not respond even if print jobs are sent
Printing stops and an error message is displayed
Failed to Printer Driver Installation (Windows)
Removing Printer Software
Repairing Your Printer

Search by Category

Cannot Configure Network Settings

Message Appears on Computer During Setup
Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen
"Failed to connect to the wireless router." Appears
Printer Cannot Be Used After Replacing Wireless Router or Changed Router Settings
Error Occurs During Wi-Fi Setup
Taking Time to Setup Process (Windows)

Cannot Find Printer on Network

Cannot Connect Printer to Network
Cannot Find Printer During Setup
Cannot Find Printer while Using Wi-Fi
Cannot Find Printer while Using Wired LAN
Searching Printer by IP Address or Host Name During Setup

Cannot Print over Network

Cannot Print over TCP/IP Network
Cannot Print over Bonjour networks
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Cannot Print Using AirPrint

Network Connection Problems

Network Settings and Common Problems
Cannot Connect to the Printer
Network Key (Password) Unknown
Forgot Administrator Password of Printer
Checking Network Information
Restoring to Factory Defaults
Cannot Access to Internet on Wi-Fi from Communication Device

Printer Problems

Printer Does Not Turn On
USB Connection Problems
Cannot Communicate with Printer via USB
Touch Screen Is Off
Messages advising to check the maintenance cartridge are not cleared
If the Printer Makes a Strange Sound

Printing Problems

Printing Stops
Printer Prints Slowly
Part of Page Is Not Printed (Windows)

Paper is not Fed or Ejected Properly

Remove Jammed Roll Paper
Remove a Jammed Sheet
Remove Jammed Paper (Paper Feed Slot)
Roll paper cannot be inserted into the Paper Feed Slot
Printer Does Not Pick up or Feed the Paper/"No Paper" Error
Roll Paper Remains/Lacks under Quantity Management
The printer ejects blank, unprinted paper
When printing on roll paper, the printed surface becomes scratched

Paper Cutting Problems

Paper is not cut straight
Cutter Blade Does Not Work While Cutting Is in Progress
I want to know how to configure roll cutting
I want to configure so that the roll is cut automatically after waiting for the ink to dry

Paper Setting Problems

Cannot detect tracing paper size
I want to know the paper types that can be used in this printer
Media Type Selection does not Match Loaded Media Type
The paper type that I want to print is not displayed on the Touch Screen

Ink-related Problems

Ink Does Not Come Out
Printer consumes a lot of ink
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Ink Level Detection

About Print Settings

How do I print without borders
I want to easily create vertical or horizontal banners
Can I perform duplex printing
I want to perform enlargement printing
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Printer Does Not Print

Check 1  Make sure printer is turned on.

If not, make sure the printer is securely plugged in and press ON button to turn on.

The ON lamp flashes while the printer is initializing. Wait until the ON lamp stops flashing and remains lit.

Note
• If you are printing large data such as photos or other graphics, printing may take longer to start. The ON•

lamp flashes while the computer is processing data and sending it to the printer. Wait until printing starts.

Check 2  Make sure printer is properly connected to computer.

If you are using a USB cable, make sure it is securely connected to both the printer and the computer. When the
USB cable is securely plugged in, check the following:

• If you are using a relay device such as a USB hub, disconnect it, connect the printer directly to the•
computer, and retry the printing. If printing starts normally, there is a problem with the relay device. Contact
the vendor of the relay device.

• There could also be a problem with the USB cable. Replace the USB cable and retry the printing.•

If you use the printer with a network connection, make sure the printer is correctly set up for network use.

Cannot Find Printer while Using Wi-Fi
Cannot Find Printer while Using Wired LAN

Note
• Wi-Fi Connection Assistant allows you to diagnose and repair the network status.•

Select the link below to download Wi-Fi Connection Assistant and install it.

Checking Printer Connection Status Using Wi-Fi Connection Assistant

Check 3  Make sure paper settings match information set for the printer

If the paper settings do not match the information set for the printer, an error message appears on the touch
screen. Follow the instructions on the touch screen to solve the problem.

Check 4  If printing from a computer, delete unnecessary print jobs.

• For Windows:•

Deleting the Undesired Print Job

• For macOS:•

Deleting the Undesired Print Job
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Check 5  Is your printer's printer driver selected when printing?

The printer will not print properly if you are using a printer driver for a different printer.

• For Windows:•

Make sure "Canon XXX" (where "XXX" is your printer's name) is selected in the Print dialog box.

Note
• If multiple printers are registered to your computer, set your printer as default printer to make the one•

selected by default.

For Windows 10:

If you have set the default printer, additional settings are required to stop Windows 10 from changing
the default printer.

Select Settings > Devices > Printers & scanners and uncheck Let Windows manage my default
printer.

• For macOS:•

Make sure your printer's name is selected in Printer in the Print dialog.

Note
• If multiple printers are registered to your computer, select Set as Default Printer from System•

Preferences > Printers & Scanners for a printer to make the one selected by default.

Check 6  If printing from your computer, restart the computer.

Restart the computer and try printing again.
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Cannot Print or Connect

If you need to redo printer setup:
Redo printer setup if one of the conditions below applies.

• If you have replaced a computer or wireless router
• If you have changed wireless router settings
• If you have changed the printer connection method (Wi-Fi / wired LAN / USB)

See the Setup Guide for details on the setup procedure.

If you have forgotten the administrator password specified for the
printer:
Forgot Administrator Password of Printer

If none of the above applies:
See Cannot Connect to the Printer.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

415



The printer does not respond even if print jobs are sent

Check  Is LAN connection disabled?

Set Enable/disable Wired LAN, Enable/disable Wi-Fi, or Enable/disable Wireless
Direct on the touch screen menu to Enable.

Note
• Wired LAN and Wi-Fi or wired LAN and wireless direct cannot be used simultaneously.
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Printing stops and an error message is displayed

If the action indicated in the error message does not solve the problem, the roll paper may be stuck and not
able to be advanced.

Check 1  Is the loaded roll paper touching printer parts, etc.?

If the loaded roll paper is touching printer parts, load the roll paper again.

Removing the Roll from the Printer

Check 2  Is the roll paper proper to use?

Check the outer diameter and paper thickness of the roll paper that can be used with your printer.

Paper Sizes
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Failed to Printer Driver Installation (Windows)

• If installation does not start when you insert Setup CD-ROM:•

Follow the instructions below to start the installation.

1. Make the following settings.1.

◦ In Windows 11, click Start button > Explorer, and then click PC from list on left.◦

◦ In Windows 10, click Start button > File Explorer, and then click This PC from list on left.◦

◦ In Windows 8.1, select Explorer icon in Taskbar on Desktop, and then select This PC from◦
list on left.

◦ In Windows 7, click Start, and then click Computer.◦

2. Double-click the  CD-ROM icon in the window that appears.2.

If the contents of the CD-ROM appear, double-click MSETUP4.EXE.

If you cannot install the printer driver with the Setup CD-ROM, install it from the Canon website.

Note
• If the CD-ROM icon does not appear, try the following:•

Remove the CD-ROM from your computer and reinsert it.

Restart your computer.

If the icon still does not appear, try a different disc and see if it appears. If it does, there is a
problem with the Setup CD-ROM. Contact your nearest Canon service center to request a repair.
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• If you cannot get past the Printer Connection screen:•

Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen

• Other cases:•

Reinstall the printer driver.

If the printer driver was not installed correctly, uninstall the printer driver, restart your computer, and then
reinstall the printer driver.

Deleting the Unnecessary Printer Driver

Reinstall the printer driver with the Setup CD-ROM or install it from the Canon website.

Note
• If the installer was stopped due to a Windows error, Windows operation may be unstable, and you•

may not be able to install the drivers. Restart your computer and then reinstall the drivers.
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Removing Printer Software

Follow the steps below to remove utility software installed on the computer.

Important
• You must log in as an administrator or have administrator permissions.

Note
• See the pages below for how to remove printer drivers.•

Deleting the Unnecessary Printer Driver (Windows)
Delete the Unnecessary Canon IJ Printer from the Printer List (macOS)

Removing the Wi-Fi Connection Assistant (Windows)
Follow the steps below to remove the Wi-Fi Connection Assistant.

• Windows 10•

1. Click start, select Windows System, and then select Control Panel.1.

2. Under Programs, select Programs and Features, select Wi-Fi Connection Assistant2.
from the list of programs, and then click Uninstall.

• Windows 8.1•

1. Use the Settings charm on the desktop to open the Control Panel.1.

2. Under Programs, select Programs and Features, select Wi-Fi Connection Assistant2.
from the list of programs, and then click the Uninstall button.

• Windows 7•

1. Select Control Panel from the start menu.1.

2. Select Uninstall a program.2.

3. Select Wi-Fi Connection Assistant, and then click the Uninstall button.3.

Note
• If the User Account Control dialog box is displayed, click Yes.
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Removing the Wi-Fi Connection Assistant (macOS)
Follow the steps below to remove the Wi-Fi Connection Assistant.

1. Select Applications from Go menu of Finder, double-click Canon Utilities > Wi-Fi1.
Connection Assistant, and then drag Canon Wi-Fi Connection Assistant icon into
Trash.

2. Restart computer.2.

Empty the Trash and restart your computer.

Note
• To reinstall Wi-Fi Connection Assistant, uninstall Wi-Fi Connection Assistant and install it again from•

the Canon website.
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Repairing Your Printer

If the power does not turn on or you cannot run the transport mode from the operation panel, perform the
following steps.

Important
• You cannot take ink out of ink tanks.•

• Make sure the tank caps of ink tanks are closed securely. If the tank caps are open, close the tank caps•
properly.

• Press the ON button to turn off the printer with the print heads installed. The printer protects the print•
heads by covering them automatically to prevent them from being dried.

• Do not remove the print heads. Ink may leak.•

• If the inside of the printer becomes dirty, clean with a soft cloth that gets wet with water and squeezed•
firmly.

• When transporting the printer, pack the printer in a plastic bag so that ink does not leak.•

• Pack the printer in a sturdy box so that it is placed with its bottom facing down, using sufficient•
protective material to ensure safe transport.

• Do not tilt the printer; otherwise, ink may leak.•

• When a shipping agent is handling transport of the printer, have its box marked "THIS SIDE UP" to•
keep the printer with its bottom facing down. Mark also with "FRAGILE" or "HANDLE WITH CARE".

• Please handle with care and ensure the box remains flat and NOT turned upside down or on its side, as•
the printer may be damaged and ink in the printer may leak.

1. If the power is on, press the ON button to turn off the printer.1.

Turning off the printer
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2. Remove all paper.2.

3. Open the access cover on the right side of the printer.3.

4. Close ink valve.4.

Close the ink valve by tilting the ink valve lever tightly to the left.

Important
• If you pack the printer without closing the ink valve, ink may leak out. Be sure to close the ink•

valve before packing the printer.

• If the ink valve lever is dirty, wipe the lever clean before closing the valve.•

Note
•  If the ink valve lever is already tilted to the left and the ink valve is closed, leave it in place.

5. Close the access cover on the right side of the printer.5.
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6. Pack the printer.6.

Packing Printer

Important
• Remove the roll holder, roll holder support, desktop basket, and printer stand from the printer.•

Contact the customer service center in your country or region for information on how to handle these
parts when sending the printer unit for repair.
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Problems with the Printing Quality

Printing is faint

Banding in different colors occurs

Colors in printed images are uneven

Image edges are blurred or white banding occurs

Paper rubs against the Print Head

The edges of the paper are dirty

The surface of the paper is dirty

The back side of the paper is dirty

Printed colors are inaccurate

Documents are printed in monochrome

Line thickness is not uniform

Lines or colors are misaligned

The length of the printed image in the paper ejection direction is not accurate

Images are printed crooked

Margins are wide
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Printing is faint

Check 1  Is the reverse side of the paper being used for printing?

Print on the printing surface.

Check 2  Is the Print head nozzle blocked?

Print a test pattern to check the nozzles and see if they are clogged.

Checking for Nozzle Clogging

Check 3  Are paper scraps stuck in the printer?

Remove paper scraps left inside the printer.

Remove Jammed Roll Paper
Remove a Jammed Sheet

Check 4  Was the paper cut before the ink dried?

In the touch screen menu, select Paper-related settings > Advanced paper settings, and increase time in
Pause between scans or Pause between pages.

Specifying the Ink Drying Time

Check 5  When printing photos and posters, are the Print target settings set correctly?

Do one of the following.

• In the printer driver, change the setting to Photo (Color) or Poster in Print Target.•

Printing by setting the Print target

• In the touch screen menu, select Printer settings > Print settings > Default print settings > Print quality•
settings > Print target, and change the setting to Photo. (This is only available when the printer driver's
Media Type is set to Auto (Use Printer Settings)).
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Menu Structure

Check 6  Is the printer driver Print Quality set to a low quality setting?

Follow the steps below to set Print Quality to higher quality settings, and then print.

• Windows•

Change the Print Quality settings in the printer driver Advanced Settings.

Changing the Print Quality and Correcting Image Data (Windows)

• macOS•

Change the Print Quality in the printer driver Quality & Media settings.

Changing the Print Quality and Correcting Image Data (macOS)

Check 7  Does the paper used for printing create a lot of cutting dust?

In the touch screen menu, set Cut-dust reduction in Advanced paper settings to ON.

Reducing Dust from Cutting Rolls
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Banding in different colors occurs

Check 1  Make sure that the Print head nozzle is not blocked

Print a test pattern to check the nozzles and see if they are clogged.

Checking for Nozzle Clogging

Check 2  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

When printing with the media type specified in the printer driver, load the specified media type in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

When printing with the media type loaded in the printer, specify the same media type in the printer driver.

1. To stop printing, press the Stop button.1.

2. Change the type of paper in the printer driver and try printing again.2.

Note
• When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media•

type loaded in the printer.

• Click Get Information to reflect the paper information set in the printer to the printer driver.•

Printing with Easy Setup

Check 3  Does the paper loaded on the printer match the media type selected on the
touch screen?

Select the correct media type in the touch screen menu when loading paper in the printer.
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Loading Rolls in the Printer
Loading Sheets in the Printer

Check 4  Has the paper feed rate been calibrated properly?

Adjust the feed amount.

Automatically Adjusting Different Colored Horizontal Streaks
Adjusting Line Length

Check 5  When printing photos and posters, are the Print target settings set correctly?

Do one of the following.

• In the printer driver, change the setting to Photo (Color) or Poster in Print Target.•

Printing by setting the Print target

• In the touch screen menu, select Printer settings > Print settings > Default print settings > Print quality•
settings > Print target, and change the setting to Photo. (This is only available when the printer driver's
Media Type is set to Auto (Use Printer Settings)).

Menu Structure

Check 6  Low Print Quality setting causing lines in the printing

Follow the steps below to set Print Quality to the highest quality setting, and then print.

• Windows•

Change the Print Quality settings in the printer driver Advanced Settings.

Changing the Print Quality and Correcting Image Data (Windows)

• macOS•

Change the Print Quality in the printer driver Quality & Media settings.

Changing the Print Quality and Correcting Image Data (macOS)

Check 7  Is Set priority in the touch screen menu set to Prioritize length accuracy?

Setting Set priority to Prioritize print quality and adjusting the feed amount can help.

Automatically Adjusting Different Colored Horizontal Streaks
Adjusting Line Length

Check 8  Check if the Print head is in the right position

Adjust the Print head position.

Automatic Adjustment to Straighten Lines and Colors

Check 9  Print job may have been interrupted while receiving, and therefore not printed
at a fast frame rate

Exit other applications and cancel other print jobs.
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Colors in printed images are uneven

Check 1  Does the paper loaded on the printer match the media type selected in the
printer driver?

When printing with the media type specified in the printer driver, load the specified media type in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

When printing with the media type specified in the printer driver, load the specified media type in the printer.

1. To stop printing, press the Stop button.1.

2. Change the paper type in the printer driver and try printing again.2.

Note
• When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media•

type loaded in the printer.

• Click Get Information to reflect the paper information set in the printer to the printer driver.•

Printing with Easy Setup

Check 2  When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

Select the correct media type in the touch screen menu when loading paper in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

Check 3  Is the Print head position adjusted correctly?

Adjust the Print head position.
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Automatic Adjustment to Straighten Lines and Colors

Check 4  Is the feed amount adjusted correctly?

Adjust feed amount.

Automatically Adjusting Different Colored Horizontal Streaks
Adjusting Line Length

Check 5  When printing photos and posters, are the Print target settings set correctly?

Do one of the following.

• In the printer driver, change the setting to Photo (Color) or Poster in Print Target.•

Printing by setting the Print target

• In the touch screen menu, select Printer settings > Print settings > Default print settings > Print quality•
settings > Print target, and change the setting to Photo. (This is only available when the printer driver's
Media Type is set to Auto (Use Printer Settings)).

Menu Structure

Check 6  Colors in printed images may be uneven if the Print Quality setting is too low

If using Windows, select Advanced Settings from the Main tab of the printer driver, and then select a higher
Print Quality setting.

If using macOS, select Quality & Media in the printer driver, and then select a higher Print Quality setting.

Changing the Print Quality and Correcting Image Data (Windows)
Changing the Print Quality and Correcting Image Data (macOS)

Check 7  Are the Print Head nozzles clogged?

Check for nozzle clogging.

Checking for Nozzle Clogging

Check 8  Colors in printed images may be uneven on the boundary between shades if
there are dark and light areas in an image

Prints on the same page while switching between Bidirectional printing and Unidirectional printing. Therefore,
color unevenness may occur when switching. Using the unidirectional printing function may reduce color
unevenness in this situation.

Follow the steps below for unidirectional printing.

• Windows•

Open Paper Detailed Settings from the Main tab of the printer driver, and then select Unidirectional
Printing.

Description of the Main sheet screen

• macOS•

Open Advanced Paper Settings in the printer driver, and then select Unidirectional Printing.

Advanced Paper Settings

431



Important
• If any of the following conditions are met in the printer driver settings, the unidirectional printing function•

setting will be disabled.

The Banner Printing check box is checked.
The paper length exceeds 78.7 inches (2000.0 mm).

Check 9  Does this paper curl easily?

Colors in printed images may be uneven at the leading edge of paper that curls easily. Set a margin of at least
0.8 inches (20 mm) at the front edge of the paper.

Making Margin Settings for Rolls

Check 10  Color may be uneven if printing materials were stacked while drying

To avoid uneven colors, we recommend drying each sheet separately.

Check 11  Is Ink drying target area for Pause between scans in the touch screen
menu set to Leading edge?

If the Ink drying target area for Pause between scans is set to Leading edge, color may be uneven
approximately 4.3 to 6.3 inches (110 to 160 mm) from the front edge of the paper. (The position depends
on the Print Quality settings)

On the HOME screen of the touch screen, select  (Setup) > Printer settings > Paper-related settings >
Advanced paper settings > Pause between scans > Ink drying target area and set to Overall.

However, note that printing will now take longer.

Specifying the Ink Drying Time
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Image edges are blurred or white banding occurs

Check 1  Check if the Print head is in the right position.

For detailed printing of small text or fine lines on glossy or semi-gloss photo paper etc., adjust the position of the
Print head.

Automatic Adjustment to Straighten Lines and Colors

Check 2  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

When printing with the media type specified in the printer driver, load the specified media type in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

When printing with the media type specified in the printer driver, load the specified media type in the printer.

1. To stop printing, press the Stop button.1.

2. Change the paper type in the printer driver and try printing again.2.

Note
• When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media•

type loaded in the printer.

• Click Get Information to reflect the paper information set in the printer to the printer driver.•

Printing with Easy Setup

Check 3  When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

Select the correct media type in the touch screen menu when loading paper in the printer.

433



Loading Rolls in the Printer
Loading Sheets in the Printer

Check 4  Are the Print Head nozzles clogged?

Perform print head cleaning.

Cleaning the Print Head
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Paper rubs against the Print Head

Check 1  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

When printing with the media type specified in the printer driver, load the specified media type in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

When printing with the media type loaded in the printer, specify the same media type in the printer driver.

1. To stop printing, press the Stop button.1.

2. Change the paper type in the printer driver and try printing again.2.

Note
• When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media•

type loaded in the printer.

• Click Get Information to reflect the paper information set in the printer to the printer driver.•

Printing with Easy Setup

Check 2  When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

Select the correct media type in the touch screen menu when loading paper in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

Check 3  Is the paper loaded properly?
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If not loaded properly, paper can buckle and rub against the Print head.

Reload the paper.

Loading Rolls in the Printer
Loading Sheets in the Printer

Check 4  Are the margins of the rolls narrow?

Narrow margins can cause the leading edge of the paper to curl easily, and the raised paper may rub against the
head after the ink has landed on it. Make the margins wider.

Making Margin Settings for Rolls

Check 5  If you are using plain paper, changing the settings from the printer driver may
improve the print results.

• For the target setting mode•

Select Poster/Photo in Print Target.

Printing by setting the Print target

• For the advanced setting mode•

Select Image in Print Priority.

Printing using the Preferences mode

Check 6  If you are using rolls, are you using the recommended paper and
recommended environment?

Using rolls or environments other than those recommended, may result in increased curl and rubbing of the print
head. Use the recommended paper and recommended environment.

List of paper settings (roll paper)

Check 7  Set the setting to prevent paper rubbing.

Adjusting the setting to prevent paper abrasion will widen the clearance between the print head and the paper.
If you notice abrasion even with the media type set correctly to match the paper, set the printer to prevent paper
abrasion using the operation panel or the computer.

This may reduce the print speed.

* Once you have finished printing, undo this setting. Otherwise, it will apply to subsequent print jobs.

• From operation panel•

Select  (Setup) on HOME screen > Printer settings > Print settings in this order, and then set
Prevent paper abrasion to ON.

Changing Settings from Operation Panel
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The edges of the paper are dirty

Check 1  Was printing on small paper?

The platen may become dirtied by printing on small paper sizes.

Open the left and right access covers, and clean the platen.

Cleaning Inside the Printer

Check 2  Is the media type specified in the printer driver the same as the media type in
the printer?

The platen may become dirty if the loaded paper does not match the settings. After cleaning the platen, adjust
the paper size.

Cleaning Inside the Printer

When printing with the media type specified in the printer driver, load the specified media type in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

When printing with the media type loaded in the printer, specify the same media type in the printer driver.

1. To stop printing, press the Stop button.1.

2. Change the type of paper in the printer driver and try printing again.2.

Note
• When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media•

type loaded in the printer.

• Click Get Information to reflect the paper information set in the printer to the printer driver.•

Printing with Easy Setup
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Check 3  When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

The platen may become dirty if the loaded paper does not match the settings. After cleaning the platen, adjust
the paper size.

Cleaning Inside the Printer

Select the correct media type in the touch screen menu when loading paper in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

Check 4  Is the paper creased or curled?

Straighten out the wrinkles or curls and reload the paper.

Loading Rolls in the Printer
Loading Sheets in the Printer

Check 5  In the touch screen menu, is Cut-dust reduction in Advanced paper settings
set to ON?

A cut dust reduction line is printed at the paper cut position when Cut-dust reduction is set to ON.

If cutting dust reduction is not required, set Cut-dust reduction to OFF.

Menu Structure

Check 6  Is the output guide clean?

Clean the output guide.

Cleaning Inside the Printer

Check 7  Are the margins of the rolls narrow?

Narrow margins can cause the leading edge of the paper to curl easily, and the raised paper may rub against the
head after the ink has landed on it. Make the margins wide.

Making Margin Settings for Rolls

Check 8  If you are using plain paper, changing the settings from the printer driver may
improve the print results.

• For the target setting mode•

Select Poster/Photo in Print Target.

Printing by setting the Print target

• For the advanced setting mode•

Select Image in Print Priority.

Printing using the Preferences mode

Check 9  If you are using rolls, are you using the recommended paper and
recommended environment?
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Using rolls or environments other than those recommended, may result in increased curl and rubbing of the print
head. Use the recommended paper and recommended environment.

List of paper settings (roll paper)

Check 10  Set the setting to prevent paper rubbing.

Adjusting the setting to prevent paper abrasion will widen the clearance between the print head and the paper.
If you notice abrasion even with the media type set correctly to match the paper, set the printer to prevent paper
abrasion using the operation panel or the computer.

This may reduce the print speed.

* Once you have finished printing, undo this setting. Otherwise, it will apply to subsequent print jobs.

• From operation panel•

Select  (Setup) on HOME screen > Printer settings > Print settings in this order, and then set
Prevent paper abrasion to ON.

Print settings

Check 11  Is the inside of the printer dirty?

During duplex printing, ink may stain the inside of the printer, smudging the printout.

Perform bottom plate cleaning to clean inside of printer.

Performing Bottom Plate Cleaning

Note
• To prevent staining inside the printer, be sure to set the correct paper size.•

Check 12  If you are using sheets, is the sheet curled?

Align the edges of paper. If paper is curled, flatten it.

Important
• Align the edges of paper neatly before loading. Loading paper without aligning the edges may cause paper•

jams.

• If paper is curled, hold the curled corners and gently bend them in the opposite direction until the paper•
becomes completely flat.
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The surface of the paper is dirty

Check 1  Is the paper retainer clean?

Clean the paper retainer.

Cleaning Inside the Printer

Check 2  Does this paper take longer to dry?

Increase the length of the Pause between pages and Pause between scans settings from the touch screen
menu.

Specifying the Ink Drying Time

Note
• When printing on paper that takes longer to dry, the paper may curl during printing and come in contact•

with the output tray.

In such situations, set an Ink drying wait time and an Ink drying target area for Pause between scans
in the touch screen menu.

However, note that printing will now take longer.

Check 3  Is the media type specified in the printer driver the same as the media type in
the printer?

The platen may become dirty if the loaded paper does not match the settings. After cleaning the platen, adjust
the paper size.

Cleaning Inside the Printer

When printing with the media type loaded in the printer, specify the same media type in the printer driver.

Loading Rolls in the Printer
Loading Sheets in the Printer

When printing with the media type loaded in the printer, specify the same media type in the printer driver.
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1. To stop printing, press the Stop button.1.

2. Change the type of paper in the printer driver and try printing again.2.

Note
• When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media•

type loaded in the printer.

• Click Get Information to reflect the paper information set in the printer to the printer driver.•

Printing with Easy Setup

Check 4  Does the paper type selected in the printer driver or on the touch screen match
the actual paper type loaded?

Clean the platen and match the paper type selected in the printer driver or touch screen with the actual paper
type loaded.

Cleaning Inside the Printer

Check 5  Dirt may be removed by letting a blank sheet of paper pass through.

If the roll paper is dirty, perform Set cut length several times.

Set cut length (feeds and cuts paper rolls by a specified length)

If the sheet is dirty, perform Bottom Plate Cleaning.

Performing Bottom Plate Cleaning

Check 6  If you are using plain paper, changing the settings from the printer driver may
improve the print results.

• For the target setting mode•

Select Poster/Photo in Print Target.

Printing by setting the Print target

• For the advanced setting mode•

Select Image in Print Priority.

Printing using the Preferences mode

Check 7  If you are using rolls, are you using the recommended paper and
recommended environment?

Using rolls or environments other than those recommended, may result in increased curl and rubbing of the print
head. Use the recommended paper and recommended environment.

List of paper settings (roll paper)

Check 8  Set the setting to prevent paper rubbing.

Adjusting the setting to prevent paper abrasion will widen the clearance between the print head and the paper.
If you notice abrasion even with the media type set correctly to match the paper, set the printer to prevent paper
abrasion using the operation panel or the computer.
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This may reduce the print speed.

* Once you have finished printing, undo this setting. Otherwise, it will apply to subsequent print jobs.

• From operation panel•

Select  (Setup) on HOME screen > Printer settings > Print settings in this order, and then set
Prevent paper abrasion to ON.

Print settings

Check 9  Is the inside of the printer dirty?

During duplex printing, ink may stain the inside of the printer, smudging the printout.

Perform bottom plate cleaning to clean inside of printer.

Performing Bottom Plate Cleaning

Note
• To prevent staining inside the printer, be sure to set the correct paper size.•

Check 10  If you are using sheets, is the sheet curled?

Align the edges of paper. If paper is curled, flatten it.

Important
• Align the edges of paper neatly before loading. Loading paper without aligning the edges may cause paper•

jams.

• If paper is curled, hold the curled corners and gently bend them in the opposite direction until the paper•
becomes completely flat.
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The back side of the paper is dirty

Check 1  Was the previous print job printed on small paper?

Open the left and right access covers, and clean the platen.

Cleaning Inside the Printer

Check 2  Is Detect paper width in the touch screen menu set to Disable?

Printing with Detect paper width set to Disable may cause the platen to be dirtied.

Set Detect paper width in the touch screen menu to Enable, and then open the left and right access covers,
and clean the platen.

Cleaning Inside the Printer

Check 3  Does this paper take longer to dry?

Increase the length of the Pause between pages and Pause between scans settings from the touch screen
menu.

Specifying the Ink Drying Time

Note
• When printing on paper that takes longer to dry, the paper may curl during printing and come in contact•

with the output tray.

In such situations, set an Ink drying wait time and an Ink drying target area for Pause between scans
in the touch screen menu.

However, note that printing will now take longer.

Menu Structure

• If the platen is dirty, open the left and right access covers, and clean the platen.•
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Check 4  Is the media type specified in the printer driver the same as the media type in
the printer?

The platen may become dirty if the loaded paper does not match the settings. After cleaning the platen, adjust
the paper size.

Cleaning Inside the Printer

When printing with the media type specified in the printer driver, load the specified media type in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

When printing with the media type loaded in the printer, specify the same media type in the printer driver.

1. To stop printing, press the Stop button.1.

2. Change the type of paper in the printer driver and try printing again.2.

Note
• When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media•

type loaded in the printer.

• Click Get Information to reflect the paper information set in the printer to the printer driver.•

Printing with Easy Setup

Check 5  Does the paper type selected in the printer driver or on the touch screen match
the actual paper type loaded?

Clean the platen and match the paper type selected in the printer driver or touch screen with the actual paper
type loaded.

Cleaning Inside the Printer

Check 6  Dirt may be removed by letting a blank sheet of paper pass through.

If the roll is dirty, repeat the Set cut length several times.

Set cut length (feeds and cuts paper rolls by a specified length)

If the sheet is dirty, perform Bottom Plate Cleaning.

Performing Bottom Plate Cleaning
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Printed colors are inaccurate

Check 1  Is the Print head nozzle blocked?

Print a test pattern to check the nozzles and see if they are clogged.

Checking for Nozzle Clogging

Check 2  When printing photos and posters, are the Print target settings set correctly?

Do one of the following.

• In the printer driver, change the setting to Photo (Color) or Poster in Print Target.•

Printing by setting the Print target

• In the touch screen menu, select Printer settings > Print settings > Default print settings > Print quality•
settings > Print target, and change the setting to Photo. (This is only available when the printer driver's
Media Type is set to Auto (Use Printer Settings)).

Menu Structure

Check 3  Has color been adjusted in the printer driver?

Follow the steps below to adjust color settings.

• Windows•

Adjust the color settings with Color Mode > Color Settings in Advanced Settings in the printer driver.

Main Tab Description (Windows)

• macOS•

Adjust the color settings in the printer driver Color Options.

Color Options (macOS)
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Check 4  Is Application Color Matching Priority set to Off in a Windows printer driver?

In the printer driver Layout sheet, click Special Settings, and then set Application Color Matching Priority to
On in the dialog box that appears.

Layout Tab Description (Windows)

Check 5  Has the computer or monitor color been adjusted?

Take the actions below.

• Refer to the computer and monitor documentation to adjust the colors.•

• Adjust the settings of the color management software, referring to the software documentation as needed.•

Check 6  Color varies even between printers of the same model due to differences in
firmware and printer driver versions, settings, or environment.

Follow these steps to prepare the printing environment.

1. Use the same version of firmware or printer driver.1.

2. Specify the same value for all settings items.2.
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Documents are printed in monochrome

Check 1  Is Color Mode set to Monochrome, or Print Target set to CAD
(Monochrome Line Drawing) in a Windows printer driver?

In the Advanced Settings of the printer driver, specify Color in Color Mode and try printing again.

Check 2  Is Black and White Photo Print selected in a macOS printer driver?

Deselect Grayscale Printing in the printer driver Quality & Media settings, and then print again.

Check 3  The print head nozzle may be blocked

Print a test pattern to check the color ink nozzles and see if they are clogged.

Checking for Nozzle Clogging
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Line thickness is not uniform

Check 1  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

When printing with the media type specified in the printer driver, load the specified media type in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

When printing with the media type specified in the printer driver, load the specified media type in the printer.

1. To stop printing, press the Stop button.1.

2. Change the paper type in the printer driver and try printing again.2.

Note
• When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media•

type loaded in the printer.

• Click Get Information to reflect the paper information set in the printer to the printer driver.•

Printing with Easy Setup

Check 2  When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

Select the correct media type in the touch screen menu when loading paper in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer
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Check 3  Adjust the position of the Print head

If the printed result does not look uniform, such as when the lines are misaligned, adjust the position of Print
Head.

Automatic Adjustment to Straighten Lines and Colors

Check 4  Disabling the line and text cleanup process may improve the situation.

If the printed result does not look uniform, such as when the lines are misaligned, adjust the position of Print
Head.

• For Windows•

Turn off Cleaner Lines/Text in the printer driver settings.

Description of the Layout sheet screen

• For macOS•

In the touchscreen menu, select  (Setup) > Printer settings > Print settings > Cleaner Lines/Text,
and set to Disable.

Check 5  Is Fast Graphic Process set to On in the 32-bit Windows printer driver
Special Settings dialog box?

Access the printer driver Properties dialog box from Print in the File menu of the source application, and follow
these steps to print.

1. Deselect Preview before printing in the Main sheet.1.

2. Deselect Page Layout in the Layout sheet.2.

3. Click the Special Settings button in the Layout sheet, and then set Fast Graphic3.
Process to Off in the Special Settings dialog box that opens.
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Lines or colors are misaligned

Check 1  Adjust the position of the Print head

If borders are misaligned or the print results are not uniform, adjust the position of the Print head.

Automatic Adjustment to Straighten Lines and Colors

Check 2  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

When printing with the media type specified in the printer driver, load the specified media type in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

When printing with the media type specified in the printer driver, load the specified media type in the printer.

1. To stop printing, press the Stop button.1.

2. Change the paper type in the printer driver and try printing again.2.

Note
• When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media•

type loaded in the printer.

• Click Get Information to reflect the paper information set in the printer to the printer driver.•

Printing with Easy Setup

Check 3  When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

Select the correct media type in the touch screen menu when loading paper in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

Check 4  Is the Roll Paper loaded at an angle?

If there is a gap between the roll paper and the roll holder, reload the roll paper.
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Loading Rolls in the Printer

Check 5  Is Detect paper width set to Disable?

Set Detect paper width in the touch screen menu to Enable to load the paper.

Advanced (Paper settings)

Check 6  Is Skew detection accuracy in the touch screen menu set to Loose or OFF?

Set Skew detection accuracy to Standard, and then reload the paper.

Advanced (Paper settings)

Check 7  If you are using rolls, are you using the recommended paper and
recommended environment?

Using rolls or environments other than those recommended, may result in increased curl and rubbing of the print
head. Use the recommended paper and recommended environment.

List of paper settings (roll paper)

Check 8  Colors in printed images may be uneven if the Print Quality setting is too low

If using Windows, select Advanced Settings from the Main tab of the printer driver, and then select a higher
Print Quality setting.

If using macOS, select Quality & Media in the printer driver, and then select a higher Print Quality setting.

Changing the Print Quality and Correcting Image Data (Windows)
Changing the Print Quality and Correcting Image Data (macOS)

Check 9  Is Unidirectional printing set to Disable?

Using the Unidirectional printing function may reduce the shift of ruled lines. Follow the steps below for
unidirectional printing.

• Windows•

Open Paper Detailed Settings from the Main tab of the printer driver, and then select Unidirectional
Printing.

Description of the Main sheet screen

• macOS•

Open Advanced Paper Settings in the printer driver, and then select Unidirectional Printing.

Advanced Paper Settings

Important
• If any of the following conditions are met in the printer driver settings, the unidirectional printing function•

setting will be disabled.

The Banner Printing check box is checked.
The paper length exceeds 78.7 in. (2000.0 mm).
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The length of the printed image in the paper ejection direction is
not accurate

Check 1  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

When printing with the media type specified in the printer driver, load the specified media type in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

When printing with the media type specified in the printer driver, load the specified media type in the printer.

1. To stop printing, press the Stop button.1.

2. Change the paper type in the printer driver and try printing again.2.

Note
• When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media•

type loaded in the printer.

• Click Get Information to reflect the paper information set in the printer to the printer driver.•

Printing with Easy Setup

Check 2  When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

Select the correct media type in the touch screen menu when loading paper in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

Check 3  Perform print quality adjustment to automatically adjust the feed amount.
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Perform Adjust print quality from Paper feed adjustment and Print alignment pattern to automatically adjust
the feed amount.

Automatically Adjusting Different Colored Horizontal Streaks

Check 4  Is Set priority for Paper feed adjustment in the touch screen menu set to
Prioritize print quality?

Set priority for Paper feed adjustment to Prioritize length accuracy, and then carry out Adjust feed length.

Automatically Adjusting Different Colored Horizontal Streaks
Adjusting Line Length
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Images are printed crooked

Check 1  Has the roll paper been loaded at an angle?

If there is a gap between the roll paper and roll holder, reload the roll on the roll holder.

Loading Rolls in the Printer

Check 2  Is Detect paper width set to Disable?

Set Detect paper width in the touch screen menu to Enable to load the paper.

Advanced (Paper settings)

Check 3  Is Skew detection accuracy in the touch screen menu set to Loose or OFF?

Set Skew detection accuracy to Standard, and then reload the paper.

Advanced (Paper settings)

Check 4  Check if the roll holder support is correctly installed.

Check that the roll holder support is installed at the proper width.

Moving the roll holder support

Also, check that the knurled screws on the roll holder supports are tightened securely.

Important
• Make sure the knurled screws are tightened until they no longer turn.•
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Margins are wide

Check 1  Is auto cut being used on printed material with a wide margin on the trailing
edge only?

Rolls are advanced a specific amount before cutting to prevent problems with cutting and paper ejection.

This operation is normal.

The specified length varies depending on the media type and the usage environment (humidity). Please refer to
the minimum printing length of the paper from paper information list.

If the length of the printed document is shorter than the minimum cut length, an extra edge margin will be added
to increase the length of the printed document to the minimum cut length.

List of paper settings (roll paper)

Check 2  Adjust the margins.

Making Margin Settings for Rolls
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Cannot Configure Network Settings

Message Appears on Computer During Setup

Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen

"Failed to connect to the wireless router." Appears

Printer Cannot Be Used After Replacing Wireless Router or Changed Router
Settings

Error Occurs During Wi-Fi Setup

Taking Time to Setup Process (Windows)
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Message Appears on Computer During Setup

Screen to Enter Password Appears During Setup (Windows)
Encryption Settings Screen Appears When Wireless Router Selected (Windows)
"You have connected the printer to the non encrypted wireless network" Appears

Screen to Enter Password Appears During Setup (Windows)

If the printer is set up for use with a network and an administrator password has been set, a screen asking
you to enter the password appears.

Enter the same password as that specified for the printer.

Note
• An administrator password is already set for the printer at the time of purchase.•

For details:

Setting Administrator Password on Operation Panel
Forgot Administrator Password of Printer

Encryption Settings Screen Appears When Wireless Router Selected
(Windows)

This screen appears automatically if the selected wireless router is encrypted. Set the same encryption
settings as those set for the wireless router.

"You have connected the printer to the non encrypted wireless
network" Appears

Security is not configured on the wireless router. The printer can still be used, so continue the setup
procedure and complete it.

Important
• If you connect to a network that is not protected with security measures, there is a risk of disclosing

data such as your personal information to a third party.
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Cannot Proceed beyond Printer Connection Screen/Connect Cable
Screen

If you cannot proceed beyond the Printer Connection screen or the Connect Cable screen, check the
following.

Check 1  Make sure USB cable is securely plugged in to printer and computer.

Connect the printer and the computer using a USB cable as the illustration below. The USB port is located at the
back side of the printer.

Check the items below only if you cannot proceed beyond the Printer Connection screen.

Check 2  Follow procedure below to connect printer and computer again.

Important
• For macOS, make sure the lock icon is on the lower left of the Printers & Scanners screen.•

If the  icon (locked) is displayed, click the icon to unlock. (The administrator name and the password
are necessary to unlock.)

1. Turn off printer.1.

2. Unplug USB cable from printer and computer and connect it again.2.

3. Turn on printer.3.

Check 3  If you cannot resolve problem, follow procedure below to reinstall printer driver.
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1. Exit setup.1.

2. Turn off printer.2.

3. Restart computer.3.

4. Make sure you have no application software running.4.

5. Refer to Setup Guide for setup.5.
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"Failed to connect to the wireless router." Appears

Each time you perform each check, select OK on the error screen to clear the error and set up the printer
again.

When Security Type is WPA/WPA2/WPA3
When Security Type is set to Disable

When Security Type is WPA/WPA2/WPA3

Check 1  Check the password entered for the wireless router is correct.

If the password you entered is incorrect, enter the correct password.

Check 2  Check the wireless router's settings.

If the wireless router's DHCP function is off, turn it on and redo the wireless connection settings.

Check 3  Check the MAC address filtering's settings.

If MAC address filtering is enabled on the wireless router, change the settings to accept the printer's MAC
address.

To check the printer's MAC address, follow these steps.

1. Select  (Information) on the HOME screen.

2. Select  System information.
3. Check the MAC address (Wi-Fi).
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Check 4  Check the wireless router's security protocol (encryption method) settings.

If the wireless router is set to communicate using the IEEE802.11n standard only and encryption is set to
TKIP, change the encryption standard to something other than TKIP or change the communication standard,
and then redo the wireless connection settings.

If the encryption standard is set to TKIP, IEEE802.11n cannot be used as the communication standard.

For details on changing the wireless router settings, see the wireless router manual or contact its
manufacturer.

When Security Type is set to Disable

Check  Is the wireless router turned on?

If it is already turned on, turn it off, and then turn it back on.

Do not proceed to the next screen of this guide until the power is turned on. The connection to the wireless
router will be temporarily disabled.
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Printer Cannot Be Used After Replacing Wireless Router or
Changed Router Settings

When you replace a wireless router, redo the network setup for the printer according to the replaced one.

See the Setup Guide and perform setup.

Note
• Wi-Fi Connection Assistant allows you to diagnose and repair the network status.•

Select the link below to download Wi-Fi Connection Assistant and install it.

Checking Printer Connection Status Using Wi-Fi Connection Assistant

If this does not solve the problem, see below.

Cannot Communicate with Printer After Enabling MAC/IP Address Filtering or Encryption Key on
Wireless Router
With Encryption On, Cannot Communicate with Printer After Changing Encryption Type at Wireless
Router

Cannot Communicate with Printer After Enabling MAC/IP Address
Filtering or Encryption Key on Wireless Router

Check 1  Check wireless router setting.

To check the wireless router setting, see the instruction manual provided with the wireless router or contact its
manufacturer. Make sure the computer and the wireless router can communicate with each other under this
setting.

Check 2  If filtering MAC addresses or IP addresses at wireless router, check
that MAC addresses or IP addresses for computer, network device, and printer are
registered.

Check 3  If using WPA/WPA2/WPA3 key or a password, make sure encryption key for
computer, network device, and printer matches key set for wireless router.

The length or format of the Wi-Fi password and authentication method must be identical among the wireless
router, the printer, and your computer.

For details, see Setting an Encryption Key.
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With Encryption On, Cannot Communicate with Printer After
Changing Encryption Type at Wireless Router

If you change the encryption type for the printer and it subsequently cannot communicate with the
computer, make sure the encryption type for the computer and the wireless router matches the type set
for the printer.
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Error Occurs During Wi-Fi Setup

Check 1  Check wireless router location

Make sure the printer is not placed far away from the wireless router.

The printer can be up to 50 m (164 ft.) from the wireless router indoors. Make sure the printer is close enough to
the wireless router to be used.

Place the printer and wireless router where there are no obstacles between them. Wireless communication
between different rooms or floors is generally poor. Wireless communication can be impeded by building
materials containing metal or concrete. If the printer cannot communicate with the computer over a Wi-Fi due to
a wall, place the printer and the computer in the same room.

In addition, if a device like a microwave oven that emits radio waves of the same frequency bandwidth as a
wireless router is nearby, it may cause interference. Place the wireless router as far away from interference
sources as possible.

Check 2  Check wireless router settings

The printer and wireless router should be connected using 2.4 GHz bandwidth. Make sure the wireless router for
the printer's destination is configured to use 2.4 GHz bandwidth.

Note
• Some wireless routers distinguish network names (SSIDs) by the last alphanumeric character according to

their bandwidth (2.4 GHz or 5 GHz) or purpose (for computer or game machine).

To check the network name (SSID) of the wireless router the printer is connected to, print the network settings.

Printing Network Settings

For details, see the instruction manual supplied with the wireless router or contact the manufacturer.

If you use an encryption key, specify it for the network name (SSID) you are using.

For details, see Setting an Encryption Key.

Note
• Pressing a button on the wireless router allows you to connect the printer and wireless router.•

WPS Connection

• For manual setup:•

WPS (PIN Code) Connection
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If the measures above do not resolve the problem, make sure the DHCP of the wireless router is enabled.
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Taking Time to Setup Process (Windows)

If Windows update starts during setup, or if you perform setup while Windows update is in progress, it may
take a while to register the printer or to perform other processes.

Wait for a while. This is not a malfunction.
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Cannot Find Printer on Network

Cannot Connect Printer to Network

Cannot Find Printer During Setup

Cannot Find Printer while Using Wi-Fi

Cannot Find Printer while Using Wired LAN

Searching Printer by IP Address or Host Name During Setup
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Cannot Connect Printer to Network

Check 1  Is the Ethernet cable connected correctly to the printer's wired LAN connector?

Make sure the printer is connected to the network with the correct Ethernet cable, and then turn the printer on.
For instructions on connecting the cable, refer to the Setup Guide.
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Cannot Find Printer During Setup

If you cannot find the printer on network during setup, check the following.

When you complete all the checking, try to set up from the beginning.

Items to check for Wi-Fi

Step 1  Check the basic items for Wi-Fi

1. Check power status1.

Are printer and network device (router, etc.) turned on?

Stop setting up, and check if the router (modem) is turned on and then check if the printer is turned on.

1. Check if network devices such as router are turned on.1.

If network devices are not turned on, turn on the power. If the network devices are on, turn them off and on again.

It may take a while for the network device to become ready for use once they are turned on.

Proceed once the network devices such as router are ready for use.

2. Check if the printer is turned on2.

If printer is not turned on, turn on the power. If the printer is on, turn them off and on again.

2. Check PC network connection2.

Can you view any web pages on your computer? Make sure the computer and network device (wireless router, etc.) are configured and the
computer is connected to the network.

If you cannot view web pages on your computer, check wireless router network connection settings, such as IP address filtering, MAC address
filtering, and DHCP function.

For more on checking the settings of the wireless router, refer to the instruction manual supplied with the wireless router or contact the
manufacturer.
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Important
• Depending on the wireless router, note that different network name (SSID) is assigned for a bandwidth (2.4 GHz or 5 GHz) or its usage (for•

PC or game machine), using alphanumeric characters at the end of network name (SSID).

Once you complete checking the wireless router, configure the network settings for your computer. For the procedures, refer to the instruction
manual supplied with the computer, or contact the manufacturer.

Once you complete setting up the wireless router and your computer, configure the settings on your computer in order to view web pages, using the
information of the wireless router.

3. Check printer's Wi-Fi settings3.

Make sure the  or  icon is displayed on the touch screen.

If icon is not displayed:

The printer is not set to enable wireless communication. Change the printer settings in order to use Wi-Fi. Turn on wireless communication on the
printer.

If  icon is displayed:

 icon indicates that the wireless router and the printer are not connected. Reconsider the locations of the wireless router and the printer.

• Checking the location of wireless router:•

After checking the wireless router setting, make sure the printer is not placed too far away from the wireless router. The printer can be up 164
ft. (50 m) from the wireless router indoors if unobstructed. Make sure the printer is close enough to the wireless router to be used.

Place the printer and wireless router where there are no obstacles between them. Wireless communication between different rooms or
floors is generally poor. Wireless communication can be impeded by building materials containing metal or concrete. If the printer cannot
communicate with the computer over a Wi-Fi due to a wall, place the printer and the computer in the same room.

In addition, if a device like a microwave oven that emits radio waves of the same frequency bandwidth as a wireless router is nearby, it may
cause interference. Place the wireless router as far away from interference sources as possible.

• Checking the location of printer:•

Make sure that the printer is not placed behind an object. The printer may not be connected when placed behind a wall or on a shelf. Try to
place the printer in a location where there is no obstacle.

For details, see the instruction manual supplied with the wireless router or contact the manufacturer.

Step 2  Solve the Problem, Using Wi-Fi Connection Assistant

Diagnose and repair the network connections using Wi-Fi Connection Assistant.

Download Wi-Fi Connection Assistant from the below page, and install it on your computer.

Checking Printer Connection Status Using Wi-Fi Connection Assistant

If you can connect to the network, try to set up from the beginning.
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Items to check for wired LAN

Step 1  Check the basic items for wired LAN

1. Check the power and LAN Cable1.

When the printer cannot be found on the setup screen, using wired LAN connection setup, make sure that all the network devices are connected
with the router and the hub via LAN cables and that all the devices are turned on.

If LAN cable is not connected:

Connect the router, hub, computer and printer via LAN cables.

Make sure the printer is turned on.

Make sure the printer is turned on, and make sure that the router and the hub are turned on.

If LAN cable is connected, and printer and network device are off:

Turn on printer or network device.

If LAN cable is connected, and printer and network device are on:

If they are on, turn them off and on again.

Note
• It may take a while for the printer and network device to become ready for use once they are turned on again. After turning it on, wait for a•

while and proceed.

2. Check PC network connection2.

Can you view any web pages on your computer? Make sure the computer and network device (router, etc.) are configured and the computer is
connected to the network.

If you cannot view web pages, unplug the cable connected to the router's WAN side. Connect the cable directly to the computer to see if you can
view web pages on the Internet.

Check the settings for the router if you were able to view web pages. For details on checking the settings of the router, refer to the instruction
manual supplied with the router or contact the manufacturer. Refer also to the instruction manual regarding the connection of the provider.

Once you complete checking the router, configure the network settings of your computer. For the procedures, refer to the instruction manual
supplied with the computer, or contact the manufacturer.

Once you complete setting up the router and your computer, configure the settings on your computer to view web pages, using the information of
the router.

Proceed once you can view web pages on your computer.

3. Check printer's wired LAN settings3.

Make sure the  icon is displayed on the touch screen.

If icon is not displayed:

The printer is not set to enable wired communication. Change the printer settings in order to use wired LAN.

When you complete checking [Step 1] above, try to set up from the beginning.

If the printer cannot be detected after trying to set up from the beginning, proceed to [Step 2].

Step 2  Solve the Problem, Using Wi-Fi Connection Assistant
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Diagnose and repair the network connections using Wi-Fi Connection Assistant.

Download Wi-Fi Connection Assistant from the below page, and install it on your computer.

Checking Printer Connection Status Using Wi-Fi Connection Assistant

If you can connect to the network, try to set up from the beginning.
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Cannot Find Printer while Using Wi-Fi

Check 1  Make sure printer is turned on.

If not, make sure the printer is securely plugged in and press ON button to turn on.

The ON lamp flashes while the printer is initializing. Wait until the ON lamp stops flashing and remains lit.

Check 2  Check the network status on the touch screen.

If the  icon is displayed, or only the  icon is displayed, Wi-Fi is disabled.

Set Enable/disable Wi-Fi in the touch screen menu to Enable.

If the  icon is displayed, see Check 3 or later checking items to make sure whether printer setup is
complete or the settings of wireless router to connect are correct.

Check 3  Make sure printer setup is complete on the computer.

If it is not, perform setup.

• For Windows:•

Perform setup using the Setup CD-ROM or from Setup Guide.

• For macOS:•

Perform setup from Setup Guide.

Note
• Wi-Fi Connection Assistant allows you to diagnose and repair the network status.•

Select the link below to download Wi-Fi Connection Assistant and install it.

Checking Printer Connection Status Using Wi-Fi Connection Assistant

Check 4  Make sure printer and wireless router network settings match.

Make sure the network settings of the printer (e.g. wireless router name, SSID, network key, etc.) are identical
with those of the wireless router.

To check the settings of the wireless router, refer to the instruction manual provided with it or contact its
manufacturer.

Note
• Use 2.4 GHz frequency band to connect to a wireless router. Match the SSID set for the printer with that for

2.4 GHz frequency band of the wireless router.
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To check the SSID set for the printer, print out the network setting information or use the operation panel to
display it.

• Display on the touch screen.•

LAN settings

• Print the network settings.•

Printing Network Settings

Note
• Wi-Fi Connection Assistant allows you to diagnose and repair the network status.•

Select the link below to download Wi-Fi Connection Assistant and install it.

Checking Printer Connection Status Using Wi-Fi Connection Assistant

Check 5  Make sure the printer is not placed too far away from the wireless router.

If the distance between the printer and wireless router is too far, wireless communication becomes poor. Place
the printer and wireless router close to each other.

Note
• Though an antenna is attached to most wireless routers, note that some of them have it inside.

Check 6  Make sure wireless signal is strong. Monitor signal strength and move printer
and wireless router as necessary.

Place the printer and wireless router where there are no obstacles between them. Wireless communication
between different rooms or floors is generally poor. Wireless communication can be impeded by building
materials containing metal or concrete. If the printer cannot communicate with the computer over a Wi-Fi due to
a wall, place the printer and the computer in the same room.

In addition, if a device like a microwave oven that emits radio waves of the same frequency bandwidth as a
wireless router is nearby, it may cause interference. Place the wireless router as far away from interference
sources as possible.

Note
• Wi-Fi Connection Assistant allows you to diagnose and repair the network status.•

Select the link below to download Wi-Fi Connection Assistant and install it.

Checking Printer Connection Status Using Wi-Fi Connection Assistant

Check 7  Make sure the computer is connected to the wireless router.

For more on how to check the computer settings or connection status, see your computer instruction manual or
contact its manufacturer.

Note
• If you use a smartphone or tablet, make sure the Wi-Fi is enabled on the device.

Check 8  Make sure Enable bidirectional support is selected in the Ports sheet of the
properties dialog box of the printer driver. (Windows)
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If not, select it to enable bidirectional support.

Check 9  Make sure security software's firewall is off.

If your security software's firewall is on, a message may appear warning you that Canon software is attempting
to access the network. If this warning message appears, set security software to always allow access.

If you are using any programs that switch between network environments, check their settings.

Check 10  If printer is connected to an AirPort Base Station via LAN, make sure you use
alphanumeric characters for network identifier (SSID). (macOS)

If the problem is not resolved, redo setup.

• For Windows:•

Perform setup using the Setup CD-ROM or from Setup Guide.

• For macOS:•

Perform setup from Setup Guide.
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Cannot Find Printer while Using Wired LAN

Check 1  Make sure printer is turned on.

If not, make sure the printer is securely plugged in and press ON button to turn on.

The ON lamp flashes while the printer is initializing. Wait until the ON lamp stops flashing and remains lit.

Check 2  Make sure LAN cable is connected properly.

Make sure the printer is connected to the router with the LAN cable. If the LAN cable is loose, connect the cable
properly.

If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN side of the router.

Check 3  Is  icon displayed on touch screen?

If the icon is not displayed, wired LAN is disabled.

Select the network icon on the HOME screen, and select Wired LAN > Enable/disable Wired LAN > Enable.
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Searching Printer by IP Address or Host Name During Setup

If the printer cannot be found on the Select Printer screen, search for the printer by an IP address or
host name. Click Search By IP Address on the screen which appears by clicking Printer Not Found. The
screen to select searching criteria appears.

1. Check printer's IP address or host name.1.

To check the printer's IP Address or host name, print out the network settings information or use the
touch screen to display it.

• Display on the touch screen.•

LAN settings

• Print the network settings.•

Printing Network Settings

Note
• If you use the printer in an office, ask the network administrator.

2. Specify searching method.2.

Select one of the methods below.

A: Search by IPv4 address
Select to search for printers by IPv4 address.

B: Search by IPv6 address
Select to search for printers by IPv6 address.
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C: Search by host name
Select to search for printers by host name. A host name is referred to as LLMNR host name or
Bonjour name.

3. Enter IP address or host name and click Next.3.

Printer search starts.

If an error screen appears:
Resolve the error according to the instruction on the screen.

If the IP address you entered is already used for another device, follow the procedure below to specify
printer's IP address.

1. On the HOME screen, select the Network icon.1.

Depending on the current LAN status, the icon displayed on the button may differ.

Home Screen Menu Composition

If you specify the administrator password, enter the password.

2. Select Wi-Fi.2.

3. Select Advanced.3.

4. Select TCP/IP settings.4.

• If you specify IPv4 address:•

1. Select IPv4.1.

2. Select Yes on the displayed screen.2.

3. Select IP address.3.

4. Select Manual setup.4.

Selecting Auto setup specifies the IP address automatically.
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5. Enter IP address.5.

6. Select OK.6.

7. Enter subnet mask.7.

8. Select OK.8.

9. Enter default gateway.9.

10. Select OK.10.

The IPv4 address has been specified.

• If you specify IPv6 address:•

1. Select IPv6.1.

2. Select Yes on the displayed screen.2.

3. Select Enable/disable IPv6.3.

4. Select Enable.4.

The IPv6 address has been specified.

Important
• If firewall is enabled on the computer, printers on a different subnet may not be detected.

Disable firewall.

If firewall interferes with printer search:

• If a firewall message appears:•

If a firewall message appears warning that Canon software is attempting to access the network, set
the security software to allow access.

After allowing the software to access, specify the IP address or host name and search for printers
again.

If the printer is found, follow the instructions on the screen to continue to set up the network
communication.

• If no firewall message appears:•

Temporarily disable the firewall and specify the IP address or host name to search for printers again.

After the setup is complete, re-enable the firewall.
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Note
• For more on firewall settings of your operating system or security software, see instruction manual or

contact its manufacturer.
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Cannot Print over Network

Cannot Print over TCP/IP Network

Cannot Print over Bonjour networks

Cannot Print Using AirPrint
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Cannot Print over TCP/IP Network

Check 1  Is the printer's IP address configured correctly?

Make sure the printer's IP address is configured correctly.

Note
• For Windows, you can configure the printer's IP address using Wi-Fi Connection Assistant.•

For details, refer to "Performing/Changing Network Settings" > "Performing Network Settings" in Wi-Fi
Connection Assistant Guide.

Wi-Fi Connection Assistant Guide

Check 2  Are the printer's TCP/IP network settings configured correctly?

Make sure the printer's TCP/IP network settings are configured correctly.

Check 3  Is the computer you are trying to print from configured correctly?

Make sure the computer's TCP/IP network settings are configured correctly.
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Cannot Print over Bonjour networks

Check 1  Is the computer you are trying to print from configured correctly?

Make sure the computer is configured correctly.

Check 2  Are the computer and printer on the same network?

Due to the nature of Bonjour, printing may not be possible if the printer is on another network behind a router.
Make sure the computer and printer are on the same network. For information about network settings, ask your
network administrator.

Check 3  Are the printer's Bonjour settings configured correctly?

Make sure the Bonjour settings are configured correctly.
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Cannot Print Using AirPrint

Check 1  Make sure printer is turned on.

If the printer is turned on, turn it off and back on, and then check whether the issue is resolved.

Check 2  Make sure printer is registered to your computer.

Check 3  Make sure printer is connected by LAN to same network subnet as AirPrint
compliant device when printing over LAN.

Check 4  Make sure printer has enough paper and ink.

Check 5  Make sure no error message is displayed on printer's touch screen.
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Network Connection Problems

Network Settings and Common Problems

Cannot Connect to the Printer

Network Key (Password) Unknown

Forgot Administrator Password of Printer

Checking Network Information

Restoring to Factory Defaults

Cannot Access to Internet on Wi-Fi from Communication Device
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Network Settings and Common Problems

Here are frequently asked questions on network.

Cannot Find Printer

Cannot Find Printer During Setup
Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen
Searching Printer by IP Address or Host Name During Setup
Cannot Find Printer while Using Wi-Fi
Cannot Find Printer while Using Wired LAN
Cannot Print Using AirPrint

Cannot Print or Connect

Cannot Connect Printer to Network
Cannot Print over TCP/IP Network
Cannot Print over Bonjour networks
Cannot Connect to the Printer

LAN Setting Tips/Changing LAN Settings

Printer Connection Methods
Default Network Settings
Another Printer Found with Same Name
Printing Network Settings
Network Status and Troubleshooting
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Cannot Connect to the Printer

Cannot Connect to a Printer after Network Configuration Changes
Cannot Connect to a Printer via Wi-Fi
Cannot Connect to a Printer through Wireless Direct
Cannot Connect to a Printer via Wired LAN
Cannot Print through Network

Cannot Connect to a Printer after Network Configuration Changes

It may take a while for the computer to obtain an IP address, or you may need to restart your computer.

Make sure the computer has obtained a valid IP address, and try again to find the printer.

Cannot Connect to a Printer via Wi-Fi

Check 1  Check the power status of printer and devices (e.g. wireless router or
computer) connected to the network.

Turn on the printer or devices.

If the power is already turned on, turn it off and on again.

It may be necessary to resolve wireless router problems (e.g. update interval of a key, problems of DHCP
update interval, energy saving mode, etc.) or to update the wireless router firmware.

For details, contact the manufacturer of your wireless router.

Check 2  Can you view any web pages on your computer?

Make sure your computer is connected to the wireless router properly.

For more on checking computer settings or connection status, see the instruction manual supplied with the
computer or contact the manufacturer.

Check 3  Is the printer connected to the wireless router?

Use the icon on the touch screen to check the connection status between the printer and wireless router. If the

 icon is not displayed, Wi-Fi is disabled. Turn on wireless communication on the printer.

Check 4  Make sure the printer and wireless router network settings match.

Make sure the network settings of the printer (e.g. wireless router name, SSID, network key, etc.) are identical
with those of the wireless router.
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To check the settings of the wireless router, refer to the instruction manual provided with it or contact its
manufacturer.

To check the current network settings of the printer, print out the network setting information.

Printing Network Settings

Note
• Wi-Fi Connection Assistant allows you to diagnose and repair the network status.•

Select the link below to download Wi-Fi Connection Assistant and install it.

Checking Printer Connection Status Using Wi-Fi Connection Assistant

Check 5  Make sure the printer is not placed too far away from the wireless router.

If the distance between the printer and wireless router is too far, wireless communication becomes poor. Place
the printer and wireless router close to each other.

Note
• Though an antenna is attached to most wireless routers, note that some of them have it inside.

Check 6  Make sure wireless signal is strong. Monitor signal status and move printer
and wireless router as necessary.

Place the printer and wireless router where there are no obstacles between them. Wireless communication
between different rooms or floors is generally poor. Wireless communication can be impeded by building
materials containing metal or concrete. If the printer cannot communicate with the computer over a Wi-Fi due
to a wall, place the printer and the computer in the same room.

In addition, if a device like a microwave oven that emits radio waves of the same frequency bandwidth as a
wireless router is nearby, it may cause interference. Place the wireless router as far away from interference
sources as possible.

Note
• Wi-Fi Connection Assistant allows you to diagnose and repair the network status.•

Select the link below to download Wi-Fi Connection Assistant and install it.

Checking Printer Connection Status Using Wi-Fi Connection Assistant

Check 7  Make sure of the Wi-Fi channel numbers used for your computer.

You need to have the same Wi-Fi channel number that you are using for the wireless router as your computer.
It is normally set in the way that you can use all the Wi-Fi channels. However, when the channels that you are
using are restricted, the Wi-Fi channels do not match.

See the instruction manual provided with your computer and check the Wi-Fi channel number available for
your computer.

Check 8  Make sure channel set on wireless router is a usable channel as confirmed in
Check 7.

If it is not, change the channel set on the wireless router.
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Check 9  Make sure security software's firewall is off.

If your security software's firewall is on, a message may appear warning you that Canon software is attempting
to access the network. If this warning message appears, set security software to always allow access.

If you are using any programs that switch between network environments, check their settings.

Check 10  If printer is connected to an AirPort Base Station via LAN, make sure you
use alphanumeric characters for network identifier (SSID). (macOS)

If the problem is not resolved, redo setup.

• For Windows:•

Perform setup using the Setup CD-ROM or from Setup Guide.

• For macOS:•

Perform setup from Setup Guide.

Cannot Connect to a Printer through Wireless Direct

Check 1  Check the power status of printer and other devices (smartphone or tablet).

Turn on the printer or devices.

If the power is already turned on, turn it off and on again.

Check 2  Is the  icon displayed on the touch screen?

If not, Wireless Direct is disabled. Turn on Wireless Direct.

Check 3  Check the settings of your device (smartphone/tablet).

Make sure Wi-Fi is enabled on your device.

For details, refer to your device's instruction manual.

Check 4  Make sure printer is selected as connection for device (e.g. smartphone or
tablet).

Select the identifier for Wireless Direct (SSID) specified for the printer as the connection destination for
devices.

Check the destination on your device.

For details, refer to your device's instruction manual or visit the manufacturer's website.

To check the identifier for wireless direct (SSID) specified for the printer, display it using the operation panel of
the printer or print out the network setting information of the printer.

• Display on the touch screen.•
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LAN settings

• Print the network settings.•

Printing Network Settings

Check 5  Have you entered the proper password specified for the Wireless Direct?

To check the password specified for the printer, display it using the operation panel of the printer or print out
the network setting information of the printer.

• Display on the touch screen.•

LAN settings

• Print the network settings.•

Printing Network Settings

Check 6  Make sure the printer is not placed too far away from the device.

If the distance between the printer and device is too far, wireless communication becomes poor. Place the
printer and device close to each other.

Check 7  Make sure 5 devices are already connected.

Wireless Direct does not allow more than 5 devices to be connected.

Cannot Connect to a Printer via Wired LAN

Check 1  Make sure the printer is turned on.

Check 2  Make sure the LAN cable is connected properly.

Make sure the printer is connected to the router with the LAN cable. If the LAN cable is loose, connect the
cable properly.

If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN side of the router.

If the problem is not resolved, redo setup.

• For Windows:•

Perform setup using the Setup CD-ROM or from Setup Guide.

• For macOS:•

Perform setup from Setup Guide.
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Cannot Print through Network

Check 1  Make sure the computer is connected to the wireless router.

For more on how to check the computer settings or connection status, see your computer instruction manual
or contact its manufacturer.

Check 2  If the printer driver is not installed, install it. (Windows)

Install the printer driver using the Setup CD-ROM or install it from Setup Guide.

Check 3  When using Wi-Fi, make sure wireless router does not restrict which
computers can access it.

For more on connecting to and setting up your wireless router, see the wireless router instruction manual or
contact its manufacturer.
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Network Key (Password) Unknown

Note
• Wi-Fi Connection Assistant allows you to diagnose and repair the network status. Download it from the•

web page.

For Windows
For macOS

If the problem persists after diagnosis and repair with Wi-Fi Connection Assistant, check the following items.

WPA/WPA2/WPA3 Key Set for Wireless Router Unknown, Cannot Connect
Setting an Encryption Key

WPA/WPA2/WPA3 Key Set for Wireless Router Unknown, Cannot
Connect

For more on setting up a wireless router, see the instruction manual provided with the wireless router or
contact its manufacturer. Make sure your computer can communicate with the wireless router.

Setting an Encryption Key

For more on setting up a wireless router, see the instruction manual provided with the wireless router or
contact its manufacturer. Make sure your computer can communicate with the wireless router.

Selecting WPA, WPA2, or WPA2/WPA3 is recommended for security reason. If your wireless router is
compatible with WPA2/WPA3, you can also use WPA2 or WPA3.

• Using WPA/WPA2/WPA3 (Windows)•

The authentication method, Wi-Fi password, and dynamic encryption type must be identical among
the wireless router, the printer, and your computer.

Enter the Wi-Fi password configured on the wireless router.

Either TKIP (basic encryption) or AES (secure encryption) is selected automatically as the dynamic
encryption method.

For details, see If WPA/WPA2 Details Screen Appears.

Note
• See the product specifications for supported authentication types.

Network Specifications
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Note
• If the printer is connected to an AirPort Base Station via LAN:•

If the printer is connected to an AirPort Base Station via a LAN, check the settings in Wireless
Security of AirPort Utility.

Select 1 for the password to use. Otherwise, computer will not be able to communicate with
printer via the wireless router.
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Forgot Administrator Password of Printer

Select  (Setup) on HOME screen > Printer settings > Reset settings > Reset all, in order to
restore to default administrator password.

Reset settings

After initializing the printer settings, redo setup.

Setup Guide
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Checking Network Information

Checking Printer IP Address or MAC Address
Checking Computer IP Address or MAC Address
Checking Communication Between the Computer, the Printer, and the Wireless Router
Checking Network Setting Information

Checking Printer IP Address or MAC Address

To check the printer's IP Address or MAC address, print out the network settings information or use the
operation panel to display it.

• Display on the touch screen.•

LAN settings

• Print the network settings.•

Printing Network Settings

For Windows, you can check the network setting information on the computer screen.

Canon Wi-Fi Connection Assistant Screen

Checking Computer IP Address or MAC Address

To check the IP Address or MAC address of your computer, follow the instructions below.

• For Windows:•

1. Select Command Prompt from Start.1.

2. Enter "ipconfig/all" and press Enter.2.

The IP address and MAC address of your computer appear. If your computer is not connected to a
network, the IP address does not appear.

• For macOS:•

1. Select System Preferences from Apple menu, and then click Network.1.

2. Make sure network interface used by computer is selected, and then click Advanced.2.

Make sure Wi-Fi is selected as network interface.

3. Click TCP/IP to check the IP address, or click Hardware to check the MAC address.3.
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Checking Communication Between the Computer, the Printer, and the
Wireless Router

Perform a ping test to check if communication is taking place.

• For Windows:•

1. Select Command Prompt from Start.1.

2. Type the ping command and press Enter.2.

The ping command is as follows: ping XXX.XXX.XXX.XXX

"XXX.XXX.XXX.XXX" is the IP address of the target device.

If communication is taking place, a message like the one shown below appears.

Reply from XXX.XXX.XXX.XXX: bytes=32 time=10ms TTL=255

If Request timed out appears, communication is not taking place.

• For macOS:•

1. Start Network Utility as shown below.1.

Select Computer from Go menu of Finder, double-click Macintosh HD > System > Library >
CoreServices > Applications > Network Utility.

2. Click Ping.2.

3. Make sure Send only XX pings (XX are numbers) is selected.3.

4. Enter IP address of target printer or target wireless router in Enter the network4.
address to ping.

5. Click Ping.5.

"XXX.XXX.XXX.XXX" is the IP address of the target device.

A message such as the following appears.

64 bytes from XXX.XXX.XXX.XXX: icmp_seq=0 ttl=64 time=3.394 ms

64 bytes from XXX.XXX.XXX.XXX: icmp_seq=1 ttl=64 time=1.786 ms

64 bytes from XXX.XXX.XXX.XXX: icmp_seq=2 ttl=64 time=1.739 ms

--- XXX.XXX.XXX.XXX ping statistics ---

3 packets transmitted, 3 packets received, 0% packet loss

If "100% packet loss" appears, communication is not taking place. Otherwise, computer is
communicating with target device.
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Checking Network Setting Information

To check the printer's network settings information, print out the network settings information or use the
operation panel to display it.

• Display on the touch screen.•

LAN settings

• Print the network settings.•

Printing Network Settings
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Restoring to Factory Defaults

Important
• Initialization erases all network settings on the printer, making printing operation from a computer over•

a network impossible. To use the printer over a network again after restoring it to the factory defaults,
refer to Setup Guide and redo setup.

• LCD, Remote UI, and other tools is set as the scope for the administrator password, the administrator•
password must be entered.

Initialize the network setting using the printer's operation panel.

Reset settings
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Cannot Access to Internet on Wi-Fi from Communication Device

Check 1  Is your device connected to printer using Wireless Direct?

If your device is connected to the printer using Wireless Direct, you cannot access to the Internet. Turn off
Wireless Direct and connect your device to the wireless router.

For details, see the instruction manual provided with your device and wireless router.

Check 2  Is wireless router on?

Check 3  Is wireless router configured properly?

For more on checking wireless router settings, see the instruction manual provided with the wireless router or
contact its manufacturer.

Check 4  Check your device and wireless router location.

Check the distance between your device and wireless router, and check for obstruction or source of radio wave
interference nearby.
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Printer Problems

Printer Does Not Turn On

USB Connection Problems

Cannot Communicate with Printer via USB

Touch Screen Is Off

Messages advising to check the maintenance cartridge are not cleared

If the Printer Makes a Strange Sound
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Printer Does Not Turn On

Check 1  Press ON button.

Check 2  Make sure power plug is securely connected to printer, and then turn on again.

Check 3  Unplug printer, leave it for at least 2 minutes, and then plug it back in and turn
on again.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Repairing Your Printer

Important
• Do not tilt the printer when moving it since the ink may leak out.
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USB Connection Problems

Make sure of the checking item below when you find one of the followings.

• Printing is slow.
• Hi-Speed USB connection does not work.
• A message such as "This device can perform faster" appears. (Windows)

Note
• If your system environment does not support Hi-Speed USB, the printer operates at the slower speed

of Full-Speed or Low-Speed. In this case, the printer works properly but printing speed may slow down
due to the communication speed.

Check  Check following to make sure your system environment supports Hi-Speed USB
connection.

• Does the USB port on your computer support Hi-Speed USB connection?•

• Does the USB cable or the USB hub support Hi-Speed USB connection?•

Be sure to use a certified Hi-Speed USB cable. We recommend that the USB cable be no longer than 10
feet / 3 meters or so.

• Is the Hi-Speed USB driver working properly on your computer?•

Make sure the latest Hi-Speed USB driver is working properly and obtain and install the latest version of the
Hi-Speed USB driver for your computer, if necessary.

Important
• For more information, contact the manufacturer of your computer, USB cable, or USB hub.•
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Cannot Communicate with Printer via USB

Check 1  Make sure printer is turned on.

Check 2  Connect USB cable properly.

As the illustration below, the USB port is at the back of the printer.

Important
• Check the orientation of the "Type-B" connector and connect to the printer.

Check 3  Make sure Enable bidirectional support is selected in the Ports sheet of the
Printer properties dialog box. (Windows)

If not, select it to enable bidirectional support.

Opening Printer Driver's Setup Screen
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Touch Screen Is Off

• If ON lamp is off:•

The printer is not on. Check that the power cord is connected and press the ON button.

• If ON lamp is lit:•

The touch screen may be in screen-saver mode. Press any button on the operation panel.

504



Messages advising to check the maintenance cartridge are not
cleared

The newly replaced maintenance cartridge is not recognized.

Remove the newly replaced maintenance cartridge, and then reinsert it again firmly.

Replacing the Maintenance Cartridge
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If the Printer Makes a Strange Sound

Check 1  Has an unusual noise been produced from the vicinity of the roll holder?

If dust accumulates on the gear (A) at the end of the roll holder, a noise may be produced from that area.

When the noise starts, clean the gear with the following procedure.

1. Remove the roll holder from the printer.1.

2. Wipe the dust off the gear with a damp, tightly wrung cloth, and then dry with a dry cloth.2.

3. Insert the roll holder in the printer.3.

Check 2  Operating noise may be heard from the printer even when not printing.

The following sounds do not indicate a problem with the printer.

• Roll paper makes a fluttering sound during printing.•

There may be a fluttering sound when large paper is advanced.

• You suddenly hear the sound of cleaning operations.•

Cleaning is automatically performed at specified intervals in order to keep the printer maintained.

• You suddenly hear the sound of ink agitation.•

In other cases, contact your Canon dealer.
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Printing Problems

Printing Stops

Printer Prints Slowly

Part of Page Is Not Printed (Windows)
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Printing Stops

Check 1  Is paper loaded in the printer?

Make sure paper is loaded.

If necessary, load paper.

Check 2  Do documents to be printed have many photographs or illustrations?

It takes time for the printer and the computer to process large data such as photos or other graphics, so it may
seem that the printer is not working.

Also, if you are printing data that requires a lot of ink on successive sheets of plain paper, the printer may pause
temporarily. In either case, wait until the process is complete.

Note
• If you are printing a document with a large printing area or printing several copies, printing may pause to•

allow the ink to dry.

Check 3  Has printer been printing continuously for a long period?

If the printer has been printing continuously for a long time, the print head or other parts around it may overheat.
The printer may stop printing at a line break for a period of time and then resume printing.

In this case, wait a while without doing anything. If the printing does not resume, turn the printer off. After waiting
for a while, turn on the printer, and check whether printing is possible.

Caution
• Print head and surrounding area can become extremely hot. Never touch print head or nearby•

components.
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Printer Prints Slowly

Check 1  Printer may be printing a large job from another computer.

Check 2  When using Wi-Fi, make sure the printer is not placed too far away from the
wireless router.

Place the printer and wireless router where there are no obstacles between them. Wireless communication
between different rooms or floors is generally poor. Wireless communication can be impeded by building
materials containing metal or concrete. If the printer cannot communicate with the computer over a Wi-Fi due to
a wall, place the printer and the computer in the same room.

In addition, if a device like a microwave oven that emits radio waves of the same frequency bandwidth as a
wireless router is nearby, it may cause interference. Place the wireless router as far away from interference
sources as possible.

Check 3  Make sure wireless signal is strong. Monitor signal status and move printer and
wireless router as necessary.

Check the signal strength on the touch screen.

Home Screen Menu Composition
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Paper is not Fed or Ejected Properly

Remove Jammed Roll Paper

Remove a Jammed Sheet

Remove Jammed Paper (Paper Feed Slot)

Roll paper cannot be inserted into the Paper Feed Slot

Printer Does Not Pick up or Feed the Paper/"No Paper" Error

Roll Paper Remains/Lacks under Quantity Management

The printer ejects blank, unprinted paper

When printing on roll paper, the printed surface becomes scratched

510



Remove Jammed Roll Paper

If roll paper jams, follow the steps below to remove jams.

1. Positioning your hands as shown, open the cut sheet feed cover.1.

2. Open the roll paper feed cover by unlocking it with the lever in the position shown in the2.
figure.

3. Cut loaded roll paper with regular scissors or the like.3.

Before cutting, loose the roll paper and lift it up.

Caution
• When cutting paper, be careful to avoid injury or damage to the printer.
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4. Open the left and right access covers and move the carriage to the left or right side4.
manually, away from the jam.

Important
• Do not move the carriage over jammed paper. This may damage the print head.
• Do not touch the linear scale (A) or carriage rail (B). This may stain your hands and damage the

printer.

5. Remove the jammed paper from the output tray.5.
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6. If there is paper left on the platen, slacken the paper on the platen and wind it up.6.

7. After rolling up all the paper, remove it from the platen.7.

After removing the paper from the platen, check for any remaining pieces of paper.
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8. Close the left and right access covers.8.

9. Close the roll paper feed cover and cut sheet feed cover.9.
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Remove a Jammed Sheet

If a sheet jams, follow the steps below to remove it.

1. Remove jammed paper.1.

• If the paper is jammed by the paper feed slot•

Remove the jammed paper from the paper feed slot.

After removing the paper, make sure there are no other scraps of paper in the printer.

• If the paper is jammed by the ejection guide•

Remove the jammed paper from the output tray.

After removing the paper, make sure there are no other scraps of paper in the printer.

• If the paper cannot be pulled through by any of the solutions above, try the following.•

1. Open the left and right access covers and move the carriage to the left or right side1.
manually, away from the jam.
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Important
• Do not move the carriage over jammed paper. This may damage the print head.
• Do not touch the linear scale (A) or carriage rail (B). This may stain your hands and•

damage the printer.

2. Remove the jammed paper from the paper feed slot and output tray again.2.

After removing the paper, make sure there are no other scraps of paper in the printer.

3. Close the left and right access covers.3.
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Remove Jammed Paper (Paper Feed Slot)

Follow these steps to remove any scraps left in the paper feed slot after you clear jammed sheets or roll
paper.

1. Positioning your hands as shown, open the cut sheet feed cover.1.

2. Open the roll paper feed cover by unlocking it with the lever in the position shown in the2.
figure.

3. Fold an A4 sheet lengthwise four times, insert it through the gap of the paper feed slot, and3.
scrape the jammed paper to the paper feed slot side.

4. Remove scrap when it is pushed out onto the paper feed slot.4.
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5. If any scraps remain inside paper feed slot, repeat steps 3 and 4.5.

6. Holding it at the positions indicated, close the roll paper feed cover and cut sheet feed6.
cover.
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Roll paper cannot be inserted into the Paper Feed Slot

Check 1  Is the roll paper curled?

Straighten out curls and reload the roll.

Check 2  Is paper jammed in the feed slot?

Remove the jammed paper.

Remove Jammed Roll Paper
Remove a Jammed Sheet

Check 3  Check the paper information on the HOME screen.

Select the paper setting display area on the HOME screen of the touch screen, and if "Roll" is not displayed,
select Replace paper or Load roll paper from the Roll paper settings screen, and then load the roll paper.

Check 4  The leading edge of the roll paper may not be cut properly.

If the leading edge of the roll paper is crooked or folded, the paper may not be fed correctly. Cut the leading
edge with scissors to straighten it.
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Printer Does Not Pick up or Feed the Paper/"No Paper" Error

Check 1  Make sure paper is loaded in the printer.

Loading Rolls in the Printer
Loading Sheets in the Printer

Check 2  When loading sheets, be sure to load the paper with the following precautions.

• When loading two or more sheets of paper, align the edges of the sheets before loading the paper.•

• When loading two or more sheets of paper, make sure the paper stack does not exceed the paper load•
limit.

However, paper may not feed correctly at the maximum capacity, depending on the type of paper or
environmental conditions (very high or low temperature and humidity). In such cases, reduce the amount of
paper you load at a time to less than half of the paper load limit.

• Always load the paper in portrait orientation, regardless of the printing orientation.•

• When you load the paper on the top feed, place the print side facing UP and align the right and left paper•
guides with the paper stack.

Loading Sheets in the Printer

Check 3  Is paper too thick or curled?

Check 4  Make sure media type and paper size settings match with loaded paper.

Check 5  Make sure that there are not any foreign objects in the top feed.

Remove any foreign objects from the top feed.

If a foreign object is inside the top feed, remove it according to the following procedure.

1. Turn off the power of the printer and disconnect the power plug from the outlet.1.

2. Fold one A4 sheet in half and insert it horizontally into the top feed.2.

Insert the paper so that your hand does not directly touch the part in the center of the top feed when
removing the foreign object.
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3. Remove foreign object by hand with paper inserted.3.

Put your hand between the paper you inserted and the top feed to remove the foreign object.

4. Remove the folded paper inserted in step 2.4.

Important
• Do not tilt the printer or do not it upside down. Doing so may cause the ink to leak.•

Check 6  Clean Paper Feed Roller.

Cleaning Paper Feed Rollers

Note
• Cleaning the paper feed roller abrades it, so do this only when necessary.•
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Roll Paper Remains/Lacks under Quantity Management

Check  Check the setting of Manage remaining roll amount.

• If Auto estimate is selected for Manage remaining roll amount:•

Make sure the media type is configured correctly.

Make sure Paper core outer diameter and Paper thickness are configured correctly for Advanced paper
settings.

Note
• Paper core outer diameter and Paper thickness must be set correctly for auto estimation to be

accurate.
• Contact the media manufacturer for paper core outer diameter and paper thickness.
• For pre-registered paper, the paper core outer diameter and paper thickness are set, but they may be

changed at the convenience of the media manufacturer.
• If you want to use paper that is not displayed in the paper information list, set the paper thickness and

paper core outer diameter in the Media Configuration Tool.
Media Configuration Tool Guide

Paper-related settings
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The printer ejects blank, unprinted paper

Check 1  The leading edge of the roll paper may have been trimmed.

The leading edge of the roll paper may be trimmed if Trim edge first is not set to Off in the touch screen menu.

Cutting the Leading Edge of Roll Paper Automatically

Check 2  Is the Print head nozzle blocked?

Print a nozzle check pattern to check the Print head status.

Checking for Nozzle Clogging

Check 3  Is the correct printer driver selected?

Print again using the correct printer driver for your printer.

If none of the above apply, there may be a printer malfunction.

Contact your Canon dealer for assistance.
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When printing on roll paper, the printed surface becomes
scratched

Make sure the roll paper has not lost tension during printing.

If the roll paper loses tension, the paper surface could be damaged and the paper could wrinkle or fold.

Set Roll paper tension (printing) to High in the touch screen menu.

Advanced (Paper settings)

Note
• Carrying out Adjust print quality is recommended when changing Roll paper tension (printing)•

settings.
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Paper Cutting Problems

Paper is not cut straight

Cutter Blade Does Not Work While Cutting Is in Progress

I want to know how to configure roll cutting

I want to configure so that the roll is cut automatically after waiting for the ink to
dry
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Paper is not cut straight

Check 1  Is the edge of the paper cutting position creased?

Straighten out any curling by the edges of the paper.

Check 2  Is the edge of the paper cutting position lifting up when cutting?

Reload the paper correctly.

Check 3  Are you using the basket properly?

Make sure that you are using the basket properly.

Using the Desktop Basket
Using the Basket on the Printer Stand

Check 4  Check that the Cut speed setting is correct.

Select  (Setup) > Printer settings > Paper-related settings on Advanced paper settings in the touch
screen menu, and change Cut speed.

If the paper edge cannot be cut straight at the cut starting position, it may be improved by selecting slower cut
speed than that selected currently.

If the paper edge cannot be cut straight at the cut ending position, it may be improved by selecting faster cut
speed than that selected currently.

Select  (Setup) > Printer settings > Paper-related settings on Advanced paper settings in the touch
screen menu, and change the Cut speed setting.

Menu Structure

Check 5  Did the printing material slip diagonally while being cut?

Set the Cutting mode in the touch screen menu to Eject cut, and then hold and cut the material after it has
printed.

Specifying the Cutting Method for Rolls
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Cutter Blade Does Not Work While Cutting Is in Progress

Check 1  Does a message appear on the touch screen?

If the cutter blade failed to cut the paper, it stops moving and a message appears on the touch screen.

Remove the paper and try printing again.

Remove Jammed Roll Paper

Check 2  Check the setting value for Cut speed.

Selecting slower value may enable the cutter blade to cut paper.

Select  (Setup) > Printer settings > Paper-related settings > Advanced paper settings on the HOME
screen of the touch screen, and change the Cut speed setting.

Menu Structure
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I want to know how to configure roll cutting

Cutting methods can be selected in the printer settings.

To automatically cut roll paper after printing, open the Cutting mode settings on the printer.

When using paper that is easily scratched, or paper where the ink requires extra time to fix, we recommend
setting Cutting mode on the printer to Eject cut.

Specifying the Cutting Method for Rolls
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I want to configure so that the roll is cut automatically after waiting
for the ink to dry

You can set an ink drying time in the printer driver.

You can also configure the same settings on the printer itself.

Specifying the Ink Drying Time
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Paper Setting Problems

Cannot detect tracing paper size

I want to know the paper types that can be used in this printer

Media Type Selection does not Match Loaded Media Type

The paper type that I want to print is not displayed on the Touch Screen
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I want to know the paper types that can be used in this printer

For information about paper that can be used with this printer, refer to the paper information list.

Paper Information List
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Media Type Selection does not Match Loaded Media Type

Check 1  Is this paper being used for the first time?

If this is the first time to use the paper, it may not be selected correctly. In the media type selection, manually
select the correct paper type.

Check 2  Is the paper you set genuine paper or recommended paper?

See Using Paper Other Than Genuine Paper and feed confirmed Paper
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The paper type that I want to print is not displayed on the Touch
Screen

If using a new paper type, start the Media Configuration Tool to get the latest media information.

Updating paper information
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Ink-related Problems

Ink Does Not Come Out

Printer consumes a lot of ink

Ink Level Detection
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Ink Does Not Come Out

Check 1  Check the remaining ink level.

Checking Ink Level

Check 2  Are the print head nozzles clogged?

Print the nozzle check pattern and make sure that the ink is coming out normally.

Checking for Nozzle Clogging
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Printer consumes a lot of ink

Check 1  Are lots of full-color materials being printed?

In print jobs such as photos, images are filled with color. This consumes a lot of ink. This does not indicate a
problem with the printer.

Check 2  Is Replace Ink in Print Head being carried out frequently?

Performing Replace Ink in Print Head uses a lot of ink. This is normal. We recommend that you only carry out
Replace Ink in Print Head after the printer has been transported, if it has not been used for a long time, or if
there is a problem with the Print head.

Check 3  You have just finished initial installation, when more ink is consumed to fill the
system.

If using the printer for the first time, or using it after transport, the ink tank will supply an initial fill of ink to the
Print head.

Although the amount of remaining ink may drop as a result, it does not indicate a problem.

Check 4  Is the Print head nozzle blocked?

Check for nozzle clogging.

Checking for Nozzle Clogging
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Ink Level Detection

The printer ink tank detects the amount of ink remaining to prevent running out of ink while printing and to
avoid printer failure.

Checking Ink Level
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About Print Settings

How do I print without borders

I want to easily create vertical or horizontal banners

Can I perform duplex printing

I want to perform enlargement printing
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How do I print without borders

This printer does not support borderless printing.
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I want to easily create vertical or horizontal banners

You can print originals that are in landscape (or portrait) orientation automatically enlarged to fit the roll
width. This is an easy way to create vertical or horizontal banners.

Printing Hanging and Horizontal Banners (Large-Format Printing) (Windows)
Printing Hanging and Horizontal Banners (Large-Format Printing) (macOS)
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Can I perform duplex printing

This printer cannot print double-sided.

An alternative to double-sided printing is to use the Folded Duplex function of the Windows software Free
Layout plus, which prints two pages on one side, folds the sheet back from the center, and hangs it.

Laying Out Documents Freely Using Free Layout plus
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I want to perform enlargement printing

Use the printer driver to adjust the original to the paper size and width, or print enlarged or reduced by
specifying a magnification factor.

Performing Enlarged/Reduced Printing (Windows)
Performing Enlarged/Reduced Printing (macOS)
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List of Support Code for Error

Support code appears on the printer's touch screen and your computer screen when errors occur.

A "support code" is an error number, and appears along with an error message.

When an error occurs, check the support code and take the appropriate action in response.

Support Code Appears on Printer's Touch Screen and Computer Screen

• 1000 to 1ZZZ•

1000 100A 1021 1024 1026 1058

1070 1200 1201 120A 120B 1215

1220 1221 1300 1313 1317 1369

136A 136B 1401 1403 1405 140B

1434 147D 1496 1563 15A1 15A2

15A3 15B0 1643 1723 1724 1725

1726 1727     

• 2000 to 2ZZZ•

2114 2117 2123 2200 2500  

• 3000 to 3ZZZ•

3000 3252 3306 3310 3311 3312

3313 3314 3315 3316 3317 3318

3319 3413 3440 3441 3442 3443

3444 3445 3446 3447   

• 4000 to 4ZZZ•

4103 4104 4111 4801 4920 4931

495A      

• 5000 to 5ZZZ•

5100 5108 5200 5207 5700 5C02

5C30      
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• 6000 to 6ZZZ•

6000 6001 6004 6500 6503 6700

6701 6800 6801 6830 6831 6832

6833 6900 6901 6902 6910 6920

6921 6930 6931 6932 6933 6940

6941 6942 6943 6944 6945 6946

6A80 6A81 6D01    

• 7000 to 7ZZZ•

7500 7600 7700 7800   

• 8000 to 8ZZZ•

8200      

• A000 to ZZZZ•

B506 B508 B509 B50A C000 D103

D107 D108 D109    
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1000

Cause
Possible causes include the following.

• There is no paper in the top feed.
• Paper is not loaded in the top feed properly.

What to Do
Take the corresponding actions below.

• Load paper in the top feed.•

Loading Sheets in the Printer

• Align the paper guides of the top feed with both edges of the paper.•

After carrying out the above measures, select OK on the printer's touch screen to cancel the error.

Note
• To cancel printing, press the printer's Stop button.
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100A

Cause
You have attempted to print on a roll, but no roll is loaded.

What to Do
Tap OK on the touch screen, and then load the paper roll and print.

Loading Rolls in the Printer

Note
• To cancel printing, press the printer's Stop button.
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1021

Cause
The printer has received a print job longer than the amount of roll paper left.

What to Do
Tap OK on the printer's touch screen, replace the paper roll with a paper roll that is long enough to print
the print job and continue printing.

Removing the Roll from the Printer
Loading Rolls in the Printer

Note
• To cancel printing, press the printer's Stop button.
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1024

Cause
Possible causes include the following.

• Roll paper is empty.
• There is remaining roll paper, but because it could not be advanced, it could not be detected.

What to Do

• The roll paper has run out•

Follow the steps below to replace the used roll with a new roll of the same type and size.

1. Remove the roll paper.1.

Removing the Roll from the Printer

2. Load the new roll.2.

Loading Rolls in the Printer

• Feed stopped because the end of the paper roll is attached to the core with tape•

Remove the used roll paper and insert a new roll paper.

Removing the Roll from the Printer
Loading Rolls in the Printer

• Feed stopped because the remaining paper roll is too heavy•

It may be helpful to change the printing mode, which will change the paper feed timing.

If using Windows, select a higher Print Quality setting under Advanced Settings in the printer driver.

If using macOS, select Quality & Media in the printer driver, and then select a higher Print Quality
setting.

Setting the Print Quality Level (Custom) (Windows)
Setting the Print Quality Level (Custom) (macOS)

Note
• To cancel printing, press the printer's Stop button.
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1026

Cause
Roll paper is empty.

What to Do

• The roll paper has run out•

Follow the steps below to replace the used roll with a new roll of the same type and size.

1. Remove the roll paper.1.

Removing the Roll from the Printer

2. Load the new roll.2.

Loading Rolls in the Printer

• Feed stopped because the end of the paper roll is attached to the core with tape•

Remove the used roll paper and insert a new roll paper.

Removing the Roll from the Printer
Loading Rolls in the Printer

Note
• To cancel printing, press the printer's Stop button.
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1058

Cause
Roll paper has almost run out.

What to Do
Printing will continue. Replace the roll paper in the printer with one that has enough paper for printing as
soon as possible.

Removing the Roll from the Printer
Loading Rolls in the Printer

Note
• To cancel printing, press the printer's Stop button.
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1070

Cause
Paper cannot be fed because the paper feed rollers are dirty.

What to Do
Press the printer's Stop button to cancel printing.

Then perform the paper feed roller cleaning of top feed.

• From the printer's operation panel:•

Cleaning Paper Feed Rollers
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1200

Cause
Access cover is open.

What to Do
Close the access cover and wait for a while.
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1201

Cause
The ink tank cover is open.

What to Do
Close the ink tank cover.
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120A

Cause
The access cover is opened.

What to Do
Close the access cover, and wait for a while.
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120B

Cause
The roll paper feed cover is open.

What to Do
Close the roll paper feed cover.
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1215

Cause
Printer maintenance in progress.

What to Do
Complete printer maintenance.
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1220

Cause
Roll paper feed cover is open.

What to Do
Close the roll paper feed cover, select OK on the printer's touch screen to cancel the error.

Front
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1221

Cause
Roll paper feed cover is open.

What to Do
Close the roll paper feed cover, select OK on the printer's touch screen to cancel the error.

Front
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1300

Cause
Paper is jammed.

What to Do

1. Remove jammed paper.1.

Remove Jammed Roll Paper
Remove a Jammed Sheet

Note
• If you cannot pull out the paper, turn the printer back on without pulling forcibly. The paper may

be ejected automatically.
• If paper becomes jammed during printing and you need to turn off the printer to remove it, press

the printer's Stop button to stop the printing before you turn off the printer.
• If the paper tears and you cannot remove the jammed paper from the paper output slot or the•

top feed, remove the paper from inside the printer.

Remove Jammed Paper (Paper Feed Slot)

2. Reload paper and select OK on printer's touch screen.2.

The printer resumes printing. Reprint the page you were printing if it was not printed properly due to
the paper jam.

If you turned off the printer in step 1, all jobs in the print queue are canceled. Redo the printing.

Note
• When reloading the paper, make sure you are using suitable paper and loading it correctly.
• We recommend using paper sizes other than A5 to print documents with photos or graphics. A5

paper may curl and jam as it leaves the printer.

If the measures above do not solve the problem, contact your nearest Canon service center to request a
repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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1313

Cause
Paper is jammed as printer pulled in printed paper.

What to Do
Depending on where the paper is jammed, decide on the countermeasure.

• If the paper is jammed at the paper output slot:•

Remove Jammed Roll Paper
Remove a Jammed Sheet

• If the paper is jammed inside the printer:•

Remove Jammed Paper (Paper Feed Slot)
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1317

Cause
Paper loaded crooked was detected when the paper was advanced.

What to Do
Reload the paper.

Loading Rolls in the Printer
Loading Sheets in the Printer

If this error appears again even after reloading the paper roll, reinsert the roll holder so that there is no
gap between it and the paper roll.

Loading Rolls in the Printer

Important
• If this message continues to appear even after taking the steps above, or if you do not want this

message to appear, set Skew detection accuracy in the printer menu to OFF or Loose. However,
note that the paper will be printed skewed, which could cause paper jams and abnormal print results,
or dirty the platen and the reverse of the next printed sheet.
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1369

Cause
There is insufficient ink to perform cleaning.

What to Do
Select OK on the printer's touch screen to cancel the error.

Before performing cleaning, check the remaining ink level of all colors, and refill the ink as necessary.

Checking Ink Level
Refilling Ink Tanks

Note
• Since replace ink in print head consumes a lot of ink, perform it only when necessary.
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136A

Cause
Cleaning cannot be performed because the maintenance cartridge is almost full.

What to Do
To perform Cleaning, replace the maintenance cartridge.

Replacing the Maintenance Cartridge

Tap the printer's OK button.
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136B

Cause
Print head cleaning was executed continuously.

What to Do
Tap OK on the printer's touch screen.

If cleaning is to be performed continuously, allow a certain amount of time after the previous cleaning.
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1401

Cause
Print head may be damaged.

What to Do
Turn off the printer and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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1403

Cause
Print head may be damaged.

What to Do
Turn off the printer and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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1405

Cause
Print head may be damaged.

What to Do
Turn off the printer and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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140B

Cause
Print head may be damaged.

What to Do
Turn off the printer and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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1434

Cause
Print head may be damaged.

What to Do
Turn off the printer and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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147D

Cause
Print head may be damaged.

What to Do
Turn off the printer and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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1496

Cause
The maintenance cartridge cannot be recognized.

The maintenance cartridge may not be installed properly or may not be compatible with this printer.

What to Do
Remove the maintenance cartridge, and then reinstall it correctly.

Refer to Replacing the Maintenance Cartridge for details on removing and installing the maintenance
cartridge.
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1563

Cause
There may not be enough ink left.

What to Do
Check the remaining ink level and refill with the ink of the color that is running low.

Checking Ink Level
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15A1

Cause
Printer operation is not completed.

What to Do
Proceed with printer setup according to the message displayed on the printer's touch screen.

If this error occurs while operating the printer from a smartphone / tablet, complete the printer setup and
then operate again.
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15A2

Cause
There is no ink in the ink tanks.

What to Do
Fill the ink tanks with all the ink contained in the bottles included with the printer.

Refilling Ink Tanks

After filling the ink, close the tank caps and ink tank inner covers firmly and close the ink tank cover.
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15A3

Cause
Shipping tape or protective material may still be attached to carriage.

What to Do
Open both left and right access covers and make sure that shipping tape and protective material have
been removed from the carriage.

If the shipping tape or protective material is still there, remove it and close the access covers.

In the case of the first printer setup, select your printer name on the below page, and follow the
instructions.

Set Up
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15B0

Cause
There may not be enough ink left.

What to Do
Check the remaining ink level and refill the ink of the color that is running low, and then reset the
remaining ink count.

Checking Ink Level
Other printer settings
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1643

Cause
Ink may have run out.

What to Do
If printing is continued, the printer may consume a certain amount of ink to return to printable status,
therefore printing cannot be continued.

To continue printing, refill the ink tank with the corresponding color of ink until the  icon shown on the
operation panel disappears.
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1723

Cause
The maintenance cartridge is not installed.

What to Do
Install the maintenance cartridge.

Refer to Replacing the Maintenance Cartridge for details on installing the maintenance cartridge.
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1724

Cause
The currently installed maintenance cartridge cannot be used.

This printer cannot use maintenance cartridges that have been installed in other printers.

What to Do
Replace with a new maintenance cartridge.

Replacing the Maintenance Cartridge
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1725

Cause
The maintenance cartridge cannot be recognized.

The maintenance cartridge may not be installed properly or may not be compatible with this printer.

What to Do
Remove the maintenance cartridge, and then reinstall it correctly.

Refer to Replacing the Maintenance Cartridge for details on removing and installing the maintenance
cartridge.
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1726

Cause
The maintenance cartridge is full.

What to Do
Replace the maintenance cartridge.

Replacing the Maintenance Cartridge

Note
• The condition of the maintenance cartridge when this error is displayed will depend on where and•

how the printer is used.

When this message is displayed, you must replace the maintenance cartridge.
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1727

Cause
The maintenance cartridge is almost full.

What to Do
The printer will not be able to print with a full maintenance cartridge.

Tap the printer's OK button to cancel the error and then prepare a new maintenance cartridge.

For details on the maintenance cartridge, see Replacing the Maintenance Cartridge.
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2114

Cause
Paper settings specified when printing do not match the paper information for the top feed registered on
the printer.

Note
• For the appropriate combination of the paper settings specified on the printer driver and the paper•

information registered on the printer, refer to the paper information list.

Paper Information List

• For how to register paper information on the printer, refer to the following.•

Loading Sheets in the Printer
Changing the Type of Paper

If the paper settings specified when printing differ from the paper information for the top feed registered on
the printer, the following message appears on the printer's touch screen.

• Paper settings specified on the printer driver when printing:•

Paper size: A4

Media type: Plain paper

• Paper information for the top feed registered on the printer:•

Paper size: A3

Media type: Plain paper

What to Do
Select Next on the printer's touch screen to display the screen below.
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Select the appropriate action.

Note
• Depending on the settings, some of the options below may not be displayed.

Print with the loaded paper.
Select this option to print on the loaded paper with the paper settings specified when printing.

For example, when the paper size specified when printing is A4 and the paper information for the top
feed is registered as A3, select this option to print on an A3 paper loaded in the top feed with the A4
setting.

Replace the paper and print
Select this option to print after changing the paper in the top feed.

For example, when the paper size specified when printing is A4 and the paper information for the top
feed is registered as A3, select this option to print after changing the paper in the top feed with an A4
paper.

After changing the paper, the paper information registration screen for the top feed appears. Register
the paper information on the printer according to the loaded paper.

Note
• If you do not know the paper size and media type to be loaded in the top feed, press the printer's

Back button. The paper size and media type are displayed.
• For the appropriate combination of the paper settings specified on the printer driver and the•

paper information registered on the printer, refer to the paper information list.

Paper Information List

Cancel print
Cancels printing.

Select this option when you want to change the paper settings specified when printing. Change the
paper settings and try printing again.
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2117

Cause
Paper settings specified when printing do not match the paper information for the paper roll registered on
the printer.

Note
• For the appropriate combination of the paper settings specified on the printer driver and the paper•

information registered on the printer, refer to the paper information list.

Paper Information List

• For how to register paper information on the printer, refer to the following.•

Loading Sheets in the Printer
Changing the Type of Paper

If the paper settings specified when printing differs from the paper information for the paper roll registered
on the printer, the following message appears on the printer's touch screen.

• Paper settings specified on the printer driver when printing:•

Paper size: 24 in

Media type: Plain paper

• Paper information for the paper roll registered on the printer:•

Paper size: A2 Roll

Media type: Plain paper

What to Do
Select Next on the printer's touch screen to display the screen below.
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Select the appropriate action.

Note
• Depending on the settings, some of the options below may not be displayed.

Replace the paper and print
Select this option to print after replacing the paper roll.

For example, when the paper size specified when printing is 24 in Roll and the paper information for
the paper roll is registered as A2 Roll, select this option to print after replacing the paper roll with an
24 in Roll.

After replacing the paper roll, the paper information registration screen for the paper roll appears.
Register the paper information on the printer according to the loaded paper.

Note
• If you do not know the paper size and media type of the paper roll to be loaded, press the

printer's Back button. The paper size and media type are displayed.
• For the appropriate combination of the paper settings specified on the printer driver and the•

paper information registered on the printer, refer to the paper information list.

Paper Information List

Cancel print
Cancels printing.

Select this option when you want to change the paper settings specified when printing. Change the
paper settings and try printing again.
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2123

Cause
Top feed paper information registration is incomplete. Or, the paper may have been exchanged while the
printer is turned off.

What to Do
If the screen similar to the following is displayed on the printer's touch screen, the top feed paper
information registration is incomplete.

If the paper loaded in the top feed matches the paper information displayed on the printer's touch screen,
select Yes.

If they do not match, select Change and then register the correct paper information.
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2200

Cause
An internal part will need replacing soon.

What to Do
Select OK on the printer's touch screen to cancel the error.

Contact your nearest Canon service center to request a repair as soon as possible.

You cannot replace the internal parts of the printer yourself.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repair, see Repairing Your Printer.
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2500

Cause
Cause of following may have occurred failure of automatic adjustment to straighten lines and colors.

• Print head nozzles are clogged.
• Paper roll other than paper roll of 10.00 in. (254.0 mm) width or wider is loaded.
• Paper output slot is exposed to strong light.

What to Do
Select OK on the printer's touch screen to cancel the error and take the corresponding actions below.

• Check the print head condition by printing the nozzle check pattern.
• Load a paper roll at least 10.00 in. (254.0 mm) wide.
• Adjust your operating environment and/or the position of the printer so that the paper output slot is not

exposed directly to strong light.

After carrying out the above actions, perform automatic adjustment to straighten lines and colors again.

If the error is still not resolved, select OK on the printer's touch screen to cancel the error and perform
manual adjustment to straighten lines and colors.

Manual Adjustment to Straighten Lines and Colors
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3000

Cause
The print head has not been calibrated.

What to Do
Print Head Alignment - Auto is recommended.

Automatic Adjustment to Straighten Lines and Colors

Note
• This message will appear until Print Head Alignment - Auto is carried out.
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3252

Cause
The maintenance cartridge is almost full.

What to Do
The printer will not be able to print with a full maintenance cartridge.

Tap the printer's OK button to clear the error message.
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3306

Cause
Media information cannot be recognized because the printer media information is corrupt.

What to Do
Start the Media Configuration Tool, and then recover the media information.

Media Configuration Tool Guide

To set the Media Configuration Tool to recovery mode, open the Media Configuration Tool, select this
device and then click OK.

Select and load the media information backup file.

If you do not have a media information backup file, contact a Canon customer service center.

594



3310

Cause
Incorrect print data.

Illegal number of parameters.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3311

Cause
Incorrect print data.

Illegal number of parameters.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3312

Cause
Incorrect print data.

Illegal number of parameters.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3313

Cause
Incorrect print data.

Illegal number of parameters.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3314

Cause
Incorrect print data.

Illegal number of parameters.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3315

Cause
Incorrect print data.

Illegal number of parameters.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.

600



3316

Cause
Incorrect print data.

Illegal number of parameters.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3317

Cause
Incorrect print data.

Illegal number of parameters.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3318

Cause
Incorrect print data.

Illegal number of parameters.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.

603



3319

Cause
Incorrect print data.

Illegal number of parameters.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3413

Cause
Prevent paper abrasion has been set.

What to Do
If you continue printing in the current setting, select Yes on the printer's touch screen.

Prevent paper abrasion may reduce print speed.

If you disable this setting, select No. Select  (Setup) on the HOME screen, select Printer settings,
Print settings, and then set Prevent paper abrasion to OFF.
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3440

Cause
Easy wireless connect has failed.

What to Do
Select OK on the printer's touch screen to cancel the error and retry Easy wireless connect.

If the error is not resolved, use another method to set up Wi-Fi.
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3441

Cause
Easy wireless connect has failed.

What to Do
Select OK on the printer's touch screen to cancel the error and retry Easy wireless connect.

If the error is not resolved, use another method to set up Wi-Fi.
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3442

Cause
Printing of the first side is complete when doing manual duplex printing.

What to Do
Prepare to print the other side.

Load the paper with the printed side facing down in the top feed without changing its orientation.

Select How to set on the printer's touch screen to see how to load the paper.

After loading the paper, select Start print on the printer's touch screen.

Note
• To cancel printing, press the printer's Stop button.
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3443

Cause
Printing of the first side is complete when doing manual duplex printing.

What to Do
Prepare to print the other side.

Rotate the printed paper 180 degrees and load it with the printed side facing down in the top feed.

Select How to set on the printer's touch screen to see how to load the paper.

After loading the paper, select Start print on the printer's touch screen.

Note
• To cancel printing, press the printer's Stop button.

609



3444

Cause
Printing of the first side is complete when doing manual duplex printing.

What to Do
Prepare to print the other side.

Rotate the printed paper 180 degrees and load it with the printed side facing down in the top feed.

Select How to set on the printer's touch screen to see how to load the paper.

After loading the paper, select Start print on the printer's touch screen.

Note
• To cancel printing, press the printer's Stop button.
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3445

Cause
Printing of the first side is complete when doing manual duplex printing.

What to Do
Prepare to print the other side.

Load the paper with the printed side facing down in the top feed without changing its orientation.

Select How to set on the printer's touch screen to see how to load the paper.

After loading the paper, select Start print on the printer's touch screen.

Note
• To cancel printing, press the printer's Stop button.
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3446

Cause
IP address and subnet mask are conflicting.

What to Do
Select OK on the printer's touch screen to cancel the error.

Disable the wireless direct or change the Wi-Fi network configuration. When changing the network
configuration, specify a unique subnet range for each of the wireless direct and the Wi-Fi to prevent a
conflict.

For details on changing the network configuration, refer to the documentation for your wireless router.
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3447

Cause
An error occurred while communicating via wireless direct or while in standby.

What to Do
Select OK on the printer's touch screen to cancel the error.

Turn off the printer and turn it back on.

Wireless direct becomes enabled.
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4103

Cause
Cannot perform printing with current print settings.

What to Do
Press the printer's Stop button to cancel printing.

Change the print settings specified when printing and retry printing.
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4104

Cause
The paper settings (paper size/paper type) or paper feed method specified when printing are incorrect.

What to Do
Press the Stop button on the printer to stop printing, and then check the paper roll or the paper that can
be loaded in the top feed.

Loading Rolls in the Printer
Loading Sheets in the Printer

Do one of the following, and then try printing again.

• Change the paper settings (paper size/ paper type) specified when printing.
• Change the paper feeding method.
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4111

Cause
The media type specified is incompatible with this device.

What to Do
Press the printer's Stop button to stop printing.

Check the media type settings, and then try again.
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4801

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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4920

Cause
Cannot cut paper for one of the following reasons.

• Paper that has been cut remains on the output guide.
• There is a foreign object near the output slot that is obstructing the cutter blade.
• The paper is not being used under the recommended usage conditions.
• The paper in use cannot be used with Automatic cut.

What to Do
Remove jammed paper.

Remove Jammed Roll Paper
Remove a Jammed Sheet

After removing the jammed paper, select OK on the printer's touch screen to cancel the error.
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4931

Cause
Paper feed adjustment may have failed for the following reasons.

• The paper for printing a test pattern is soiled. Otherwise, you have loaded colored paper.
• The printer may be exposed to strong light, such as direct sunlight, which can cause the sensors to

malfunction.
• The test pattern was printed too faintly.

What to Do
Tap OK on the touch screen to dismiss the error, and then take the following actions.

• Load unused paper.
• Make adjustments to ensure that the printer is not exposed to strong light.
• Print a nozzle check pattern to check the print head status.•

If the pattern has gaps or horizontal white lines, the print head nozzle is blocked. Clean the print head.

Checking for Nozzle Clogging
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495A

Cause
An error occurred while communicating via Wi-Fi or while in standby.

What to Do
Turn off the printer and turn it back on.
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5100

Cause
Printer error has occurred.

What to Do
If you are printing, press the printer's Stop button to cancel printing, then turn off the printer.

Check the following:

• Make sure carriage motion is not impeded by protective material and tape for securing the carriage,•
jammed paper, etc.

Remove any impediment.

Important
• Do not touch the linear scale (A) or carriage rail (B). This may stain your hands and damage the•

printer.

Turn the printer back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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5108

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.

622



5200

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Wait about 10 minutes and then plug in the printer again and turn it back on.

Make sure there is enough ink remaining, and perform replace ink in print head.

Checking Ink Level

• From Windows:•

Cleaning the Print Heads

• From macOS:•

Cleaning the Print Heads

• From the operation panel of the printer:•

Replacing the Ink in the Print Head

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.

623



5207

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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5700

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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5C02

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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5C30

Cause
An error requiring a repair has occurred.

What to Do
Turn off the printer and unplug it.

Contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6000

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.

628



6001

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6004

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6500

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6503

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6700

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6701

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6800

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6801

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6830

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6831

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6832

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6833

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6900

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6901

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6902

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6910

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6920

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6921

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6930

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6931

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6932

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6933

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6940

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6941

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.

652



6942

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6943

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6944

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6945

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6946

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6A80

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6A81

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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6D01

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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7500

Cause
An error requiring a repair has occurred.

What to Do
Turn off the printer and unplug it.

Contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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7600

Cause
An error requiring a repair has occurred.

What to Do
Turn off the printer and unplug it.

Contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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7700

Cause
An error requiring a repair has occurred.

What to Do
Turn off the printer and unplug it.

Contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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7800

Cause
An error requiring a repair has occurred.

What to Do
Turn off the printer and unplug it.

Contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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8200

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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B506

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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B508

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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B509

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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B50A

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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C000

Cause
Printer error has occurred.

What to Do
Turn off the printer and unplug it.

Plug in the printer again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

Important
• Do not tilt the printer when moving it since the ink may leak out.
• When transporting the printer for repairing it, see Repairing Your Printer.
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D103

Cause
The printer is in the reset process and cannot be operated.

What to Do
Wait for a while until the process is completed.
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D107

Cause
The printer is in operation process and cannot be operated.

What to Do
Wait for a while until the process is completed.
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D108

Cause
The printer is in the process of moving the carriage and cannot be operated.

What to Do
Wait for a while until the process is completed.
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D109

Cause
Firmware updates are available.

What to Do
When update notifications are configured, a notification will appear when there is an available update.
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Specifications

Specifications

Print Area
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Specifications

Printer specifications
Printing performance
Memory
Interface
Network Specifications
Operating Conditions
Paper

Important
• The following values may vary depending on the operating environment.

Printer specifications

Power supply 100-240 V AC (50/60 Hz)

Power consumption When printing (wired LAN connection): 28 W max.

Standby (wired LAN connection): 1.8 W max.

Standby (all ports connected): 2.4 W max.

When power is off: 0.3 W max. *1

*1 The printer uses a trace amount of power even when turned off. To stop all
power consumption, turn off the printer and unplug the power cord.

Operating environment Temperature: 59 to 86 °F (15 to 30 °C)

Humidity: 10 to 80 % RH (with no condensation)

Dimensions (W x D x H) Printer only:

Approx. 38.2 x 20.7 x 9.7 in. (968 x 525 x 245 mm)

Printer and Desktop Basket BU-06 (when the basket is opened):

Approx. 38.2 x 32.5 x 38.0 in. (968 x 825 x 965 mm)

Printer and Stand SD-24 (when the basket is opened):

Approx. 38.2 x 34.3 x 34.5 in. (968 x 870 x 874 mm)

Weight Printer only *:

Approx. 69 lb (32 kg)

Printer and Desktop Basket BU-06 *:

Approx. 71 lb. (33 kg)

Printer and Stand SD-24 *:

Approx. 88 lb (40 kg)

* With the Print Head installed.

Space for installation (W x D x
H)

Printer only:

Approx. 46.0 x 44.3 x 29.4 in. (1168 x 1125 x 745 mm)

Printer and Desktop Basket BU-06 (when the basket is opened):
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Approx. 46.0 x 56.2 x 57.7 in. (1168 x 1425 x 1465 mm)

Printer and Stand SD-24 (when the basket is opened):

Approx. 46.0 x 57.9 x 54.1 in. (1168 x 1470 x 1374 mm)

Printing performance

Print method Bubblejet

Maximum resolution 2400 dpi (horizontally) * x 1200 dpi (vertically)

* Prints with a minimum 1/2400 inch dot pitch between ink droplets.

Print head PF-08

Number of nozzles 4352 nozzles (BK: 1280 nozzles, C/M/Y: 1024 nozzles)

Memory

Memory Physical memory 1GB

Interface
USB and the network can be used at the same time.

You cannot use Wi-Fi and wired LAN at the same time.

USB Hi-Speed USB *

* To use Hi-Speed USB, your computer must support Hi-Speed USB. Addition-
ally, the Hi-Speed USB interface is completely backward compatible with USB
1.1, so the printer can be connected even if the computer interface is USB 1.1.

LAN Wired LAN: IEEE802.3u (100BASE-TX) / IEEE802.3 (10BASE-T)

Wi-Fi: IEEE802.11n / IEEE802.11g / IEEE802.11b

Network Specifications

Communication protocol SNMP, HTTP, TCP / IP (IPv4 / IPv6)

Wired LAN specifications Approved standards: IEEE802.3u (100BASE-TX) / IEEE802.3 (10BASE-T)

Transmission speed: 10 Mbps / 100 Mbps (automatically selected)

Security: IEEE802.1X (EAP-TLS / EAP-TTLS / PEAP)

Wi-Fi specifications Approved standards: IEEE802.11n / IEEE802.11g / IEEE802.11b

Frequency range: 2.4 GHz

Channels: 1-11 or 1-13 *

* Varies by country and region.

Effective range: Indoors 164 feet/50 m *
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* Varies according to environmental conditions.

Security:

WPA-PSK (TKIP / AES)

WPA2-PSK (TKIP / AES)

WPA3-SAE (AES)

WPA-EAP (AES) *

WPA2-EAP (AES) *

WPA3-EAP (AES) *

* Supports IEEE802.1X (EAP-TLS / EAP-TTLS / PEAP)

Setup:

WPS (push button method/PIN code method)

Easy wireless connect

Operating Conditions
If operating conditions of the operating system are high, follow those.

Windows

Compatible Operating System (Standard supplied
printer driver)

Windows 11

Windows 10

Windows 8.1

Windows 7

Windows Server 2022

Windows Server 2019

Windows Server 2016

Windows Server 2012 R2

Windows Server 2012

Windows Server 2008 R2

Use the latest Service Pack available.

Free hard disk space 20 GB or more

macOS

Compatible Operating System (Standard
supplied printer driver)

macOS Mojave 10.14.6 - macOS Monterey 12

Free hard disk space 20 GB or more

Other Supported OS

iOS, iPadOS, Android, Chrome OS
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Some functions may not be available with the supported OS.

• An Internet connection is required to use the Online Manual.
• To install the software while using Windows, you must have a CD-ROM drive or a network

connection.
• To install the software while using macOS, you must have a network connection.

Paper
For details on the compatible media types, see Paper Information List.

For details on the paper widths supported by the printer, see Paper Sizes.

For details about Print Area, see Print Area.
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Print Area

A margin required by the printer is added with respect to the size of paper loaded in the printer. The actual
printing area corresponds to the paper size minus the space for this margin.

Note
• Printable Area: The area that can be printed.
• To match the document size with the actual printing area, print on oversize paper with the required•

margin added.

Printing to Oversized Paper Sizes (Windows)
Printing to Oversized Paper Sizes (macOS)

Sheets

Printable Area:

A margin of 0.2/1.2 in. (5/30 mm)* on top and bottom edges, and 0.2 in. (5 mm) on left and right edges are
required.

* The margins on the sheet vary depending on the paper type and print settings. The bottom margin also
depends on the OS and application.

A: Top Edge
B: Bottom Edge
C: Left Edge
D: Right Edge

Rolls

Printable Area:

A margin of 0.2/1.2 in. (5/30 mm)* on top and bottom edges, 0.2 in. (5 mm) on the left edge, 0.2/0.3 in.
(5/7.5 mm)* on the right edge is required.

* The margins on the roll paper vary depending on the paper type and print settings.
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A: Top Edge
B: Bottom Edge
C: Left Edge
D: Right Edge
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Appendix

Safety

Handling Precautions

Online Manual

Symbols Used in This Document

Touch-enabled Device Users (Windows)

Printing Online Manual

Trademarks and Licenses

682



Safety

Safety Precautions

Regulatory Information

WEEE
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Safety Precautions

Follow the items below to use the printer safely. This may cause unexpected accidents such as fire or
electrical shock.

Symbols

Warning Instructions that, if ignored, could result in death, serious personal injury, or property dam-
age caused by incorrect operation of the equipment are provided. These must be observed
for safe operation.

Caution Instructions that, if ignored, could result in personal injury or property damage caused
by incorrect operation of the equipment are provided. These must be observed for safe
operation.

Warning

• For people who are using a cardiac pacemaker•

This product generates a low-level magnetic field. If you experience discomfort while working around
this product, leave the area and consult a doctor.

• Turn off the power immediately in the following circumstances.•

If you continue to use the printer in the following cases, it may cause fires or electrical shock.
Immediately press the power button to turn off the printer, disconnect the power plug from the outlet,
and make a request for repairs.

If any foreign matter (metal fragments, liquids, etc.) gets inside the printer
If the printer emits smoke, abnormal odors, or abnormal noises
If the power cord or any of the cables become hot, corroded, bent, frayed, or damaged

• Follow the items below as there is a risk of fire and electrical shock.•

Do not set up the product in any location exposed to alcohol, thinner, or other flammable liquids.
Do not disassemble or modify the product.
Use the cables that are included with the printer. Do not use the cables included with the printer
with other devices.
Do not use outside of the designated power supply voltage and frequency.
Insert the power plug securely and completely into the power outlet.
Never handle the power plug with wet hands.
Do not damage, modify, pull, bundle, join, or forcefully bend the power cord or any cables.
Never place a heavy object on the power cord or any cables.
Do not insert multiple power plugs into the same outlet.
Do not connect multiple extension cords.
If there is lightning nearby, disconnect the power plug from the outlet and do not use the product.
When cleaning, always disconnect the cables and power plug, and do not use highly flammable
sprays or liquids such as alcohol or thinner.
Once per month, disconnect the power plug and power cord from the outlet, and check that dust
has not accumulated, and that there are no abnormalities such as heat generation, rust, bending,
chafing, or cracking.
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Caution
• Never insert your hand into the printer while it is printing.
• Never touch the electrical contacts of the print head by hand immediately after printing.
• The following symbol is displayed around the movable parts of the printer. Take care to avoid

touching them with your hand or inserting your finger. Note that this symbol may not appear on your
model.

Moving Parts
Keep body parts away from moving parts.
Keep body parts out of the motion path.

• About Ink Bottles•

Always store consumables out of the reach of small children.
Do not drink ink.
If a child licks or ingests ink accidentally, wash out their mouth or make them drink 1 or 2 cups of
water, and immediately seek medical attention. If ink accidentally gets in your eyes, immediately
rinse with water, and immediately seek medical attention.
If ink gets on your skin, immediately clean it off with soap and water. If irritation persists,
immediately seek medical attention.
When storing ink bottles, securely close the bottle cap of the ink bottle and store in an always
upright state. If it falls over, there is a risk of the ink spilling.
Take great care to avoid ink spraying around when refilling the ink tanks with ink.
If ink becomes adhered to your clothes or anything you are carrying, you might not be able to
wash it out.
Do not leave in a location that gets hot, such as near a fire, near a heater, or in a vehicle. The
container may deform, causing the ink to spill, or the ink quality may become degraded.
Do not expose ink bottles to impacts. The ink bottle may break or the bottle cap may come off,
causing ink to spill.
Do not pour into a different container. This may cause accidental ingestion or misuse of the ink,
or the ink quality may become degraded.
Do not use for any purpose other than refilling the ink in the printer specified by our company.
Do not dilute with water, mix with other inks, etc. This may damage the printer.

• Moving the Printer•

Have the following number of people carry the printer. The weight may cause pain such as back
pain.

TC-20M (Approx. 72 lb (33 kg)) 2 people

TC-20 (Approx. 69 lb (32 kg)) 2 people
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• About the Printer Stand•

If you are purchasing an optional printer stand, please observe the following caution.

When using a printer stand with the Canon TC-20M/TC-20 printer, follow the instruction manual to
securely attach the printer to the stand. Furthermore, always use the following combinations.

For Canon Printer TC-20M/TC-20, use Canon Printer Stand SD-24.

Using a different combination of printer and stand than shown above, using a printer stand not listed
above, or not attaching the printer securely to the printer stand may be unstable and may result in
injury.

Choosing a location
• Never install the printer on an unstable or vibrating surface.
• Do not install the printer in locations that are very humid or dusty, in direct sunlight, outdoors, or close

to a heating source.
To avoid the risk of fire or electric shocks, use the printer under the operating environment specified in
the Specifications.

• Do not place the printer on a thick rug or carpet.
• Do not place the printer with its back attached to the wall.
• We recommend ensuring ample space for installation.
• Do not install the printer near sources of strong electromagnetic fields, whether equipment that

generates such fields or places where such fields occur.

Power Supply
• Ensure that the area around the power outlet is kept clear at all times so you can easily unplug the

power cord if necessary.
• Never remove the plug by pulling on the cord.

Pulling the cord may damage the power cord, leading to possible fire or electrical shock.
• Do not use an extension lead/cord.

Working Around the Printer
• Never put your hands or fingers in the printer while it is printing.
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• When using and transferring the printer, do not tilt it, stand it on its side, or turn it upside down. There
is a risk of the ink spilling.

Print Heads/Ink Bottle/Maintenance Cartridges
• Keep ink bottle out of the reach of children. In case ink is accidentally licked or swallowed, rinse out

mouth or give one or two glasses of water to drink. If irritation or discomfort occurs, obtain medical
advice immediately.

• In case ink gets in contact with eyes, rinse with water immediately. In case ink gets in contact with
skin, wash with soap and water immediately. If irritation to eyes or skin persists, obtain medical advice
immediately.

• Never touch the electrical contacts on a print head after printing.
The metal parts may be very hot and could cause burns.

• Do not throw ink bottle and maintenance cartridges into fire.
• Do not attempt to disassemble or modify the print head, ink bottle, and maintenance cartridges.
• Avoid dropping or shaking print head, ink bottle, and maintenance cartridges.
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Regulatory Information

Users in the U.S.A.
FCC Notice (U.S.A. Only)
For 120V, 60Hz model
Model Number: K10560/K10562 (Contains FCC Approved WLAN Module K30387)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.
• Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If
such changes or modifications should be made, you could be required to stop operation of the equipment.

Changes or modifications not expressly approved by the party responsible for compliance could void the
user's authority to operate equipment.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

The equipment complies with FCC radiation exposure limits for at uncontrolled equipment. This
equipment should be installed and operated with minimum distance at least 20cm between the radiator
and persons body (excluding extremities: hands, wrists, feet and ankles) and must not be colocated or
operated with any other antenna or transmitter.

Canon U.S.A., Inc.
One Canon Park
Melville, New York 11747
1-800-652-2666
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Interference
Do not use the printer around medical equipment or other electronic devices. Signals from the printer may
interfere with the correct operation of these devices.
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WEEE

Only for the United Kingdom

These symbols indicate that this product is not to be disposed of with your household waste, according
to the UK Waste Electrical and Electronic Equipment Regulations and the UK Batteries and Accumulators
Regulations. If a chemical symbol is printed beneath the symbol shown above, in accordance with the
UK Batteries and Accumulators Regulations, this indicates that a heavy metal (Hg = Mercury, Cd =
Cadmium, Pb = Lead) is present in this battery or accumulator at a concentration above an applicable
threshold specified in the UK Batteries and Accumulators Regulations. This product should be handed
over to a designated collection point, e.g., on an authorized one-for-one basis when you buy a new similar
product or to an authorized collection site for recycling waste electrical and electronic equipment (EEE)
and batteries and accumulators. Improper handling of this type of waste could have a possible impact on
the environment and human health due to potentially hazardous substances that are generally associated
with EEE. Your cooperation in the correct disposal of this product will contribute to the effective usage of
natural resources. For more information about the recycling of this product, please contact your local city
office, waste authority, approved scheme or your household waste disposal service or visit www.canon-
europe.com/sustainability/approach/.

Only for European Union and EEA (Norway, Iceland and Liechtenstein)

These symbols indicate that this product is not to be disposed of with your household waste, according
to the WEEE Directive (2012/19/EU), the Battery Directive (2006/66/EC) and/or national legislation
implementing those Directives. If a chemical symbol is printed beneath the symbol shown above,
in accordance with the Battery Directive, this indicates that a heavy metal (Hg = Mercury, Cd =
Cadmium, Pb = Lead) is present in this battery or accumulator at a concentration above an applicable
threshold specified in the Battery Directive. This product should be handed over to a designated
collection point, e.g., on an authorized one-for-one basis when you buy a new similar product or to an
authorized collection site for recycling waste electrical and electronic equipment (EEE) and batteries and
accumulators. Improper handling of this type of waste could have a possible impact on the environment
and human health due to potentially hazardous substances that are generally associated with EEE.
Your cooperation in the correct disposal of this product will contribute to the effective usage of natural
resources. For more information about the recycling of this product, please contact your local city
office, waste authority, approved scheme or your household waste disposal service or visit www.canon-
europe.com/weee, or www.canon-europe.com/battery.
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Nur für Europäische Union und EWR (Norwegen, Island und
Liechtenstein)

Diese Symbole weisen darauf hin, dass dieses Produkt gemäß WEEE-Richtlinie (2012/19/EU; Richtlinie
über Elektro- und Elektronik-Altgeräte), Batterien-Richtlinie (2006/66/EG) und nationalen Gesetzen
zur Umsetzung dieser Richtlinien nicht über den Hausmüll entsorgt werden darf. Falls sich unter
dem oben abgebildeten Symbol ein chemisches Symbol befindet, bedeutet dies gemäß der Batterien-
Richtlinie, dass in dieser Batterie oder diesem Akkumulator ein Schwermetall (Hg = Quecksilber, Cd =
Cadmium, Pb = Blei) in einer Konzentration vorhanden ist, die über einem in der Batterien-Richtlinie
angegebenen Grenzwert liegt. Dieses Produkt muss bei einer dafür vorgesehenen Sammelstelle
abgegeben werden. Dies kann z. B. durch Rückgabe beim Kauf eines neuen ähnlichen Produkts
oder durch Abgabe bei einer autorisierten Sammelstelle für die Wiederaufbereitung von Elektro- und
Elektronik-Altgeräten sowie Batterien und Akkumulatoren geschehen. Der unsachgemäße Umgang
mit Altgeräten kann aufgrund potenziell gefährlicher Stoffe, die generell mit Elektro- und Elektronik-
Altgeräten in Verbindung stehen, negative Auswirkungen auf die Umwelt und die menschliche Gesundheit
haben. Durch Ihre Mitarbeit bei der umweltgerechten Entsorgung dieses Produkts tragen Sie zu einer
effektiven Nutzung natürlicher Ressourcen bei. Um weitere Informationen über die Wiederverwertung
dieses Produkts zu erhalten, wenden Sie sich an Ihre Stadtverwaltung, den öffentlich-rechtlichen
Entsorgungsträger, eine autorisierte Stelle für die Entsorgung von Elektro- und Elektronik-Altgeräten
oder Ihr örtliches Entsorgungsunternehmen oder besuchen Sie www.canon-europe.com/weee, oder
www.canon-europe.com/battery.

Zusatzinformationen für Deutschland:
Dieses Produkt kann durch Rückgabe an den Händler unter den in der Verordnung des Elektro- und
Elektronikgerätegesetzes beschriebenen Bedingungen abgegeben werden.
Als Endbenutzer und Besitzer von Elektro- oder Elektronikgeräten sind Sie verpflichtet:
- diese einer vom unsortierten Siedlungsabfall getrennten Erfassung zuzuführen,
- Altbatterien und Altakkumulatoren, die nicht von Altgerät umschlossen sind, sowie Lampen, die
zerstörungsfrei aus dem Altgerät entnommen werden können, vor der Abgabe an einer Erfassungsstelle
vom Altgerät zerstörungsfrei zu trennen,
- personenbezogener Daten auf den Altgeräten vor der Entsorgung zu löschen. Die Bedeutung von dem
Symbol der durchgestrichenen Abfalltonne auf Rädern finden Sie oben in dieser Beschreibung.
Die Vertreiber von Elektro- oder Elektronikgeräten haben die Pflicht zur unentgeltlichen Rücknahme
von Altgeräten. Die Vertreiber haben die Endnutzer über die von ihnen geschaffenen Möglichkeiten der
Rückgabe von Altgeräten zu informieren.

Union Européenne, Norvège, Islande et Liechtenstein uniquement.

Ces symboles indiquent que ce produit ne doit pas être mis au rebut avec les ordures ménagères, comme
le spécifient la Directive européenne DEEE (2012/19/UE), la Directive européenne relative à l'élimination
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des piles et des accumulateurs usagés (2006/66/CE) et les lois en vigueur dans votre pays appliquant
ces directives. Si un symbole de toxicité chimique est imprimé sous le symbole illustré ci-dessus
conformément à la Directive relative aux piles et aux accumulateurs, il indique la présence d'un métal
lourd (Hg = mercure, Cd = cadmium, Pb = plomb) dans la pile ou l'accumulateur à une concentration
supérieure au seuil applicable spécifié par la Directive. Ce produit doit être confié au distributeur à
chaque fois que vous achetez un produit neuf similaire, ou à un point de collecte mis en place par les
collectivités locales pour le recyclage des Déchets des Équipements Électriques et Électroniques (DEEE).
Le traitement inapproprié de ce type de déchet risque d'avoir des répercussions sur l'environnement
et la santé humaine, du fait de la présence de substances potentiellement dangereuses généralement
associées aux équipements électriques et électroniques. Votre entière coopération dans le cadre de
la mise au rebut correcte de ce produit favorisera une meilleure utilisation des ressources naturelles.
Pour plus d'informations sur le recyclage de ce produit, contactez vos services municipaux, votre éco-
organisme ou les autorités locales compétentes, ou consultez le site www.canon-europe.com/weee, ou
www.canon-europe.com/battery.

Uitsluitend bestemd voor de Europese Unie en EER (Noorwegen,
IJsland en Liechtenstein)

Met deze symbolen wordt aangegeven dat dit product in overeenstemming met de AEEA-richtlijn
(2012/19/EU), de richtlijn 2006/66/EG betreffende batterijen en accu's en/of de plaatselijk geldende
wetgeving waarin deze richtlijnen zijn geïmplementeerd, niet bij het normale huisvuil mag worden
weggegooid. Indien onder het hierboven getoonde symbool een chemisch symbool gedrukt staat, geeft
dit in overeenstemming met de richtlijn betreffende batterijen en accu's aan dat deze batterij of accu een
zwaar metaal bevat (Hg = kwik, Cd = cadmium, Pb = lood) waarvan de concentratie de toepasselijke
drempelwaarde in overeenstemming met de genoemde richtlijn overschrijdt. Dit product dient te worden
ingeleverd bij een hiervoor aangewezen inzamelpunt, bijv. door dit in te leveren bij een hiertoe erkend
verkooppunt bij aankoop van een gelijksoortig product, of bij een officiële inzameldienst voor de recycling
van elektrische en elektronische apparatuur (EEA) en batterijen en accu's. Door de potentieel gevaarlijke
stoffen die gewoonlijk gepaard gaan met EEA, kan onjuiste verwerking van dit type afval mogelijk
nadelige gevolgen hebben voor het milieu en de menselijke gezondheid. Uw medewerking bij het op
juiste wijze weggooien van dit product draagt bij tot effectief gebruik van natuurlijke hulpbronnen. Voor
verdere informatie over recycling van dit product kunt u contact opnemen met uw plaatselijke gemeente,
afvaldienst, officiële dienst voor klein chemisch afval of afvalstortplaats, of kunt u terecht op www.canon-
europe.com/weee, of www.canon-europe.com/battery.

Sólo para la Unión Europea y el Área Económica Europea (Noruega,
Islandia y Liechtenstein)
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Estos iconos indican que este producto no debe desecharse con los residuos domésticos de acuerdo
con la Directiva sobre RAEE (2012/19/UE) y la Directiva sobre Pilas y Acumuladores (2006/66/CE) y/o la
legislación nacional. Si aparece un símbolo químico bajo este icono, de acuerdo con la Directiva sobre
Pilas y Acumuladores, significa que la pila o el acumulador contiene metales pesados (Hg = Mercurio,
Cd = Cadmio, Pb = Plomo) en una concentración superior al límite especificado en dicha directiva.
Este producto deberá entregarse en un punto de recogida designado, por ejemplo, entregándolo en
el lugar de venta al adquirir un producto nuevo similar o en un centro autorizado para la recogida de
residuos de aparatos eléctricos y electrónicos (RAEE), baterías y acumuladores. La gestión incorrecta
de este tipo de residuos puede afectar al medio ambiente y a la salud humana debido a las sustancias
potencialmente nocivas que suelen contener estos aparatos. Su cooperación en la correcta eliminación
de este producto contribuirá al correcto aprovechamiento de los recursos naturales. Los usuarios tienen
derecho a devolver pilas, acumuladores o baterías usados sin coste alguno. El precio de venta de pilas,
acumuladores y baterías incluye el coste de la gestión medioambiental de su desecho, y no es necesario
mostrar la cuantía de dicho coste en la información y la factura suministradas a los usuarios finales. Si
desea más información sobre el reciclado de este producto, póngase en contacto con su municipio, el
servicio o el organismo encargado de la gestión de residuos domésticos o visite www.canon-europe.com/
weee, o www.canon-europe.com/battery.

Només per a la Unió Europea i a l’Espai Econòmic Europeu (Noruega,
Islàndia i Liechtenstein)

Aquests símbols indican que aquest producte no s’ha de llençar amb les escombraries de la llar,
d’acord amb la RAEE (2012/19/UE), la Directiva relativa a piles i acumuladors (2006/66/CE) i la
legislació nacional que implementi aquestes directives. Si al costat d’aquest símbol hi apareix imprès
un símbol químic, segons especifica la Directiva relativa a piles i acumuladors, significa que la bateria o
l’acumulador conté un metall pesant (Hg = mercuri, Cd = cadmi, Pb = plom) en una concentració superior
al límit aplicable especificat en la Directiva. Aquest producte s’hauria de lliurar en un dels punts de
recollida designats, com per exemple, intercanviant un per un en comprar un producte similar o lliurant-lo
en un lloc de recollida autoritzat per al reciclatge de residus d’aparells elèctrics i electrònics (RAEE) i
piles i acumuladors. La manipulació inadequada d’aquest tipus de residus podria tenir un impacte negatiu
en l’entorn i en la salut humana, a causa de les substàncies potencialment perilloses que normalment
estan associades a l'RAEE. La vostra cooperació a l’hora de rebutjar correctament aquest producte
contribuirà a la utilització efectiva dels recursos naturals. Els usuaris tenen dret a retornar les bateries o
els acumuladors usats sense cap càrrec. El preu de venda de les bateries i els acumuladors inclou el cost
de la gestió ambiental dels residus i no es necessari mostrar l’import d’aquest cost en aquest fullet o en la
factura que es lliuri a l’usuari final. Per a més informació sobre el reciclatge d’aquest producte, contacteu
amb l’oficina municipal, les autoritats encarregades dels residus, el pla de residus homologat o el servei
de recollida d’escombraries domèstiques de la vostra localitat o visiteu www.canon-europe.com/weee, o
www.canon-europe.com/battery.
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Solo per Unione Europea e SEE (Norvegia, Islanda e Liechtenstein)

Questi simboli indicano che il prodotto non può essere smaltito con i rifiuti domestici, ai sensi della
Direttiva RAEE (2012/19/UE), della Direttiva sulle Batterie (2006/66/CE) e/o delle leggi nazionali che
attuano tali Direttive. Se sotto il simbolo indicato sopra è riportato un simbolo chimico, in osservanza
della Direttiva sulle batterie, tale simbolo indica la presenza di un metallo pesante (Hg = Mercurio, Cd
= Cadmio, Pb = Piombo) nella batteria o nell'accumulatore con un livello di concentrazione superiore
a una soglia applicabile specificata nella Direttiva sulle batterie. Il prodotto deve essere conferito a
un punto di raccolta designato, ad esempio il rivenditore in caso di acquisto di un nuovo prodotto
simile oppure un centro di raccolta autorizzato per il riciclaggio di rifiuti di apparecchiature elettriche
ed elettroniche (RAEE) nonché di batterie e accumulatori. Un trattamento improprio di questo tipo di
rifiuti può avere conseguenze negative sull'ambiente e sulla salute umana a causa delle sostanze
potenzialmente nocive solitamente contenute in tali rifiuti. La collaborazione dell'utente per il corretto
smaltimento di questo prodotto contribuirà a un utilizzo efficace delle risorse naturali ed eviterà di
incorrere in sanzioni amministrative ai sensi dell'art. 255 e successivi del Decreto Legislativo n. 152/06.
Per ulteriori informazioni sul riciclaggio di questo prodotto, contattare le autorità locali, l'ente responsabile
della raccolta dei rifiuti, un rivenditore autorizzato o il servizio di raccolta dei rifiuti domestici, oppure
visitare il sito www.canon-europe.com/weee, o www.canon-europe.com/battery.

Apenas para a União Europeia e AEE (Noruega, Islândia e
Liechtenstein)

Estes símbolos indicam que este produto não deve ser eliminado juntamente com o seu lixo doméstico,
segundo a Diretiva REEE de 2012/19/UE, a Diretiva de Baterias (2006/66/CE) e/ou a sua legislação
nacional que transponha estas Diretivas. Se houver um símbolo químico impresso como mostrado
abaixo, de acordo com a Diretiva de Baterias, isto indica que um metal pesado (Hg = Mercúrio, Cd =
Cádmio, Pb = Chumbo) está presente nesta pilha ou acumulador, numa concentração acima de um limite
aplicável especificado na Diretiva. Este produto deve ser entregue num ponto de recolha designado, por
exemplo num local autorizado de troca quando compra um equipamento novo idêntico, ou num local
de recolha autorizado para reciclar equipamento elétrico e eletrónico (EEE) em fim de vida, bem como
pilhas e baterias. O tratamento inadequado deste tipo de resíduos pode ter um impacto negativo no
ambiente e na saúde humana, devido a substâncias potencialmente perigosas que estão associadas
com equipamentos do tipo EEE. A sua cooperação no tratamento correto deste produto irá contribuir
para a utilização mais eficaz dos recursos naturais. Para obter mais informações acerca de como
reciclar este produto, por favor contacte as suas autoridades locais responsáveis pela matéria, serviço
de recolha aprovado para pilhas e baterias ou serviço de recolha de resíduos sólidos domésticos da sua
municipalidade, ou visite www.canon-europe.com/weee, ou www.canon-europe.com/battery.
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Gælder kun i Europæiske Union og EØS (Norge, Island og
Liechtenstein)

Disse symboler betyder, at produktet ikke må bortskaffes sammen med dagrenovation i henhold til
WEEE-direktivet (2012/19/EU), batteridirektivet (2006/66/EF) og/eller den lokale lovgivning, som disse
direktiver er gennemført i. Hvis der i overensstemmelse med batteridirektivet er trykt et kemisk symbol
under det symbol, der er vist ovenfor, betyder det, at batteriet eller akkumulatoren indeholder tungmetaller
(Hg = kviksølv, Cd = cadmium, Pb = bly) i en koncentration, som ligger over de grænseværdier,
der er beskrevet i batteridirektivet. Produktet skal afleveres på et godkendt indsamlingssted, f.eks. i
overensstemmelse med en godkendt én-til-én-procedure, når du indkøber et nyt tilsvarende produkt,
eller på et godkendt indsamlingssted for elektronikaffald samt for batterier og akkumulatorer. Forkert
håndtering af denne type affald kan medføre negative konsekvenser for miljøet og menneskers
helbred på grund af de potentielt sundhedsskadelige stoffer, der generelt kan forefindes i elektrisk og
elektronisk udstyr. Når du foretager korrekt bortskaffelse af produktet, bidrager du til effektiv brug af
naturressourcerne. Kontakt din kommune, den lokale affaldsmyndighed, det lokale affaldsanlæg, eller
besøg www.canon-europe.com/weee, eller www.canon-europe.com/battery for at få flere oplysninger om
genbrug af dette produkt.

Μόνο για την Ευρωπαϊκή Ένωση και τον ΕΟΧ (Νορβηγία, Ισλανδία και
Λιχτενστάιν)

Αυτά τα σύμβολα υποδεικνύουν ότι αυτό το προϊόν δεν πρέπει να απορρίπτεται μαζί με τα οικιακά
απορρίμματα, σύμφωνα με την Οδηγία για τα Απόβλητα Ηλεκτρικού και Ηλεκτρονικού Εξοπλισμού
(ΑΗΗΕ) (2012/19/ΕΕ), την Οδηγία για τις Ηλεκτρικές Στήλες (2006/66/ΕΚ) ή/και την εθνική νομοθεσία
που εφαρμόζει τις Οδηγίες εκείνες. Εάν κάποιο χημικό σύμβολο είναι τυπωμένο κάτω από το σύμβολο
που φαίνεται παραπάνω, σύμφωνα με την Οδηγία για τις Ηλεκτρικές Στήλες, υποδηλώνει ότι κάποιο βαρύ
μέταλλο (Hg = Υδράργυρος, Cd = Κάδμιο, Pb = Μόλυβδος) υπάρχει στην μπαταρία ή τον συσσωρευτή σε
συγκέντρωση μεγαλύτερη από το ισχύον επίπεδο που καθορίζεται στην Οδηγία για τις Ηλεκτρικές Στήλες.
Αυτό το προϊόν πρέπει να παραδίδεται σε καθορισμένο σημείο συλλογής, π.χ. σε μια εξουσιοδοτημένη
βάση ανταλλαγής όταν αγοράζετε ένα νέο παρόμοιο προϊόν ή σε μια εξουσιοδοτημένη θέση συλλογής για
την ανακύκλωση των αποβλήτων ηλεκτρικού και ηλεκτρονικού εξοπλισμού (ΗΗE) και των ηλεκτρικών
στηλών και συσσωρευτών. Ο ακατάλληλος χειρισμός αυτού του τύπου αποβλήτων μπορεί να έχει
αρνητικό αντίκτυπο στο περιβάλλον και την υγεία του ανθρώπου, λόγω δυνητικά επικίνδυνων ουσιών
που γενικά συνδέονται με τον ΗΗΕ. Η συνεργασία σας για τη σωστή απόρριψη αυτού του προϊόντος θα
συμβάλει στην αποτελεσματική χρήση των φυσικών πόρων. Για περισσότερες πληροφορίες σχετικά με
ανακύκλωση αυτού του προϊόντος, επικοινωνήστε με το τοπικό γραφείο της πόλης σας, την υπηρεσία
απορριμμάτων, το εγκεκριμένο σχήμα ή την υπηρεσία απόρριψης οικιακών αποβλήτων ή επισκεφθείτε τη
διεύθυνση www.canon-europe.com/weee ή www.canon-europe.com/battery.
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Gjelder kun den europeiske union og EØS (Norge, Island og
Liechtenstein)

Disse symbolene indikerer at dette produktet ikke skal kastes sammen med husholdningsavfall, i
henhold til WEEE-direktivet (2012/19/EU), batteridirektivet (2006/66/EF) og/eller nasjonal lov som har
implementert disse direktivene. Hvis et kjemisk symbol vises under symbolet vist ovenfor, i samsvar
med batteridirektivet, indikerer dette at et tungmetall (Hg = kvikksølv, Cd = kadmium, Pb = bly) finnes
i batteriet eller akkumulatoren i en konsentrasjon over en gjeldende øvre grense som er spesifisert i
batteridirektivet. Produktet må leveres til et dertil egnet innsamlingspunkt, det vil si på en autorisert
en-til-en-basis når en kjøper et nytt lignende produkt, eller til et autorisert innsamlingssted for resirkulering
av avfall fra elektrisk og elektronisk utstyr (EE-utstyr) og batterier og akkumulatorer. Feil håndtering
av denne typen avfall kan være miljø- og helseskadelig på grunn av potensielt skadelige stoffer som
ofte brukes i EE-utstyr. Din innsats for korrekt avhending av produktet vil bidra til effektiv bruk av
naturressurser. Du kan få mer informasjon om resirkulering av dette produktet ved å kontakte lokale
myndigheter, avfallsadministrasjonen, et godkjent program eller husholdningens renovasjonsselskap, eller
gå til www.canon-europe.com/weee, eller www.canon-europe.com/battery.

Vain Euroopan unionin sekä ETA:n (Norja, Islanti ja Liechtenstein)
alueelle.

Nämä tunnukset osoittavat, että sähkö- ja elektroniikkalaiteromua koskeva direktiivi (SER-direktiivi,
2012/19/EU), paristoista ja akuista annettu direktiivi (2006/66/EY) sekä kansallinen lainsäädäntö kieltävät
tuotteen hävittämisen talousjätteen mukana. Jos yllä olevan symbolin alapuolelle on paristodirektiivin
mukaisesti painettu kemiallisen aineen tunnus, kyseinen paristo tai akku sisältää raskasmetalleja (Hg
= elohopea, Cd = kadmium, Pb = lyijy) enemmän kuin paristodirektiivin salliman määrän. Tuote on
vietävä asianmukaiseen keräyspisteeseen, esimerkiksi kodinkoneliikkeeseen uutta vastaavaa tuotetta
ostettaessa tai viralliseen sähkö- ja elektroniikkalaiteromun tai paristojen ja akkujen keräyspisteeseen.
Sähkö- ja elektroniikkalaiteromun virheellinen käsittely voi vahingoittaa ympäristöä ja ihmisten terveyttä,
koska laitteet saattavat sisältää ympäristölle ja terveydelle haitallisia aineita. Tuotteen asianmukainen
hävittäminen säästää myös luonnonvaroja. Jos haluat lisätietoja tämän tuotteen kierrätyksestä, ota
yhteys kunnan jätehuoltoviranomaisiin tai käyttämääsi jätehuoltoyhtiöön tai käy osoitteessa www.canon-
europe.com/weee, tai www.canon-europe.com/battery.

Endast för Europeiska unionen och EES (Norge, Island och
Liechtenstein)
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De här symbolerna visar att produkten inte får sorteras och slängas som hushållsavfall enligt WEEE-
direktivet (2012/19/EU), batteridirektivet (2006/66/EG) och/eller nationell lagstiftning som implementerar
dessa direktiv. Om en kemisk symbol förekommer under ovanstående symbol innebär detta enligt
Batteridirektivet att en tungmetall (Hg = Kvicksilver, Cd = Kadmium, Pb = Bly) förekommer i batteriet
eller ackumulatorn med en koncentration som överstiger tillämplig gräns som anges i Batteridirektivet.
Produkten ska lämnas in på en avsedd insamlingsplats, t.ex. på en återvinningsstation auktoriserad
att hantera elektrisk och elektronisk utrustning (EE-utrustning) samt batterier och ackumulatorer eller
hos handlare som är auktoriserade att byta in varor då nya, motsvarande köps (en mot en). Olämplig
hantering av avfall av den här typen kan ha negativ inverkan på miljön och människors hälsa på grund
av de potentiellt farliga ämnen som kan återfinnas i elektrisk och elektronisk utrustning. Din medverkan
till en korrekt avfallshantering av produkten bidrar till effektiv användning av naturresurserna. Om du vill
ha mer information om var du kan lämna in den här produkten, kontakta ditt lokala kommunkontor, berörd
myndighet eller företag för avfallshantering eller se www.canon-europe.com/weee, eller www.canon-
europe.com/battery.

Pouze Evropská unie a EHP (Norsko, Island a Lichtenštejnsko)

Tento symbol znamená, že podle směrnice OEEZ (2012/19/EU), směrnice o bateriích (2006/66/ES) a/
nebo podle vnitrostátních právních prováděcích předpisů k těmto směrnicím nemá být tento výrobek
likvidován s odpadem z domácností. Je-li v souladu s požadavky směrnice o bateriích vytištěna pod výše
uvedeným symbolem chemická značka, udává, že tato baterie nebo akumulátor obsahuje těžké kovy (Hg
= rtuť, Cd = kadmium, Pb = olovo) v koncentraci vyšší, než je příslušná hodnota předepsaná směrnicí.
Tento výrobek má být vrácen do určeného sběrného místa, např. v rámci autorizovaného systému
odběru jednoho výrobku za jeden nově prodaný podobný výrobek, nebo do autorizovaného sběrného
místa pro recyklaci odpadních elektrických a elektronických zařízení (OEEZ), baterií a akumulátorů.
Nevhodné nakládání s tímto druhem odpadu by mohlo mít negativní dopad na životní prostředí a
lidské zdraví, protože elektrická a elektronická zařízení zpravidla obsahují potenciálně nebezpečné
látky. Vaše spolupráce na správné likvidaci tohoto výrobku napomůže efektivnímu využívání přírodních
zdrojů. Chcete-li získat podrobné informace týkající se recyklace tohoto výrobku, obraťte se prosím
na místní úřad, orgán pro nakládání s odpady, schválený systém nakládání s odpady či společnost
zajišťující likvidaci domovního odpadu, nebo navštivte webové stránky www.canon-europe.com/weee
nebo www.canon-europe.com/battery.

Csak az Európai Unió és az EGT (Norvégia, Izland és Liechtenstein)
országaiban

Ezek a szimbólumok azt jelzik, hogy a termék hulladékkezelése a háztartási hulladéktól különválasztva,
az elektromos és elektronikus berendezések hulladékairól (WEEE) szóló (2012/19/EU) irányelvnek és az
elemekről és akkumulátorokról, valamint a hulladék elemekről és akkumulátorokról szóló (2006/66/EK)
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irányelvnek megfelelően és/vagy ezen irányelveknek megfelelő helyi előírások szerint történik.
Amennyiben a fent feltüntetett szimbólum alatt egy vegyjel is szerepel, az elemekről és akkumulátorokról
szóló irányelvben foglaltak értelmében ez azt jelzi, hogy az elem vagy az akkumulátor az irányelvben
meghatározott határértéknél nagyobb mennyiségben tartalmaz nehézfémet (Hg = higany, Cd = kadmium,
Pb = ólom). E terméket az arra kijelölt gyűjtőhelyre kell juttatni – pl. hasonló termék vásárlásakor
a régi becserélésére vonatkozó hivatalos program keretében, vagy az elektromos és elektronikus
berendezések (EEE) hulladékainak gyűjtésére, valamint a hulladék elemek és hulladék akkumulátorok
gyűjtésére kijelölt hivatalos gyűjtőhelyre. Az ilyen jellegű hulladékok nem előírásszerű kezelése az
elektromos és elektronikus berendezésekhez (EEE) általánosan kapcsolható potenciálisan veszélyes
anyagok révén hatással lehet a környezetre és az egészségre. E termék megfelelő leselejtezésével
Ön is hozzájárul a természeti források hatékony használatához. A termék újrahasznosítását illetően
informálódjon a helyi polgármesteri hivatalnál, a helyi közterület-fenntartó vállalatnál, a hivatalos
hulladéklerakó telephelyen vagy a háztartási hulladék begyűjtését végző szolgáltatónál, illetve látogasson
el a www.canon-europe.com/weee, vagy www.canon-europe.com/battery internetes oldalra.

Tylko dla krajów Unii Europejskiej oraz EOG (Norwegia, Islandia i
Liechtenstein)

Te symbole oznaczają, że produktu nie należy wyrzucać razem z odpadami gospodarstwa domowego,
zgodnie z dyrektywą WEEE w sprawie zużytego sprzętu elektrycznego i elektronicznego (2012/19/UE)
lub dyrektywą w sprawie baterii (2006/66/WE) bądź przepisami krajowymi wdrażającymi te dyrektywy.
Jeśli pod powyższym symbolem znajduje się symbol chemiczny, zgodnie z dyrektywą w sprawie
baterii oznacza to, że bateria lub akumulator zawiera metal ciężki (Hg = rtęć, Cd = kadm, Pb
= ołów) w stężeniu przekraczającym odpowiedni poziom określony w dyrektywie w sprawie baterii.
Użytkownicy baterii i akumulatorów mają obowiązek korzystać z dostępnego programu zwrotu, recyklingu
i utylizacji baterii oraz akumulatorów. Niewłaściwe postępowanie z tego typu odpadami może mieć
wpływ na środowisko i zdrowie ludzi ze względu na substancje potencjalnie niebezpieczne, związane
ze zużytym sprzętem elektrycznym i elektronicznym. Państwa współpraca w zakresie właściwej utylizacji
tego produktu przyczyni się do efektywnego wykorzystania zasobów naturalnych. W celu uzyskania
informacji o sposobie recyklingu tego produktu prosimy o kontakt z właściwym urzędem miejskim
lub zakładem gospodarki komunalnej bądź zapraszamy na stronę www.canon-europe.com/weee, lub
www.canon-europe.com/battery.

Platí len pre štáty Európskej únie a EHP (Nórsko, Island a
Lichtenštajnsko)

Tieto symboly označujú, že podľa Smernice o odpade z elektrických a elektronických zariadení (OEEZ)
2012/19/EÚ, Smernice o batériách (2006/66/ES) a podľa platnej legislatívy Slovenskej republiky sa tento
produkt nesmie likvidovať spolu s komunálnym odpadom. Ak je chemická značka vytlačená pod vyššie
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uvedeným symbolom, znamená to, že táto batéria alebo akumulátor obsahuje ťažký kov (Hg = ortuť,
Cd = kadmium, Pb = olovo) v koncentrácii vyššej, ako je príslušná povolená hodnota stanovená v
Smernici o batériách. Produkt je potrebné odovzdať do určenej zberne, napr. prostredníctvom výmeny
za kúpu nového podobného produktu, alebo na autorizované zberné miesto, ktoré spracúva odpad z
elektrických a elektronických zariadení (EEZ), batérií a akumulátorov. Nesprávna manipulácia s takýmto
typom odpadu môže mať negatívny vplyv na životné prostredie a ľudské zdravie, pretože elektrické
a elektronické zariadenia obsahujú potenciálne nebezpečné látky. Spoluprácou na správnej likvidácii
tohto produktu prispejete k účinnému využívaniu prírodných zdrojov. Ďalšie informácie o recyklácii tohto
produktu získate od miestneho úradu, úradu životného prostredia, zo schváleného plánu OEEZ alebo od
spoločnosti, ktorá zaisťuje likvidáciu komunálneho odpadu. Viac informácií nájdete aj na webovej stránke:
www.canon-europe.com/weee, alebo www.canon-europe.com/battery.

Üksnes Euroopa Liit ja EMP (Norra, Island ja Liechtenstein)

Antud sümbolid viitavad sellele, et vastavalt elektri- ja elektroonikaseadmete jäätmeid käsitlevale
direktiivile (2012/19/EL), patareisid ja akusid ning patarei- ja akujäätmeid käsitlevale direktiivile
(2006/66/EÜ) ja/või nimetatud direktiive rakendavatele riiklikele õigusaktidele ei või seda toodet koos
olmejäätmetega ära visata. Kui keemiline sümbol on trükitud eespool toodud sümboli alla, siis tähendab
see, et antud patareis või akus leiduva raskemetalli (Hg = elavhõbe, Cd = kaadmium, Pb = plii)
kontsentratsioonitase on kõrgem kui patareisid ja akusid ning patarei- ja akujäätmeid käsitlevas
direktiivis sätestatud piirmäär. Antud tootest tekkinud jäätmed tuleb anda vastavasse kogumispunkti,
nt müügipunkti, mis on volitatud üks ühe vastu vahetama, kui ostate uue sarnase toote, või
vastavasse elektri- ja lektroonikaseadmete jäätmete ning patareide ja akude ümbertöötlemiseks mõeldud
kogumispunkti. Antud liiki jäätmete vale käitlemine võib kahjustada keskkonda ja inimeste tervist elektri-
ja elektroonikajäätmetes tavaliselt leiduvate potentsiaalselt ohtlike ainete tõttu. Antud tootest tekkinud
jäätmete nõuetekohase kõrvaldamisega aitate kasutada loodusvarasid efektiivselt. Täiendava teabe
saamiseks elektri- ja elektroonikaseadmetest tekkinud jäätmete ning patarei- ja akujäätmete tagastamise
ja ümbertöötlemise kohta võtke ühendust kohaliku omavalitsusega, asjakohase valitsusasutusega,
asjakohase tootjavastutusorganisatsiooniga või olmejäätmete käitlejaga. Lisateavet leitate ka Interneti-
leheküljelt www.canon-europe.com/weee või www.canon-europe.com/battery.

Tikai Eiropas Savienībai un EEZ (Norvēģijai, Islandei un Lihtenšteinai)

Šie simboli norāda, ka atbilstoši ES Direktīvai (2012/19/ES) par elektrisko un elektronisko iekārtu
atkritumiem (EEIA), Direktīvai (2006/66/EK) par baterijām un akumulatoriem, un akumulatoru atkritumiem,
ar ko atceļ Direktīvu 91/157/EEK, un vietējiem tiesību aktiem šo izstrādājumu nedrīkst izmest kopā
ar sadzīves atkritumiem. Ja zem iepriekš norādītā simbola ir uzdrukāts ķīmiskais simbols, saskaņā ar
direktīvu par baterijām un akumulatoriem tas nozīmē, ka šīs baterijas vai akumulatori satur smagos
metālus (Hg = dzīvsudrabs, Cd = kadmijs, Pb = svins) un to koncentrācijas līmenis pārsniedz direktīvā
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par baterijām un akumulatoriem minēto piemērojamo slieksni. Šis izstrādājums ir jānodod piemērotā
savākšanas vietā, piemēram, apstiprinātā veikalā, kur iegādājaties līdzīgu jaunu produktu un atstājat
veco, vai apstiprinātā vietā izlietotu elektrisko un elektronisko iekārtu un bateriju un akumulatoru
pārstrādei. Nepareiza šāda veida atkritumu apsaimniekošana var apdraudēt vidi un cilvēka veselību
tādu iespējami bīstamu vielu dēļ, kas parasti ir elektriskajās un elektroniskajās iekārtās. Jūsu atbalsts
pareizā šāda veida atkritumu apsaimniekošanā sekmēs efektīvu dabas resursu izmantošanu. Lai saņemtu
pilnīgāku informāciju par šāda veida izstrādājumu nodošanu otrreizējai pārstrādei, sazinieties ar vietējo
pašvaldību, atkritumu savākšanas atbildīgo dienestu, pilnvaroto organizāciju vai iestādi, kas veic sadzīves
atkritumu apsaimniekošanu, vai apmeklējiet tīmekļa vietni www.canon-europe.com/weee, vai www.canon-
europe.com/battery.

Tik Europos Sąjungai ir EEE (Norvegijai, Islandijai ir Lichtenšteinui)

Šie simboliai reiškia, kad šio gaminio negalima išmesti į buitines atliekas, kaip reikalaujama WEEE
Direktyvoje (2012/19/ES) ir Baterijų direktyvoje (2006/66/EB) ir (ar) jūsų šalies nacionaliniuose
įstatymuose, kuriais šios Direktyvos yra įgyvendinamos. Jeigu cheminio ženklo simbolis yra nurodytas
žemiau šio ženklo, tai reiškia, kad vadovaujantis Baterijų direktyvą, baterijų ar akumuliatorių sudėtyje
yra sunkiųjų metalų (Hg = gyvsidabrio, Cd = kadmio, Pb = švino), kurių koncentracija viršija Baterijų
direktyvoje nurodytas leistinas ribas. Šį gaminį reikia pristatyti į specialųjį surinkimo punktą, pavyzdžiui,
mainais, kai jūs perkate naują panašų gaminį, arba į specialiąją surinkimo vietą, kurioje perdirbamos
elektrinės ir elektroninės įrangos atliekos bei naudotos baterijos ir akumuliatoriai. Dėl netinkamo šio
tipo atliekų tvarkymo gali nukentėti aplinka ir iškilti grėsmė žmogaus sveikatai dėl galimai kenksmingų
medžiagų, iš esmės susijusių su elektrine ir elektronine įranga. Bendradarbiaudami ir teisingai
utilizuodami šiuos gaminius, jūs padėsite efektyviai naudoti gamtinius išteklius. Daugiau informacijos
apie gaminio perdirbimą jums gali suteikti vietinis biuras, atliekų tvarkymo bendrovė, sertifikuoti organai
ar buitinių atliekų surinkimo įmonės. Taip pat siūloma apsilankyti interneto svetainėje www.canon-
europe.com/weee, arba www.canon-europe.com/battery.

Samo za Evropsko unijo in EGP (Norveška, Islandija in Lihtenštajn)

Ti simboli pomenijo, da tega izdelka skladno z Direktivo OEEO (2012/19/EU), Direktivo 2006/66/ES in/ali
nacionalno zakonodajo, ki uvaja ti direktivi, ne smete odlagati z nesortiranimi gospodinjskimi odpadki.
Če je pod zgoraj prikazanim simbolom natisnjen kemijski simbol, to v skladu z Direktivo pomeni, da je
v tej bateriji ali akumulatorju prisotna težka kovina (Hg = živo srebro, Cd = kadmij, Pb = svinec), in
sicer v koncentraciji, ki je nad relevantno mejno vrednostjo, določeno v Direktivi. Ta izdelek je potrebno
odnesti na izbrano zbirno mesto, t. j. pooblaščeno trgovino, kjer ob nakupu novega (podobnega) izdelka
vrnete starega, ali na pooblaščeno zbirno mesto za ponovno uporabo odpadne električne in elektronske
opreme (EEO) ter baterij in akumulatorjev. Neustrezno ravnanje s to vrsto odpadkov lahko negativno
vpliva na okolje in človeško zdravje zaradi potencialno nevarnih snovi, ki so pogosto povezane z EEO.
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Vaše sodelovanje pri pravilnem odlaganju tega izdelka predstavlja pomemben prispevek k smotrni izrabi
naravnih virov. Za več informacij o ponovni uporabi tega izdelka se obrnite na lokalen mestni urad,
pristojno službo za odpadke, predstavnika pooblaščenega programa za obdelavo odpadkov ali na lokalno
komunalo. Lahko pa tudi obiščete našo spletno stran www.canon-europe.com/weee, ali www.canon-
europe.com/battery.

Само за Европейския съюз и ЕИП (Норвегия, Исландия и
Лихтенщайн)

Тези символи показват, че този продукт не трябва да се изхвърля заедно с битовите отпадъци
съгласно Директивата за ИУЕЕО (2012/19/ЕC), Директивата за батерии (2006/66/ЕО) и/или Вашето
национално законодателство, прилагащо тези Директиви. Ако под показания горе символ е
отпечатан символ за химически елемент, съгласно разпоредбите на Директивата за батерии,
този втори символ означава наличието на тежък метал (Hg = живак, Cd = кадмий, Pb = олово)
в батерията или акумулатора в концентрация над указаната граница за съответния елемент в
Директивата. Този продукт трябва да бъде предаден в предназначен за целта пункт за събиране,
например на база размяна, когато купувате нов подобен продукт, или в одобрен събирателен
пункт за рециклиране на излязло от употреба електрическо и електронно оборудване (ИУЕЕО),
батерии и акумулатори. Неправилното третиране на този тип отпадъци може да доведе до
евентуални отрицателни последствия за околната среда и човешкото здраве поради потенциално
опасните вещества, които обикновено са свързани с ЕЕО. В същото време Вашето съдействие за
правилното изхвърляне на този продукт ще допринесе за ефективното използване на природните
ресурси. За повече информация относно това къде можете да предадете за рециклиране на
този продукт, моля свържете се с Вашите местни власти, с органа, отговорен за отпадъците, с
одобрената система за ИУЕЕО или с Вашата местна служба за битови отпадъци, или посетете
www.canon-europe.com/weee, или www.canon-europe.com/battery.

Doar pentru Uniunea Europeană şi EEA (Norvegia, Islanda şi
Liechtenstein)

Aceste simboluri indică faptul că acest produs nu trebuie aruncat împreună cu deşeurile menajere, în
conformitate cu Directiva DEEE (2012/19/UE), Directiva referitoare la baterii (2006/66/CE) şi/sau legile
dvs. naţionale ce implementează aceste Directive. Dacă un simbol chimic este imprimat sub simbolul de
mai sus, în conformitate cu Directiva referitoare la baterii, acest simbol indică prezenţa în baterie sau
acumulator a unui metal greu (Hg = Mercur, Cd = Cadmiu, Pb = Plumb) într-o concentraţie mai mare
decât pragul admis specificat în Directiva referitoare la baterii. Acest produs trebuie înmânat punctului de
colectare adecvat, ex: printr-un schimb autorizat unu la unu atunci când cumpăraţi un produs nou similar
sau la un loc de colectare autorizat pentru reciclarea reziduurilor de echipament electric şi electronic
(EEE) şi baterii şi acumulatori. Administrarea neadecvată a acestui tip de deşeuri, ar putea avea un

701



impact asupra mediului şi asupra sănătăţii umane datorită substanţelor cu potenţial de risc care sunt în
general asociate cu EEE. Cooperarea dvs. în direcţia reciclării corecte a acestui produs va contribui la
o utilizare eficientă a resurselor naturale. Pentru mai multe informaţii despre reciclarea acestui produs,
vă rugăm să contactaţi biroul dvs. local, autorităţile responsabile cu deşeurile, schema aprobată sau
serviciul dvs. responsabil cu deşeurile menajere sau vizitaţi-ne la www.canon-europe.com/weee, sau
www.canon-europe.com/battery.

Samo za Europsku uniju i EEA (Norveška, Island i Lihtenštajn)

Oznaka pokazuje da se ovaj proizvod ne smije odlagati s komunalnim i ostalim vrstama otpada, u skladu
s direktivom WEEE (2012/19/EC), Direktivom o baterijama (2006/66/EC) i Pravilnikom o gospodarenju
otpadnim baterijama i akumulatorima te Pravilnikom o gospodarenju otpadnim električnim i elektroničkim
uređajima i opremom. Ako je ispod prethodno prikazane oznake otisnut kemijski simbol, u skladu s
Direktivom o baterijama, to znači da se u ovoj bateriji ili akumulatoru nalazi teški metal (Hg = živa, Cd
= kadmij, Pb = olovo) i da je njegova koncentracija iznad razine propisane u Direktivi o baterijama. Ovaj
bi proizvod trebalo predati ovlašenom skupljaču EE otpada ili prodavatelju koji je dužan preuzeti otpadni
proizvod po sistemu jedan za jedan, ukoliko isti odgovara vrsti te je obavljao primarne funkcije kao i
isporučena EE oprema. Otpadne baterije i akumulatori predaju se ovlaštenom skupljaču otpadnih baterija
ili akumulatora ili prodavatelju bez naknade i obveze kupnje za krajnjeg korisnika. Neodgovarajuće
rukovanje ovom vrstom otpada može utjecati na okoliš i ljudsko zdravlje zbog potencijalno opasnih
supstanci koje se najčešće nalaze na takvim mjestima. Vaša suradnja u pravilnom zbrinjavanju ovog
proizvoda pridonijet će djelotvornom iskorištavanju prirodnih resursa. Dodatne informacije o recikliranju
ovog proizvoda zatražite od svog lokalnog gradskog ureda, službe za zbrinjavanje otpada, odobrenog
programa ili komunalne službe za uklanjanje otpada ili pak na stranicama www.canon-europe.com/weee
ili www.canon-europe.com/battery.

Korisnici u Srbiji

Ovaj simbol označava da ovaj proizvod ne sme da se odlaže sa ostalim kućnim otpadom, u skladu sa
WEEE Direktivom (2012/19/EU), Direktivom o baterijama (2006/66/EC) i nacionalnim zakonima. Ukoliko
je ispod gore navedenog simbola odštampan hemijski simbol, u skladu sa Direktivom o baterijama, ovaj
simbol označava da su u ovoj bateriji ili akumulatoru prisutni teški metali (Hg – živa, Cd – kadmijum, Pb -
olovo) u koncentracijama koje premašuju prihvatljivi prag naveden u Direktivi o baterijama. Ovaj proizvod
treba predati određenom centru za prikupljanje, npr. po principu „jedan-za-jedan“ kada kupujete sličan
novi proizvod, ili ovlašćenom centru za prikupljanje za reciklažu istrošene električne i elektronske opreme
(EEE), baterija i akumulatora. Nepravilno rukovanje ovom vrstom otpada može imati negativne posledice
po životnu sredinu i ljudsko zdravlje usled potencijalno opasnih materijala koji se uglavnom vezuju za
EEE. Vaša saradnja na ispravnom odlaganju ovog proizvoda će doprineti efikasnom korišćenju prirodnih
resursa. Više informacija o tome kako možete da reciklirate ovaj proizvod potražite od lokalnih gradskih
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vlasti, komunalne službe, odobrenog plana reciklaže ili servisa za odlaganje kućnog otpada, ili posetite
stranicu www.canon-europe.com/weee, ili www.canon-europe.com/battery.

703



Handling Precautions

When Repairing, Lending, or Disposing of the Printer

Ink Tips
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When Repairing, Lending, or Disposing of the Printer

If you have entered personal data, passwords and/or other security settings on the printer, such information
may be stored in the printer.

When sending the printer for repair, lending or transferring the printer to another person, or disposing of the
printer, please be sure to follow the steps below in order to delete such information and prevent third parties
from accessing it.

• Select  (Setup) on the HOME screen and select Printer settings > Reset settings > Reset•
all > Yes.
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Ink Tips

How is ink used for various purposes other than printing?
Ink may be used for purposes other than printing.

During initial setup, some of the ink from the bundled ink bottles is used to fill the print head's nozzles to
ensure the printer is print-ready.

Therefore, the page yield of the initial bundled set of ink bottles is lower than that of the subsequent sets
of bottles.

To keep printer's performance, Canon printer performs cleaning automatically according to its condition.
When the printer performs cleaning, a small amount of ink is consumed. In this case, all colors of ink may
be consumed.

[Cleaning function]

The cleaning function helps the printer to suck air bubbles or ink itself from the nozzle and thus prevents
print quality degradation or nozzle clogging.

Important
• The used ink is ejected into the maintenance cartridge. When the maintenance cartridge becomes•

full, replacement is necessary. If the displayed message indicates that the maintenance cartridge is
nearly full, promptly obtain a new one.

Replacing the Maintenance Cartridge

Does black-and-white printing use color ink?
Black-and-white printing may use ink other than black ink depending on the type of printing paper or the
settings of the printer driver. So, color ink is consumed even when printing in black-and-white.

Similarly, color inks are also consumed along with black ink during print head cleaning when Black is
specified for cleaning.
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Online Manual

This manual has been confirmed to be displayed on the following web browsers (latest version).

• Windows device
Microsoft Edge and Google Chrome

• macOS / iOS / iPadOS device
Safari

• Android device
Google Chrome

* Set your browser to allow cookies and enable JavaScript.

The illustrations in this manual are based on the TC-20M printer. The illustrations may differ from the
model you are using.

Screenshots in This Manual
For Windows:
The screenshots used in this manual are taken with Windows 10.

For macOS:
The screenshots used in this manual are taken with macOS Catalina 10.15.
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